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Getting Started

This section is intended to provide users with an introduction to the STEP system and concepts. Additionally, it
provides detailed information needed to perform basic data maintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around STEP Workbench, but the concepts and functionality presented are often applicable to
both the workbench and Web Ul interfaces. Because of this, it is helpful for users of either interface to be familiar with
the material in this guide. For documentation specific to the Web Ul, refer to the Web User Interfaces guide.

The Getting Started guide contains the following sections.

* Introduction: This section includes a terminology table and an overview of some basic STEP concepts. This

material should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.

STEP Workbench Ul: This section introduces the user to the workbench interface, as well as providing detailed
reference information for the various functions, including toolbar actions and menu options.

Object Maintenance in the Tree Tab: This section provides an overview of creating, editing, and deleting
objects in the workbench, as well as providing detailed information for working with particular types of objects.

Navigating and Searching: This section introduces the user to basic search and navigation functionality in
STEP Workbench, as well as providing detailed descriptions of the search criteria available on the Advanced
Search tab.

STEP Workbench Keyboard Shortcuts : This topic provides a list of keyboard shortcuts that can be used in the
workbench.

© Stibo Systems - Public - 2025.3 - September 2025 8
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Introduction

This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.

* STEP Terminology: A table defining basic STEP terms, including links to topics with additional information.

Basic STEP Concepts: Introduces some core concepts in STEP to facilitate understanding of the Getting
Started and System Setup guides.

Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.
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This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the online
help. Links to additional material on related topics are also provided, when appropriate. This should not be
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considered a complete list of all STEP terms as it is intended to cover only the more commonly used terms that

users are likely to encounter throughout the online help.

A

Term Definition Further Reading

Action Type of business rule that can be executed to manipulate data or perform an Refer to the
action. Actions can be executed by various processes and events within the Business Actions
system. For example, at approval of an object, within a workflow (on entry to a topic in the
state, exit from a state, on the transition between tasks, or when a deadline has Business Rules
been met), as part of an import process, or from a bulk update process. documentation.

API refer to Public API Refer to the

Technical
Documentation
link on the Start
Page.

Approval The process of pushing data from the Maintenance workspace to the Approved Refer to the
workspace in STEP. Approval can be associated with business logic that may Approval of
prevent approval or may perform automated data updates during approval. Objects topic in
Approvals are often the triggers for sending data to downstream systems. the Getting

Started
documentation.

Asset Any type of digital media, such as an image, Word document, PDF, Excel file, Refer to the
PowerPoint, JPG, GIF, etc. Assets topic in

the Getting

Started

documentation.
Asset Push | A process that exports assets from STEP to a file system. Conversion templates | Refer to the Asset

© Stibo Systems - Public - 2025.3 - September 2025
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Definition

Term Definition Further Reading
can be applied to transform images, for example from high res to low res, Push topic in the
resizing, applying color scales, etc., though assets can also be sent as-is to Digital Assets
make them available on the file system. documentation.

Assignee The user or group to which a task is assigned for work to be performed within a Refer to the
workflow. User states can be assigned directly to a named user or to a user Assignees in
group. When a state is assigned to a user group the task is "offered" to all Workflows topic
members of that group. To perform the task associated with the state, a member | in the Workflows
of the group has to claim the task. Once a task is claimed it is no longer visible in | documentation.
the group task list; only the person who claimed the task is able to view it. A user
may subsequently release a task back to the group.

Attribute A characteristic or detailed piece of information related to a particular object. Refer to the
Attributes can be one of two types, description or specification. Description Attributes topic in
attributes are available on most object types in STEP, while specification the System Setup
attributes are only available on objects in the Primary Product Hierarchy. documentation.

Attribute Groups attributes, reference types, and/or link types. Attribute groups can have Refer to the

Group sub-groups. Attribute Groups

topic in the
System Setup
documentation.

Attribute The value stored in a particular attribute on a particular object. Refer to the

Value Attributes topicin

the System Setup
documentation.
B

Further Reading

Bookmark

A placeholder created by the user that serves as a shortcut to a
previously viewed location.

Refer to the Bookmarks
topic in the Getting

© Stibo Systems - Public - 2025.3 - September 2025
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Term Definition Further Reading

Started documentation.
Business Automated piece of programming logic that may implement customer- Refer to the Business
Rule defined rules, such as validations, automatic updates, notifications, data- | Rules topic in the

driven workflow routing, etc. Also refer to Condition and Action.

Business Rules
documentation.

C

Term

Calculated
Attribute

Definition

An attribute where the value is calculated according to a specific formula
defined for this attribute. The formula may include static text, other
attribute values, information from references on the object, and a number
of other options.

Further Reading

Refer to the
Calculated
Attributes topicin
the System Setup
documentation.

Category Profile

View in STEP that helps product managers and data analysts to get an
overview of an entire section of the Product Hierarchy through various
metrics that are displayed in dashboard format.

Refer to the Data
Profiles topic in the
Data Profiling

documentation.
Character Tag An entry that begins with “<” and ends with “/>” such as <check/>. These Refer to the Tags
tags represent characters that may not be found in the special character topic in the System
map in Unicode, or may be used instead of the Unicode character. Setup
documentation.
Claim The action that a user performs to take a task in a workflow out of a group | Refer to the
queue and assign to himself / herself. Claiming and

Releasing Tasks in
Workflows topic in
the Workflows
documentation.

© Stibo Systems - Public - 2025.3 - September 2025




- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

Term Definition Further Reading
Classification A particular type of hierarchy that organizes groups of objects or assets. Refer to the
Objects are linked to classifications via references, and may have Classifications topic
references to multiple classifications. Also referred to as "yellow folders." | in the Getting
Started
documentation.
Collection An object that holds a static set of objects, or a dynamic search criteria Refer to the
that can be refreshed as needed to find the latest matching objects. Using | Collections topic in
collections, the resulting data can be displayed, bulk actions can be the Getting Started
performed, or the objects can be exported. documentation.

Completeness

A measurement within STEP, expressed as a percentage, to indicate the

Refer to the Metric

Score proportion of key data that has been completed for a particular object. Visualization topic
This key data is configurable, as is the weighting of importance. in the System Setup
documentation.
Condition A condition is a type of business rule that evaluates to either true or false, | Referto the
and does not change data. In relation with approval, a condition can act Business

as validation for whether an approval action can be carried out. In relation
to workflows, conditions can be used to prevent a transition from being
taken if certain conditions are not met.

Conditions topic in
the Business Rules
documentation.

Configuration
Property, Config

A setting in the Self-Service Ul (found on an environment's 'Configuration
Properties' tab) that administrators can modify to control specific

Refer to the Self-
Service Ul topic.

© Stibo Systems - Public - 2025.3 - September 2025

Properties functionality.
Context A specific filter placed on the system data. Each context is a combination | Referto the
of different dimensions such as language, country, and so forth, for Contexts topic in
example, English US, French CA, or German DE. Data may vary based the System Setup
on context. documentation.
D
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Term Definition Further Reading
Data An object type for modeling complex entity or product data structures with a | Refer to the Data
Container single record. Data containers make use of composite attributes which are Containers topic in
composed of other data structures, and they are intended to ensure thatall | the System Setup
create, read, update, and delete operations can be performed as a whole. documentation.
Data Model Basic system configuration defining the allowable structures and make up Refer to the sections
of data within STEP. Consists of system setup data, including: dimensions, | within the System
contexts, object types, reference types, keys, component models, attribute Setup
groups, attributes, lists of values, units, and tags. documentation.
Dimension- An attribute that can have different values for different dimension points, Refer to the
Dependent where the actual value is determined by the context in which the attribute is | Dimension
Attribute presented. Dependent
Attributes topic in
the System Setup
documentation.
E
Term Definition Further Reading
Entity A group of master data that has a specific business meaning. Entities typically Refer to the
store product-neutral data in STEP according to client-specific groupings of Entities topicin
information, such as customers, employees, suppliers, and addresses. Entities | the Getting
are also often used to store reference data that is utilized within the system. Started
Entities can be grouped into a hierarchy using reference types that are only documentation.
valid from an entity object to an entity object. A source object can be displayed
as a child of the target object or the target as a child of the source.
Externally A characteristic of an attribute or reference that can be setto 'Yes’ or ’'No’. A Refer to the
Maintained 'Yes’ selection indicates that the data point is maintained externally, and a Externally
Attribute change in it does not trigger a change in approval status and/or a new revision Maintained
on the STEP object on which the data was changed. A 'No’ selection indicates Attributes topic in
that the data point is maintained internally and a change in it has the potential the System

© Stibo Systems - Public - 2025.3 - September 2025
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Definition Further Reading
to trigger a change in the approval status and/or a new revision on the STEP Setup
object on which the data was changed. documentation.

F
Definition Further Reading
Function A type of business rule that allows for input parameters to produce | Refer to the Business Functions
an output. These operations are side-effect free, and it do not topic in the Business Rules
change STEP data. documentation.
G
Term Definition Further Reading
Golden Collection of data from a variety of sources, based on Refer to the Survivorship in Match and
Record matching, linking, and survivorship rules. The Golden Merge topic, the Survivorship in Match and
Record is considered the trusted data record, compiled Link topic in the Matching, Linking, and
from the various source objects. Merging documentation.
GUI Graphical user interface. For STEP, this can be the Refer to the GUI Setup topic in the System
workbench or Web Ul. A GUI Setup documentation or the Design Mode
Basics topic in the Web User Interfaces
documentation.

Definition Further Reading

Hierarchy A data structure composed of parents | Refer to the Object Type Hierarchy topic in the System
and children. Setup documentation.

© Stibo Systems - Public - 2025.3 - September 2025 15
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Term Definition Further Reading
Hotfolder File system of folders where data can | Refer to the IIEP - Choose Receiver topic in the Data
be dropped for automatic loading into | Exchange documentation, Configuring an Asynchronous
STEP, based on the particular File Exchange Service topic in the Data Integration
configurations and/or code appliedto | documentation, or the Asset Importer topic in the Digital
the hotfolder. Assets documentation.
I
Term Definition Further Reading
ID The unique identifier for all objects within STEP. It cannot be translated or
edited once created, and cannot contain special characters.
Image A series of parameters defining the way in which an image is transformed from | Refer to the
Conversion the standard high resolution asset that exists in STEP to the required Image
downstream format. Several conversion options are available by default, and Conversion
additional conversions can be added via configuration and/or extensions. Configuration
Note that conversions change assets as they are pushed from STEP, leaving topic in the Digital
the originating file unchanged in STEP. Assets
documentation.
Inbound Communication channel defining how data is received by STEP. Each Refer to the
Integration endpoint defines how data is received from an external system, specifying Inbound
Endpoint location, transport protocol, data to be exchanged and other configuration Integration
(NEP) parameters. Endpoints topic in
the Data
Exchange
documentation.
Integration Communication channel between STEP and external systems. Refer to Refer to the Data
Endpoint Inbound Integration Endpoint and Outbound Integration Endpoint. Exchange
(IEP) documentation.

© Stibo Systems - Public - 2025.3 - September 2025
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Term Definition Further Reading
Inheritance The ability to make data available in the product or classification hierarchy to Refer to the
lower nodes by linking it to a higher node in the hierarchical structure. Inherited
Attributes topicin
the System Setup
documentation.
J
K
L
Definition Further Reading
Library Set of functions that can be reused in multiple business rules or other Refer to the Business
libraries. Libraries cannot be called independently and must be referenced | Libraries topic in the
from other actions, conditions, or functions. Business Rules
documentation.

Link A parent/child relationship between objects within the STEP system. Refer to the Reference
and Link Types topic in
the System Setup
documentation.

List of A validation base type for an attribute that only allows a value to be Refer to the List of

Values considered valid if it belongs to a respective list of pre-configured values Values (LOV) topic in

(LOV) assigned to the attribute. Also used to refer to the value list itself. LOVs are | the System Setup

also referred to as 'Domains' at times. documentation.

Localized An attribute value that is set directly on an object and is not inherited from Refer to the Inherited

Value any level above in the hierarchy. Attributes topic in the
System Setup
documentation.

M
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Term Definition Further Reading
Mandatory Indicates that the product and all its sub-products must Refer to the Mandatory Attributes
Attribute have a value for the specified attribute in order for the topic in the System Setup
object to be approved. documentation.
Multi-Valued | An attribute that can contain more than one value for a Refer to the Editing Multi-Valued
Attribute specific object. Attributes topic in the System Setup
documentation.
N
O
Term Definition Further Reading
Object An element within the system, for example, a product, image, classification, Refer to the
attribute, workflow, business rule, etc. Basic STEP
Concepts topicin
the Getting
Started
documentation.
Object Type | A specific label for levels within a taxonomy, given to different elements within Refer to the
the system. Nearly every object in STEP is labeled with an object type to help Basic STEP
identify what it is (i.e., a product or entity rather than an image, a TIF rather than | Concepts topicin
a PDF, etc.). This includes entities, products, product categories, alternate the Getting
hierarchies, images and other assets, attributes, and LOVs. Through the use of | Started
object types, system administrators can control how rigid or loosely defined the | documentation.
database will be in terms of object creation and where objects are allowed to
‘live’ and/or be used. This labeling also becomes very important when working
with exported data so that each type of object in STEP can be identified for
special handling in web applications or other uses outside of STEP.
Orphan A specification attribute that has a value, which has been deleted from / not Refer to the
Attribute linked to a product node or classification and is denoted by italics. Linking Orphan

© Stibo Systems - Public - 2025.3 - September 2025
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Further Reading

Attributes topic in
the System
Setup
documentation.

Outbound
Integration
Endpoint
(OIEP)

Communication channel defining how data is sent by STEP. Each endpoint
defines how data is sent to an external system, specifying location, transport
protocol, data to be exchanged and other configuration parameters.

Refer to the
Outbound
Integration
Endpoints topic
in the Data
Exchange
documentation.

P

Term

Definition

Further Reading

Post-processor

A plugin component within the IEP framework
that allows STEP to act on the result of the
import / export such as starting workflows,
sending notifications, etc.

Refer to the IIEP Configuration Section of the
Maintaining an Inbound Integration Endpoint
topic and the OIEP - Event-Based - Output
Templates Section and OIEP - Select Objects -
Output Templates Section topics in the Data
Exchange documentation.

Pre-processor

A plugin component within the integration
endpoint framework that allows STEP to
modify the message prior to import / export. It
can be used for various functionality such as

pre-validation, format conversion, filtering, etc.

Refer to the IIEP Configuration Section of the
Maintaining an Inbound Integration Endpoint
topic and the OIEP - Event-Based - Output
Templates Section and OIEP - Select Objects -
Output Templates Section topics in the Data
Exchange documentation.

Primary
Product
Classification

Hierarchy that allows for different types of
objects to be stored once in the database;
each object within this hierarchy has a unique

Refer to the Object Type Hierarchy topic in the
System Setup documentation.

© Stibo Systems -
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Term Definition Further Reading
(PPC) ID / identifier and may have only one location
within the hierarchy. Also referred to as the
'blue hierarchy'.
Product One of the object super types, referring to any | Refer to the Products topic in the Getting
object within the Primary Product Started documentation.
Classification (blue hierarchy).
Product InDesign templates that determine what type Refer to the Product Templates topic in the
Template of data will appear on a printed page, including | Publisher (Adobe InDesign Integration)
the positioning and styling. documentation.
Product Variant | Data type used to model multiple variants of a Refer to the Product Variants topic in the

similar object. For example, T-shirts in various
sizes and colors could all be variants of a
single product.

System Setup documentation.

Print Proof View

A tab in the workbench or Web Ul that displays
a product template view (‘proof') of a selected
node (typically a Product but can also be an
Entity or Classification) without the user
needing to access InDesign.

Refer to the Print Proof View section of the
Publisher (Adobe InDesign Integration)
documentation.

Publication One of the super types, referring to objects in Refer to the Publication Hierarchy topic of the

the publication (green) hierarchy. Publisher (Adobe InDesign Integration)
documentation.

Public API The set of server-side functions that have been | Refer to the Technical Documentation link on
exposed to be used in the business logic. This | the Start Page.
includes many functions to create, get, and set
data, such as values and references. It also
includes various methods for logging as well
as sending emails.

Purge Removal of an object from the database. Refer to the Revisions topic in the System

Following purge, an object cannot be revived.

Setup documentation.

© Stibo Systems - Public - 2025.3 - September 2025
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Q
Term Definition Further Reading
Queue The mechanism within the IIEP framework that allows messages to be processed in | Refer to the
an asynchronous way. The queuing concept allows separating processes from Background
different integration endpoints as well as controlling the degree of parallel imports (a | Processes and
queue size of one guarantees sequential import, while a queue size larger than one | Queues topicin
allows parallel processing of multiple messages for increased throughput where the System
sequential execution is not required). Setup
documentation.
R
Definition Further Reading
Reference An association between objects within Refer to the Reference and Link Types topic in the
the STEP system. System Setup documentation.
S
Term Definition Further Reading
Setup Entity A configuration object that is based on a generic type of Refer to the URL Address Field
object which has been expanded for the specific need. For | section of the Toolbar topic and
example: Completeness Metric, Elasticsearch the Setup Actions and Error
Configuration, Asset Importer Configuration Type. Descriptions topic, both in the

Getting Started d tation.
Setup entities are identified in the URL with etiing Started documentation

'step://SetupEntity’, in STEPXML within the Also refer to the STEP-

<SetupEntities> tag, and in user privileges via the Productinformation Tag in

Maintain Setup Entity action set. Setup Entities can be STEPXML topic and the

exported using both the STEPXML and Advanced STEPXML Outbound Parameters

STEPXML formats. topic, both in the Data Exchange
documentation.
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Term Definition Further Reading

Special A character that cannot be found on a standard keyboard Refer to the Tags topicin the

Character but can usually be found in the Windows character map. System Setup documentation.
Example: Trademark Symbol - ™

SSuUl The Self-Service Ul allows administrators to access their Refer to the Self-Service Ul topic
Stibo Systems SaaS environments and perform in online help.
configuration tasks. Other information is available
including the Updates calendar.

State A step within a workflow to which a specific user, user Refer to the Creating a Workflow
group, or system can be assigned to complete the task(s) topic in the Workflows
associated with the state. documentation.

STEP Stibo Enterprise Platform master data software
application that provides business managers a single
source database to store, manage, and re-purpose
product information for publication or syndication.

STEP’n’design STEP’s plugins for InDesign that allow data from the STEP | Refer to the Print Publisher topic
database to be pulled onto pages. This is an outdated term | in the Publisher (Adobe InDesign
and has been replaced with 'Print Publisher.' Integration) documentation.

STEPXML The native XML language for STEP, which can be used for | Refer to the STEPXML Format
importing / exporting STEP data, as well as transferring topic in the Data Exchange
configurations between STEP systems. documentation.

Super type A major category of data within STEP including: Asset, Refer to the Object Super Types
Classification, Entity, Product, and Publication. Refer to topic in the Getting Started
the specific definition for each super type for additional documentation.
information.

Super User A user that is given administrative privileges within the Refer to the Action Sets topic in
STEP system. the System Setup documentation.

Superseded The 'Superseded' status displays with affected Refer to the Web Ul Component
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Definition Further Reading
components and serves as guidance to admin users Basics topic in the Web User
selecting which components to implement when Interfaces documentation.
configuring their Web UI.

T
Definition Further Reading
Task The work and/or action that must be completed within a Refer to the Working with Tasks in
specific workflow state (whether by a user or via Workflows topic in the Workflows
automation). documentation.
Transition The change of tasks from one state to another within a Refer to Creating a Workflow topic in the
workflow. Workflows documentation.
U
Term Definition Further Reading
Unique Key A unique key is a system entity that represents a specific object in the STEP Refer to the
system. The entity is composed of one or more data points, whether utilized Unique Keys
as-is or in a combined and/or transformed format using a specified formula. topicin the
There can be exactly one record for each object for each defined key. Notwo | System Setup
objects with the same unique key for an active key can exist. documentation.
User Rules that allow or restrict users from performing certain functions within the Refer to the
Permissions system. Privilege Rules
topic in the

System Setup
documentation.

<
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Definition Further Reading

task for a user, or sending an alert. Workflows may contain a number of
process steps or tasks, as well as business logic.

Validation A characteristic of attributes that identifies the format of the accepted | Refer to the Validation Rules
Base Type data for the attribute value, such as whether the value is a date, topic in the System Setup
integer, fraction, text, LOV, etc. documentation.
W
Term Definition Further Reading
Web Ul A web-based interface to access the STEP database in order to read, edit, or Refer to the Web
download data and assets. Multiple Web Uls can be configured for each STEP | User Interfaces
installation. documentation.
Workbench An interface for managing data in STEP, as well as carrying out administrative | Refer to the STEP
functions. Workbench Ul
topic in the
Getting Started
documentation.
Workers A unit in SaaS to define how a process is run, one process runs on one or Refer to the
multiple workers. One CPU can run on multiple workers. Sensors for
External
Monitoring topic
in the
Administration
Portal
documentation.
Workflow Business process(es) modeled as a series of states and tasks that can be Refer to the
executed by users and/or automatic processes within the STEP system. Workflows
Workflows prompt the next step of a process to be started, by either creatinga | documentation.
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Term

Workspace

Definition

A set of independent ‘copies’ of the database objects that provides a revision-
specific view of objects. Workspaces are organized into separate areas
including Main and Approved. The Main workspace is where data
maintenance takes place. The approved workspace is a non-editable
snapshot of data that has been determined to have been acceptable for
publishing to downstream systems.

Further Reading

Refer to the
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Workspaces topic

in the System
Setup
documentation.
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Basic STEP Concepts

This topic introduces some fundamental STEP concepts that provide a foundation for the rest of the material in the
Getting Started documentation, as well as the System Setup documentation. The focus of this topic is on data
structures and data management, and is notintended to be an introduction to the full capabilities of a STEP
system.

Object Types Overview

Technically, nearly everything in STEP is an object, and object types must be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different elements
within the system. Nearly every object in STEP is labeled with an object type to help identify whatitis (i.e., a
product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products, product
categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of object types,
system administrators can control how rigid or loosely defined the database will be in terms of object creation and
where objects are allowed to "live" and/or be used. This labeling also becomes very important when working with
exported data so that each type of object in STEP can be identified for special handling in web applications or
other uses outside of STEP.

Object types in STEP can largely be divided into two categories:

* Tree Object Types: Object types that make up the standard STEP hierarchies are accessible on the Tree tab in
the workbench. Many of these object types can be further grouped into five categories of object types, referred
to as the super types. Tree object types are defined in System Setup, but instances of the object types are
accessed within the Tree.

System Setup Object Types: Also referred to as Basic Object Types. This category encompasses all of the
remaining object types that make up a STEP system. Among many other things, this includes attributes, users,
integration endpoints, workflows, and business rules. System Setup object types are defined in System Setup,
and instances of the object types are also accessed within System Setup.

For more general information on object types, including how to create and maintain object types, refer to the
Object Types and Structures topic of the System Setup documentation.

Object Super Types

Each super type has specific characteristics that make it suitable for modeling particular types of data. For example,
inheritance of data is available within the product super type so objects that share data based on common
characteristics are typically modeled using this super type. Alternatively, digital media files are housed using the asset
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super type, which allows for automatic reading and storing of asset properties such as size and format. Any humber of

individual object types within each super type can be created. For example, a system may use both an 'lcon’ object type

and an 'lllustration’ object type (along with any number of others) within the asset super type.

The object super types are:

1.

Assets

Classifications

Entities

Products

Publications

For more information on the characteristics of the various super types, refer to the Object Super Types topic.

Object Types Versus Object Instances

Two core capabilities for managing data in STEP are the Tree tab and the System Setup tab. To successfully use

STEP, itis critical to understand the differences between the functions available in these two areas, specifically in

relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and import

configurations, products, classifications, images, etc. However, the term "objects" is more generally used to mean

assets, classifications, entities, products, and publications. In other words, the super types are also all things that you

can find on the Tree tab in STEP. This section focuses on the differences between object types and object instances for
Tree objects, specifically those that fall into the super types.

For example:
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PRODUCTION

Tree

P[] Assets

b [ Configurations
P = Index Words
+ [0 web Sites US

Ad*.n:jrmed » [C] Marketing Postcards
Search
w [2 PreferredProducts
© B 20714
BG Processes B 20714A
(154) B 207148
¥ 20714-D
o B 20714-E
System Setup B 20714-F
» B Entity Root
[:] » Il Publications
e E Ll ~ ™ Primary Product Hierarchy
w [3 Products
s b 15 Alarm Clocks
STEP Workflow P 5 Alarms
b 3 Apparel

P 3 Audio Visual Equipment
¥ 3 Automotive
¥ [2 Parts & Accessories
P 3 Spark Plugs
 [3 Tire Care
* [0] Tire Care SalesItems
.. 7130-03-FR
| 8225-012
+ [l Tire Care Items
» B8 20001

™ 2007

B rRP4100
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The objects and structures available in the Tree will vary based on your particular data model, but the concepts
described can be applied across any data model. Regardless of the specific names or structures, each node on
the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user can right-click on
many of these objects and have a 'New..." option, such as 'New Product' or 'New Classification', allowing them to
create a new node in the hierarchy. For example, when right-clicking on the 'Apparel' object and selecting 'New
Product, a dialog appears with an option to create an object with one of a few possible object types.

Tree
Create Product

~ I Primary Product Hierarchy

w 3 Products Object Type
P [3 Alarm Clocks ]
P O Alarms
b =1 [apparel ID 5913433

P 3 Audio Visual Equipment Name
P 3 Automotive
P 3 Building Products

Create Cancel

Typing a Name and clicking Create would create a new object as a child to the Apparel node.

But consider these questions:

® What defines that a 'Level 2' object can be created on this node?

® What defines that it is a Product (blue) object rather than an Entity (gray) or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in System Setup.
Continuing with the above example, we can observe that the defined object types and structures include a Primary
Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which in turn can only have a
Level 3 child. However, a Level 3 object type can have a number of child object types, including an Item Folder, Level 4,
and a Sales ltem Folder. A Sales Item Folder is a child of a Level 3 object type, as mentioned, but can also be a child to
a Level 4. Similarly, a Sales ltem can be child to multiple things, including a Sales Item Folder and a Sales Item Family.
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- [ Object Types & Structures
P [T] Alternate Classifications
b 3 Assets
& Avaiabiity
» & Basic Object Types
» &) Commerdal Types
b [ Entity user-type root
» & Event Queue Object Types
~ 0 Primary Product Classification
b 3 Discontinued Products
P 2 External Products
P B8 Packaging Hierarchy
» B Primary Product Classification
 [3 Products
v O Level 1

w [0 Level 2
* [0 Level 3

+ Il [tem Folder
« M item

Wl Open Item
» Il Item Family

~ @ Item

W Open tem
w [0 Level 4

+ il [tem Folder
v @ Item
W Open Item
~ [l Item Family
~ @ Item
W Open Item
* O] Sales Item Folder
w || Sales Ttem
|| Open Sales Item
w [T SalesItemFamity
w || Sales Item
|| Open Sales Item
w ] Sales Item Folder
w || Sales Ttem
| Open Sales Item
* [0 SalesItemFamiby
* | Sales Item
o Systems - Public - 2025.3 - Bepleentset20asn
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The object types defined in System Setup provide the "skeleton" for the allowable instances of objects that can be
created in the Tree. It is important to understand that only the structure and types of objects are defined in System
Setup, but any number of instances of the defined types can be created in Tree. This is best illustrated by viewing
System Setup and Tree side by side, as shown below. Object instances are displayed in Tree, with red text indicating
the corresponding object type designations from System Setup.

Bl System Setup PROD [y y vt
.I= ~ (& Object Types & Structures .1= ~ [ Primary Product Hierarchy ~ Primary Product Classification
» [T Alternate Classifications
Q b 3 Assets
& Avaiabiity
© » (Z Basic Object Types

¥ 3 Products  Products
~ [0 Automotive Level 1
¥ [3 Parts & Accessories  Level 2
¥ [0 Spark Plugs  Level 3

» &l Commerdial Types B14 item
» (& Entity user-type root Bisc ltem
» & Event Queue Object Types P17 lem

~ [ Primary Product Classification
» B Discontinued Products
» I3 External Products
» B8 Packaging Hierarchy
» B Primary Product Classification

~ S Tire Care | evel 2
w 3] Tire Care Salesltems  Sales ltem Folder
i 7130-03-FR ~ Sales ltem
|l 8225-012 Sales ltem
~ Wl Tire Care Items  Item Folder

~ 5 Products ~ 20001  item
¥ O level 1 Wl 120-Volt AC Inflator ~ Open Item
T e B |
- g8 e Folder BARP4100  item
~ [0 Games Level1
~ Bitem ~ [S1Board Games  Level 2
Wl Open Item ~ [3 Family Games  Level 3
» Wl Item Family BiLe ltem
- I Item B Monopoly  item
@ Open Ttem w | Other Games Sales ltem
v [0 Level4 |1 Bamboozle Open Sales ltem
~ I Ttem Folder w [T Card Games  Level 2
v B 1em B soitaire  ltem
Wl Open Item
~ Il Item Family
~ & tem
@ Open Item
w [0 Sales Item Folder
w || Sales Item

| Open Sales Ttem
¥ [T SalesItemFamily
w || Sales Item
| Open Sales Item

Notice in the above screenshots that a Level 2 object exists in System Setup only once, but there are multiple instances
ofitin Tree.
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The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For example,
an entity hierarchy could have a customer object type with allowable children of address and contact object types. The
object types and structures are defined in System Setup, and instances of these objects can then be created in Tree.

System Setup Tree
[ Object Types & Structures v I Entity Root
¥ [T Alternate Classifications v {J Customer Hierarchy
b 2 Assets ~ 2 Customer A
& Availabiity 4t Axel Kiers Veg 11
» (& Basic Object Types £%| Jesper Jensen
» & Commercal Types ~ 2 Customer B
¥ [ Entity user-type root 4} 3200 Windy Hil Road SE
~ [ Entity Root £ Jane Smith
v iy Al Customers 2 Customer C
+ 2 Customer
» 4% Address
» |25| Contact

Object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy (blue hierarchy)
can only contain object types of the product super type, while an entity hierarchy (gray hierarchy) can only contain
objects of the entity super type. It is possible to have the visual appearance of mixed hierarchies, but this is
accomplished via references rather than actual data structures. For example, products in the Tree may appear to be
within a classification hierarchy, but this is due to references on the object, as shown below.

Tree 115121
¥ [0 Merchandising Hierarchy ftem o Revision: 0.2
» 2 Apparel
» [0 Automotive -
» [T] Beverages )
Product Data Containers  Sub Products References Referenced By Images & Documents  Commercil
~ [0 Footwear
~ [0 Women's Footwear Sales Item References, Classification
w [ 7] Dress Shoes
Reference Type v Target
L [115121
L 115122 Merchandising Link + E [T Merchandising Hierarchy/Footwear/\Women's Footwear/Dress Shoes | X

Ll 115123 Website Link + | ¥ | [@ Web Sites/Sales Promotions/Footwear/Shoes X

Notice that the corresponding System Setup structure for the above does not include the product object types.
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System Setup

* [T Merchandising Hierarchy Root
+ [ Department
* [T SubDepartment
2 MerchandisingClass
+ [ Web Hierarchy Root
w [ Website Root
» [ Web Level 1

~ [[3 Web Level 2
[C1 WeblLevel3

The true residence of the product objects is within the Primary Product Classification, with a visual display of the
product references into various classification hierarchies being just that: a visual display of references. However,
assets are an exception to this concept. Assets are not part of the classification structure in System Setup, but do
exist within this structure in Tree. Each asset must be linked to one or more classifications, and this is the only
location in which they "live" in STEP. Each asset automatically has a reference applied to each classification in
which itis linked. More information on references can be found in the Reference and Link Types topic in the
System Setup documentation. More information on the various object super types and their characteristics can be
found in the Object Super Types topic.

Using the above information, the questions posed earlier in this topic can now be answered:

¢ Why can we only create a Level 2 object under the Apparel node? Because in this particular data model
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be created

under a Level 1 object type.

Why can we not create an Entity or Classification under the Apparel node? Because only object types within the
same super type can exist within the same hierarchy. And even if this was not the case, the structure defined in
System Setup in this particular hierarchy only allows a Level 2 object type (of the product super type) under a Level
1 object type.
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Note: All text data is saved in the system in Unicode UTF-8. All standard data exports from the system are also in
UTF-8. Some system extensions may use a different character set on export, but the standard is UTF-8.

UTF-8 can define more than one million characters. To do so, it uses up to 4 bytes of storage. Regardless of whether
it uses one, two, three, or four bytes, it is still one character, and as such, any character counts that are imposed on
the text attribute’s length are specified and counted in characters and not in bytes.

As a standard, the Microsoft Arial Unicode font is used for display. Its character set supports most languages of the
Americas, and Western and Eastern Europe (including Cyrillic and Greek). In some cases, as in the case with some
Asian languages, additional fonts must be loaded onto the PC or MAC. But for most cases, the character set

provided by Arial Unicode MS is sufficient.

For more information on Unicode UTF-8, refer to the various web sites that describe its functionality, such as the
Wikipedia site: https://en.wikipedia.org/wiki/UTF-8.
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Object Super Types

This topic provides an introduction to the STEP object super types. It will be helpful to first read and understand
the Basic STEP Concepts topic.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in the workbench are
referred to as Tree Object Types. Many of these object types can be further grouped into five categories of object
types, referred to as the super types. This topic introduces the primary object super types in STEP. Understanding
the differences between the various object super types is important when making decisions about how to model
data in STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon’ object type and an 'lllustration' object type (along with any number of others) within the asset
super type.

The object super types are:

1. Assets

2. Classifications
3. Entities

4. Products

5. Publications

Each is described below, along with links to more detailed information for working with the various super types.

Assets

The asset super type is used to hold any type of digital media, including images, videos, documents, and text files.
Assets are organized within classifications, and can be linked to other objects in STEP using references. Specifically,
assets can be linked to objects of the classification, entity, or product object super types. Upon import, STEP populates
some basic information about each asset, which can be viewed under the System Properties section on each asset, but
cannot be edited. Default asset icons vary by file type, and can be updated by admin users.
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Tree
w [ Assets
» [C1Group B Assets
¥ [TIcons

NewSmIcon

ﬂ Icon = Revision: 1.0

&

[&] calGreen_Icon

'] CalGreen_Icon_Large
(%] LeadFree_Icon

] NEW!

@

[&] ProductFolderIcon
%] Showroom_Preferred
[&] WaterSense_Icon

Images & Documents  References Referenced By Status Log Statelog Tasks

“ Description

P [T Hustrations

» [Tl Installation Manuals
» [ Logos

» [ MSDS Sheets

» [ Owners Manual

» [ Product Images

» [T Product Videos

» [T Situation Images

» [T Suppliers

» (2 web Sites

» [T Addresses

» [T) Customers

» [TJ Entity Root

» (D GDSN

» [ Pubiications

» [Z1 Primary Product Hierarchy
» [ Colections

» (@ eCatalogs

» 3 Recycle Bin

Name H ¢ | value

ID 224300

Name NewSmIcon

Object Type Icon

Revision 2.0 Last edited by USERJ on Wed Nov 06 12:20:41 EST 2024
Approved X Never Been Approved

Translation Not Translated

Path Classification 1 root/Assets/Icons/NewSmIcon

Content In Language=Al Languages

v System Properties

Name : ¢ | value

¢ | Class rmsc | True color
Colorspace aec | RGB
Compression Rec | Zip
Depth 8 (bits/sample)
Extension sEC | png
Filename rec | NewSmlcon.png

For more information on working with assets, refer to the Assets topic.

Classifications
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The Classification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these icons may be updated by
an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored in
appropriate subfolders under the 'Assets' classification folder. Product objects could also be linked into

classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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Tree

D MSJIBO SYSTEMS

STER DATA MANAGEMEMNT

~ Cfhssets]
» [Z Group B Assets
» [CIcons
» [T Tlustrations
» [ Installation Manuals
» [T Logos
¥ [2] MSDS Sheets

Assets
AssetRoot » Revision: 0.1

#! Gloves MSDS1
! MSDSETHANOL AHYD HISTO

» [ Product Videos
[0 QAlbgo
» [C Situation Images
» ] Classifications
} [T Configurations
» [ eClass 10
b [T ECLASS ADVANCED Classifications

¥ [ ETIMS Article Groups
¥ [T Excel Custom Template

» = Index Words
P &) Media Asset Management
¥ [ Merchandising Hierarchy
» [= Apparel
* [ Automotive
* [ Tires

[ Tire Accessories

& 6854
| 8225

Classification  Sub Products  References Referenced By Images & Docum...
Description
Name Value
jin] AssetsRoot
Name Assets
Object Type AssetRoot
Revision 0.1 Last edited by Stibo Systems on Fri Jan 02 00:00:00 EST 1970
Approved + Approved on Fri Jan 02 00:00:00 EST 1970
Translation Not Translated
Path Classification 1 root/Assets
Visibility Country Root
Purpose nec | Global area to store assets by type

For more information on working with classifications, refer to the Classifications topic.

Entities

The Entity super type is used to create hierarchies and objects that do not require inheritance of data through

categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to store

reference data. In addition, entities are used to store source data for golden records. Entities are represented by

gray folders and white and gray cubes by default, but these can be updated by an admin user, as is evident in the
screenshot below.
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Tree

P[] Assets

b [T] Configurations
b [T ETIM Article Groups

b = Index Words

Advanced » [T] Merchandising Hierarchy
Search

b [ Suppliers
» [ Web Sites

© —
~ [ [Entity Root
BG Processes
1) v &f Customer Hierarchy
~ & Customer A
o ) Axel Kiers Vej 11
System Setup 22 Jesper Jensen
~ & Customer B
u 4} 3550 George Busbee Pkwy
Bookmarks 25| John Smith
» & Customer C
s » & Customer D
STEP Workflow o Key Accounts

For more information on working with entities, refer to the Entities topic.

Products

The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy are
often categories and subcategories, with leaf nodes being actual objects. Whether an organizational folder,
sellable object, or something else, each node in the hierarchy is of the product super type, and all child objects are
able to inherit attributes and values from parental objects.
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Tree
» [T Entity Root
» T GDSN
» I Publications
* [] Primary Product Hierarchy
Advanced
Search ¥ [ Products
b [ Apparel
@ » [0 Electronics
BG Processes > 51 Footwear
(1) b 5 Safety
P [ Hardware
Q b [T Displays
System Setup w [ Furniture
+ [ Bedroom
u ¥ [0 Beds
Bookmarks ~ [l Beds Items
|.. [Comfy Bed
Is |2 Comfy Side Rail
STEP Workflow |.| Comfy Headboard
|s] Comfy Footboard
P ] Beds Sales Items

For more information on working with products, refer to the Products topic.

Publications

The Publication super type is used to create hierarchies and objects used for print publishing solutions, including
Print Publisher, Print Flatplanner, and Print AutoPage. Publication objects are used to create templates used in
print solutions, as well as publications such as catalogs or pamphlets. Product objects can be linked into
publication hierarchies, meaning data from the product(s) will be reflected in the publication. Publication objects
use green icons by default, though these can be updated by an admin user.
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Tree X Shoes ) §
» D Entity Root Pubiication Section ~ Pagination Rules ~ Status ~ State Log  Tasks
» [T GDSN
~ [ Publications * Description
» Il Templates T
» [ standard Pubiications Name Pl G| vale
« [ Autopage Pubiications ¢ | D 1084398
~ [ Acme Wholesale Clothing Name Shoes
» 8 Commercial Data
» 2 Caps and Hats Object Type Section
¥ 2 Shirts ¢ | Revision 0.4 Last edited by USERY on Thu Nov 16 04:19:27 EST 2017
M ﬁ ¢ | Path Publications/Autopage Publications/Acme Wholesale Clothing/Shoes
| 20714
11 20695 Catalog Description | A8t
» & DTP Documents ¢ | Mai Date (same as ... | [=)
¥ 2 Jewelry Total Number of Ite... 123
» = Accessories
b 3 Gloves ¢ | Effective Date )
» (P Beta Tools_AutoPage ¢ | Expiration Date O
» [ Flatplanner Publications =

For more information on working with publication objects, refer to the Publication Hierarchy topic of the Publisher
(Adobe InDesign Integration) documentation.
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Accessing STEP System Information

STEP system information is useful for system troubleshooting and new project planning, as well as helping users
ensure compliance with their contracted license terms.

The most straightforward way to view system information is to click About STEP from the Start page.

'‘About STEP' Page

Clicking the About STEP link opens a new page (e.g., http://[yoursystem]/about/step) that is password protected to
ensure that only STEP users have access to the information.
This page displays the following information:

* 'System name'

'STEP version'in a string (as shown below) that identifies the system by its baseline version that includes the
year (e.g., 2025); the quarter (e.g., .1); and the baseline creation date.

'Number of user accounts' and the 'Number of allowed user accounts'. Standard STEP users that do not count
against the number of licensed users are not included in the user count, such as DBA, STEPSYS, SERVICE,
and SWADMIN.

The approximate number of 'products’, 'classifications', 'assets', and 'entities'. Object counts are approximate
because changes can happen in the background while the page is being viewed. Also, considering the time
required for an exact count, the quick approximation number is preferable since an exact count could
potentially tie up system resources for a prolonged time.

The number of 'contexts’, 'dimensions’, and 'languages’.

The state of 'InMemory'.
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System name: doc-rel

STEP version: 2025.1-2025-03-26-13-55-43

Detailed version information

Number of user accounts (including suppliers): 47

MNumber of supplier accounts: 10

Allowed number of user accounts: 100

MNumber of products (approx.): 10000

MNumber of classifications (approx.): 2000

Number of assets (approx.): 3000

Number of entities (approx.): 200

MNumber of contexts: 5

MNumber of dimensions: 1

Is InMemory Enabled: true

Number of languages: 4

The full version information of this system is available via snapshot.spr file, please submit this file along with any support requests.

If you are having any problems with the STEP system, please produce a diagnostics package instead. This can be done via the Administration page.

Copyright & STIBO SYSTEMS

Detailed Version Information

A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g., http://
[yoursystem]/about/version) where you can access information about the licensed-enabled components applied to your
system.

[ 1STIBOSYSTEMS

s MASTER DATA MAMAGEMENT

= STEP version: 2025.1-2025-03-26-13-55-43 (change log)
= License-enabled acrolinx

components: across
ai-service
asset-deduplication
assetanalyzer
assetdownload

assetloader

async-translation
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Click the 'change log' link to display a new page that includes the hotfixes and bugfixes addressed in the current
update.

saas-2025.1-2025-03-26-13-55-43

This supersedes 2025.1-2025-03-25-14-11-29 and earlier versions.

Fix for bulk article creation fails through portal (HOTFIX-8073, ISSUE-753406)

Added missing dependency to Apache POL Its absence made the Excel Import component fail in Web UI when uploading an Excel file.

Fix and RCA for the production environment outage (ISSUE-757428, HOTFIX-8090)

Decreased memory usage when running multiple parallel Match and Merge threads which calculate Decision Table business functions.

Fix / RCA: STEP was unavailable (ISSUE-756693)

Now, the amount of classification children returned by Browse tab in a Smartsheet will be limited to avoid memory consumption.

System Snapshot and Diagnostics Package Links

= Number of languages: 4

The full version information of this system is available via snapshot.spr file, please submit this file along with any support requests.

If you are having any problems with the STEP system, please produce a diagnostics package instead. This can be done via the Administration page.

Copyright ® STIBO SYSTEMS

Below the bullet list on the About STEP page, additional information is provided to assist users who need to access
more complete system information for support purposes.

Click the 'snapshot.spr' link to download a snapshot file that contains full system information, including installed
bundles, metrics, and differences to previous snapshots. This file is intended to be submitted to Stibo Systems along
with support requests. For more information on snapshots and their contents, refer to the Tools topic in the
Administration Portal documentation.

If you need produce a diagnostics package, click the 'Administration page' link to display the Administration Portal. The
package is generated and uploaded to Stibo Systems. For more information, refer to the Send Diagnostics topic in the

Administration Portal documentation.
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STEP Workbench Ul

The screenshot below shows a basic view of the STEP Workbench. Though system customizations and variable

[ ﬁTIBO SYSTEMS
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access permissions may result in a slightly different view, the basic elements in this view of the workbench's Main

Window will be present for most users. The key elements of the workbench Ul are numbered and defined below.

Important: A one-time installation of the STEP Workbench Launcher needs to be done on each client

workstation before opening the workbench. STEP Workbench users do not need Java installed separately on

their computers. After installation, the workbench will launch via conventional means. For details and

directions, click on the Workbench Launchers link, accessible on the Start Page.

g doc-dev - Development-User12 - STEPworkbench

e Edit View Navigate Format Maintain Window Helpl

% Context EnglishUS

4
PRODUCTION
Tree

Advanced
Search

n ©

BG Processes

g =

System Setup

s [

Bookmarks

K2
STEP Workflow

10

1 ==

12 (] 13‘60

View
Mode

Approved
Workspace

[J ACME Lookup Tables
» [ ACME Part Type Root
» [T ACME Web Store
} [ Article Groups
b [ Assets
} [ Bulk Update Configurations
} [ Classifications
} [7] Configurations
} [T DuplicateETIME(2)
» [ DuplicaleUNSPSC(2)
» sk eClass 9.1
} [C/ECLASS ADVANCED Classifications
} [ ETIME Article Groups
» [ ETIM7 Article Groups
} [ ETIMS Article Groups
» [ ETIMSB Article Groups
} = Index Words
[J Industry Standard Mapping files

- O x
Normal > URL workspaceid=Main IDMame  ~ |Search
RO o &
- Product Data Conta: Sub Products References Referenced By Images & Docu...
Description

Name Value
D 411857
Name Alarm-001
Object Type Level 2
Revision 0.10 Last edited by USERJ on Fri Mar 31 14:51:20 EDT 2023
Approved (% Last Approved on Mon Jul 18 12:18:28 EDT 2022
Translation Master
Path Primary Product Hierarchy/Products/Alarm Clocks/Alarm-001
Display Name Rec
Attribute Completeness Score
Attribute Description REC
Attribute Help Text L
Attribute Name Style Name =E

e Attribute ShortName Rac

>

Note: The STEP Workbench is a Java client. STEP's backend is AdoptOpenJDK.

1. The Title Bar includes system information including the name of the system accessed and the user's ID.

2. The Menu Bar contains a collection of various tools for users to perform actions in the workbench. For more

information, refer to the Menu Items topic.
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3. The Toolbar contains actions that help with the view and navigation of the workbench. For more information,
refer to the Toolbar topic.

4. The Environment badge displays the environment's purpose using color coding and text. The available
environment badges include development, test, acceptance, production, retired, training, sandbox,
preproduction, permanent sandbox, and release preview sandbox. When the bar is collapsed, hover over the
badge text to display the full name of the environment.

DEV TEST
"= "= "=

The badge name and color can be changed via the Self-Service Ul. Relevant properties include:

* Workbench.Environment.Color.Back - The color of the badge itself.

® Workbench.Environment.Color.Fore - The color of the text on the badge.

* Workbench.Environment.Type.Long - The full name of the environment, which appears when the bar is

expanded or when hovering over the badge.

Workbench.Environment.Type.Short - The abbreviated name of the environment, which displays on the badge
when the bar is collapsed.

Note: Changes to these properties may require you to restart the workbench before they take effect.

5. The Tree tab navigates users to the object tree in the workbench. For more information, refer to the Tree Tab
topic.

6. The Advanced Search tab provides access to the advanced search functionality of the workbench where users
can filter results, save these results as a collection, export these results for external use, or perform bulk
updates on these results. For more information, refer to the Advanced Search Tab topic.

7. The BG Processes tab contains all the background processes occurring in the STEP instance. For more
information, refer to the BG Processes Tab topic.

8. The System Setup tab contains all the administrative actions to set up the workbench to maintain data. For
more information, refer to the System Setup Tab topic.
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The Bookmarks tab contains all the bookmarks that are saved by the user. For more information, refer to the
Bookmarks Tab topic.

The STEP Workflow tab contains all the workflows currently associated with STEP. For more information, refer
to the STEP Workflow Tab topic.

The collapse bar button ) removes the text from the left navigation bar; the expand bar button () adds
text to the options.

STEP connection status displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

* Reading - STEP is requesting information from the database.
® Lost Connection to - STEP has lost connection to the server.

® Reconnected to - STEP has reconnected to the server after a lost connection. May alternate with the 'Lost
Connection' to status if the connection to the internet is lost for a significant period.

Connection strength illustrates the connection strength between the user and the server, also known as the
'Network Latency.' Hover the cursor over the graph to display how fast data is traveling between the server and
the user as measured in milliseconds.

The close button () hides the hierarchy for the selected navigation bar option, which allows more space for

the Object Editor. Select a navigation bar option to display the hierarchy again. For more information, refer to
the Object Editor topic.

The Object Editor pushpin default is unpinned (1) but allows users to pin (l) the right-hand side of the

window. When pinned, a user can navigate to other items in the Tree or System Setup while the information on
the right side of the screen remains unchanged. This can be used to add objects to the Flatplanner basket and
to add objects to a change package. For more information, refer to the Adding Objects Manually to Baskets
topic in the Publisher (Adobe InDesign Integration) documentation and the Editing a Change Package topic in
the Configuration Management documentation.
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The BG Processes tab shows all active and inactive background processes (BGPs). Activity such as an import, export,

bulk-update, collection creation, etc., generates a background process and a log and informs users if the process was

successful. In the event of an unsuccessful background process, an error message is displayed showing the reason for

failure.

Background processes are based on the type of activity, for example 'Approve recursively,' 'Bulk update,' 'Create

Collection,' 'Download Report,' as well as 'Translation,' which is shown in the image below.

BG Processes
W @

I
w 5 Translation
§§_=*| Queued Processes
w £ Active Processes

é:'é% LongItemDescription Context?
405 113615 Contexts
485 113615 Context2
485 123853, en-US > Danish

40 |18215, en-US > Danish

485 18216, en-US > German
405 13216, en-US » fr

é:'é% 20720, std.lang.all = German
485 130906, en-US > Danish
485 130906, en-US > Danish
485 130906, en-US » fr

485 130906, en-US > Spanish
485 130906, en-US = Hebrew
485 130906, en-US = fr

485 130906, en-US = Hebrew
482 130906, en-US = UK English
482 130906, en-US = UK English
482 130906, en-US = UK English
482 130906, en-US = UK English
482 130906, en-US = UK English
482 130909, en-US > UK English
482 130914, en-US > Spanish
485 130914, en-US > Hebrew

485 130914, en-US > Danish

X

18216, en-US = Danish

Background Process Queue Info

" Properties

Froperty + | Value

Started by LISERY

Id BGP_127930

Description 18216, en-US > Danish
Execution Server docrel

Status suspended

Created Thu Jan 18 05:32:30 EST 2018
Started Thu Jan 18 05:33:41 EST 2018
Finished Thu Jan 18 05:33:41 EST 2018
Processing Time Om0Os

Time in Queue 1mlls

# of warnings 0

# of errors ]

" Execution Report

Analyse

Logged on

Analyzing translation request

Analysis selected 2 out of 4 nodes for translation
Leaving query service
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BGP Execution Mechanism

The mechanism implemented for running background processes determines the options and data displayed in the BG

Processes tab. Refer to the Background Processes and Queues topic in the System Setup documentation.

Evaluating BG Processes

Select a BGP folder (not an individual BGP) to display all BGPs currently in that state. Select the columns in a section,

right-click and choose Copy (or use Ctrl+C) to copy the data. Only the data visible on the screen is copied. For further

evaluation, in Excel, paste the copied data using Ctrl+V and manually add the header row information.

BG Processes

W)
-

w £ Translation
%7 Queued Processes
w 77 Active Processes
35¢ LongltemDescription Context2
38¢ 113615 Contextd
365 113615 Context2
507 123853, en-US » Danish
%97 18216, en-US > Danish
36 18216, en-JS > German
207 18216, en-Us > fr

467 20720, std.lang.all > German

S8 130904, en- 1S = NDanish

Process Overview

Process Overview

Summary
LongItemDescription Con...| BGP_113514 USERY Wait for Translation SUSpE
113615 Contexts Ctrl+X  py | Wait for Translation SUSpE
B c Ctrl+C
113615 Context2 oY g Y | Wait for Translation Suspe
A B C D E
125855, en US> 1 [LongltemDescription Context2 |BGP_113614 USERY 0 Waitfor Translation
18216, en-US > Di 2 1113615 Contextt BGP_113637 USERY 0 Wait for Translation
3 |113615 Context2 BGP_113638 USERY 0 Wait for Translation
18216, en-Us > Gy 4 |123853, en-US > Danish BGP_124168 USERY 50 Wait for Translation
e e 1 £ 5 |18216, en-US » Danish BGP_127930 USERY 50 Wait for Translation
& |18216, en-US > German BGP_127929 USERY 50 Wait for Translation
7 |18216, en-US > fr BGP_127931 USERY 50 Wait for Translation
g 120720, std.lang.all > German BGP_129865 USERY 50 Wait for Translation
9 |130906, en-US > Danish BGP_130915 USERY 50 Wait for Translation
10130906, en-US = Danish BGP_130916 USERY 50 Wait for Translation
11130906, en-US = fr BGP_130917 USERY 50 Wait for Translation
12 |130906, en-US > Spanish BGP_130918 USERY 50 Wait for Translation

BG Processes Displayed

In the BG Process tab, a user can choose to view only the BGPs that they have initiated, or with the appropriate

privileges, they can view all the BGPs run by any user. The display is selected by clicking the appropriate button

highlighted in the image below.
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BG Processes

(1 )]
i

b £ AddItemsToCollection &
b &5 Analyze Change-Package
Advanced P &5 Approve Recursively

Search

b 25 Asset Integrity chedk

@ ] #:7) Assetimporter process

I E i
BG Processes 4 wl AssetDelivery

b &= AcvncPallerRunner
}2‘ All Users displays all background processes started by any user. This button is enabled by the 'View Background

Processes of Other Users' setup action as defined in the Setup Actions and Error Descriptions topic of the System
Setup documentation.

My User displays only the background processes started by the user who is logged in.

Background Process Tab

The Background Process tab in the editor contains:

* The Properties section includes the user who started the background process, an auto-generated unique
identifier, the type of BGP performed (export, import, bulk update, etc.), status (Succeeded, Failed), creation
date and time, start date and time, end date and time, time taken to process the request, number of warnings,
and number of error messages.

Background Process Queue Info

Properties
Property : | value
Started by LISER.]
Id BGP_211100
Description Exporting {excel-2024-06-18_09, 25, 17.xlsx)
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* The Execution Report section includes detailed information about the process. If the process failed, a
message displays the reason.

Execution Report

Export process started (Tue Jun 18 09:25:17 EDT 2024)
Logging on to PIM server doc-rel as USER]...

Logged on

Delivery started (Tue Jun 18 09:25:17 EDT 2024)
Delivery completed (Tue Jun 18 09:25:18 EDT 2024)

H 4l 1-40 of 40 3 23 SAVE. .. Truncate

The navigation buttons are:

4 navigate back one page.
4] navigate back to the beginning of the log.
I+ navigate forward one page.

b navigate forward to the end of the log.

* The Save button allows the user to download the execution report. Click the 'Save' button to display the 'Save
File' window. Browse to the download location, add a file name, and click the 'Save' button. The file can be
saved as a CSV or HTML file type. For larger files, CSV files can be zipped.

Note: The 'CSV (Zipped)' option is available in the 'Files of Type' dropdown when there are more than one

million lines (presented as rows) within the execution report. This is a result of MS Excel having a limitation
of one million rows per file; the 'CSV (Zipped)' option allows multiple files to be saved.
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"J Save File

Lockin: | = Documents LV T e 123

File name: Save

Files of type: |y o Cancel
| 4
HTML

Truncate - This button is available only on the 'Ended Processes' node.

When the Execution Report becomes cluttered or only specific information is needed (errors or warnings), truncating
the report permanently removes the unneeded information. Click the "Truncate' button to display the 'Truncate
execution report' dialog.

Important: Once execution report lines are removed via truncate they cannot be recovered.

Truncate execution report

Mumber of lines to retain |16
Execution report entry types to delete
[ Error
B info
[ warning
QK Cancel
h -

For example, assume the execution report has 50 lines and a user wants to examine only 16 lines from the report
that are errors. With the settings shown in the image above, the user clicks the OK button and the execution report
retains only the first 16 error lines. All other lines are permanently deleted.

Queue Info Tab

The Queue Info tab in the editor only displays when the 'Multiple Queues' legacy BGP execution mechanism is
implemented. Refer to the Background Processes and Queues topic in the System Setup documentation.
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The name of the queue being used for the process is displayed within the section title.

Exporting (excel-2024-06-18_09.25. 17.xlsx)

Background Process Queue Info

L Queue

Position *

Process Type *

Process Description

Process ID * ‘ Started by *

Server *

Progress * Processing Time ¢ | Time in Queue *

Created * ‘ Started 2 ‘ Finished *
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Bookmarks Tab

The Bookmarks tab allows users to set standard navigation bookmarks and search bookmarks, and both allow users
to easily access objects without having to search or navigate the Tree.

A bookmark is a Uniform Resource Identifier (URI) that is stored to provide the user with a quick method of

retrieving the data at any time.

Note: Bookmarks are user-specific, similar to those in a web browser. This means that one user cannot view the
bookmarks created by another user.

Bookmarks are stored on the local STEP system and are not accessible when the user logs into STEP from a
different computer.

The types of bookmarks available include:

* Standard navigation bookmarks, used for quickly accessing specific nodes in the Tree and System Setup

hierarchies.

* Search bookmarks, used for storing specific searches that can be easily re-run.

Accessing Bookmarks

Bookmarks are accessible via:
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* The Navigate menu using the Bookmarks option.

- |STIBOSYSTEMS

File Edit View MNavigate Format Maintain Window

& Search Ctrl+F %
I

| | context E

Search Below

P Goto Ctrl+G
Soto MNext Ctrl+E
Back
Forward
Bookmarks »

Find Similar Product

Go to Wik

' [ R T T T T

* Clicking the Bookmarks tab.

Bookmarks

Search ltems

Cotton T-Shirts (18209)

Installation Manuals (InstallationManualRoot)
Top Level Headwear

Refer to the following topics for more information:

* Adding a Bookmark
* Copying a Bookmark to the Clipboard
* Editing a Bookmark

¢ Removing a Bookmark
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Adding a Bookmark

Standard navigation bookmarks are used to quickly access specific nodes in the Tree and System Setup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or System
Setup hierarchies can be added with the usage of the bookmarks functionality.

Additionally, search criteria can be saved as a bookmark.

Create a Standard Navigation Bookmark
To save an object as a standard navigation bookmark:

1. In Tree, select the item to be bookmarked.

PROD

"

Tree

* W Primary Product Hierarchy

 [3 Products
Q P [ Alarm Clocks
P 3 Alarms
@ P [C1|Apparel

P 3 Audio Visual Equipment

2. Either use the Ctrl+D shortcut, or on the Navigate menu, select Bookmarks and then Add Bookmark. Existing
bookmarks are also displayed on this menu.
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Fie Edit \.ro Navigate Format Maintain Window Help

[ context [En ® Advanced Search CtrbeF oy ' URL =182008work
Search Below
PROD
Tree | | search Ctri+G “ || Apparel

Level 1 » 49, Complete » Rev

[ Eril Ctrl+E
[0 Tables  Category Profie Py

»

> Tables

» ) Bookmarks > 0¥ Add Bookmark (E)) Ctrl+D

: Find Simiar Product @ Add Search Bookmark
@& Search Items
(@ Cotton T-Shirts (18209)
[0 Installation Manuals (InstalationManualRoot)

3. The new bookmark is displayed on the Bookmarks tab with the object icon and labeled with the object name
and (ID).

[P Cotton T-Shirts (18209)
j als (InstallationManualRoot)

AT 4[]
arel (18200}

To use the bookmark, click the link to display the Bookmarks main tab and the bookmarked object tab.
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T Search ltems

(P Cotton T-Shirts (18209)

I:I Installation Manuals (InstallationManualRoot)
(P Apparel (13200)
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) Bookmarks

Apparel

Level 1 » 4% Complete o Revision: 0.48

Product  Sub Products

References  Referenced By Image...

* Description
Name Value
D 18200
Name Apparel
Object Type Level 1
Revision 0.48 Last edited by USERJ on Wed Jan 29 10:35:...
Approved (¥ Last Approved on Fri Jan 26 14:12:29 EST 2024

Create a Search Bookmark

To save an object as a search criteria bookmark:
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1. Onthe Advanced Search, create the necessary search criteria, for example, searching from a list. Refer to the

Advanced Search topic for details.

Advanced Search

Search Below ~ X
Assets (AssetsRoot)

+ - Reset Search

Show Details

Mame

2. Onthe Navigate menu, select Bookmarks and then Add Search Bookmark. Existing bookmarks are also

displayed on this menu.

Fie Edit View MNavigate Format Maintain Window Help

1 context @ Advanced Search  Ctrl+F

Search Below
e Advar [+ Search Ctrl+ G
cearch| Ctrl+E
Assets ()
Q ( Back
@ Bookmarks
+ -
a Find Similar Product

3. Add a bookmark name.
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CA Add Bookmark
) add search Bookmark

& PPH2
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F
X 5)

Pr
Ctrl+D
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Enter Bookmark Name

Enter the bookmark name

AssetsRoot

The new bookmark is displayed with the search icon.

Bookmarks

¥ PPH2
¥ AssetsRoot

To use the bookmark, click the link to display the Advanced Search tab with the selected criteria.
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Removing a Bookmark

When a save bookmark is no longer be needed, right-click the bookmark to remove it.

Bookmarks

Search ltems

Cotton T-Shirts (18208)

Installation Manuals (InstallationManualRoat)
Apparel (182007

Edit Bookmark

Remowve Bookmark
Copy To Clipboard

Note: No confirmation window displays before removing a bookmark.

The selected bookmark is no longer displays on the Bookmarks tab.

Bookmarks

Search ltems
Cotton T-3hirts (15208)
Installation Manuals (InstallationManualRoat)

Important: Deleting a bookmarked object via the Maintain menu > Delete option, acts on the object itself. The
object may be moved to the applicable recycle bin, or may be deleted without the ability to revive. Refer to the
Recycle Bin for the Tree Tab topic or the Recycle Bin for System Setup topic for more information.
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Editing a Bookmark

Both standard navigation (the link to specific objects) and search bookmarks can be edited in the Bookmarks tab.
To edit a bookmark:

1. Onthe Bookmarks tab, right-click the bookmark to be modified and click 'Edit Bookmark.'

Bookmarks

Search ltems
Cotton T-Shirts (18208)

Installation Manuals (InstallationManualRoot)
Apparel (18200)

Edit Bookmark
Remove Bookmark
Copy To Clipboard

2. If desired, change the name of the Bookmark then click OK.

Edit Bookmark

MName Top Level Apparel (18200)

URL |step://product?editor=Table&versionid=128525&contextid=Context1&id=18200&workspaceid=Main
(CJ Edit URL

OK Cancel

3. The name is updated in the Bookmarks tab.

Bookmarks

T Search ltems
ﬁ Cotton T-Shirts (18209)

1 Installation Manuals (InstallationManualRoot)
(M Top Level|Apparel (18200)

© Stibo Systems - Public - 2025.3 - September 2025 61



- |STIBOSYSTEMS

L — MASTER DATA MAMAGEMEMNT

4. To edit the object URL, check the Edit URL checkbox. In the below screenshot, the product URL has been
modified which points to a new product URL. The same steps apply to editing a 'Search Bookmark'.

Edit Bookmark

Mame |Top Level Headwear

URL step://product?editor=Table&versionid=128525&contextid=Context1&id=20433Rworkspaceid=Main
@ Edit URL

OK Cancel

5. Click the OK button to save any changes to this bookmark.

Bookmarks

%% Search ltems
ﬁ Cotton T-3hirts (18209)

! : Installation Manuals (InstallationManualRoot)
Top Level Headwear
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Copying a Bookmark to the Clipboard

Bookmarks are direct addresses to a specific object (such as a product, entity, or publication) or a set of search criterion
in STEP. These bookmarks can be shared with other users by copying the bookmark to the clipboard, and then sharing

it.

1. On the Bookmarks tab, right-click the bookmark to be shared or saved and click 'Copy to Clipboard."

Bookmarks

Search ltems
Cotton T-Shirts (18209)
Installation Manuals (InstallationManualRoot)

A [ (18200
prarel( } Edit Bookmark
Remove Bookmark
Copy To Clipboard

2. Paste the copied URL of the bookmark as needed.

E stepproducteditor=Table&versioni. ® +

File Edit View

step://product?editor=Tablefversionid=128525%&contextid=Context1&id=1820088workspaceid=Main

Share the URL with other STEP users to paste it into the workbench URL field to locate the object(s) or search

criteria.

Window Help

LLE Normal URL step://product?editor=Table&versionid=128525&contextid=Context1&id=182008&w:

Mode
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Menu ltems

The STEP Workbench menu bar provides access to many aspects of STEP's functionality. Some of the options in these
menus are also available via a right-click menu accessible elsewhere in STEP. For instance, users may add a product
to a product family by selecting the product family, and then selecting Maintain > Insert > Product in the menu bar, but
they may also perform the same action by right-clicking on the product family in the Tree. However, some options, like
changing the view target, are only available in the menu bar dropdown menus. Each of the menu bar sections are
detailed on subsequent topics.

Note: Many menu options can be used with a keyboard shortcut. For a list of the keyboard shortcuts, refer to
the STEP Workbench Keyboard Shortcuts topic in the Getting Started documentation.

doc-dev - Development-userj - STEPworkbench

Fie Edit View MNavigate Format Maintain Window Help

File — The File menu provides access to import and export actions as well as general STEP Workbench tasks,
such as running bulk updates, changing passwords, and emptying the Recycle Bin. For more information, refer
to the File Menu topic.

Edit — In addition to administration actions like copying and pasting, the Edit menu also provides access to
tasks like spelling checks, managing assets, and editing unique keys. For more information, refer to the Edit
Menu topic.

View — The View menu contains options that change how data is displayed in the workbench. For more
information, refer to the View Menu topic.

Navigate — The Navigate menu contains searching options and the ability to find similar objects. For more
information, refer to the Navigate Menu topic.

Format — The Format menu allows for setting styles such as bold or italics and inserting character tags. For
more information, refer to the Format Menu topic.

Maintain — The actions available on the Maintain menu pertain to data maintenance at the object level. Data
such as LOVs and attribute values can be merged. Data can also be forcefully deleted, duplicated, or
approved. Links and new objects can be created in this menu. For more information, refer to the Maintain Menu
topic.

Window — The Window menu provides actions for changing the presentation of the STEP Workbench. For
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more information, refer to the Window Menu topic

* Help — The primary function of this menu is to link users to the online documentation. For more information,

refer to Help Menu topic.
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The file menu contains actions that are related to maintaining the workbench from a performance level, such as

cleaning the recycle bin, purging old revisions, scheduling bulk updates, as well as defining imports and exports.

Each of the options on the File menu are defined below.

Translate
Import
Export
Reports
Bulk Update

Schedule Category Profiling
Business Module Manager

Save

Change Password

Ernpty Recycle Bin

Ernpty Recycle Bin Before...

Purge old revisions

Check integrity of external assets..

Pre-generate Thumbnail Cache...

Close Window
Exit STEPwarkbench

Translate

Ctrl+Alt+5

The Translate menu allows users to translate products, classifications, and names of images and documents, product

values, index words, LOVs (List of Values), units, attribute names, free text cells in tables in the workbench, and to

import translations.
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File Edit View Mavigate Format Maintain Window Help

Translate : Data Objects...

Import : Setup Objects...

Export : Manual Excel Translation Export
# Reports @] Import Translation...

Bulk Update 3 Change Translation

By selecting 'Data Objects' or 'Setup Objects,' the Request Translation wizard will display. This process results
in the creation of a translation file that will include either data objects (objects that contain usable customer
data) or setup objects (objects that help organize the data objects). For more information on data object
translations, refer to the Structured XML Translation topic and the Structured Translation for Setup Objects
topic in the Translations documentation.

The 'Manual Excel Translation Export' is best used for a specific set of use cases, namely when there is not
much content to translate, the translator does not have access to STEP, or the objects to be translated are
setup objects. For more information on performing a manual Excel translation, refer to the Starting a Manual
Excel Translation Export topic in the Translations documentation.

The 'Import Translation' allows users to select an external translation file.

The 'Change Translation' allows users to change configurations.

For more information on the translate functionality, refer to the Translations documentation.
Import

The Import menu contains actions for bringing data into STEP.

File Edit View Mavigate Format Maintain Window Help

Translate #
Import ; @] Data...
Export : @] eCl@ss ..
7 Reports A Images & Documents...
Bulk Update ;

Business Rule from Editable Format
Schedule Category Profiling
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The 'Data...' option loads the Import Manager. For more information, refer to the Import Manager topic in the
Data Exchange documentation.

The 'eCl@ss' option launches the ECLASS Classification import wizard. ECLASS is used to group materials,
products, and services. For information on how to best use ECLASS and its importer, refer to the ECLASS
Format topic and the ECLASS Classification Import topic in the Data Exchange documentation.

The 'Images & Documents...' option, while on a Tree node that contains assets (images and documents), will
load the Import Images and Document wizard. For more information, refer to the Import Images and
Documents Wizard topic in the Digital Assets documentation.

The Business Rule from Editable Format allows users to manually import business rule definitions in the
editable format described in the VCSI: Editable Business Rules Format topic of the Configuration Management
documentation.

Export

The Export menu contains actions for getting data out of STEP for external management.

File Edit View Mavigate Format Maintain Window Help

Translate >
Import >
Export : E@] Data...
# Reports F@] Schedule Data Export...
Bulk Update ) Images & Documents...

Schedule Category Profiling Compare System Setup Exports

* The'Data... option loads the Export Manager. For more information, refer to the Export Manager topic of the
Data Exchange documentation.

* The 'Schedule Data Export..." allows you to create a data export that executes at a specific time or repeatedly.
This option starts the Schedule Data Export wizard. For more information, refer to the Scheduling a Data
Export topic in the Data Exchange documentation.

* The 'Images & Documents..." option, while on a Tree node that contains assets (images and documents), loads
the Export Images and Document wizard. For more information, refer to the Export Images and Documents
Wizard topic in the Digital Assets documentation.
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* The '‘Compare System Setup Exports' option enables you to migrate systems and allows users to determine
which items should not be added to the new system. This option will compare two STEP XML files that are
exported from two STEP systems, such as a production system being compared with a development system.

Reports

Selecting 'Reports' option will load the Reports wizard.

Translate
Import
Export

Bulk Update 2. Parameters

Schedule Category Profiling 3. Advanced Settings

e I Report Settngs

Report Group

JAssets

Report Name

Assets Lists

Assets Either Linked or Not Linked to Products in PIM

Report Description

Back

MNext Finish Cancel

For more information on the reports wizard, refer to the Reporter documentation.

Bulk Update

Bulk updates allow you to perform one or more actions on multiple objects at the same time.

File Edit View Mavigate Format Maintain Window Help

Translate *
Import »
Export ]
# Reports
Bulk Update : | Run Bulk Update
Schedule Category Profiling Schedule Bulk Update
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* The 'Run Bulk Update' option will start the Bulk Update wizard.
* The 'Schedule Bulk Update' option will allow users to create repeatable bulk updates.

For more information, refer to the Creating a Bulk Update topic and the Scheduling Bulk Updates for Collections
topic in the Bulk Updates documentation.

Schedule Category Profiling

Category profiles (also called data profiles) are used to take a snapshot of data that would be displayed in the category
profile tab. This snapshot does not update as new changes are made. With this action, the 'Schedule Category Profiling'
wizard will display and users may schedule the updates of existing profiles and the ability to copy profiles as well. For
more information, refer to Generating, Updating, and Scheduling a Data Profile topic in the Data Profiling

documentation.
Business Module Manager

A business module is a functional configuration which handles use cases based on common practices observed in
the industry. The Business Module Manager allows an administrator to install a pre-configured data model for a
business purpose, such as the 'sell side' of the product enrichment process, or the 'buy side' for the vendor data
onboarding process. Business module installation can include the creation of product objects types, classification
objects, lists of values types, etc. The 'Business Module Manager' option displays on the File menu for all users.
The install functionality is available for users who are assigned the 'Install Business Modules' setup action

privilege.
Business Module Manager
Select ¢ | Business Module ¢ | Auto Install ¢ | Upgradeable : | CanInstal : | Installed Version : | Latest Version :
Insta Cancel

For more information, refer to the Business Module Manager topic in the System Setup documentation.

Save

While saving in STEP Workbench is automatic, the Save option allows users to force a save without leaving a field.

Change Password
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During any session, any user may change their own password. Enter your current password in the 'Old Password' field,
then enter the new password twice in the 'New Password' and 'Retype Password' parameters. Click 'Save' to complete
the update or 'Cancel’ to leave the password unchanged.

Change Current User Password
Old Password

Mew Password

Retype Password

Save Cancel

Empty Recycle Bin

This action purges the 'Not In Use' objects in the Tree Recycle Bin. For more information, refer to the 'In Use and Not In
Use Obijects' section in the Approval of Objects topic.

~ 73 Recycle Bin
/7 webuUIBkgdImagel
B Zidjian1
20714-F
21933
- 49028
- 49028DUP1
AdVSTEPXML

Select the 'Empty Recycle Bin' option to display the Confirm Purge dialog. The number of items that will be
removed is displayed. Click 'Purge' to permanently delete the items, or 'Cancel' to leave the Recycle Bin
unchanged.

© Stibo Systems - Public - 2025.3 - September 2025 71



H Save

Change Password

Confirm Purge

@ Ernpty Recycle Bin [p—
T Eony Recyele Bin Before.. o Are you sure you want to permanently delete these objects:
Purge old revisions Assets: 186
Classifications: 9
Enftities: 2
Products; 22

Skip Analysis Cancel

This action is also available via by right-clicking on the recycle bin.

» % Recycle Bin

Search in recycle bin

Empty Recycle Bin

Empty Recycle Bin Before...
Force Empty Recycle Bin
Schedule Empty Recycle Bin
Approve Deletion Recursively

€ EE

Empty Recycle Bin Before

This action allows users to purge the recycle bin of anything created before a specified date.

Empty Recyde Bin Options

Only purge objects deleted before: 2025-03-04 09:58:06| ...

cance

This action is also available via right-clicking on the recycle bin.
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» =7 Recycle Bin
Search in recycle bin
¥ Empty Recycle Bin
¥ Empty Recycle Bin Before...
¥ Force Empty Recycle Bin
% Schedule Empty Recycle Bin

Approve Deletion Recursively

Purge Old Revisions

This is a global purge of revisions contained within a specified workspace. A further description of this functionality is
available in the Revisions section of the System Setup documentation.

Check integrity of external assets...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself. This can
reduce the size of the database significantly, and for DTP tools depending on having the referenced high-resolution
images directly available on the file system, replication from DB to file system of these images can be avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File Structure
topic of the Digital Assets documentation.

The 'Check integrity of external assets...' option is enabled on systems set up to store images in a file system and not in
the STEP database. If a Classification is selected, the user can click this menu item to examine if all images in the
selected classification have been successfully migrated from the database to the file system.

The integrity of the file system for storing digital assets can be double-checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu. This starts a background
process reporting if any assets are missing or have been changed against expectations.

When errors are found, the assets with wrong or missing content are added to a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A check of approximately 10,000 asset files on standard hardware can complete after one minute. Thus, expect
that the integrity check might take some time on systems with many assets.

Pre-generate Thumbnail Cache...

This option will generate thumbnail cache of images and documents manually. This action allows any selected
image or images in a classification folder to display as thumbnails without having to wait for them to generate.
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For example, on the Image and Documents tab of a classification folder, if the image thumbnails are delayed in
displaying, then Pre-generate Thumbnail Cache from File menu can be run to generate them in a background
process.

For more information, refer to the Image Cache Processing Plugin Parameters and Triggers topic in the System Setup
documentation.

This option is disabled by default. To enable it, ask an authorized user (one with the Setup Action = Maintain System) to
perform the following steps.

Note: Although this automates the loading process, there will be delays during upload.

1. Under 'System Setup' tab, navigate to 'Users & Groups.'
2. Select 'System Settings' tab.
3. Goto'Image & Document Settings' flipper.

4. Set'Pre-generate thumbnail cache on upload' = Yes. On upload of image or document, the thumbnail will be
generated automatically.

For more information, refer to the 'Pre-generate Thumbnail cache on upload' section of the Image and Document
Settings topic in the System Setup documentation.

Close Window

This option closes the active workbench window.

Exit STEPworkbench

This will exit the STEP Workbench completely by closing all active windows.
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Edit Menu

The Edit menu allows for typical text editing actions, asset editing actions, unique key editing, and spell check.

=
(=

i [l [ 3<

Undo
Redo

Cut

Copy

Paste

Paste and Match Style
Paste Link

Select All

Spelling
Asset
Edit Unique Key Values

Rermowve Row(s)

Insert Row

Undo

Ctrl+Z
Ctrl+5Shift+ £

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+Shift+V
Ctrl+L

Ctrl+ &

Ctrl+Minus

Ctrl+Plus

This action reverses the last action of the user.

Note: It does NOT restore character-by-character changes in text editors.

Redo

[ ]
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Once an action is undone by selecting 'Undo’, a user can then select 'Redo’ to repeat the action.

Cut

Standard 'cut' operation to remove the selected characters.

Copy

Standard 'copy' operation to duplicate the selected characters.

Note: If a folder is copied, the subfolders will NOT be copied.

Paste
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Standard 'paste’ operation to insert the copied characters at the selected point.

Paste and Match Style

Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. For more
information, refer to the Style tag section of the Tags topic of the System Setup documentation.

Paste Link

Allows the copied object to be linked into another object (e.g., linking an attribute into a second attribute group). Creates
a new instance of the same object (not a copy), just in a different location.

For example, if a user has an image for a product line that will live under multiple parents, the Paste Link action can be
used. The user selects the asset, and then selects another location that will serve as a parent object. The paste link
option can be used to create a link, giving this object two parents. This action will not work on products as products can
only have one parent.

Some considerations with this action are:

* an attribute must exist in at least one attribute group,

* if the data must be shown in the Web Ul, then an attribute for display purposes should be created
Note: The Paste option is available based on the selected node. For example, when selecting a product node
and placing it into a classification folder, only the 'Paste Link' option is available. However, if a product is to be

moved to another product family, when selecting the target family after cutting the original product, 'Paste Link'
is disabled.

Select All

Standard 'select all' operation to mark all visible objects for another action, like copying or deleting.
Spelling

Allows a user to check the spelling of available text.

Spelling : Automatic Spell Check
HAsset : Spell Check

Edit Unique Key Values .
Mo Suggestions

When the 'Automatic Spell Check' option is selected, as users type, incorrectly spelled words are displayed in red text.
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Item Description Information

Name : © | Value

Long Description asc [This imteis avaiabelein multiple colbors, |

If the 'Automatic Spell Check' is disabled, then selecting the 'Spell Check' action while in a field checks that field's

spelling. If a user selects one of the incorrectly spelled words and navigates back to the Spelling menu, STEP will
offer possible spelling corrections.

Speling » Automatic Spell Check
Asset » Spel Check
Edit Unique Key Values
4 Y mite
Ctrl+Minus ftem

Ctrl+Plus time
I'tem Drescripoomm LimoTid oo
Name : © Value
Long Description age |THiS imieis avaizbekein multiple colbors.
Asset

When an asset is selected in Tree, the 'Asset' menu shows various options to manage and change assets.

Azcet : Edit Asset
Edit Unique Key Values External Viewer
. Replace Asset Content
Remowve Row(s) Ctrl+Minus
Create Local Content of Asset
Insert Row Ctrl+Plus

Update Systern Properties

Delete Local Content of Asset

Note: If no object is selected or a non-asset node is selected, all of the 'Asset' menu options are disabled.

* The 'Edit Asset' action will open the asset in the program that is associated with the selected file type, like
Adobe Acrobat for PDFs.

* The 'External Viewer' will open the asset in a program on the user's local computer.
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* The 'Replace Asset Content' action will allow users to replace the asset with local assets.
* The 'Create Local Content of Asset' option initiates an asset push and downloads the asset.

* The'Update System Properties' action refreshes the asset's system properties in the 'Images & Documents'

tab of the asset.

* After selecting the 'Create Local Content of Asset' action, the 'Delete Local Content of Asset' option is enabled

and allows a user to delete that downloaded asset.

Edit Unique Key Values

Unique Keys provide a special way of designating objects for identification outside of STEP. Selecting the 'Edit Unique
Key Values' action on an object with active unique keys will display the 'Edit Unique Key Values' dialog, allowing users

to edit any unique key related attributes on the object.

Edit Unique Key Values

Attributes

Name : : | Value

Receiver Product G...| @

GTIN 614
124 |PA-351354

Supplier Part No.

Receiver Product TM | rec | 16353215836

Cancel

If there are no active unique keys for the selected object, then the following message displays.

Edit Unigue Key Values

Mo unique key attributes to edit

Cancel

For more information, refer to the Unique Keys topic of the System Setup documentation.
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Remove / Insert / Add Options

At the bottom of the Edit menu are two options that will change based on the selected node or current view. The

following are a sampling of what may appear:

On attribute references

Remove Attribute Group  Ctrl+Minus
Add Attribute Group Ctrl+Plus

On the sub-products tab of a Product object

Remowve Row(s) Ctrl+Minus

Add Product Ctrl+Plus

On Lookup tables

Remowve Row(s) Ctrl+Minus

Add Row Ctrl+Plus

The options will allow users to add or remove to the selected node as desired.
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View Menu

The View Menu's purpose is to change the way a user views objects in the STEP system. In this menu, users may
change the viewable workspace, context, and mode, add a filter, change the primary hierarchy, and other options to
customize the view to their needs.

Note: This menu does not edit or change any of the values. For more information to edit these values, refer to
the Maintain Menu topic.

Mode ]
Context ]
Workspace ]
Source

Filter ]
Prirnary Hierarchy ]
Select version ]
Mew View

Remowve view H]
Product views ]

Show Source Context
Rotate Table
*  Reload F3

Collapse Tree

Disable calculated values

Default Font Size

Choose User Display Sequence Attribute

Teggle Show Hidden Background Process Templates

Default Context ¥
Logs >
Mode

The 'Mode' sub-menu includes options that allows the user to view STEP data in a variety of ways, dependent on the
need. These options are mirrored on the toolbar. For more information, refer to the Toolbar topic.

© Stibo Systems - Public - 2025.3 - September 2025 80



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

File Eo\ﬂew Navigate Format Maintain Window Help

D Co Mode > ~  Normal
Context ’ Translation
Workspace » T
Context
Filter > Revision
Primary Hierarchy » Update

From the toolbar, the mode can be modified with the 'View Mode' option, as defined below:

View

Mode Normal e

Translation
Workspace
Revision
Context
Llpdlqte

Normal mode is the view where the majority of object maintenance occurs.

Translation mode shows the split view of the different contexts for objects. To use the Translation mode, select
a Source context from the View menu. Online Translation can be done from this Translation Tab. Fields
highlighted in green color can be translated within STEP from this Translation Mode. For more information on
translating data into other languages, refer to the Translations documentation.

Workspace mode shows a comparison of values between Main and Approved workspaces using the 'Approve
Workspace' toggle. For more information on workspaces, refer to the Workspaces topic in the System Setup
documentation.

Context mode shows a comparison of values between different contexts. For example, this will allow a user to
view values for all languages or for all price versions. For more information on contexts, refer to the Contexts
topic in the System Setup documentation.

Revision shows a comparison of values between different revisions. If you have selected any object in STEP,
then switched to the revision view, it will show a comparison screen of the two latest revisions. The latest
revision is displayed in the first column and the older revision is displayed next. These revisions are also listed
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under the Status tab in a product editor. For more information on managing revisions, refer to the Revisions
topic in the System Setup documentation.

* Update shows a comparison between objects across workspaces (Main and Approved) and allows the user to
update the object in the current workspace from a source workspace.

Context

When an object is selected, 'Context' displays all available contexts in a dropdown. By selecting one of these contexts,
the viewed context for the current object and all other objects, is changed to the selected context.

Workspace

Vimovigate Format Maintain Window Help

Made >
Context ]
eWurk‘space 9 Main
A d
Tarnet e

Workspace shows all available workspaces. It is possible to change the viewed workspace and view objects as they
appear in different workspaces. In this example, there are only two workspaces: Main and Approved. However, more
can be added as desired. For more information on setting up and using workspaces, refer to the Workspaces topic in
the System Setup documentation.

In the toolbar next to the context selector, the toggle allows you to switch between the Main ( Approved )and
Workspace
Approved ( Approved ) workspaces.
Workspace
Target/ Source

The 'Target' and 'Source' sub-menu allows users to choose alternative dimensions to show in the Context mode.

Depending on the view chosen, this function label changes from target to source.
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* In the Translation view, this allows the user to select the source language.
Source * « UK English
German
English
Danish
Hebrew

Spanish

* Inthe Workspace view mode, this allows the user to select the target workspace.

Target * ~ Approved

* In the Context view mode, this allows the user to select a single target as context or multiple contexts to

compare the content.

Target * ~ Danish DK
~  French Belgium
English UK
English US
French FR
Germany German
Global

|srael Hebrew

Other

* In the Revision view mode, this allows the user to select a past revision(s), provided there is a recorded change

in STEP. If the revisions are older than the current session, the 'Other' option will display a window to select
necessary revision for comparison. When the Revision view is selected, the selected object will show the
current version and the immediately previous version. By using target, users may select specific revisions for
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comparison.

Target > 049 last edited by USERJ on ThuJun 01 15:49:09 EDT 2017
0.48 last edited by USERJ on Thu Jun 07 153:4%:06 EDT 2017
0.47 last edited by USERJ on Thu Jun 07 153:47:33 EDT 2017

Other

* Inthe Update view mode, this allows the user to select the source workspace.

Source * " Approved

Filter

File Eo\.ﬂew Navigate Format Maintain Window Help

Mode > | URL
Context »
Workspace »
Source >
g 9 Fitter >9 Hide Empty Values
Primary Hierarchy » Show Mandatory Attributes Onby
Select version > Show Editable Attributes Onby

Show Legal Attributes Only

Select a view to filter out empty attribute values, show only mandatory attributes, show only editable attributes, and/or
show only legal attributes.

Primary Hierarchy

An object may be located in multiple hierarchies. When locating objects, there may be a reason that a user wants the
object's path to specify one of those hierarchies instead of all the applicable hierarchies. Changing this view can be
done by switching the primary hierarchy view used for the workbench. This path is displayed in the object details within
the workbench, but the path is also used when navigating to an object via a search results set.
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For example, object 12345 is in a supplier hierarchy and a primary product hierarchy. When doing a search for object
12345, upon clicking the 12345 link in the search results, User A wants the object to be displayed in the Tree within the
primary product hierarchy. User B wants to click on the 12345 link and be taken to the object within the suppliers
hierarchy. Both scenarios can be accommodated when each user sets their own view.

File Eo‘-ﬂew MNavigate Format Maintain Window Help

[ oo ~ Mode >} URL
Context > v ACME Web Store
Workspace > Assets
s 5 Bulk Update Configurations
Fiter y Classifications
L - )
. 9 Primary Hierarchy >e Other

ol B e

An objects' path can be changed based on the selected primary hierarchy. To change the display view, select Primary
Hierarchy from the View menu, and then select the desired hierarchy. For many, the Primary Product Hierarchy will be
the default selection.

In the below example, Object 'Red Cap' is a product object type being viewed in the Primary Product Hierarchy. This
path echos the location of the object in the Tree tab.

Tree Red Cap
Item » * Revision: 0.15
~ [ Primary Product Hierarchy
~ = Products Product Data Containers  Sub Products References Referenced By Images & Documents Commercial T
» 3 Alarm Clocks
» 3 Alarms Description
¥ 2 Apparel Name Value
¥ [0 Head Wear
D 179653
w [0 Hats and Caps
~ Wl Cap Items Name Red Cap
8 Black Cap Object Type Ttem
& Pk Cb Revisi 0.15 Last edited by USERL on Tue Aug 23 16:40:08 EDT 2022
evision X Y on Tue Aug :40:
¥ Red Cap
B velow Cap Approved (3 Last Approved on Wed Jul 29 11:43:36 EDT 2020
& Orange Cap Translation Not Translated
B Gray Hat Path [Primary Product Herarchy/ProductsfAppare/Head Wear/Hats and Caps/Cap Items/Red Cap|
3 rimary Product Hierard] rodu rel/Head VWear/Hats an em
B Industrial Hard Hat Y Y ppa ps/Cap P

When viewing this same object with the selected 'Web Sites US' classification, the path shows the classification
location.
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Tree Red Cap
Item Revision: 0.16
(3 Industry Standard Mapping files * *
b &) Media Asset Management Product Data Containers Sub Products References Referenced By Images & Dg
» [ Merchandising Hierarchy
P [0 UNSPSC Dﬁcripﬁon
P [C] Web Images
= g Name Value
* [0 Web Sites US
[ Ful Catalog D 179653
» [0 Marketing Postcards Name Red Cap
» 3 PreferredProducts
Object Type Item
2 sales Fiyers
[ Specialty Catalog Revision 0.16 Last edited by USERJ on Mon Mar 10 13:56:43 EDT 2025
» [ Website Root Approved (% Last Approved on Wed Jul 29 11:43:36 EDT 2020
Red Ca|
= P Translation Not Translated
b [TJ ACME Customers
» (T CMDM Customer Root Path IClass'rﬁcation 1 root/Web Sites US/Red Cap

Select Version
Allows the user to set the default publication or version used for proofing.
New View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used. Views
are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in the Tree Tab
topic. A view allows a user to customize the attributes shown for more than one object, instead of displaying all
attributes for all selected objects.

Remove View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used. Views
are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in the Tree Tab
topic. A view that is no longer needed can be remove with this menu option.

Product Views

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used. Views
are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in the Tree Tab
topic. The Product Views option displays all saved views.

Show Source Context

© Stibo Systems - Public - 2025.3 - September 2025 86



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Attribute names may be translated. This option allows a user to view attribute values in both a foreign language and in
the source language.

Rotate Table

This will flip the selected table so that the columns become rows and vice versa. This is most often used in a multi-
product editor.

Reload

Retrieves updated information from the database including other users’ changes.
Collapse Tree

Collapses the folders in the Tree navigator.

Disable calculated values

Disables the automatic calculation of calculated attributes. This will make the STEP interface load faster.

If Disable calculated attributes is checked, calculated attributes can be rendered one-by-one by clicking the Calculate
button on a calculated parameter in the product editor.

Child Count fx || calculate

Default Font Size
Allows the user to change GUI font.
Choose User Display Sequence Attribute

Allows the user to select a user-specific Display Sequence Attribute. This option is different from the Attribute set under
Users & Groups in System Setup. For more information on using Display Sequence Attributes, refer to Display
Sequence Attribute topic in the System Setup documentation.
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Select User Display Sequence Attribute

The system default display sequence attribute: DisplaySequence

User Display Sequence Attribute | DisplaySequence v
AttributeCompletenessScore &

Completeness Score
eClassAdv_DCAttributeOrder
PrintDisplaySequence
SmartsheetMandatory
TableSortOrder

VariantPriority v

Toggle Show Hidden Background Process Template

Once selected, any previously hidden Background Process Template will display.

Default Context

Sets the default context used when logging in.
Logs

Displays Workspace and System Setup logs.
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Navigate Menu

The Navigate menu offers options for moving around the workbench.

@& Advanced Search  Ctri+F
Search Below

»  Search Ctrl+G

> Go To Next Object Ctri+E

Back

Bookmarks -

Find Similar Product

Search

The 'Search' action accesses the 'Search' tab, which displays along the left side of the workbench window. Using the
search functionality, users may perform a search of all of STEP objects. For more information on searching within
STEP, refer to the Navigating and Searching topic in this guide.

Search Below

Only after selecting an object will the 'Search Below' action become selectable. Once this option is selected, the
'Search' tab will perform populate with a 'Search Below' for that object. Click the Search button to perform this query.

Advanced Search

Search Below ~ X
Upper Body Wear (18201)

Q
B L. Reset

Search

A quick way to display a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displays multiple results and allows the user to select the desired object.
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ID/Name  ~ T-shirtg I
5 T-shirts (18202)
[ T-shirts (18206)
[T T-shirts (18454)
= T-shirts (253689)
Il T-shirts Items (18
[0 T-Shirts Sales Item
Bl T-Shirts Family (2¢

Go To Next Object

When there are multiple Search results (or typeahead results) from the 'Search’ function, the user can opt to click
'Go To Next Object' to continue on to the next result.

When multiple items meet the criteria for a Search action, the 'Go To Next Object' action will cycle to the next object in
that list, which is ordered by STEP IDs.

Go To Next Object is disabled if the previous Search command has not been used.
Back / Forward

The 'Back' and 'Forward' actions function the same as most web browsers. 'Back' allows users to go to a previously
visited screen, and 'Forward' returns to the screen from which a user went back.

Bookmarks

The Bookmarks sub-menu allows a user to bookmark the currently displayed object or create and name a search based
on the selected object.

Add Bookmarlk Ctrl+D
Add Search Bookmark

Bookmarks b

Search Items
Cotton T-Shirts (18209)
Installation Manuals (InstalationManualRoot)

OD&d® €&

Find Similar Product
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The Find Similar Product option populates a search based on the attributes and its values of the selected product.
When this option is selected, a window will appear prompting the user to check off common attributes to search
for.

Important: Attribute values from calculated attributes and inherited attribute values are not searched

Please Select Attnbutes

(J Primary Color
(] secondary Color
@ Size

Select Cancel

Note: The selection dialog shows only the attributes which have values (inherited from context, inherited from
hierarchy, local values, and calculated values).

When the attributes are selected, click the 'Select' button, and the Advanced Search Tab is displayed with the
object type and the selected attributes with their values. After clicking the 'Search' button, the selected product(s)
which match the search criteria are displayed.
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Advanced Search

Object Type =
Product -

Search -
(NeckStyle) = V-Neck

> Advanced

Search =
(Size) = 200(L
> Advanced

+ ~ Reset

Search Result Profiling

Displaying 2 of 2 results

Show Details

Mame

P 15212 L B(269622)

13212 L B(18212)

Operations on Entire Result

e O o

Search Result Profiling

2 hit(s)
Click links to narrow down search

Results by Object Type
Product {2} - exclude
EHEH"I (2) - exclude

Results by Position in Tree Hierarchy
Results per Parent

[_|Sleepwear (2} - sxclude

L[Z] Writing Tools (2) - exclude

-CUHUH T-Shirts (1) - exclude

Bl T-Shirts Family (1) - =xclude
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Note: This search is recommended for externally maintained attributes with validation base types of Text, LOV,

and Numeric. It is not recommended for attributes with validation base types like Number, URL, Date,

Condition, Multivalued Text, or Multivalued LOV, etc.
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Format Menu

The Format menu contains items for stylizing and transforming text in the workbench.

Style k
Clear All Styles
Character Tag r

Insert Special Character Ctrl+5hift+E

Style
This option allows setting either bold or italics. Users may create their own styles, which will show in this menu.

Format Maintain Window Help
Style > Bold
Clear All Styles Italic

Style

BodyRowStyle
bold

Bold_C
BoldHeader
bolditalic
BottomLeftCorner

Character Tag ;
Insert Special Character Ctrl+5hift+E

BottomRightCorner
bullet

Other Ctrl+Y

Users can apply style formatting to selected strings of text such as bold, italics, or custom style tags. The secondary
'Style' menu contains a list of additional styles. Selecting any will change the selected text. To add more styles to the list
of options, refer to the Tags topic in the System Setup documentation.

Selecting 'Other' from the extended Style menu displays a bank of all the custom styles in the STEP system.
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Style > B Bold Ctrl+B
Clear All Styles I ltalic Ctrl+l
Character Tag ; eﬁt}rkz : it
W Insert Special Character Ctrl+5hift+E TR
Bold_C
BoldHeader
bolditalic
(CJ BottomLeftCorner BoldRed
(| BottomRightCorner | BottomLeftCorner
(] bullet BottomPRightCorner
(] ColumnHeader e Other Ctrl+Y
(] CompactBottomRow1

Cancel

Note: Formatting is limited to free text fields.

In this example, bullets are applied to the Long Description field and 'Soft Crown' is bold.

100% Cofton

Unstructured
Long Item Description | A8c

Low-Fitting

Clear All Styles

This action clears all applied styles on the selected text.

Character Tag

The 'Character Tag' action allows for the insertion of custom-made character tags.
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Format Maintain Window Help

Style #

Clear All Styles

Character Tag ] LineBreak

¥ Insert Special Character Ctrl+Shift+E MoVersiocnPageMo

Emspace
ft
gt
It
multisep
phone
Other Ctrl+R

To learn more about editing character tags, refer to the Tags topic in the System Setup documentation. In the example

below, a non-breaking space character tag is used, followed by a line break, and then a multi-item separator.

[ph]
Long Item Description | RS | &

/

Selecting 'Other' from the character tag menu displays a bank of all the character tags in the STEP system.
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Style ]
Clear All Styles
Character Tage : LineBreak
W Insert Special Character Ctrl+Shift+E MoVersionPageMo
Emspace
Insert Character Tag x &
gt
4 Emspace It
ENM Space -
ft | multisep
gt phone
Ir_"ldentToHere e Other Crl+R
LineBreak
Cancel

Insert Special Character

This is an embedded character map. It shows the most recently used characters and offers a complete Unicode
character range.

Format
Style >
Clear All Styles
Character Tag >

¥ Insert Special Character Ctrl+Shift+E

Selecting the 'Insert Special Character' option displays a pop-up of the most recently used symbols.

Long Item Description | Aee

@ K2

Other... Enter

Selecting the 'Other..." option on this pop-up will generate another dialog that allows for selecting all of the special
characters, as well as changing the character set to choose from.
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Insert Special Character

Most Recently Used Symbols

elefs| | | ||

Unicode Character Block: Basic Latin v

~ All Spedal Characters

Ll 6 %|& "
ClY | * )+ -]

Insert Cancel

© Stibo Systems - Public - 2025.3 - September 2025 97



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Maintain Menu

Maintain menu provides the user to maintain STEP data by inserting, linking, merging, deleting, approving and
others. Some options, such as Customer MDM Monitoring and User Anonymizer, are only available if the
functionality is activated via a license and/or add-on component. Many options have additional actions and are
explained below.

Insert >

Link >

Merge >
»  Purge

Force Delete & Purge

Ctrl+)

Make Revision

Approval »

Revive

Revive Recursivehy

CMDM Monitoring »

User Anonymizer

Insert

The 'Insert' action allows the user to create an object based on the currently selected object. The options are disabled
based on the selection.

Note: Right-click an appropriate Tree hierarchy node to create products, classifications, entities, publications,
and assets. For more information on object creation, refer to the Creating Objects in the Tree Tab topic.
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Insert
Link

V)

BEEERESEc-EHBISS0OS0LES

(¥

(¥

Merge

Delete
Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+J

Duplicate Recursively

Make Revision

(¥

Approval

Enable group for workflows

Revive

Revive Recursively

Truncate log...

=

PREELZ 6D ke BO

Product

Classification
Classification Root

Mew Entity Node

Entity Root

Mew Publication...

Mew Publication Group
Mew Publication Section...

Mew Page Template ...
Orphan Attribute
Asset

Attribute

Attribute Group

List of Values

Mew Dimension

Mew Dimensicn Point

Action Set

Mew Image Conversion Configuration...

Create Transformation Lookup Table
Mew Event Queue

Mew AssetPush Event Cueue

Mew AssetPush Configuration

STEP Workflow

Background Process to Monitor Deadlines

User

Group

Mew Supplier

Create Package

Create STEP Workflow
Mew Business Condition
Mew Business Action
Mew Business Function
Mew Business Library

Setup Group Root...

Ctrl+5hift+P
Ctrl+5hift+C
Ctrl+5hift+R

Ctrl+Shift+0
Ctrl+Shift+A
Ctrl+Shift+T
Ctrl+Shift+]
Ctrl+Shift+L
Ctrl+Shift+D
Ctrl+Shift+ M
Ctrl+Shift+5

Ctrl+5Shift+R
Ctrl+5hift+D

Ctrl+5hift+ G

Ctrl+5hift+R

The following options are available in the Insert sub-menu:
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Product - If the user is within the primary product hierarchy, this option creates a new product beneath the
selected hierarchy.

Classification - If the user selected a classification hierarchy, this option allows creation of a new classification
folder beneath the selected classification with the predefined classification object types.

Classification Root - If the user would like to have a classification root to store images or configurations or to
link products in the classifications folder, this option creates a classification root with a set of predefined
classification root object types that are listed.

New Entity Node - If the user selected an entity root, this option creates a new entity object based on one of
the predefined entity types.

Entity Root - A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root object
types.

New Publication... - Allows the user to create a new publication. If the user has already selected a publication
hierarchy, this option displays the 'Create Publication' dialog with the default object type selected. The user
must provide a name of the publication and 'Page Template,' 'Product Template,' and 'Publication Template' to
create a new publication.

Note: The 'Create' button in the ‘Create Publication’ dialog is enabled only if the user has selected a
publication template.

New Publication Group - Allows the user to create a new publication group within the selected publication
group. If a publication group is selected, this option displays the ‘Create Publication Group’ dialog with the
predefined set of object type.

New Publication Section... - Allows the user to create a 'New Publication Section' from the 'New Section'
dialog. Complete the Section Name and select the Page Template from the dropdown list.

New Page Template... - Allows the user to create a new page template. After selecting a 'Publication Group,'
this option displays the 'Create New Page Template in STEP' wizard.

Orphan Attribute - This allows the user to add an attribute as an orphan attribute to a product by searching or
browsing from System Setup tab. For information, refer to the Linking Orphan Attributes topic in the System
Setup documentation.

Asset - Allows the user to create placeholder with ID and name for a new asset on the selected classification
folder. The user may choose an asset object type from the Create Asset dialog, then asset content can be
added.
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Attribute - Allows the user to create a new attribute in the selected attribute group in System Setup.
Attribute Group - Allows the user to create a new attribute group in System Setup.

List of Values - Allows a user to create new list of values under Lists of Values Group / LOVs in System Setup.
The user can add ID and Name in the 'Create LOV' dialog.

New Dimension - This option creates a new dimension when a user selects the 'Contexts' node in the System
Setup. For more information on dimensions, refer to the Dimensions and Dimension Points topic in the System
Setup documentation.

New Dimension Point - Allows the user to create new dimension point. A user must select a dimension under
System Setup > Contexts > Dimension (for example 'Language’). The label of this option changes dynamically
based on the selection of dimension, so the option ‘Dimension Point’ is never displayed. For example, if the
user has chosen 'Language' as Dimension, this option is labeled 'New Language'.

Action Set - This option creates a new setup or user action. A 'Create Action Set' dialog displays with ID and
Name to be filled when user selects the option Action Set. Creating a setup or user action is based on which
node is selected in System Setup. For more information on action sets, refer to the Maintaining Action Sets
topic in the System Setup documentation.

New Image Conversion Configuration...- A wizard displays to create new image conversion configuration and
save it for reuse in the selected classification folder. For more information on image conversions, refer to the
Image Conversion Configuration topic in the Digital Assets documentation.

Create Transformation Lookup Table - Allows the user to create a transformation lookup table under the
selected classification. For more information, refer to the Transformation Lookup Tables topic in the Resource
Materials online help documentation.

New Event Queue - The user can create a new event queue in System Setup. For more information, refer to
the Creating a New Event Queue topic in the System Setup documentation.

New Asset Push Event Queue - The user can create a new asset push event queue in System Setup and it
creates a new event queue. The event queue can have any number of asset push configurations running from
it. For more on assets push events, refer to the Creating and Maintaining Asset Push Event Queues topic in the
Digital Assets documentation.

New Asset Push Configuration - A new asset push configuration is created under the selected Asset Push
Event Queue. For more on assets push configurations, refer to the Creating and Maintaining Asset Push
Configurations topic in the Digital Assets documentation.
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STEP Workflow - When the user first selects "Workflows' in 'System Setup', this creates a new workflow under
System Setup > Workflows. The STEP Workflow designer window displays. The user can also create a
workflow by right-clicking on the 'Workflows' folder. For more information on workflows, refer to the Workflows
documentation.

Background Process to Monitor Deadlines - When first selecting the System Setup > Workflows node, this
option starts a background process for checking STEP Workflow items that have exceeded their deadlines.
Refer to the Deadlines and Escalations in Workflows topic in the Workflows documentation.

User - Users are created by first selecting System Setup > Users & Groups > Group where the user belongs.
When a user selects a Group and selects this option, the 'Enter New User' dialog displays. For more
information on users in STEP, refer to the Working with Users topic in the System Setup documentation.

Group - Groups are created by first selecting System Setup > Users & Groups > and selecting the necessary
node to hold the group. For more information on groups in STEP, refer to the Working with User Groups topic in
the System Setup documentation.

New Supplier - Supplier users are created in System Setup > Supplier Group. A hew supplier can be created
by first selecting the supplier group.

Create Package - Creates a package by first selecting System Setup > Change Package. After the user has
selected the change package option, a 'Create Change Package' dialog displays. Enter an ID and Name of the
Package. For more information on packages, refer to the Change Packages topic in the Configuration
Management documentation.

Create STEP Workflow - When the user first selects 'Workflows' in 'System Setup’, this creates a new
workflow under System Setup > Workflows. The STEP Workflow designer window displays. The user can also
create a workflow by right-clicking on the 'Workflows' folder. For more information on workflows, refer to the
Workflows documentation.

New Business Condition - Creates a new business condition under Global Business Rules in System Setup.
Business Conditions can also be created under Workflows in System Setup. For more information on business
conditions, refer to the Business Conditions in the Business Rules documentation.

New Business Action - Creates a new business action in System Setup under Global Business Rules.
Business action can also be created under Workflows in System Setup. For more information on business
actions, refer to the Business Actions in the Business Rules documentation.
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* New Business Function - Creates a new business function in System Setup under Global Business Rules.

Business function can also be created under Workflows in System Setup. For more information on business
functions, refer to the Business Functions in the Business Rules documentation.

* New Business Library - Creates a new business library in System Setup under Global Business Rules.
Business libraries can also be created under Workflows in System Setup. For more information on business
libraries, refer to the Business Libraries in the Business Rules documentation.

* Setup Group Root... - Creates a new setup group root under System Setup. When the user selects this option,
the 'Create Setup Group Root' dialog displays with a set of object types. The user may create a new setup
group root based on the object the object type selected.

Link

The 'Link' action provides a list of object or reference types for linkable actions. This menu only shows the relevant
options as active if it is available for the selected object.

Insert ¥
Link : Product Ctrl+Shift+
Merge ; Asset Ctrl+5Shift+F
Attribute to Classification  Ctrl+5Shift+}
> Delete r

Product to Classification  Ctrl+5hift+H

Force Delete & Purge
Attribute to Product Ctrl+Shift+ K

Lnlink Ohiect Twne

Based on the source object there are different link options available with keyboard shortcuts shown in the above
screenshot.

* When a user selects a product hierarchy and clicks on Link > Product, the product is linked to the selected
product via a product reference type dropdown.

When a user selects a product hierarchy and clicks on Link > Asset, the asset is linked to the selected product
via an asset reference type dropdown.

When a user selects an attribute, it can be linked to classifications.
When a user selects a classification, it can be linked to products.
When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, refer to the Creating a Product Attribute Link topic in
the System Setup documentation.
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Merge

Depending on the selected object, the user can merge attributes, LOVs, and LOV values. For more information, refer to
the Merging Attribute Values topic, the Merging Values in an LOV topic, or the Merging LOV Values in Bulk topic in the
System Setup documentation.

Merge : Attribute Values
LOVs
¥ Delete
Values in LOV

Eorra Dolcts B Diirns

Delete

The 'Delete' action sends items to the Tree Recycle Bin. If the selected item for deletion contains child objects, the user
receives a warning that these items will also be deleted. For more information, refer to the Recycle Bin for the Tree Tab
topic.

Note: The keyboard 'Delete' button does not delete objects in STEP Workbench.

Force Delete and Purge

Selecting an object in the workbench and clicking 'Force Delete and Purge' displays the 'Confirm Force Delete and
Purge' dialog. Click the 'Force Delete and Purge' button to permanently delete the object and purge it from the recycle
bin without any further opportunity to cancel or revive the object and without generating an event.

Confirm Force Delete and Purge

o After force delete and purge you cannot revive these objects again.
Force deleting and purging an object will NOT cause an Approve Deletion event.
Are you sure you want to permanently force delete and purge these objects:

Products: 1

Force Delete and Purge ] Skip Analysis Cancel

The Force Delete and Purge option is also available on the right-click menu when selecting the Tree Recycle Bin,
as defined in the Recycle Bin for the Tree Tab topic. This clears unnecessary data already in the recycle bin
quickly, without going through the various 'approve deletion' actions (if required), and errors reported about
existing references or events on queues.

Unlink Object Type
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When in System Setup, this option allows a user with the appropriate privileges to unlink the selected object type from
its parent.

Duplicate

This standard 'duplicate’ operation essentially copies and pastes in one click. Users may also right-click while selecting
multiple objects and duplicate each of them. A prompt for a new ID is displayed when an auto ID is not set, then
automatically provides a different name. The user is also allowed to indicate if duplicate references should be created.

Duplicate Recursively

A hierarchy can be duplicated when the user selects the top node in the hierarchy and clicks 'Duplicate Recursively.'
The ID should be editable to duplicate recursively since duplicate IDs for the same object type are not allowed.

In the below example, the ID is auto generated so the duplicate recursively background process ultimately returns
an error.

Duplicate Recursively

o D 18209

New Name | Cotton T-Shirts(2)
@ Duplicate references

Start Process with Description
Name | Duplicate Cotton T-Shirts(2)

Cancel

Make Revision
Allows a user to force a revision on a product and provide a comment for explanation.
Approval

The approval options allow objects to be moved to the Approved workspace.
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Approve Object Ctrl+Shift+)
Partial Approve...

Check Approve

Approve Deletion

Approve Recursively

Approve Object - Approves an object from the Main workspace to the Approved workspace and changes
never been approved (%) to either approved (..~ ) or partially approved (' ). Refer to the Approved Symbols

and Messages topic for more information.

Partial Approval - Approve selected parts of the unapproved changes on the selected object.

Check Approve - The 'Check Approve' action allows the user to refer to if anything is barring successful
approval of an object. In the example below, mandatory values are missing.

Unable to approve product

Approve report for 198623

Unable to approve object due to missing mandatory values on attribute(s):
Minimum Order Oty

Height

OK

Approve Deletion - For an approved object to be removed from the Recycle Bin, the object must be Approve
Deleted. If a previously approved object is deleted, in the Recycle Bin it displays a red '(in Use)' header:

Performing an Approve Deletion changes the header to 'Not in Use' and allows the object to be deleted.

For more information, refer to the In Use and Not In Use Objects section in the Approval of Objects topic.
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© Approve Recursively - Launches a workflow process that approves the currently selected object and all of
its children.

Enable Group for Workflows

This is a disabled legacy option.

Revive

Revives a deleted object, either 'In Use' or 'Not In Use', from the Recycle Bin. For more information, refer to the In Use
and Not In Use Objects section in the Approval of Objects topic.

Revive Recursively

Revives a deleted object as well as all of its children, both 'in use' and 'not in use', from the Recycle Bin. For more
information, refer to the In Use and Not In Use Objects section in the Approval of Objects topic.

Truncate Log

Once selecting an Event Queue or Asset Push Queue, this option reduces the log to the most recent entries. For more
information, refer to the Event Queues topic in the System Setup documentation.

Customer MDM Monitoring

Selecting the 'Start background process for monitoring Customer Data Policies' option under Customer MDM
Monitoring manually initiates any of the active data policies in the system.

A background process refreshes policies every day at 12 a.m. Within this hour, there is a 30-minute window from 25 to
55 minutes past the start hour, during which the system initiates the background process as soon as possible. If a
running process or a previous process finished too recently, the process is not started until the next scheduled start
hour.

For more information, refer to the Data Policies topic in the Data Governance documentation.

User Anonymizer

This option is available to admin users and is used to anonymize a deleted user within the object change logs,
revision logs, and workflow status logs. For more information, refer to the User Anonymizer topic in the System
Setup documentation.
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Window Menu

The Window menu offers actions around the STEP Workbench window.
Mew PIM Window Ctrl+M

Goto Window

D Goto Dashboard

Zoom Window

New PIM Window

This action will create a new instance of the STEP Workbench.

Goto Window

This is a legacy option and no longer functions.

Goto Dashboard

This option will display the STEP Workbench dashboard.
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doc-dev - Development-userj - STEPworkbench

File Help

D (%' show Dashboard for User Group:

Profile generated Fri Feb 01 2019 15:21 in
context 'English US', workspace "Main’

W Hemn (491}

B Edernal tem Golden Record (160}
“ [ Edemnal tem {(159)

W Edernal kem BEnrichment Record (159)

W Sales kem {135)

1 Other object types (428)

Profile generated Fri Feb 01 2019 15:21 in
context 'English US', workspace "Main’

Y’ '\ = Re-Translation Needed (1)
|

| mwaster (138)
b I Not Translated (1344)

_Fexpt . | Number of tems in Workflow State
Profile generated Fri Feb 01 2019 15:21 in| | Profile generated Tue Jun 18 2019 16:50 ||STEP Workflow profile is unavailable
context 'English US', workspace "Main’ in context 'English US', workspace 'Main"

0-10% 1
1020 % 5

20-30 % 4

30-40 %
™ Yes (10) 40-50 %
- Mo (1) 50-60 %
60-70 %
7080 %
80-00 %
00-100 %

Zoom Window

This action will center the STEP Workbench on your primary display.
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Help Menu

The Help Menu has two options: 'Help' and 'About STEP'.

& Help F1

T About STEP

Help

The 'Help' option opens the STEP documentation in your default web browser.

About STEP

The 'About STEP' option displays the workbench introductory window.

[] About STEPworkbench X

DSTIBO SYSTEMS

MASTER DATA MANAGEMENT

Copyright © Stibo Systems: All trademarks, service marks, and
logos appearing are proprietary to Stibo Systems or its licensors.
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Object Editor

When an object is selected from the left panel in STEP (e.g., Tree tab, System Setup tab, etc.), the right panel
displays details on the first tab for the selected object. The left panel can be hidden by clicking the 'X' button.

The kind and number of tabs will vary depending on the selected object. However, all objects will have at least an ID,
Name, Object Type, Revision, Approved, Translation, and Path. These fields are called 'aspects.’

f\ 18207-011
; Sales Item « Revision: 0.19
Product Data Containers  Sub Products References Referenced By  Images & Documents  Commercial
Description
Name : : | Value
(D] 18207
MName 18207-011
Object Type Sales Item
Fevision 0.19 Last edited by USERJ on Maon Moy 23 07:48:30 EST 2020
Approved / Last Approved on Mon Oct 08 12:16:24 EDT 2018
Translation Master
Path Primary Product Hierarchy/Products/Apparel/Upper Body Wear/T-shirts/T-Shirts Sales

Refer to the Object Maintenance in the Tree Tab topic and child topics for additional information on the various
object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the documentation (e.g.,
information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with aspects in the first
flipper called 'Description.' For more information about description attributes, refer to the Description Attributes
topic in the System Setup documentation.
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Advanced Search Tab

The Advanced Search tab allows users to perform simple searches by typing directly into the default search field. For
more on searching, refer to the Advanced Search topic.

H Advanced Search

Search ~ *
Q
©

> Advanced

m + - Reset Search
:-. Show Details
b ¢

MName

Users can also perform more complex searches by selecting and/or combining additional search criteria. For more
information about search criteria, refer to Search Operations on Entire Result topic.
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Advanced Search

Search ¥ X
t Search
5 Search
Object Type
Search Below

Referenced Assets
Background Process Search
Revised Objects Changed Since
Data Containers

Search from List

Javascript search

Missing Mandatory Values
Unapproved

Product Override Search
Search in Publication Hierarchy
Referenced By

References

STEP Workflow

Sample Result

Translation Status

Unpushed or Failed Assets

The 'Save as Collection', 'Export', and 'Bulk Update' operations can be performed on the entire search result.

Operations on Entire Result
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STEP Workflow Tab

STEP Workflow is STEP's native functionality for structuring and to some extent automating processes around
objects in STEP. Typical examples are product onboarding processes and change / governance processes.

The concept of STEP Workflows differs from the general concept of a workflow, in that STEP Workflows are data-
centric, meaning that each instance of a given workflow will always be tied to an object in STEP. As illustrated
below, technically, a workflow instance is a relation between a STEP object and a workflow definition, which also
exists as an object in STEP.

For information on how to configure workflows, refer to the Creating a Workflow topic in the Workflows documentation.

Data Enrichment (=g

Reject

Marketing

Workflow Instance

STEP Object

Active - Done

Workflow Definition

The STEP Workflow tab has the Tasks and Profile sub tabs.

Tasks

The Tasks sub tab is the primary interface for working with workflows in STEP Workbench.

Note: As indicated by the information icon (@), the list of actual tasks can be filtered by privileges.
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1. Open a workflow section to display details.

STEP Workflow X
Tasks  Profie
|v Asset Enrichment Workflow |

e 22 2

Filter by Collection [+
Review 10
Rejected

MNeed Info

Final Review

Removed from Worlkflow
Verify Digital Assets

=N

Workflow states are displayed for each workflow as configured by an administrator. The number of tasks for

each state is displayed.

STEP Workflow p.4

Tasks  Profie

~ Asset Enrichment Workflow
&N =2 2

Filter by Collection [+

Review 10
Rejected

MNeed Info

Final Review

Removed from Workflow
Verify Digital Assets

=D ==

2. Click the Refresh button to update the number of tasks in the workflow states.
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STEP Workflow

Tasks  Profie

~  Asset Enrichment Workflow
Cle 2 2

Fitter by Collection

Review

Rejected

MNeed Info

Final Review

Removed from Worlkflow
Verify Digital Assets

]
_—

10

[N = B TR S
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3. Click the Show All Items button to display all tasks in all displayed states, regardless of the assignee. Only
users with the STEP Workflow Administrator privilege have access to this button.

STEP Workflow

Tasks  Profie

X

~  Asset Enrichment Workflow
C e 2|

Filter by Collection

Review

Rejected

MNeed Info

Final Review

Removed from Workflow
Verify Digital Assets

10

[ = B S
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4. Click the Show All Items assigned to me or any group | am a member of button to display tasks directly

assigned to the current user or to any group that the user is a member of.

STEP Workflow

Tasks  Profie

Asset Enrichment Workflow

i ]
Filtter by Collection
Review
Rejected
Meed Info
Final Review
Removed from Workflow
Verify Digital Assets

L
_—

10

== O3

5. Click the Show All Items assigned to me button to display only tasks that are directly assigned to the current

user.
STEP Workflow
Tasks  Profie

Asset Enrichment Workflow

i ]
Filter by Collection
Review
Rejected
Meed Info
Final Review
Removed from Workflow
Verify Digital Assets

6. Click the filter button to select a collection and filter the list of displayed tasks.
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For example, to view objects in the workflow where the 'Color Attribute = Blue', perform an 'Object Type = Attribute
search on the Advanced Search tab, then save the result as a collection. Select that collection to filter the objects

and display only those where the color is 'Blue’'.

STEP Workflow

Tasks  Profie

Asset Enrichment Workflow
o <4
Blue (5782021)
Review
Rejected
Meed Info
Final Review

Removed from Workflow
Verify Digital Assets

ololololm ]
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Profile
STEP Workflow | Sample Workflow Profile I
Tasks ﬂ STEP Workflow profie Lo
KPL StatusTracking nﬁgurahon last editelby User 3 on 2016-10-24 13:23:31; On-demand data last updated by USER3 on 2016-10-24 13:23:33
Nevi Irem Creation Profie - By Assignee Edlt configuration ' Update on-demand data  Copy to Cipboard
New Ttem Creation Profile - By Workflow
Sample Workflow Profile o e State : | STEP Workflow | Ttemsin State : | Exceeded ... : | Average... : | Maximum... : | Throughput... :
sampeWorkdonWihParales Start SampeWorkiow | 5 5Days | 29D |25
Review SampleWorkflow | 0 0Minutes  OMinutes |0
Paralel SampleWorkflow | 2 28 Days 29 Days 0
Review Data SampleWorkflow | 1 29Days | 29 Days 2
Review Images SampleWorkflow | 0 0Minutes  OMinutes |0
(ather Data SampleWorkflow | 1 28 Days 28 Days 2
Gather Images SampleWorkflow | 1 28 Days 28 Days 5
Enrich Data SampleWorkflow | 2 28 Days 29 Days 0
Product Assets SampleWorkflow | 2 28 Days 29 Days 0
Enrich Data Complete | SampleWorkflow | 0 0Minutes  OMinutes |0
Product Assets Complete | SampleWorkfow | 1 22 Days 22 Days 0
End SampleWorkflow | 0 0Minutes  OMinutes |0
Create new
To work with a profile:
1. Click a Profile link to display details of the configuration.
2. Click the Edit Configuration button to modify the data being profiled.
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3. Click the Update on-demand data button to run the profile and update the data displayed.
4. Click the Copy to Clipboard button to save the displayed data to your computer's clipboard

5. Once saved to the clipboard, the profile data can be pasted into Excel for further analysis.
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System Setup Tab

Schema objects are maintained from the System Setup tab. Examples of such objects are Attributes, Action Sets,
Contexts, LOVs, Object Types, Tags, Units, Users & Groups, Workspaces, Reference Types, and many more. Most
actions performed require Super User access. This is where the core components like integration endpoints, STEP
Workflow, Web Ul, and business rules are created and configured.
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Search
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(154)

s

System Setup
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Bookmarks
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System Setup

¥ £ Attribute Groups

P ) Attribute Transformations
b [£5] Action Sets

Contexts

C3 Lists of Values / LOVS

Al Setup

Change Packages
Elasticsearch Configuration
Event Processors
Gateway Endpoints

Global Business Rules
Inbound Integration Endpoints
Metrics

Outbound Integration Endpoints
Sufficiencies

Web Uls

Workflows

&J SSL Client Certificates

=l Derived Events

» & Object Types & Structures
» 05 Tags

» & Units

P & Users & Groups

» B Reference Types

Q

Q

v v v v v v v v v v v v v v

b 113 Workspaces

b if Table

P = Keys

» ¥ Event Queues

» B Component Models
» 23 Recycle Bin
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Additional information on the System Setup objects and functions can be found throughout the online help. For
example, information on workflows is available in the Workflows documentation, while information on integration
endpoints is available within the Data Exchange documentation. Information for general functions that are not

covered in independent guides (e.g., attributes, references, users and groups) can be found in the System Setup
documentation.
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Toolbar

The features accessible on the toolbar, (located beneath the menu bar), are geared towards navigating between
objects and viewing object data in different ways.

doc - Production-userj - STEPworkbench

File Edit View Mavigate Format Maintain  Window Help

|D Context English US ~ afg_i;::e :EQ‘E MNormal ~ URL ipaceid1=Approvediwor IDfMName -~ |
e ——

Item Folder » Revision: 0,17

b [ ACME web Store
Tree I Compare and Update References  Referenced By
b =1 Anaska

The features available on the toolbar are described below.
Stibo Systems Logo
[

Clicking the Stibo Systems logo toggles between the STEP dashboard and the STEP Workbench. For more
information regarding the dashboard, refer to the Global Dashboard topic of the Data Profiling documentation.

Context

Context EnglishUs  ~

'‘Context' is a filter that allows a user to view object data defined by, for example, country or language.

To select the context, click the dropdown and then choose the desired context. It is useful to check that the context is
properly set because viewing data in the wrong context is likely to cause significant confusion. For more information
regarding contexts, refer to the Contexts topic in the System Setup documentation.

Approved Workspace

The Approved Workspace button toggles the user's view of a given object:

« Approved

LO21EEEE indicates you are working in the 'Main' workspace where object values can be edited.

« Approved ®
Workspace - . . : .
indicates you are in the 'Approved' workspace where you cannot edit values, but you can

examine values that have been approved.

For more information on workspaces, refer to the Workspaces topic in the System Setup documentation.
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View Mode

View
Mode

MNormal e

Translation
Workspace
Revision
Context
Update

View Mode enables the user to view data in a variety of ways, dependent on the need. Click a 'View' option to present
data in different ways, as described below:

* Normal - The default view of the STEP Workbench. With this view selected, users can examine a listing of all

relevant attribute and metadata associated with that object.

Translation - Users can view all object-related data in up to two languages. The data is presented in a comparison
display format. Attributes that require translation are automatically highlighted in green. More information of
translations is available in the Translations documentation.

Workspace - Users can refer to object data as it appears in both the 'Main' and 'Approved' workspaces. This
comparison view can be useful to allow a user to view which values have changed since the object was last
approved. However, if the object is in 'Never been approved' status, only the 'Main' workspace displays when this
view is active. For more information on workspaces, refer to the Workspaces topic in the System Setup
documentation.

Revision - Users can view the current state of an object's data as well as all previous revisions in a comparison
display format. By default, current and previous versions are displayed. The number of revisions viewable at the
same time is configurable. For more information on revisions, refer to the Revisions topic in the System Setup
documentation.

Context - Users can view all of an object's data for two or more available contexts in a comparison display format.
The number of contexts viewable at the same time is configurable. For more information regarding contexts refer to
the Contexts topic in the System Setup documentation.

Update - Users can view and compare the values of an object's attributes in both the Approved and Main
workspaces. The 'Compare and Update' tab clearly displays differences between the workspaces.

Navigation
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To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, click the 'Back’,
'Forward', or 'Reload' buttons, respectively. When clicked, these buttons behave in a way similar to most web browsers'
'Back’, 'Forward', and 'Reload' functions.

URL

URL |ipaceid 1=Approved&workspaceid=Main

To maximize navigability of the STEP tool, all objects may be accessed via an in-tool URL. As with the URL field in a
standard web browser, a product can be displayed within STEP by pasting its unique URL into the URL field. Sharing an
item's URL is effective for directing another STEP user to a specific object. The STEP URL always begins with 'step://';
where web URLSs begin with 'http://' or 'https://.'

Search
b

ID/Name v

La
T
1)

This field allows searching for specific objects in the hierarchy by typing their ID, name, or key into the 'Search'’ field.
When the desired item appears in this field, click on it to display the object. For more information regarding the Search
field, refer to the Search topic in the Getting Started documentation. For more information on keys, refer to the Unique
Keys topic in the System Setup documentation.
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Tree Tab

This section contains information about how to create and remove local overrides and information about table
dimension points.

ditld  Tree X

P [T Assets

» [T] Configurations

P [T ECLASS ADVANCED Classifications
P [T Merchandising Hierarchy

P [ Suppliers

» [ Web Sites US

» F= Entity Root

» I Publications

P [0 Primary Product Hierarchy
» I Collections

» (@ eCatalogs

» =% Recycle Bin

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.

Object Description

Products Itis used to store actual product information. Alternative name is 'Blue folder'

Classifications Itis used to store assets (Images and documents), configurations, and link products. Alternative
name is '"Yellow folders' or 'Secondary classification.'

Index Words An Index structure needs to be created in STEP, in the same way as a ‘Classification Hierarchy,’
and products are linked into this structure.

Entities Itis used to store the party, supplier data, or contact information. Alternative name is 'White
folders."'
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Object Description

Publications

Itis used to store print (Example: InDesign) documents and print related configuration like
templates, versions, commercial data, and dtp documents. Alternative name is 'Green folders.'

Collections

Collections are containers for storing different sets of objects to perform bulk update or export
data.

eCatalogs

It is used to create electronic product catalogs. An electronic product catalog is a data file
containing product and price information for a specific product selection. Alternative name is
STEP sync.

Recycle Bin

Deleted objects (products, assets, classifications, configurations and entities) are moved to
recycle bin from the Tree tab.

It is used to create electronic product catalogs. An electronic product catalog is a data file containing product and

price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, refer to the Basic STEP Concepts topic and

the Object Maintenance in the Tree Tab topic.
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Object Maintenance in the Tree Tab

Regardless of the particular object type or hierarchy that you are working with, the general principles of maintaining
objects in the workbench are the same, and are described in the All Objects topic. This includes general information on
creating, editing, approving, and deleting objects.

Note: The All Objects information should be read and understood prior to focusing on any of the object type
specific information (links below), as the basic information that is common to all object types is not repeated in
the type-specific sections.

Beyond the general object maintenance topics, additional information on working with specific object types in Tree,
including details about the various editors and functionalities available on them can be found in the subsequent topics in
this guide:

* Assets
Classifications
Collections
Entities
Products

Recycle Bin for the Tree Tab

Publications: Information about maintenance of objects in the green publication hierarchy is not covered in this
guide. ltis located in the Publication Hierarchy section of the Publisher (Adobe InDesign Integration)
documentation.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects, or
may only have options to edit specific object types, hierarchies, or attribute values. The information in this
guide focuses strictly on the means for carrying out the various actions, and assumes that all required
privileges are available to do so. More information on privileges is available in the Privilege Rules topic in the
System Setup documentation.

A variety of components are also available for maintaining objects in Web UI. For more information, refer to the
Web User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or via
imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of this
material, but additional information is available in the relevant guides throughout the STEP Online Help.
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All Objects

This section covers the basic functionality of creating, editing, and deleting objects in the Tree, as well as
providing an overview of the commonalities between the various object editors. Regardless of the particular object

type or hierarchy that you are working with, the general principles of creating and maintaining objects are the
same.

Itis helpful if the Basic STEP Concepts topic has been read and understood prior to reading this material.

A variety of components are available for creating and maintaining objects in Web Ul. For more information, refer to the
Web User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or via
imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of this
material, but additional information is available in the relevant guides throughout STEP Online Help.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects, or
may only have options to edit specific object types, hierarchies, or attribute values.

The information below focuses strictly on the means for carrying out the various actions, and assumes that all required

privileges are available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup documentation.

Refer to the relevant section(s) below for detailed information on working with objects in the workbench:
¢ Approval of Objects

¢ Creating Objects in the Tree Tab

* Deleting Objects in the Tree Tab

* Editing Objects in the Tree Tab
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Approval of Objects

This section introduces the user to the concept of approvals in STEP, and provides detailed information on how to carry
out approvals in the STEP Workbench.

Approval of objects in the Web Ul is handled via a Partial Approval action button on a Node Editor screen. Refer to the
Partial Approval in Web Ul topic in the Web User Interfaces documentation.

Approval Overview
The data in STEP is logically divided into two workspaces named Main and Approved.

The Main Workspace is the editable 'draft' Workspace where data is initially born and enriched. The Approved
workspace holds approved data deemed ready for production.

Main Approved

=y

Approval

In a typical setup, data from the Approved workspace is made available to downstream systems. Data cannot be
edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation called
approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or other
operation.

The approval operation only applies to objects that are workspace revisable. These are:

* Product objects
* Classification objects
* Asset objects

¢ Entity objects configured to be workspace revisable
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All other objects in STEP (like attributes, references, etc.) will be identical in the Main and Approved Workspaces
and changes made to these will be reflected automatically in both workspaces. These objects are known as being
'Globally revisable'.

Detailed information on how to carry out approvals in STEP Workbench can be found in the Approving an Object topic.
This guide also contains a detailed description of the approval symbols that are visible in the different object editors in
the Approved Symbols and Messages topic.

Note: All actions are controlled via privileges. Some users may not have access to approve objects, or may
only have options to approve specific object types, hierarchies, or attribute values. The information in the
subsequent topics assumes that all required privileges are available to carry out the described actions. More
information on privileges is available in the Privilege Rules topic in the System Setup documentation.

In Use and Not In Use Objects

When an object is approved in STEP, it cannot be purged from the Tree Recycle Bin. This restriction prevents approved
objects that show on the Approved workspace from being removed erroneously. 'in Use' indicates that an object is in
the Approved workspace, while 'Not In Use' means that the object is only in the Main workspace. For more information,
refer to the Recycle Bin for the Tree Tab topic in this documentation or the Recycle Bin for System Setup topic in the
System Setup documentation.

'In Use' objects cannot be individually deleted nor are they included in the Purge action. The 'Approve Deletion' action
is required for each 'In Use' item.
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Product Sub Products References Referenced By Images & Docu... b
“ Description
Name : : | Value
ID 104702
Name T-shirt long sleeves
Object Type Level 1
Revision 0.3 Last edited by USERJ on Thu Aug 08 18:39:03 CEST 2024
Approved (% Last Approved on Thu Aug 08 18:36:03 CEST 2024
Translation Mot Translated
Path Primary Product Hierarchy/Products/T-shirt long sleeves

When an object that is not approved is deleted, the Tree Recycle Bin shows the 'Not In Use' indicator. This means it will
be purged with the 'Empty Recycle Bin' option.
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Product Sub Products References Referenced By Images & Docu... >
v Description
Name : ¢ | Value
ID 103503
Name T-shirt
Object Type Level 1
Revision 0.2 Last edited by USER] on Thu Aug 08 18:32:26 CEST 2024
Approved X Never Been Approved
Translation Mot Translated
Path Primary Product Hierarchy/Products/T-shirt

If an object that is approved is deleted, it continues to display in the Approved workspace until an Approve
Deletion or Approve Deletion Recursively action is performed.

An approved object can be removed from the Approved workspace by manually performing a Force Purge operation
from the BGP screen after a purge operation fails (due to the object being 'in use'), or, from the Maintain menu.
Additionally, you can force purge approved objects which have not yet been approved for deletion from the Tree
Recycle Bin, by running a scheduled Recycle Bin empty operation that has 'Force Purge' selected within the Schedule
Recycle Bin wizard.

The key difference with the System Setup Recycle Bin and the Tree Recycle Bin is that all of the System Setup objects
in the Recycle Bin are flagged with 'Not In Use' since nothing in the System Setup is constrained by Approval status.
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Note: When in the Approved workspace , neither the Tree nor the System Setup recycle bin are displayed.

o Approved

Workspace - . . : :
P indicates you are working in the '‘Main' workspace where object values can be edited.

« Approved ®

Workspace - , :
pa indicates you are in the 'Approved' workspace where you cannot edit values, but you can

examine values that have been approved.
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Approving an Object

This topic describes how to approve an object in the workbench. When an object is approved, it moves to the Approved
workspace.

Data Ownership

The concept of data ownership is very important in relation to approvals. For an object to be fully approved, all
data that the object owns must also be approved. When data changes, the object that owns that data is
considered 'modified' and can potentially become 'unapproved.'

The figure below shows data owned by a product object (the largest box).

Local References
to other Products

Parent Product
Local References
to Entities

_ Local Links to
Local Specification cl iFicati
Attribute Values assimncations

Description
Attribute Values
Local References

to Assets

Local Links to
Specification Attributes

* A product owns its parent link (also true for classifications, entities, and assets).

* The product owns local values, but not inherited specification attribute values. Thus, when these are modified
at an ancestor level, this will not affect the product’s approval status. Also, the object's local values (that is,
assigned at the product level), will be approved.

* The product owns all local references and links for which it is the source. When a reference or link is modified,
it is the source that is changed while the target is unaffected. Attribute values on the reference or link are also
owned by the source object.
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Approving an Object

To approve an object, right-click on the object and select one of the available approval options.
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» [ (ETIMT_Article_Groups)
» [ (ETIMB_Article_Groups)
» [T (ETIMS)
o 3 ACME Lookup Tables
SRRV » [ ACME Part Type Root
w [C] ACME Web Store

Mo task fou

] v [ Audio B New Classification
Bookmarks [ Audio Accessori New Asset Ctrl+Shift+A
w [ Assets W hew Product
3 » [T (BoardAssetContel & Import Images & Documents. .
STEP Warkflow » [C(lcons_323261) | & Export Images & Documents...
b [ (JPAssets) @5 Export Data Below
> O BMECat Templates Unlink classification
P [C] CASS Repaorts
v (7 F-D Images & cut Ctrl+X
7 2B-acetate-cloth Copy Cirl+C
3m-gti-3000-wal Paste Ctrl+V
| bottles Paste Link Ctrl+L
'w| bottles_Brightne
‘W bottles_Brightne > Delete
‘W bottles_Brightne 52 Duplicate L]
B certificate 52 Duplicate Recursively
doeshotExist Approve Object Ctrl+Shift+)

scatch-vinyl-eled
» [0 Filters for Match Tz
» [ icon Types
P [ lllustrations

Partial Appraove. ..
Check Approve

Approve Recursively

You can also use the options on the Maintain menu.

© Stibo Systems - Public - 2025.3 - September 2025 138



Maintain Window Help
Insert
Link
Merge

¥ Delete
Force Delete & Purge

Unlink Object Type

Duplicate

B

Duplicate Recursively
Malke Revision

Approval

Enable group for workflows
Fewvive

Revive Recursively

Tt v L

Ctrl+)

LEL [arkflowltemEditorg

Audio Accessories 1

Classification  Sub Products R

Mo task found

Approve Object Ctrl+Shift+)
Partial Approve. ..
Check Approve

Apprave Deletion

Approve Recursively

[ ]
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Note: If 'approval' is a task within a workflow, then objects can alternately be approved from the task view.
Refer to Working with Tasks in Workflows in the Workflows documentation.

Approve Objects is available when the Main workspace is selected.

Approving objects is available for:

* Classifications
* Products

¢ Images & Documents

* Entities (set up to be workspace revisable)

The status of an object in the various workspaces can be viewed in the Status tab in the Workspaces section of the

relevant editor.
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T-shirt long sleeves
Level 1 » Revision: 0.4

Tables Category Profie  Proof View Status  Log
Revisions
Workspaces
D Name Path
Approved Approved Approved 0.2
Main Main Main 0.4
Translation

Approval status in all contexts
Hidden values
Diagnostics

Once object editing is complete, and the object is ready for publishing, approving the object copies the current object
values into the Approved workspace.

Conditions to approve an object

¢ Objects must be approved from the Main workspace.

An object cannot be approved if parent objects are not yet approved (approving must be done from the top
down in the hierarchy).

A reference or link cannot be approved if the target does not exist in the Approved Workspace, i.e., if a product
or classification is referenced with another product, asset, or classification, then the referenced product, asset,
or classification needs to be approved first before the actual product or classification is approved.

If attributes, references, links are mandatory, objects cannot be approved if there are no values or targets.

Externally maintained attributes, references or links are not under revision control. Values and references will
automatically be reflected in the Approved Workspace and modifying the data will not affect object’s approval
status.

The user must have sufficient approve privileges.
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* To easily check differences in the Main and Approved Workspaces, select Partial Approve, as discussed in
the Partially Approving an Object section below.

* When approving, the object's revision number changes automatically.

* An entire hierarchy can be approved using the Approve Recursively option. For more information, refer to the
Approve Recursively section below.

Partially Approving an Object

Itis possible to approve an object that has a reference or link to another object that does not exist in the Approved
Workspace. In this instance, the object will become 'partially approved,' meaning that the object and all data that
can be approved will be approved. However, the reference or link will not be approved. If the target for the
reference or link is later approved, the source will need to be approved again for the reference or link to be
updated in the Approved Workspace.

Main Approved

Classification only
in Main

Productsought Product without Link to
approved 3 E- Classification

Partial approvals can also be performed deliberately - both manually and programmatically. Specific attributes,

references, links, and the object name can be selected for approval. The attributes, references, links, and names
are sometimes referred to as 'part objects.' These part objects cannot exist in the Approved Workspace without
the object to which they belong. Thus, when the first part object is approved, the object will need to be present in
the Approved Workspace.

Usage

© Stibo Systems - Public - 2025.3 - September 2025 141



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Partial approval of selected elements of the object is particularly helpful in situations where certain elements of the
object need to be available for usage (in the Approved Workspace) before the rest of the object or its elements can
be approved.

For example, consider that there are two users who perform changes for a product and then approve the product.
If the product is completely approved, then it can be difficult to identify which user performed specific changes. In

this case, using the Partial Approve will allow the user to approve only their own changes and leave the rest of the
changes to be approved by the other user who made those changes.

Approving partially

1. Inthe Tree, select the object to partially approve.

2. Right-click the selected object and click Partial Approve. Alternatively, from the Maintain menu, click Approval,
and click Partial Approve.

3. On the Partial Approve dialog, select the checkboxes for the element(s) to be approved.

[] Partial Approve >
Main Approved
£ [All Elements]
~[_| Parent Object Audio
-1 Name Audio Accessaries 1 Detalls...
Expand All Callapse Al
Suppress Re-Translation
Approve Selected Check Cancel

4. Click the Approve Selected button.

Note: The attribute groups displayed to a user in the Partial Approve dialog are controlled by privilege rules.
For more information, refer to the Privilege Rules topic in the System Setup documentation.When an attribute
is linked to multiple attribute groups that a user has privileges to, the attribute will display to the user in all of
these attribute groups.

Partial Approve Compare View Dialog
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The dialog shows which elements of the selected object have been changed since the last approval of the object.

Besides name, parent object, and default DTP Template, the type of elements listed are attributes, references, and
tables. For each element the values in Main and Approved Workspaces are listed.

For detailed information about the value for an element, click the Details...link to display a detailed view of the element
showing the values for the Main and Approved Workspace:

[ 1 Partial Approval Compare View - Name x

Main Appraved
Audio Accessaries 1

Cance|

In the above example, the value for the attribute has changed. Values only present in Main Workspace are marked with
a green background color. Values only present in Approve Workspace are marked with a red background color.

Note: The detailed view differs slightly depending on the element type selected.

All elements are selected by default. To deselect all elements, click the checkbox next to the All Elements node.

You can select the element(s) to approve by clicking the check boxes next to each element. You can also select a whole
element group, i.e., attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click the - sign
next to the element group. To expand all elements in the dialog, click the Expand All button. To collapse all elements in
the dialog, click the Collapse All button. To check if the selected elements can be successfully approved, click the
Check button to display an approve report that summarizes the results.

Clicking the Approve Selected button will approve the selected elements of the object and the Approve status of the
object will change accordingly. Privilege rules apply to Partial Approve as discussed in the Action Sets topic.

This functionality is also available in the Web Ul. For more information on this feature, refer to the Partial Approval in
Web Ul topic in the Web User Interfaces documentation.

Suppress Re-translation

Typically, approval of a translated product in a source language causes the Translation status of the product to be set to
'Re-translation needed'. In the Partial Approval dialog, this behavior can be suppressed by clicking the Suppress Re-
translation checkbox. All existing translation relations with status 'Up to Date' will retain that status. This is useful when
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only minor changes are approved and no re-translation is needed. For more information, refer to the Translations
documentation.

Note: To get a list of language variations of the object that potentially will be affected by the approval, hover the
cursor on the 'Suppress Re-translation’ label.

Check Approve

Consider a product that has multiple attributes linked and has mandatory values and references which needs to be
approved after the changes. The 'Check Approve' option easily confirms if the product can be approved completely with
a detailed report.

To determine if you are allowed to completely approve an object, run 'Check Approve' as follows:
1. Inthe Tree, click the object to be approved. The editor shows the object contents in Main and Approved

Workspaces.

2. Right-click on the object and select the Check Approve option. Alternatively, on the Maintain menu, click
Approval, and click Check Approve.

® you only have changed attribute values for which you have the Approve privileges, the 'Complete
Approval Possible' dialog box displays.

[ 1 Complete Approval Possible >

The object can be be approved completely

without errors,

* Ifthe product cannot be approved (for example, due to mandatory values or references being empty), the
dialog provides details, as shown below:
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[ Unable to approve product >

Approve report for 18210 M B
Unable to approve object due to missing mandatory values on attribute(s):
Manufacturer Name

0K

Note: If you changed attribute values for which you do not have the Approve privileges the approval
options are unavailable.

Approve Recursively

Approving objects recursively searches for unapproved objects linked to (or below) a selected hierarchy node, and
approves these objects, copying them from the Main Workspace to the Approved Workspace. This is useful and time
saving, for example, when multiple images have been imported and checked and should all be approved, compared to
reviewing and approving each object individually.

Approving Recursively is available for:

* Classifications

* Products

¢ Images & Documents

* Entities (setup to be workspace revisable)

The status of an object in the various workspaces can be displayed using the Workspace View Mode of the relevant
editor.

To recursively approve:

1. Select the Main Workspace.
2. Inthe Tree, select the hierarchy containing the objects to be approved.

3. Right-click the hierarchy object and click Approve Recursively. Alternatively, on the Maintain menu, click
Approval, then click Approve Recursively. A dialog displays the nhame of the selected hierarchy node, a count
of the objects within the hierarchy, and other information.
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Note: Approve Recursively automatically performs a search for unapproved Objects. Click the Skip
Analysis button if desired.

D Approve Recursively >

o Finding Unapproved Objects (This might be time consuming)
Object Classifications Froducts Assets

Audio Accessaries 1 1 0 0

Empty mandatory links/values in Main workspace

Start Process with Description

Mame aApprove Audio Accessories 1

oK Skip Analysis Cancel

4. Optionally, type a name for the process.
5. Click the OK button to start the approve process and display a dialog with information.

6. Click Go to process button to open the Process view showing details of the process and a report of approved
objects. The hierarchy displays an Approved status to indicate that it is copied into the Approved Workspace.

Approval Feedback

Depending on Approve privileges, the following warnings and dialogs may be displayed after clicking Approve Object
or Partial Approve.

For more information about user privileges, refer to the User Actions and Error Descriptions topic in the System
Setup documentation.

Approve Object Feedback

If you have modified attribute values for which you do have Approve Privileges and at the same time you have modified
attribute values for which you do not have Approve Privileges, an 'Unable to approve' object dialog displays.
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[ Unable te approve product

Missing approve values privilege on attributes:
T'shirt ity
Attribute English

Short Ttem Description

Ok

If you have modified attributes values and do not have Approve Privileges, then the 'Approve' option is disabled in

the right-click menu.

If you have modified attributes values for which you do not have Approve Privileges, a 'Missing privileges' dialog

displays.

[ 1 Missing privileges >

‘fou do not have suffident privileges to approve
any of the non-approved modifications performed

on this object

Partial Approve Feedback
If you have modified attribute values for which you do have Approve Privileges, and at the same time you have modified
attribute values for which you do not have Approve Privileges, a Partial Approve dialog box displays.

[ Partial Approve >
Main Appraved
£ [All Elements]
~[IParent Object Audio
-3 Name Audio Accessaries 1 Details...
Expand All Collapse All
Suppress Re-Translation
Approve Selected Check Cancel

© Stibo Systems - Public - 2025.3 - September 2025 147



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

In the example above, the user can approve all attribute values in 'Audio Accessories 1' and 'Audio’. Only attributes that

the user has permissions for are displayed.
Approve Recursively feedback
After running Approve Recursively for a hierarchy node, review the feedback in the Background Processes tab.

1. On the BG Processes tab, click Approve Recursively, open the Active or Ended Processes node, and click the

relevant process.
2. Inthe Background Process tab, open the Execution Report.

% Execution Report

Recursive approval started on "235915 in context "‘English US
Approved 0 classifications; 1 products; 0 assets; 0 entities..
Recursive approval of 1 objects done. 0 warnings and 0 errors.

If the process or approval was successful, the report shows 0 errors and 0 warnings. Details are provided if

errors were found.

The following example shows a missing mandatory attribute value error, which caused the object to not be

approved.

%' Execution Report
Recursive approval started on "235915" in context "‘English LS

Approved 0 classifications; 1 products; 0 assets; 0 entities.; 1 errors

Approve error report for 235915-2
I LInable to approve object due to missing mandatory values on attribute(s): step:ifattribute ?id=Target_Attribute

Recursive approval of 1 objects done. 0 warnings and 1 errors.

&
o
m

4 41 1-5of 5 13 [ Save... FLIn

Approve Recursively dialog
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[ Approve Recursively >

o Finding Unapproved Objects (This might be time consuming)
Object Classifications Products Assets

Audio Accessories 1|1 0 0

Empty mandatory links/values in Main workspace

Start Process with Description

MName aApprove Audio Accessories 1

The following information is included on this dialog:

¢ Finding Unapproved Obijects: Analyze the hierarchy and provide the count of the products, classifications,
assets, or entities which are currently in unapproved status.

Empty mandatory links / values in Main workspace: Display details about mandatory values, links, or
references that are missing for the products, classifications, assets, and entities.

Start Process with Description: Enter a name for the background process. While this option is not
mandatory, it is recommended to easily identify the process during review.

Skip Analysis: When the number of child products is large, the analysis of unapproved or missing
mandatory values and references can be time consuming. Click this button to stop the analysis and skip the
report, but proceed with the approving recursively background process.

Context Dependent Approvals
Object approval happens in the current context and only applies to data visible in that context.

To illustrate this concept, refer to the figure below in which object 'P' has values for the attributes Color and
Width in the Main workspace. While Width is not dimension dependent, Color is dimension dependent and has
different values in two contexts: 'Blue' in the English context and 'Bleu’ in the French context. If the object is
approved in the English context, only the data visible in the English context is reflected in the Approved
Workspace. Because of this separated approval, the object must also be approved in the French context to be
completely approved, indicated by a green checkmark in the Approved parameter. Until all contexts are
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approved, the object in the English context has the status 'Approved in Current Context on [date + time],

indicated by a yellow checkmark, and the object in the French context has the status of 'Last Approved on [date
+time]', indicated by a red clock.

Main Approved
Width : 20 cm Width: 20 cm
Color (EN): Blue Color (EN): Blue
Color (FR): Bleu Color (FR):

If Color is set as a mandatory attribute in the French context but is left empty, then an empty mandatory
attribute warning will display when attempting to approve the object in the French context.

[ Unable to approve product >
Approve report for (245034
Unable to approve object due to missing mandatory values on attribute(s):
(ColorAttv)

Ok

All mandatory attributes will be checked upon approval to notify is any are empty in the context in which the object is
being approved. For example, in the first of the images shown below, the value added for the mandatory attribute
'Color' in the English context is 'Blue'. The object can be approved in this context without any issue. The approval
icon is for the current context only, so in this example, the English context displays the partial approval icon.
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.| Approved View " o
Context English US Workspace Mode Normal & (2 URL Ntext1&id=103503&wn ID/Name
Tree % | T-shirt
Level 1 = Revision: 0.7
b [ Assets
» [ Configurations Product Sub Products References Referenced By Images & Documents Commercial Tabl
= Index Words
» 8 Publications * Description
~ [ Primary Product Hierarchy Name : | value
+ @ Products
: D 103503
[0 T-shirt
5 T-shirt long sleeves ¢ | Name T-shirt
I3 Discontinued Products ¢ | Object Type Level 1
=2 Product Overrides - ]
) Revision 0.7 Last edited by USERJ on Thu Aug 08 19:41:24 CEST 2024
= Packaging
» B Collections : | Approved ) Approved in Current Context on Thu Aug 08 19:40:19 CEST 2024
» (@ eCatalogs : | Translation Mot Translated
» 7 Recycle Bin - - -
Path Primary Product Hierarchy/Products/T-shirt
~ Display
Mame : ¢ | value
Color mec | Blue

When the View Mode is changed from Normal to Context, the empty mandatory attribute alert is shown in the French
context.
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View

g e - v[search ]
Context English US Workspace Mode Context & (' URL i3&workspaceid=Main ID/Name Search [
Tree % || T-shirt 1
Level 1 = Revision: 0.7
» [ Assets
» [ Configurations Compare Contexts  References Referenced By
= Index Words 7
» B Publications English US French FR H
~ 5 Primary Product Hierarchy {| D 103503 103503
~ [ Products | Name T-shirt T-shirt
5 T-shirt T
B T-shirt long skeeves :| Object Type Level 1 Level 1
B8 Discontinued Products :| Revision 0.7 Last edited by USERJ on Thu Aug 08 19:51:32 C... | 0.7 Last edited by USERJ on Thu Aug 08 19:51:32 C...
B2 Product Overrides ‘| Path Primary Product Hierarchy/Products/T-shirt Primary Product Hierarchy/Products/T-shirt
B8 Packaging
» B2 Collections :| Approved [ 2] Approved in Current Context on Thu Aug 08 19:4... [ 2] Approved in Current Context on Thu Aug 08 19:4...
» (@ eCatalogs :| Translation Not Translated Not Translated
» 33 Recyde Bin :| Default InDesign te...
:| Default Quark temp...
:| Color Blue

When changes are made to both contexts, the approval icons are updated to show 'Approved in Current Context'

and 'Last Approved'.

T-shirt i
Level 1 » Revision: 0.7
Compare Contexts References  Referenced By

English US French FR H
D 103503 103503
:| Name T-shirt T-shirt
:| Object Type Level 1 Level 1
:| Revision 0.7 Last edited by USER] on Thu Aug 08 19:51:32 C... | 0.7 Last edited by USERJ on Thu Aug 08 19:51:32 C...
:| Path Primary Product Hierarchy/Products/T-shirt Primary Product Hierarchy/Products/T-shirt
:| Approved (2) Approved in Current Context on Thu Aug 08 19:4... (¥ Last Approved on Thu Aug 08 19:40:19 CEST 202
:| Translation Not Translated Not Translated
:| Defaulk InDesign te...
:| Defaulk Quark temp...
:| Color Blue Bleu
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contexts.
T-shirt I
Level 1 » Revision: 0.8
Compare Contexts  References Referenced By
English US French FR
I ID 103503 103503
:| Name T-shirt T-shirt
:| Object Type Level 1 Level 1
:| Revision 0.8 Last edited by USER] on Thu Aug 08 19:59:50 C... | 0.8 Last edited by USERJ on Thu Aug 08 19:59:50 C...
:| Path Primary Product Hierarchy/Products/T-shirt Primary Product Hierarchy/Products/T-shirt
:| Approved " Approved on Thu Aug 08 19:59:50 CEST 2024 /" Approved on Thu Aug 08 19:59:50 CEST 2024
:| Translation Mot Translated Not Translated
: | Default InDesign te...
;| Default Quark temp...
:| Color Blue Bleu

If a change is made in one context, for example, changing the Color attribute value in the French context but

leaving the value for the Color attribute in the English as is, the object regains full approval once the object is

approved again in the French context.

© Stibo Systems - Public -

2025.3 - September 2025

153



- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

Approved Symbols and Messages

An object can contain both workspace revisable data and globally revisable data. The Approved symbols and
messages indicate the status of the workspace revisable data on a product, classification, image, or document. The
status can be viewed in the Approved parameter on these objects.

For details on the approval process, refer to the Approving an Object topic.

For more information on revisability, refer to the Revisions topic in the System Setup documentation.

Approved Status Symbols

Approved Status

Symbols

Description

X Unapproved
(Never Been
Approved)

An object is unapproved if it has never been approved or if revised data on the
product, classification, or images & documents in the current context is not
approved.

For example:

© An object has never been approved.

© Revised data has been changed in current context without being
approved. Revised data includes attribute values, references, object
names, or tables.

Examples of changes to revised data include:

"A change in object name.
" A changed value on an internally maintained attribute.
™ If an attribute has been linked to a product.

® I reference links to objects have been made.

Note: When linking a product to classification and in case the classification
object type owns the product links, then the product does not get the
Unapproved symbol. For more information, refer to the Object Types and
Structures topic in the System Setup documentation.

v Approved

Revised data on product, classification, orimages & documents is approved in all
contexts.

© Stibo Systems - Public - 2025.3 - September 2025 154



Approved Status

Symbols

- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

Description

Note: No data in any context needs to be approved.

c© Last Approved

Revised data has been approved and then subsequently changed.

S

Partial Approve
(Approved in
Current Context)

Revised data has been approved in current context but a reference, object name,
or value needs to be approved for the object to be approved in all contexts.

If you view another context, then you typically notice that:
© A dimension dependent reference is not approved.
© Adimension dependent value is not approved.
© A dimension dependent object name is not approved.
When all the dimension dependent references, attribute values, and object

names have been approved, the symbol changes from yellow Partial Approved
symbol to a green Approved symbol.

Approved Status Messages

The following messages (with the user, dates, and time) are displayed for workspace revisable data.

Unapproved / Never Been Approved

An object that is newly created and has never been approved is shown as below:
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Product Sub Products References Referenced By >
“ Description
Name : : | value
ID 103503
Name T-shirt
Object Type Level 1
Revision 0.3 Last edited by USER] on Thu Aug 08 ...
Approved X Never Been Approved
Approved
An object that is approved in all contexts is shown as below:
Product  Sub Products References R... >
* Description
Name Value
ID ProductsRoot
Name Products
Object Type Products
Revision 0.1 Last edited by Stibo Systems on Fri J
Approved " Approved on Fri Jan 02 00:00:00 CE
Last Approved

An object attribute or reference that is modified shows is as shown below:
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Product Sub Products References Referenced By 2
“ Description
Name : : | Value
ID 104702
Name T-shirt long sleeves
Object Type Level 1
Revision 0.4 Last edited by USER] on Thu Aug 08 18:41:5...
Approved (% Last Approved on Thu Aug 08 18:36:03 CEST ...

Note: The 'Last Approved' message also displays if using the 'Partial Approve' option on an object. If 'Approved
in Current Context' is displayed, then an object is also partially approved but a different message displays (as
described in the Approving an Object topic).

Partially Approved / Approved in Current Context

An object that is approved in only some contexts displays as shown below:

Product Sub Products References Referenced By Images & Documents Commercial Tabl
~ Description
Name : : | Value
ID 103503
Name T-shirt
Object Type Level 1
Revision 0.7 Last edited by USER] on Thu Aug 08 19:41:24 CEST 2024
Approved 2 Approved in Current Context on Thu Aug 08 19:40:19 CEST 2024
Translation Not Translated
Path Primary Product Hierarchy/Products/T-shirt
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Creating Objects in the Tree Tab

Regardless of the particular object type or hierarchy that you are working with, the general principles of creating objects

in the workbench are the same, and are described below. Tree icons are set during object type creation according to

preference and may be different in your system.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects, or
may only have options to edit specific object types, hierarchies, or attribute values. The information below
focuses strictly on the means for carrying out the various actions, and assumes that all required privileges are
available to do so. More information on privileges is available in the Privilege Rules topic in the System Setup
documentation.

Objects can be manually created in the Tree via right-clicking or using the Maintain menu.

Create a new object via right-click

1.

Select a parent under which the new object should be created. Note that if the new object should be created as
a root node on the Tree tab, the Maintain menu must be used (refer below).

Right-click on the parent and select the appropriate 'New...' option. The options will vary based on the selected
parent. For example, note the differences between the available options on a classification and an entity, as
shown below.

Tree Tree
P [T Assets » I Entity Root
» [ 2 New Classfication » Dol O New Entity Node
» [ ¥ New Asset Ctrl+ Shift+A » [T GI New List >
» [ ( W@ New Product 0 I
e (T0

Selecting the right-click option will open a Create dialog, appropriate for the selected object super type (e.g.,
Create Assets for assets and Create Entity for entities). The options available in the dialog are based on the
data model defined in System Setup. For example, the Object Type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being
created does not have autogenerated IDs applied.
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Create Entity Create Asset
Object Type Object Type

O Address Root Assets

(O Contacts Root (O Auto Classification Rule Set

(O Customers O Bulk Update Configuration

O Key Account Root () DAM Asset

() Prospects Root () Export Manager Configuration

() External Stored DAM Accpf
ID
Name D
Create Cancel Name
\ J Create Cancel

Note: The following restrictions apply to the ID for all objects:

* Maximum 40 characters.

¢ Only the standard ASCII printable characters in the range of 32-126 are allowed.
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4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking Create
completes the creation of the new object, which is then accessible in the Tree. If a Name is not supplied, the

object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation, the object will

display in the Tree using the Name entry. For example, two new objects have been added under Customer C in
the screenshot below. The first did not have a Name supplied, while the second did.

/- Entity Root

E}% Customer Hierarchy
8 Customer A

8 Customer B

=2

-4 (ADD_114888)

Create a new object via the Maintain menu
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From the menu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use this method when adding a new root node to Tree. Additionally, note that the
available options differ based on the active selection when the menu is accessed. For example, the below shows
the available insert options when a classification has been selected, whereas the publication-related options
would be enabled if a publication object had been selected instead.

Fie Edit View Navigate Format Windc-w Help

By
D Context Englis... ~ STTTEET . ? .
Workspac Link ,| @ Product Ctrl+Shift+P
PRODUCTION [ Classification Ctrl+5Shift+C
TFEE Merge 3 . . .
O Classffication Root Ctrl+Shift+R
b Configuratio
"ED rgtH ¥ Delete @
uplicateET! ;
Force Delete & Purge )[BT s
} 2 DuplicatelUN
b b eClass 9.1 (-]
Advanced b
ECLASS ADY [ ]
Search = _ S Dupicate i —
b [ ETIM6 Artick B puplicate Recursively L
© » [ ETIM7 Artich Ctrl+Shift+0
» [0 ETIMS Artich Make Revison T Asset Ctrl+ Shift+ A

BG Processes

Many of the available options will only be enabled when an appropriate selection has been made on the System
Setup tab. For example, an attribute group must be selected for the Attribute or Attribute Group options to be
enabled.
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Deleting Objects in the Tree Tab

Regardless of the object type or hierarchy that you are working with, the general principles of deleting objects in
the workbench are the same and are described below.

Prerequisites

All actions are controlled via privileges. Some users may not have access to create or delete objects or may only have
access to edit specific object types, hierarchies, or attribute values. The information below focuses strictly on carrying
out the various actions and assumes that all required privileges are granted. More information on privileges is available
in the Privilege Rules topic in the System Setup documentation.

Delete Objects

Objects deleted in the Tree tab are moved to the Recycle Bin for the Tree, where they can be revived or purged. To fully
delete an object, the deletion must be approved, and the object must be purged from the Recycle Bin. For information
on the Tree Recycle Bin, refer to the Recycle Bin for the Tree Tab topic.

Important: As an alternative, an object can be deleted from the Tree and also purged in a single step using the
'Force Delete & Purge' option in the Maintain menu. This option bypasses the Recycle Bin. Do not use this
option if deletion events are required for output to downstream systems since a DELETEAPPROVAL event is
not generated for 'Force Delete & Purge'. Refer to the Force Delete and Purge heading in the Maintain Menu
topic of the Getting Started documentation.

To delete from the Tree:
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1. Select an object (or multiselect using Ctrl or Command) in the Tree.

2. Choose a delete method:

* Right-click the selection and click Delete.

Tree

» BB Publications
* I Primary Pro 5 cut
* [0 Products

Copy
b O Alarm
b O Alarm
b [0 Appar

P O Audio ¥ Delete

b T A el =

*® From the Maintain menu click Delete.

Fle Edit View Navigate Format [Maintain |Window Help

Approved Insert
D Context Engls...
Workspac
b2 Link
PRODUCTION
Tree Merge

» I Publications
* [ Primary Prod
* [3 Products

P 3 Alarm

P B Aarm: B Duplicate

» EAppar B3 Duplicate Recursively
P [0 Audio

> Delete
Force Delete & Purge

Advanced
Search

3. Review the Delete confirmation dialog, which varies slightly based on the object selected for deletion and the
number of objects to be deleted.

* Analyzing nodes to be deleted progress bar - displays as needed when large numbers of objects are being
deleted. The Delete button is disabled while the analysis is running. Although the table is empty during the
analysis phase, the impacted object types are displayed in the header.
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Are you sure, you want to delete this object and its sub-objects?
Analyzing nodes to be deleted.
MName : | Assets Sub-Product Count : | Classifications
Sub Products
O Unlink
O Delete
Delete Cancel

* The view options buttons - allow display of the primary image when available.

Delete

Delete

Are you sure, you want to delete these 3 objects?

Are you sure, you want to delete these 3 objects?

'w|BlackTub(271029)

'w|CopperTub (265653)

& WhiteTub (265654)

Delete Cancel

\ ‘m| BlackTub

271029

_ [w] CopperTub

- 265653
"‘“ _ 'a| WhiteTub
; 265654

Delete Cancel

* The object to delete table - includes the names of objects to be deleted and the number of impacted objects.
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® Sub Products - when deleting a classification, select Unlink to leave the sub product in the hierarchy, or select

Delete to delete the selected objects and the sub products linked to the classification.

This is not an option for products; all child objects for products are automatically deleted.

Are you sure, you want to delete this object and its sub-objects?

Are you sure, you want to delete this object and its sub-objects?

Delete

Cancel

Name ¢ | Assets Sub-Product Count : | Classifications  : Name ¢ | Sub-Product Count
[T Assets (Assets) 23 3 4 B CSHSOVE200WH 2(409332) | 0
Sub Products
Delete Cancel
O Unlink
O Delete

Deleting a large number of objects, such as a parent object with more than 1,000 objects, uses a background

process (BGP) to move the objects to the recycle bin. This allows the user to continue other activities in the

workbench while the BGP runs.

Note: The following functionality is managed by a configuration property that is not available in the Self-

Service Ul. Contact Stibo Systems Support for assistance.

The number of objects that triggers a BGP is determined by the

Delete.InBackgroundProcess.RequiredNodeNumber=1000 configuration property. The default is

1,000.
Delete Delete
Are you sure, you want to delete this object and its sub-objects? Are you sure, you want to delete this object and its sub-objects?
Name Assets Sub-Product Count : | Classfications : MName Entities
[Z]DuplicateETIM&(2) (5168602) O 0 2421 I Entity Root(Customer_Data_Root) | 24300
Sub Products Delete in background Cancel
O Uniink
O Delete
Delete in background Cancel
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4. Click Delete or Delete in background to proceed with the deletion or click Cancel to close the dialog without making
any changes.

5. Review the 'Delete report' dialog or details of the BGP execution report, including the Delete Objections and
Warnings if displayed.

To delete an object, a number of conditions must be met. For example, the object must not be referenced by any
other object and must not be active in any workflow. When the deletion conditions are not met, the confirmation
window displays the errors (Delete Objections) that must be corrected prior to deletion.

Approval may be required for the deletion to take effect. For example, if an object has been referenced by another
object and that reference has been approved, removing the reference must also be approved (by approving the
change on the referencing object) to resolve the deletion objection.

*® If no errors or warnings are displayed, click Close.

® If errors or warnings are displayed in the ‘Delete report’ window or the ‘Delete large number of objects’ BGP, it is
recommended to note the issues, click Close, and manually resolve them. Review the warning section to decide
if the Force Delete option is a good choice.
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Delete report

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below.

Name

B 12-GGK79 (100703)

r Delete Objections

"12-GGK79" could not be deleted due to the reasons listed below:
step://product?id=269814 has a cross reference to the object being deleted
step://product?id=100703. The link is visible in these workspaces Approved, Main.
step://product?id=20714 has a cross reference to the object being deleted
step://product?id=100703. The link is Visible.multible.contexts.multiple.workspaces.
step://product?id=269622 has a cross reference to the object being deleted
step://product?id=100703. The link is visible in these workspaces Approved, Main.

rWarning! If you use force delete, the below actions wil be taken.

Cross references to objects being deleted wil be removed. These cross references will not be
reconstructed, if the objects are revived. |

Force Delete Close

® The Force Delete button allows deletion of objects with errors and warnings from the ‘Delete report’ or the

‘Delete large number of objects’ BGP if the object is not in use (instantiated in the Tree) and typically involves
restrictions (as defined on the dialog) if the deleted object is later revived. In either case, Force Delete uses a
background process to perform the deletion and the process can be monitored on the BG Processes tab within
the Force Purge or Delete Nodes queues.

If the object is in use, the 'Force delete report' dialog displays success or the objections that must be resolved
manually before deletion can succeed.

6. View the deleted object(s) in the recycle bin. For information on the Tree Recycle Bin, refer to the Recycle Bin for the
Tree Tab topic.
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Editing Objects in the Tree Tab

Objects can be easily edited within the Tree tab, and general principles for editing are the same, regardless of the type
of object. The available tabs will vary based on the object type selected, as well as other considerations such as data
model and licenses. Some tabs are common across the various object super types, while others appear only on specific
object types or subsets of object types. Additionally, some editors appear on more than one super type, but have
differing functionality based on the type of object that has been selected.

This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects, or
may only have options to edit specific object types, hierarchies, or attribute values. The information below
focuses strictly on the means for carrying out the various actions, and assumes that all required privileges are
available to do so. More information on privileges is available in the Privilege Rules topic in the System Setup
documentation.

When an object is selected, the main portion of the screen displays a corresponding editor. The main editor for the
object is the first tab, which is Classification in the below example.

Tree Icons
~ [ Assets Icons « Revision: 0.3
> If Classfication ~ Sub Products  References  Referenced By Images & Docume...
¥ [T Hlustrations
» [l Installation Manuals Description
» O Logos Name Value
» [ Models
} [Z1MSDS Sheets D fconRoot
P [CIMTC Name Icons
»
(5 Owners Manual Object Type Icons
» [C] Product Images
} [ Product Videos Revision 0.3 Last edited by USERS on Mon Apr 17 11:25:12 EDT 2017
» [C1'Watermarks Approved Approved in Current Context on Fri May 05 14:10:50 EDT 2017
» [T Bulk Update Configurations .
o Translation Not Translated
¥ [T Classifications
» [ Configurations Path Classification 1 root/Assets/Icons
¥ [T] ECLASS ADVANCED Classifications Visibility
» I8 Entity Root
Tty Keywords REC
» (T Promotions
0 WSEP CalculatedAttributel | fx | N/A-retai
» I Publications Completeness Score | 122
w [ Primary Product Hierarchy |
Famihy-Level Key At...| A8E
¥ 3 Products 4 v
» 3 Alarm Clocks Purpose sec | Storage for icons
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All objects will have an ID, Name, Object Type, Revision, and Path field. Objects that are subject to approval (known
as 'workspace revisable') will also have an Approved field.

* ID cannot be changed once an object has been created, so the field appears yellow, meaning it is not editable. For

details, refer to the Creating Objects in the Tree Tab topic.

* Revision and Approved data is auto-populated by the system, so these fields are also not editable.

* Conversely, object Name and Object Type can be edited (assuming the user has privileges to do so), so those

fields appear white.

Note: Any number of attributes may be added to objects under the Description section. However, not all data
shown in the Description section is an editable attribute. Fields such as ID, Revision, Approved, Translation,
and Path are aspects of the object (not attributes), and are not editable. Name and Object Type are also
aspects of the object, though these may be edited.

Some object types only support Description attributes, meaning all object data is accessed under the Description
section. For object types that support Specification attributes, data is organized by attribute group, and clicking the
section icon (indicated by a 1 in the screenshot below) will collapse or expand each group, allowing users to focus on
the relevant data. All attributes have a validation base type applied that determines the allowable data that can be
entered, and is indicated by the icon to the right of the attribute name below (2). Detailed information on attribute
validations is available in the Validation Rules topic in the System Setup documentation.

To edit data, click in any editable field. Text attributes can be edited by typing directly into the field, while LOV attributes
will provide a dropdown from which users can select a value, as shown below (3).

Tree Black Cap
Item » « Revision: 0.20
* [0 Apparel
¥ [0 Head Wear
w [ Hats and Caps -
~ I Cap Items Product Dafta Containers gmSuUb Products

I Black Cap 6
B Pink Cap Primary Color =M | Black
B Red Ca

P Product Height 123 | 120
B velow Cap
I Orange Cap secondary Color £~ e v
I Gray Hat o
B Industrial Hard F Item Description Informajg;;q (239659)

Blue (239664)

E Blue Hat Ttem Fnrich Waorkflow Drran I2OCCEY
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Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2 opens
the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, refer to the STEP
Workbench Keyboard Shortcuts topic. The data fields available for editing will depend entirely on the data model and
will vary for each implementation.

Note: Data edited in the workbench is auto-saved, with the change / save being applied as soon as the user
exits any field. Therefore, no explicit save action is ever required by the user.

If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will change the
approval status (if the object had been previously approved). Refer to the Approval of Objects topic for more information

on approvals.

Multi-Editors

Objects can be multi-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally, objects of
the products and classification super types have a Sub Products tab that can be used for multi-editing. Functionality for
editing objects is comparable, regardless of how the multi-editor interface is accessed.

Right-clicking in any row header will expose the Rotate Table option which can be used to access the preferred
orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active selection.). Editing in
this manner allows for easy copy / paste of values between objects using Ctrl + C and Ctrl + V.

Tree Products
~ 3 Apparel Products References Referenced By
¥ [0 Head Wear
w [0 Hats and Caps View: Show all =
~ [l Cap Items
B Black Cap Name Black Cap | Dink Can
Hide
& Pink Cap D D 120170 Show Al Col
ow All Columns -

B Red Cap Name Name Black Cap Sort y
B velow Cap —
I Orange Cap Object Type Object Type Ttem Rotate Table
B Gray Hat Revision Revision U'?D Last edi [Rotates the current table[
B Industrial Hard K Path Path Primary Prod Ctrl+Minus  put
& Blue Hat Approved Approved (% Last Appr N

Tranclatinn Tranclatian Mt Tranclata Fitter nA

Right-clicking in any data cell will expose the Hide Equal and Mark Different options, which are especially useful
when working across multiple objects as they will hide all equal values, or highlight all different values,
respectively.

© Stibo Systems - Public - 2025.3 - September 2025 169



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

ID MName Object Type Revision
Name ID Name Object Type Revision
Black Cap 120170 Black Cap T A==t
& Ccut Ctrl+X
Pink Cap 120666 Pink Cap Copy ke C
[ Paste Ctrl+V
Ctrl+L
Rotate Table
Hide Equal

Mark Different

Additional options for viewing data are available using the View menu located in the upper left corner of the multi-

editors.

Products

Products References Referenced By

View: Show all |*|

View: showal b Mame
Product views > , Name
MNew \View

Ta653 Red Cap
Edit view ]

79864 Yelow Cap

Remove view »
Orange Cap 179866 Orange Cap

The default view option is to Show all which displays all data on the object, similar to what would be available in a
single-object editor. Additional options can be configured using the New View option. Clicking this opens a dialog
for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the user can

select the attributes to be included in the view.
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Edit Filter
Legal Attributes ']| O Sshow only O Do not show
D Add D
Name I Name
Object Type Remove Object Type
Revision Revision
Path Add Al Path
Approved Approved
Transiation RemoveAl Transition
InDesign Templale InDesign Termplale
Quark Tempiate Quark Tempiaie
11A Sizing Brand Owner
Update table setting
Save Cancel
L /Data

The dialog defaults to having only "legal" attributes shown, meaning those attributes that are valid for the object, as well
as standard aspects of the object such as ID and Name. Note that object aspects are italicized, while attributes (which
are always specification attributes) are shown in standard text. By default, all available attributes and aspects are
shown in both the left and right panels. The dropdown in the upper left corner also has options to expose standard
attribute search / browse functionality, though typically the Legal Attributes selection is used as this prevents a user
from defining an invalid view. The 'Show only' and 'Do not show' radio buttons are applicable to the right panel, where
the data for the view is defined. The Add button is used when an attribute or aspect has been selected in the left panel
and should be added to the view (the right panel). The Remove button is used when an attribute or aspect has been
selected in the right panel that should be removed the view. The Add All and Remove All buttons are used to add or
remove all attributes and aspects from the view. Clicking Save stores the new view.

Once one or more views have been created, they are available for selection from the View menu under Product views.

View: Data Updates

Product views »* ~ Streamlined View
Mew View Show al
Edit view b

Remove view >

An existing view can be edited using the Edit view option, and a view that is no longer needed can be removed
with the Remove view option.
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Note: Views are user-specific and machine-specific, so a view created by one user will always be available for
that user when using the machine on which they created the view, but will not be available for any other user or
for the same user working from a different machine. STEP Workbench views are stored in an XML file on the
user's local machine at C:\Users\[user\STEPUserViews[UserID].xml. If the file is deleted, the configured views
will no longer be available.

Right-Click Editing Options

Additional editing options are available by right-clicking within the various editors. These include standard cut/ copy /
paste options, as well as more exotic options which are briefly described below.

Note: Not all options are available and/or enabled at all times. Some options are available only for particular
attribute validation types, and others are available only on specific editors and/or object types. Menus also
change based on whether the right-click takes place on the column or row header, or within the active editable
value field, as well as when a single object/ column / row has been selected vs. when multiples are selected.

Character Tag: Used as a quick option to add tags to attribute values without having to enter the Rich Text Editor.
Character tags that have been defined for the system will be available as sub-options to the Character Tag
selection. For more information, refer to the Tags topic in the System Setup documentation.

Edit: Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell check,
special characters, etc.

Filter: Used to filter the displayed data under any section, by values, and is exposed by clicking the column header.
This can be especially useful when working with attribute groups with a large number of attributes in them as it
allows users to filter based on empty / populated, greater than / less than, etc.

Footnote (Insert / Edit): Used to add an additional piece of information (e.g., a footnote) to an attribute value.
Footnotes are added / edited within the Rich Text Editor so using these options will open that dialog. Note that
footnotes are only supported for use in conjunction with STEP tables. Using footnotes within attribute values that will
output in something other than a table will not yield the expected results. For more information on footnotes, refer to
the Tags topic in the System Setup documentation.

Hide: Used to hide a particular row or column from view, and a hidden row or column is exposed by clicking on the
row indicator or column header.

Hyperlink (Insert / Edit, Follow, End): Used for adding hyperlinks to attribute values. Highlight text within the
attribute value and select the insert option to provide a hyperlink to be assigned to the selected text. After inserting,
and with the cursor at the end of the hyperlinked text, use the end option. This ends the hyperlink so that subsequent
text does not become part of it. Use the edit option to edit a previously inserted hyperlink. Select the follow option
while the cursor is within the hyperlinked text to follow the hyperlink. For more information, refer to the Tags topic in
the System Setup documentation.
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Inline Reference (Insert / Edit, Copy as): Used to add inline references to attribute values. Inline references are
used to re-use values present within another attribute, object Name, or ID. This avoids duplication of data by
maintaining the data only once, and re-using it from that source as needed. For example, a description attribute may
need to dynamically include the object Name, e.g., [Name] is a great product!'. Detailed information on working with
inline references is available in the Inline References in Attribute Values topic.

Insert Special Character: Used as a quick option to add special characters to attribute values without having to
enter the Rich Text Editor. Opens an editor allowing for selection of the most recently used special characters, with
an option to access a full Unicode character menu. For more information, refer to the Tags topic in the System Setup
documentation.

Override: Used to manually populate a local value to override a calculated (derived) value. This option is only
enabled on calculated attributes. For more information, refer to the Calculated Attributes topic in the System Setup
documentation.

Recalculate: Used for on-demand display of calculated attribute values in the editor if they have previously been
disabled via the 'Disable calculated values' option in the View menu. For more information, refer to the Calculated
Attributes topic in the System Setup documentation.

Rotate Table: Used to rotate the data display. As a right-click option, it is only enabled from row / column headers
when multiple objects are selected. For a single object, it can be used to rotate the data under a section only via
keyboard shortcut (Alt + F11).

Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows / columns.

Sort: Used to sort data based on attribute value rather than attribute name or display sequence. This option is
exposed when a column header is selected, and requires a sort selection (Ascending, Descending, or None).

Style: Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter the Rich
Text Editor. Styles that have been defined for the system will be available as sub-options to the Style selection. For
more information, refer to the Tags topic in the System Setup documentation.

Additional Information

In addition to the main editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functions within them vary based on the selected
object. Therefore, they are described in the context of the type of object being edited, in the subsequent sections of this
guide:

* Assets

* Classifications

[ ] .
Collections

* Entities

© Stibo Systems - Public - 2025.3 - September 2025 173



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

* Products

* Recycle Bin for the Tree Tab

* Publications: The publication hierarchy and its associated objects are detailed in the Publication Hierarchy
section of the Publisher (Adobe InDesign Integration) documentation.
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Inline References in Attribute Values

Inline references can be embedded in attribute values for attributes that have Text, Text (exclude tags), Numeric Text,

and Numeric Text (exclude tags) validation base types. An inline reference use case follows:

You are working with product objects whose model number is the same as their STEP ID (for example,
'12345"). On these objects there is an attribute called 'Product Description' that needs to dynamically reference
the object's model number within the text of the attribute. For a Product Description such as 'Acme lawn
mower, model number 12345,' the inline reference to the STEP ID would populate '12345." Using an inline
reference in this instance helps to avoid duplication of effort—since the product's model number already exists
in STEP as its ID, there is no need for users to manually enter it a second time into the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system resources. For

example, it may be easier for users to use an inline reference to pullin a STEP ID than to create a calculated attribute

using the formula 'StepID()".

One attribute value can include several inline references. An inline reference can reference either a single attribute or

an attribute group.

Inserting an Inline Reference Using STEP Workbench

1.

Select the relevant node. The corresponding editor appears.

Click on the leftmost tab within the editor, which is different depending on the object type (for example,
'Product’, 'Classification’, 'Images & Documents', 'Publication,' and so forth).

Activate the Value field of the relevant attribute where you want to create or edit the inline reference. Or,
highlight the field, right-click, and select Edit to launch the larger value editor.

Note: Pressing Alt + F2 will also open the value editor.

Place the cursor at the position in the Value field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference to
edit an existing inline reference.
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Tree

~ [0 Games
[0 Board Games
¥ 51 Famity Games
B Lfe
B Monopoly
b |l Other Games
P [0 Card Games
» O Hardware

~ || Life

Item » 3% Complete » Revision:

0.2

Product Data Containers  Sub Products

* DataVisualization

Name

Value

Base Unit of Measure | =&

Description, Web aac |The Life M

Paste and Match Style  Ctrl+Shift+V

Style »
Character Tag >
Insert Special Character  Ctrl+Shift+E

Insert Inline Reference

Edit Inline Reference

6. The Inline Reference dialog displays.

Inline Reference

- Object Selection
Object

O Resolve To Object ID

(O Resolve To Object Name

() Resolve To Attribute Value and/or Unit

- Attribute Selection
Attribute

- Attribute Name(s)
Include

Separator =

- Attribute Value(s)
Aspect
Attribute Separator

Values(s) and Unit(s)

cance
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To return a value or values from another object in STEP, not the name or ID of the current object, click the

ellipsis button (: ) to the right of the Object field. Ignore this field if you plan to return value(s) from the current

......

object instead.

Click the ellipsis button ) to display the 'Select Object' dialog, search for or browse to the object that holds
the value(s) that you would like to return, then click Select to choose the object.

Select Resolve To Object ID to return the value of the STEP ID of the chosen or current object.

Select Resolve To Object Name to return the value of the STEP Name of the chosen or current object.

Select Resolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion of the
Inline Reference dialog.

Click the ellipsis button () to the right of the Attribute field to open the 'Select Attribute or Attribute Group'
dialog.
Search for or browse to the relevant attribute or attribute group for the inline reference, and then click Select.

For Attribute Name(s), check the Include box if the name of the attribute(s) should be included in the inline
reference.

In the Separator field, type a separator to be used between the name and value of the attribute. The default is
the equals sign (=). The Separator is activated when the Include box is checked.

For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:
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Inline Reference

Object Selection
Object
(O Resolve To Object ID

) Resolve To Object Name

© Resolve To Attribute Value and/or Unit

Attribute Selection

Attribute | Brand Name DataVisualization /
Attribute Name(s) Name : i | value I
e Inciude Manufacturer Warranty | #=c | Brand Name=Hasbro
Separator |=
Aftribute Value(s)
Aspect Values(s) and Unit(s) ~

Attribute Separator .

Cancel

15. Under Attribute Value(s), select the relevant Aspect from the dropdown list. Available options are 'Value(s)
and Unit(s),' 'Unit(s),' and 'Value(s).'

16. In the Attribute Separator field—which is only valid when an attribute group has been chosen for the Attribute
selection—type in one or more characters to specify how the attribute values should be separated. The default
is the semicolon character (;) without a following space.
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Inline Reference

o Buyer, View
Object Selection Name Value
Object
e Brand Owner gec Hasbro
0 Resolve To Object ID
: Manufacturer's Part Number | ssc | 121177
O Resolve To Object Name
Minimum Order Qty 123 24
© Resolve To Attribute Value and/or Unit
Product Name 12a | Life
Attribute Selection
Attribute BU'}’EI’, View
Attribute Name(s) Item Manufacturer Information
] Include 9 Name Value o
Separator |= Brand Owner=Hasbro;Manufacturer's Part
Attribute Value(s) Basic Manufacturer Information ABC Number_=1211?}‘;l"'||n|mum Order Qty=24;Product
Name=Life
Aspect Values(s) and Unit(s]

|pttribute Separator . |9

Cancel

The screenshot shows:

® (1) An attribute group called 'Buyer, View' selected for Attribute

® (2) A separator of = placed between the attribute name and attribute value

® (3) An attribute separator of ; placed between each attribute within the group
® (4) The attributes and attribute values resolved in the inline reference

17. Click OK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes

The Attribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued attributes.
Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag (multisep). The multisep
tag is a Character Tag in System Setup and comes standard with STEP systems. STEP stores the values of multi-
valued attributes with the multisep tag between them, and this tag typically renders as a forward slash (/).
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System Setup multisep/
v ) Tags Character Tag

» 05 Styles Tags Character Tag

b G5 Spedial Characters

« &) Character Tags Character Tag Definition
2| BeforelLastDigitinNumerator Name Value
‘| FractionBar
ol ft Name multisep
= gt Edited By
<l in Character Tag multisep
| IntegerToFractionSeparator
&3 LineBreak HErEET /

o It Show Character Tag Yes

= | Kevhoard Shortout

If a multivalued attribute is used in an inline reference, the rendering setup for the multisep tag will be shown between
each of the values. In the below example, the 'Country of Manufacture' attribute has four values. When rendered in the
inline reference, these four values are separated by the forward slash (/) character.

Hong Kong
Taiwan

Viet Nam
Mexico

Country of Manufacture AEC

Item Manufacturer Information

Name : . Value
Hong Kong/Taiwan/Viet Nam/Mexico|

Basic Manufacturer Information | Ree

For more information on STEP character tags, refer to the Tags topic in the System Setup documentation.

Copying Attribute Values as Inline References

An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then paste it into
the value editor of another attribute as an inline reference. This inline reference can then be edited like any other inline

reference.
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1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor field.

2. Right-click and select Copy as inline reference.

~ Ttem Brand Information

Mame

Manufacturer Name | mec | Acme Party Su PP‘E,S,.-@ Copy as infine reference

3. Navigate to the 'destination’ attribute value and select the value editor field.

4. Right-click and select Paste.

~ Ttem Manufacturer Information

Mame

Value

% Cut Ctrl+x

Copy Ctrl+(C
Cut Ctrl+ X
Copy Ctrl+C

Basic Manufacturer Information

ABEC

N

AT T4

Paste

Copy as inline reference

Ctrl+V

L 2 |

5. The value appears in the destination field as an inline reference.
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% Insert Special Character Ctrl+Shift+E

Insert Inline Reference

Edit Inline Reference

Ualuef

Basic Manufacturer Information

f
Acme Party Supplies

Inline Reference

Object Selection
Object | ™ Life
O Resolve To Object ID
) Resolve To Object Name
© Resolve To Attribute Value and

Attribute Selection
Attribute | Manufacturer Name

N IR (SR SN " I— -

Note: The copied 'source’ attribute value is connected to the 'source' object, meaning that any time an attribute
value is coped as an inline reference and pasted elsewhere, the inline reference will never pick up the attribute
value from the current object but only from the 'source' object. Also, STEP IDs and STEP names cannot be

copied as inline references.
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Style >
Character Tag »
£ Insert Special Character Ctrl+Shift+E

Insert Inline Reference

Item Manufacturer Information Edit Inline Reference
. . Inline Reference
Name : | Value
Basic Manufacturer Information | #ec | Acme Party Supplies Object Selection

Object B ufe
(O Resolve To Object ID
(O Resolve To Object Name

© Resolve To Attribute Value and

Attribute Selection
Attribute | Manufacturer Name

NN R T ' PE— ., |

Inserting an Inline Reference using Web Ul

Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted into an
attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference in Web Ul is similar to adding one in the workbench. For instructions, refer to the Rich

Text Editor topic of the Web User Interfaces documentation.
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This topic covers information specific to the asset super type that is important to know when working with assets.

For general object maintenance information (applicable to all object types rather than specific to assets), refer to

the All Objects topic.

An asset is any product-related electronic file, such as images (tiff, eps, jpeg, etc.), Word docs, Excel files, PDFs,

PowerPoint files, text files, etc. Images are a common asset so they will be the focus of this section. In most cases, the

terms 'asset' and 'image’ are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality check be

performed by users with graphic arts knowledge. Ideally, this check occurs prior to import into STEP so that only

approved images are available in the system.

Classification of Assets

Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated from

other classification hierarchies (e.g., those used for alternate structuring of products, import / export configuration

storage, etc.).

The recommendation is to have one classification object type and instance for each asset object type. For

example:

i System Setup

w (& Object Types & Structures
P [T Alternate Classifications
w 7 Assets

b 7 Assets
Configuration
&4 External Stored DAM Asset
| Icon
o] Tustration
& Instalation Manual
b i Logo
4| MSDS
&) owners Manual
I Product Video
t5 RuleSet
ga Training Material
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w [] Assets

F [ Icons

» [0 Icon Types

¥ [ Hlustrations

P [ Installation Manuals
P [T Logos

P [T Models

¥ [T MSDS Sheets

PO MTC

» [0 Onboarding Training Supplier Asset Root
F [ Owners Manual

» [0 Product Images

P [T Product Videos
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Within the individual type-based classifications, additional levels can be modeled if necessary. A common option
is to work with a 2-level folder structure based on the first characters of the asset file name. For example:

Tree
w [T Product Images
*[71
* [ 10
&) 10 _blueShirt_mirror
m| 11 fruit
w| 11_fruit_395px
a| 11_fruit_75percentQuality
| 11 fruit_contrastPluss

With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets. Instead,
assets are typically located via references from other objects and/or via searches. STEP does not require that the
image hierarchy have multiple levels. Assets can be stored in a single folder (e.g., a flat structure). However, this
is not typically recommended as it can be impractical to navigate the hierarchy as the number of assets increases.

The same asset object can exist below multiple different classifications. However, this functionality is typically only
used for cases where suppliers upload assets. These assets will initially go into supplier-specific classifications
and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation

New asset object types are defined in STEP the same way any other object types are, via the System Setup tab.
One key difference between asset object types and other object types, such as products or classifications, is that
there are no parent-child relations between assets, as asset instances live in classification hierarchies.

Asset object types are defined in STEP Workbench System Setup under 'Object Types & Structures.' Apart from
the built-in generic type 'Assets’, it will be a flat list of the different asset object types required for the setup. For
example:
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gl System Setup

~ [ Object Types & Structures
P [ Alternate Classifications
w 7l Assets
b 3 Assets
Configuration
4 External Stored DAM Asset
%] Icon
o Tlustration
8 Instalation Manual
» =2 Logo
4| MSDS
1 owners Manual
I product Video
¢4 Ruleset

ga Training Material

On older systems, you may observe asset object types that are file-type specific. For example: JPG Image, Word
Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather than the
file type. This is done for clarity as it is often more important to understand the purpose of the asset. For example,
an asset is not just a PDF file, instead it is an Installation Manual, a Product Brochure or an Owner's Manual. One
advantage of the purpose-based setup is that it is possible to restrict reference types to point to the specific types
of assets and not just to generic file types.

With the move away from file type specific asset object types, asset object types cannot be applied automatically
when digital media files are imported into STEP as there is no 1:1 relationship between file types and asset object
types. Itis possible to have object types automatically applied upon import when a file-based approach is used,
but this functionality generally does not weigh up to the disadvantages of the approach.

Asset Objects and Digital Media Files

A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and digital
media files in STEP. Thus, itis possible to work with asset objects that do not have "content", i.e., are not tied to
any digital media files. Furthermore, the content can be dimension-dependent so that an asset is tied to different
files in different contexts. Finally, an asset can have different content in different historical revisions.
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Product Object

Asset Reference “Primary Product Image”

Asset Object

JPG File

As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects (not
to the actual media files) that relations are modeled (using references).

Image Variants and Handling

Different publishing projects impose various requirements on the use of images. For example, a high-resolution
image in STEP may be a TIFF. However, for the web, a jpeg is needed. Or, if the high-resolution image is an EPS,
a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high-resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines. When using an image conversion, the images
in STEP must be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configuration topic in the Digital Assets
documentation.

More Information

For specific details about working with assets in the workbench, refer to the Maintaining Assets topic and the Linking
Assets to Products topic.

For information on working with assets in Web UlI, refer to the Asset Handling in Web Ul topic in the Web User
Interfaces documentation.

For information on importing, exporting, and managing assets, refer to the Digital Assets documentation.
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Maintaining Assets

This topic covers information specific to the Asset super type that is important to know when working with assets. For
general object maintenance information (applicable to all object types rather than specific to assets), refer to the All
Obijects topic.

Creating Assets

The basic methods for creating an asset are the same as any other object type, as described in the Creating Objects in
the Tree Tab topic within this guide. However, there are a few considerations that are specific to assets that users
should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated. When assets are created
in STEP via import of a digital media file, this association happens automatically. However, when assets are created
using standard object creation methods in Tree (e.g., right-clicking on a classification folder and selecting 'New Asset'),
it is only the placeholder that is created. An asset created in this manner will initially have no system properties and no

content. For example:

Tree 448903
~ [T Logos Assets « Revision: 0.1
» [ Brand Logos Images & Documents  References  Referen

[ Miscellaneous Logos

* [~ Product Logos Description
L2 A448903
4| BlueTruckIcon System Properties
iead New?2 Mo System Properties

A user can right-click on the asset and select Replace Asset Content to open a dialog where a digital media file can be
selected from the local machine. STEP will automatically read and populate the properties of the asset, and a thumbnail

of the digital media file will display. For example:
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* [T Logos
P [T Brand Logos
[T Miscellaneous Logos
* [T Product Logos
2 448903
4| BlueTruckIcon
leg= w2
4| TruckIcon
P [T Models
P [T MSDS Sheets
P OMTC
» [ Onboarding Training Supplier Asset
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448903
Assets « Revision: 3.0
ACME &CO.
il
Images & Documents  References  Referenced
Description
System Properties
MName Value
Class aec | True color
Colorspace aec | RGB

To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols for an

initial implementation). More information on importing assets is available in the Importing Assets topic of the Digital

Assets documentation.

Asset Editor

General information about editing objects in STEP is available in the Editing Objects in the Tree Tab topic and is not

repeated in this section. However, assets have some additional editing options specific to working with digital media

files, which are described.

Images & Documents

The Images & Documents tab is the primary workbench interface for assets. It has three sections, described below.

© Stibo Systems - Public - 2025.3 - September 2025

189



- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

3.0

ACME Edit Asset
External Viewer
Save to disk
Image Viewer 25 Referenced By Status Log Statelog Tasks
~ Description
Name Value
D 448903
MName 448903
Object Type Assets
Revision 3.0 Last edited by USERJ on Mon Jan 13 11:49:16 EST 2025
Approved X Never Been Approved
Translation Not Translated
Path Classification 1 root/Assets/Logos/Product Logos/448903

~ System Properties

Name Value

Class aec | True color
Colorspace aec | RGB
Compression rec | Zip

Depth 8 | 8 (bits/sample)
Extension REC | pNg

1. The Description section contains the same basic information as other object types. Additional Description attributes
can be made valid for assets to support data such as keywords or asset descriptions. Specification attributes cannot
be made valid for assets.

2. The System Properties section displays data that is read automatically from the digital media file. This information
cannot be edited.
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3. The asset thumbnail has a number of options available for editing assets. Additional right-click options are also

available when the asset itself is right-clicked from the Tree. All of the options that are specific to assets only

(accessible from right-click on the thumbnail or the asset) are described below.

[#]

Create Local Content of Asset: Creates a local version of the asset specific to the current context. Refer to the
Asset Dimension Dependencies section below for more information.

Delete Local Content of Asset: Deletes the content of an asset that is not dimension dependent. Deletes the
local (context-specific) content of the asset if the asset is dimension dependent. Refer to the Asset Dimension
Dependencies section below for more information.

Edit Asset: Opens the digital media file for editing in an external program, in addition to an Edit Asset dialog in
STEP. Upon completion of editing in the external program, click save within the program to store the edited asset
to a temporary directory. Then click OK in the Edit Asset dialog in STEP to have STEP retrieve the edited file from
the temporary directory and store this in the asset. Note that the media file will open in the application associated
with the file type. For example, for files ending with .xlIs, Excel will automatically be launched. This may be
different from computer to computer. One user’s computer may open up EPS images in Photoshop, while another
user’'s computer may open the same file types in lllustrator.

Export Images & Documents: Opens the Export Images and Documents wizard to make selections to export the
currently selected asset(s). Refer to the Export Images and Documents Wizard topic in the Digital Assets
documentation for more information.

External Viewer: Opens an external viewer for viewing the asset. This is comparable to the Edit Asset function in
that the program that is utilized is specific to the file type and the user's computer settings. It differs in that any
changes made to the asset in the external program are not saved back to STEP.

Image Viewer: Opens an image viewer within STEP for the user to examine the actual asset (as opposed to just
the thumbnail).

Push Asset(s): Initiates asset push for the selected asset(s). Refer to the Asset Push topic of the Digital Assets
documentation for more information.

Replace Asset Content: Opens a dialog for the user to select a digital media file for the asset. Refer to the
'Creating Assets' section above for more information.

Save to disk: Opens a standard save dialog allowing the user to select a location on their local machine to save

the digital media file to.

Unlink asset: Only enabled if the asset has been linked directly into a publication, in which case it unlinks the
asset from the publication. Refer to the Publication Hierarchy topic of the Publisher (Adobe InDesign Integration)
documentation for more information.

References

The References tab displays the classifications that the selected asset is linked to, and allows for linking to additional

classifications using the Link to Classification link. Each asset must be linked to at least one classification, but may be

linked to many. Links can be removed by right-clicking on the row indicator and selecting 'Remove Link to
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Classification'. The Name of each classification displayed is hyperlinked for easy navigation, and revision, approval,

and translation statuses are also displayed.

448903

Assets e Revision: 0.1

ACME & CO.

Images & Documents References Referenced By Status Log Statelog Tasks

Classifications
18} Name Object Type Revision Approved Translation

ProductLogos | Product Logos | Asset Level 1 0.1 Last edited ...| ~ Approved on Fri...| Not Translated

Link to Classification

Note: While the maximum number of references to one object node is limited to 10,000 instances, this value
can be changed; however, it is against Stibo Systems recommended practices to use this many references.

Before changing this value, contact Stibo Systems for assistance.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that the

selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). The display of the

Referenced By tab on an asset will vary slightly from system to system, based on the data model.
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448903
Assets = Revision: 3.0

ACME & CO.

Images & Documents  References Referenced By Status Log Statelog Tasks

Image References

Reference Type ~| : | Source : | Thumbnai ImagePriority D Name
HDPhoto  + &

Ungrouped Referenced by Products, Classifications or Entities
Reference Type v Source

Certificate + | =

Used on Page

Publication Version Page Area Used Page Type

1. Reference Sections: References can be placed in attribute groups for display purposes. All references for which the
selected object is a valid target that have been placed in attribute groups will display first on the screen, with the
section title being equal to the name of the attribute group. References can be added by clicking the (+) on the
reference. This will open a dialog allowing the user to select a source for the reference, and a reference will be
created from the object selected in the dialog to the currently selected object that you are standing on (e.g., current
object = target, dialog selection = source). If any attributes are available on the reference and editable, they can be
edited within this interface. References can be removed by clicking the (X) on any existing reference. Additional
information on configuring and working with references is available in the Reference and Link Types topic in the
System Setup documentation.

2. Ungrouped Referenced by Products, Classifications or Entities:The functionality is identical to what is described
for the Reference Sections section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes.

3. Used on Page: Displays publications that the selected object is used in. Additional information about working with
publications is available in the Publisher (Adobe InDesign Integration) section.

Status

The Status tab provides general information about objects, including revisions, translation status, and approval status.
For more information on these basic settings, refer to the Status Tab topic. For assets specifically, this tab also includes
an Asset Push Status section that describes the status of assets for the various asset push configurations on the
system. For more information, refer to the Monitoring Asset Push topic in the Digital Assets documentation.
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State Log

The State Log tab allows users to view the recent history of the object across all workflows in which it has been entered.
Refer to the State Log Tab topic in the Workflows documentation for more information.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges (only
tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the user is
able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More information on
the Tasks tab is available in the Moving Tasks through a Workflow in STEP Workbench topic in the Workflows
documentation.

Asset Dimension Dependencies

Individual asset object types can be made dimension dependent using the Dimension Dependencies parameter
on the object type. This configuration will only affect the STEP Name of assets, meaning that it allows for
individual assets to have a different name based on the indicated dimension dependencies (e.g., 'Red Hat'in
English and 'Chapeau Rouge' in French when the dependency is Language).

System Setup Icon
~ (7% Object Types & Structures General user-type roo
¥ [ Alternate Classifications Object Type  References Log
+ 7 Assets
b 2 Assets Description
Auto Classification Rule Set
Name Value

(& BMECat Schema
(% BMECat Template D Icon
Bulk Update Configuration Name Icon

[ Business Rule Example

Last edited by 2024-11-06 12:25:09 by USER]
(& CASS Certification Report
Configuration Name Pattern
(@ Custom_Excel_Template 1D Pattern [id]
Tl DAM Asset
Icon 2]
Export Manager Configuration
sl External Stored DAM Asset applcation/postscript
= MIME Types image,/tiff
© Headshot image/tif
El Dimension Dependencies Language;
o] Tustration
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Itis also possible to make the content of assets dimension dependent so that an asset in STEP can be tied to

different digital media files in different Contexts. This is configured using the Image & Document Settings >

Dimension Dependencies parameter in System Settings.

System Setup

P

» & Object Types & Structures
» 05 Tags

» & Units

b & Users & Groups

» B, Reference Types

» £i% Workspaces

P [ Table

b (E Keve

System Settings

System Seftings  Log
Classification Hierarchy Settings

Image & Document Settings

Dimension Dependencies Language;

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on asset

dimension dependencies, this should be avoided. As mentioned, the setting is global, meaning that special procedures

must be implemented for creating assets that are to have the same content in all contexts. Thus, if you import a digital

media file (and via this create an asset instance) in a context that does not use the top-level dimension point for the

dimension on which asset content depends, the content will be created only in the dimension point the current context

uses.

For additional information, refer to the Image and Document Settings topic in the System Setup documentation.
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Custom Asset Metadata

When importing assets into STEP, System Properties attributes can be automatically created in STEP on the
asset, and then populated with the image metadata detected on the incoming assets. The image metadata must
be formatted as either XMP (Extensible Metadata Platform) or EXIF (Exchange Image File). Determination of
which metadata attributes should be housed in STEP is configured manually.

In an image file, image metadata is stored as plain text in XML format. Based on the configuration file and import
shown below, the Creator, Subject, and Description metadata will be written to STEP. In the following sample,
some rows have been removed for brevity, as indicated by '...".

1E <x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 5.3-c@@7 1.136881, 2016/86/10-18:11:35 ">
z[i] <rdf:RDF xmlns:rdf="http://wwmw.w3.org/1999/082/22-rdf-syntax-ns#">»

3 <rdf:Description

B rdf:about=""

5 xmlns:xmpMM="http://ns.adobe.com/xap/1.8/mm/"

7= <dc:creator) f—

E <rdf:Seqg>»

2 <rdf:1i»>0KL Photo:RM Style:RM</rdf:1i>
18 </rdf:Seqg>»

11 F <fdc:creators>

12 [ <dc:subject)

'_F-E <rdf:Bag>

14 <rdf:li»lucite</rdf:11i>
15 <rdf:lisbox</rdf:1i>

16 <pdf:lischest</rdf:1ix
17 <pdf:listrunk</rdf:1ix

18 </rdf:Bag>»

19 <fdc:subject>

2-:% <dc:description) e

21 = <rdf:Alt>

22 <rdf:1i xml:lang="x-default">Lucite trunk</rdf:1li»
23 L </rdf:Alt>

24 </dc:description»

26 </rdf:Description>»

27 - «/rdf:RDF>»

28 < /x:xmpmeta>

Prerequisites

The user should have a basic understanding of XML, the XML structure of image metadata, and XPath before
proceeding with configuration. The configuration file uses XML to define attribute names and the XPath query to
retrieve metadata. For more information, search the web.

XMP Configuration File

The custom asset metadata configuration file uses the instruction "XmpConfiguration' to define the name of the
system attributes being created in STEP and the XPath that defines how to retrieve the image metadata.
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XPath is an XML query language STEP uses to search the XML within an image file and identify the desired metadata.
The XMP configuration file defines the XPath queries to be run against an image file being imported.

The following sample configuration file defines three metadata attributes (Creator, Description, and Subject), and
the XPath query required to find the corresponding metadata.

<XmpConfiguration>
<XmpProperties allow="true">»

<XmpProperty
name="Creator” unit=""
xpath="/*[name(.)="x:xmpmeta’]/*[name(.)="rdf:RDF" ]/*[name(.)="rdf:Description’]/*[name(.)="dc:creator’]/*[name(.)="rdf:Seq" ]/*[name(.)="rdf:1i"]"/>

<XmpProperty
name="Description” unit=""
xpath="/*[name(.)="x:xmpmeta']/=*[name(.)="rdf:RDF']/*[name(.)="rdf:Description’]/*[name(.)="dc:description’ ]/*[name(.)="rdf:Alt" ]/*[name(.)="rdf:11"]"/>

<XmpProperty
name="5Subject” unit=""
xpath="/*[name(.)="x:xmpmeta’ ]/=[name(.)="rdf:RDF" ]1/=[name(.)="rdf:Description’]/*[name(.)="dc:subject ]/*[name(.)="rdf:Bag’ 1/=[name(.)="rdf:11"]"/>

</XmpProperties>
</¥XmpConfiguration>

In the above example, the 'creator' attribute is defined by the text:

nmn

name="Creator" unit=

The XPath to find the creator metadata is defined by the text:

xpath="/*[name (.)="x:xmpmeta']/* [name (.)="rdf:RDF']/*[name (.)="rdf:Description']/*

[name (.)='dc:creator']/*[name(.)="rdf:Seq']/*[name (.)="rdf:1i"]"/>
Refer to the online version of this topic for another example.

Using an XMP Configuration File

Note: The following functionality is managed by a configuration property that is not available in the Self-Service
Ul. Contact Stibo Systems Support for assistance.

1. Create and save a custom asset metadata configuration file using XmpConfiguration instruction as shown above,

that defines:

° the image metadata attribute name(s)

° the appropriate XPath to the required metadata on the image

2. Save the configuration properties file.

3. Edit the configuration property XMP.ConfigFile as follows, where 'customxmpconfiguration.xml' is the name of
the configuration file created above.

XMP.ConfigFile = /workarea/customxmpconfiguration.xml
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Save the configuration property.
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Restart the STEP server to apply changes to both configuration files.
Import an image that includes the metadata attributes defined in the XMP configuration file.

Navigate to the imported asset to view the metadata assets on the System Properties flipper.

Custom attributes are identified in the STEP asset editor by the text 'asset.' which is prepended to the attribute

name (for example, 'asset.Creator').

Tree

* [ Product Images

*[O1

P10

i1

P12

-l |Prod uct_SDT10010_Image_1

P2
P[4
6
P[9
FOA
»[OB
»[OIC
»[OD

Product_SDT10010_Image 1

Product Image « Revision: 1.2

Images & Documents  References  Referenced By  Status

Description

System Properties

Mame Value

asset.Creator 12a | OKL Photo:RM Style:RM
asset.Description 12a | Lucite trunk
asset.Subject 12a | lucite;box;chest;trunk

Important: Custom coding by Stibo Systems can be used to allow attributes to be displayed in the
workbench with names other than 'asset.[attribute name]'. For more information, contact Stibo Systems.
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Linking Assets to Products

If the asset’s name can be matched to the product, then this function can be performed when the asset is imported. If
not linked at this time, there are two ways that the interface allows the link to be made: a) from the product or b) from the

asset.

There are three ways to link images to products:

* From the product
L]

From the asset

* From import

Note: While the maximum number of references to one object node is limited to 10,000 instances, this value
can be changed; however, it is against Stibo Systems recommended practices to use this many references.
Before changing this value, contact Stibo Systems for assistance.

Linking Assets to Products (From Products)

1. Select the product and then select the References tab.

Product Data Containers  Sub Products References Referenced By Images & Documents  Commerdcial

2. Navigate to the Image References section of the References tab. Click on the + symbol to link the image to the
correct area. For this example 'Primary Product' will be used as it is the most common reference type made.

Image References

Reference Type v Target Thumbnail
Brand Logo E
Tlustration =

Primary Product Image =

3. Asearch window displays.
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Select Asset (Reference Type = Primary Product Image)

Browse  Search

P [T Assets

b [ Classifications

k [T Configurations

¥ [C] Merchandising Hierarchy

P [T Suppliers
» [C'Web Sites

P[] Primary Product Hierarchy

Details

Select Cancel

4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of the
image will appear when the product is selected.

Image References

Reference Type v Target Thumbnail
Brand Logo E
Tlustration [

Primary Product Image | = | @] Acme Anvi r

Note: When assets are linked to products, you must designate what type of reference is being made. For
example, is it an image that represents the product? Is it an accessory to the product? Or a related
document? This reference type denotes that the image being linked to the product is a direct representation
of that product. When you make such a reference, a thumbnail of the image is attached to the product. The
thumbnail will only appear for this reference type. It is possible to link more than one image to the reference
type if the reference type is set to allow multiple references 'yes.'
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Linking Assets to Products (From Assets)

5. Select the image in the Assets folder in the Tree. Then, select the References by tab.

Images & Documents

References

Referenced By

Status

Log  State Log

Tasks

6. Ifitis not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary

Product Image' to link the image to the product.

Images & Documents  References Referenced By Status Log State Lg
* Image References
Reference Type v Source Thumbnail
Primary Product Image =
Product Image + E

7. Navigate to the Product in the pop up window, and select it.
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Select Object (Reference Type = Primary Product Image)

Browse  Search

(115603) Search
> Advanced

Name

|.. (115603)

Cancel
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8. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a thumbnail
of the image will appear when the product is selected as illustrated in the below image.

Tree mouse
v [ Product Images Product Image = Revision: 1.0

P11

b2 wl

P4

Images & Documents  References Referenced By Status Log Statel
[ lighthouse
'w| LinkingSpecattrs -~ Image References
al
"\ Reference Type vl i | Source Thumbnail

@] mygif

.
&J mypng Primary Product Image  + | & | L (115603) .
& mypng
i mypng Product Image + E

4 Mimmmind T

Linking Assets to Products using the Import Manager
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This method is best used for large amounts of products / assets linking. Ideally, you should already have a file in Excel
that has the products and desired Image ID set up according to how you want them to be after import.

Note: If you only need to link a few assets to products, then it is more efficient to link them via the interface.

1. Goto File and select Import, then Data. On the 'Import Manager' window, navigate to the 'Select Data Sources'
step and click the ellipsis button () next to 'Filename' and select your file.

Import Manager

1. Select Configuration

Select Data Source

3. Select Format Data Source File v
T LR © Retrieves contents from files reachable from your local computer.
5. Identify Objects

6. Identify Destination
7. Select Business Rules

Flename | /InputFile.txt

Finish Cancel

Back

2. Proceed to the 'Map Data' step. Select a source column and click the Map button. Map the column holding IDs
to'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the 'Asset
Reference' radio button, select the 'Primary Image' radio button. For more information on mapping, refer to
Inbound Map Data - Map topic in the Data Exchange documentation.
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O

) Name

O Attribute

O Product Classffication Link
() Product Reference

© Asset Reference

() Classification Reference

Target ID Aspect D

) Owners Manual
() PDF

© Primary Product Image

) Product Image

() Showroom Preferred

() Mandatory

Cancel

OK

3. Click OK to close the Map To dialog.

If the image IDs were not found or the import file data was not done correctly, then columns will appear in red.

For information on input files, refer to Asset Reference - Map Inbound topic in the Data Exchange

documentation.

Note: If the image IDs were not found or the import was not done correctly, then columns will appear in red.
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Impert Manager

1. Select Configuration Map Data
2. Select Data Source Source:

3. Select Format <ID=> ¢ | =Name= :
4. Map Data 18210 18210 M B
5. Identify Objects
18212 182121 B
6. Identify Destination
18213 18213 M0
7. Select Business Rules
8. Advanced Settings Result Map to:  Product v
[D=<ID= + PrimaryProductimage AssetReference=<Name> @
18210 18210 M B
18212 182121 B
18213 18213 M0
Auto Map Map Constant Remove Transform Generate Profile

Back Mext Finish Cancel

STEPXML Import

It is also possible to link the images to product via STEPXML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>
<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">
<Products>
<Product ID="18210" UserTypelID="Item" ParentID="18209">
<Name>18210 M B</Name>
<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>
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</Product>
</Products>

</STEP-ProductInformation>
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Classifications

This topic covers information specific to the Classification super type that is important to know when working with
classifications. For general object maintenance information (applicable to all object types rather than specific to
classifications), refer to the All Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings. For
example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate subfolders
under the 'Assets' classification folder. Product objects could also be linked into classifications to provide
alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor

The primary editor for classification objects is the Classification tab.

Tree Marketing Postcards
b [ Web Images || Vebsite Roat - Revision: 0.5
w [ Web Sites US Classification  Sub Products  References Referenced By  Images & ...
» [CFull Catalog
w [ Marketing Postcards Description "
| FallSales
\& springSales Name Walue
| SummerSales D MarketingPostcards
¥ [0 PreferredProducts Name Marketing Pastcards

» [T Sales Flyers

Ohject Type Website Root
» [ specialty Catalog goer M- =
[ Website Root Revision 0.5 Last edited by USERJ on Mon Mov 16 08:42:31 EST 2020
» (D ACME Customers Approved X Never Been Approved
» () CMDM Customer Root
_ Translation Not Translated
» (7] Company Hierarchy Data Raat
» [T] Customer Root Path Classification 1 root/Web Sites US/Marketing Postcards
» =] Entity Root VISIDI“W
» (D GDSM
— v Landing Page Copy | A8E
£ > W

This tab will display all description attributes that are valid for the classification. Note that only description
attributes are available on classifications (as opposed to products, which can also have specification attributes).
More information on description attributes is available in the Description Attributes topic of the System Setup
documentation.
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Sub Products

When on a classification, the Sub Products tab is used to display objects of the product super type that are linked into
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the classification via Product to Classification links. When the selected classification does not have product children

(e.g., classifications used to house assets or configurations), the Sub Products tab does not provide any meaningful

information.

<

Tree

P [ Web Images

~ ['\Web Sites US

» [ Full Catalag
+ [ Marketing Postcards
L Fallsales
| SpringSales
|« SummersSales
» [0 PreferredProducts
» [T Sales Flyers
» [ Specialty Catalog
[ website Root
» (TJ ACME Customers
» () CMDM Customer Root
» (7] Company Hierarchy Data Raat
» [TJ Customer Root
» £ Entity Root
» (D) GDSN

[ S Nt nl-1 N e Tttt

Marketing Postcards

Website Foot » Revision: 0.5

Classification  Sub Products

D

MName
Object Type
Revisian
Path

Approved
Translation

Category

References  Referenced By
FallSales SpringSales
5594181 5594193
FallSales SpringSales
Sales Item Sales Item

0.1 Last edited by ... | 0.1 Last edited by ...

Primary Product Hi... | Primary Product Hi...
X Mever Been Ap...

X Mever Been Ap...

Nat Translated Nat Translated

Classification 1 root || Classification 1 root |

Web Sites US| Web Sites US|

Marketing Postcards | Marketing Postcards

| FallSales | SpringSales

£
Add Product

Images & ...

Summersales
5594195
summersSales
Sales ltem

0.1 Last edited by ...

Primary Product Hi...
> Never Been Ap...
Mot Translated

Classification 1 root |
Web Sites US|
Marketing Postcards
| SummerSales

Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly into any
editable field. Standard editing capabilities are available within this interface (as described in the Editing Objects in the

Tree Tab topic within this guide), including copy / paste functionality using Crtl + C and Crtl + V. Right-clicking on any

field within the table will expose additional options, including Copy, Paste, Hide Equal, and Mark Different selections -

all of which are self-explanatory and can be especially useful when editing multiple objects.
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FallSales : | SpringSales | Sumn

ID ¢ | 5594181 &% cut Ctel +X
Name ‘| FallSales Copy Ctrl+C

i . Faste Ctrl +V
Object Type : | Sales tem .

== Paste Linlk Ctrl +L

Revision : | 0.1 Last edite
Fath . | Primary Produ Rotate Table
Approved ¢ | X Never Bee Hide Equal
Translation ¢ | Mot Translate: Mark Different

Classification _ _
Hide/Show Aftributes

Cateqa Weh Sites US
=gory Marketing Pos Filter
| FallSales
£ Edit
Add P Override
Recalculate

Two views are available using the Rotate Table option. As shown above, the view can be organized to have attributes
on the vertical axis. As shown below, the table can also display products on the vertical axis. Right-clicking within the
header field exposes different options than within the data fields, including options to add and remove products.

Classification  Sub Products  Eeferences Ref
D ¢ Name

Fallsales ¢ | 5594181 FallSales
Hide L
Show All Eows

, Rotate Table

SpringSales Sal
Add Product Ctrl+Plus
Femove Product Ctrl+Minus
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Selecting Remove Product deletes the product to classification link between the objects, but does not delete the
product itself.

Selecting Add Product opens a dialog allowing the user to browse hierarchies to select a product to link, as well as
specifying the link type to be applied.

Select Classification Product Link

Browse  Search

[0 Miscellaneous
w [0 Postcards

|..| FalSales

|« SpringSales
|l SummerSales
L. [WinterSales

Details

Link Type website Link ~

Select Cancel

The same functionality is available using the Add Product link at the bottom of the Sub Products editor.

References

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has privileges applied, has objects visible in other
contexts, or has any linked attributes, that information can be viewed (and in some cases edited) on this tab.

The display of the References tab on a classification will vary slightly from system to system, based on the data model.
If the selected object has classification reference types for which the object is a valid source, those will appear on this
tab, in addition to the default section options.
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Tree Marketing Postcards
b = UNSPSC || Website Root « Revision: 0.6
» [C1Web Images Classification  Sub Products References Referenced By  Images & Documents
~ [0 Web Sites US
» LI Full Catalog o Retail
~ [l|Marketing Postcards i
Reference Type v| % | Target
= FallSales
\& SpringSales Classification to Classific... + | 2
L.« Summersales 9 U 4 Entity Ref
ngrouped Entity References
L. Wintersales group v
» [ PreferredProducts Reference Type vl i | Target
b [ sales Flyers Classifiction To Entity + |8
» [ Specialty Catalog
[T website Raat 9 Applied Privileges
» T ACME Custamers Applies to ¢ | Action Set ¢ | Aftribut... ¢ | Object.. ! | Group ¢ |Language : | Country
» () CMDM Customer Root =
Marketi Classi Merchandis...| <ANY ANY
» (D) Company Hierarchy Data Root arketing | Classity pro erchands...| <ANY> <ANYE
» [T Customer Root Add Privilege
» B Entity Roat
» ) GOSN 1 Visible Objects in Other Contexts
b (T) GDSN Receiver No Visible Objects in Other Contexts
» [ Location Root Attributes
> @ Location Root 2 D i [N ¢ | Displays ¢ | Mandat ¢ | Inherited f | Visibility
¢ | Name : | DisplaySequence § | Mandato ¢ | Inherited fram  § | Visibility ¢
» (D Merge_Golden_Root plavsEa v
» (T) Promoations Capacity Capacity 4 Web Sites US English
D wsepP CardSize | Card Size O English
» B Publications
LT v Link to Attribute
£ >

1. Reference Sections: References can be placed in attribute groups for display purposes. All references for which the
selected object is a valid source that have been placed in attribute groups will display first on the screen, with the
section title being equal to the name of the attribute group. References can be added by clicking the plus button (+)
on the reference. This will open a dialog allowing the user to select a target for the reference, and a reference will be
created to the object selected in the dialog from the currently selected object that you are standing on (e.g., current
object = source, dialog selection = target). If any attributes are available on the reference and editable, they can be
edited within this interface. References can be removed by clicking the () on any existing reference. Additional
information on configuring and working with references is available in the Reference and Link Types topic in the
System Setup documentation.

2. Ungrouped Classification References: The functionality is identical to what is described for the Reference Sections
section above. The only difference is that this area displays references that have not been placed in attribute groups
for display purposes. If all references that are valid for the selected object have been placed in attribute groups, the
Ungrouped Classification References section will not be present.

3. The Applied Privileges section allows users to apply privileges to the selected classification. Detailed information
on creating and editing privileges is available in the Privilege Rules section of the System Setup documentation.
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4. The Visible Objects in Other Contexts section displays subproducts that are visible in another context, which is
only applicable if classification hierarchies have been set to be dimension-dependent in System Settings. Refer to
the Classification Hierarchy Settings topic in the System Setup documentation for detailed information.

5. The Attributes section allows the user to view attributes linked to the classification, as well as to add new links using
the Link to Attribute link. When attributes are linked to a classification, they are available to be populated on any
objects of the product super type that reference the classification (assuming the attributes are also made valid on
the applicable product object type). The exact columns available will depend on the data model and the attributes
that have been made valid on the attribute links. Whether or not the various attributes are editable will also depend
on the setup of the data model. However, an ID and Name field are always shown, with the attribute name being a
hyperlink that can be used to navigate directly to the attribute. An Attribute Groups column is also present,
displaying the attribute group(s) that the attribute is in. A Mandatory column is present and if checked, product
objects that reference the classification cannot be approved until a value has been provided for the attribute. Note
that mandatory settings on the attribute itself apply globally, while mandatory settings on the attribute link apply only
to product objects that reference the classification at which the attribute is linked (or reference a classification that is
inheriting the link). More information on mandatory settings is available in the Mandatory Attributes topic in the
System Setup. If the attribute link is inherited, the row cannot be edited and the 'Inherited from' column will display
the parental node where the attribute has been linked, which is hyperlinked for easy navigation. More information on
linked attributes is available in the Inheritance in the Product Hierarchy topic within this guide and in the Attribute
Links topic in the System Setup documentation.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that the
selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In addition, if the
object is used by a match code or is used by any publication, that information can be viewed on this tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data model.
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Tree Marketing Postcards
b = UNSPSC || website Roat - Revision: 0.6
¥ [T Weh Images Classification  Sub Products  References  Referenced By —Images & Documents  Tahl...

~ [0'\Wehb Sites US

» [ Full Catalog d Retail

 [l|Marketing Postcards i
Reference Type v| % | Source
|l Fallsales
Il Springsales Classification to Classification + |t
L Summersales Product to Classification + |t
|+ WinterSales
» 3 PreferredProducts 9 Ungrouped Referenced by Products, Classifications or Entities
» [ sales Fiyers Reference Type v| i | Source ¢ | Source System ID
» [ Specialty Catalo
p_c _ _ty g | & Karan Reed
[ website Root Entity ta Classification +
» [T ACME Customers ta | & mariyam Morgan

» (D) CMDM Customer Roat

Used by Match Code Object
» [T Company Hierarchy Data Roat sed by Match Code Objects

» [T Customer Roat D ¢ | Name
» B3 Entity Root
» m GOSN Used on Page
» (D) GDSN Receiver Publication ¢ | Version ¢ | Page ¢ | Area Used i | Page Type
» (@ Location Raot v
£ >
1. Reference Sections: References can be placed in attribute groups for display purposes. All references for which the
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selected object is a valid source that have been placed in attribute groups will display first on the screen, with the
section title being equal to the name of the attribute group. References can be added by clicking the (+) on the
reference. This will open a dialog allowing the user to select a target for the reference, and a reference will be
created from the object selected in the dialog to the currently selected object that you are standing on (e.g., current
object = target, dialog selection = source). If any attributes are available on the reference and editable, they can be
edited within this interface. References can be removed by clicking the (X) on any existing reference. Additional
information on configuring and working with references is available in the Reference and Link Types topic in the
System Setup documentation.

2. Ungrouped Referenced by Products, Classifications or Entities:The functionality is identical to what is described

for the Reference Sections section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match code will

display. For example:
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Find Similar CH Match Code

Match Code

Match Code | Match Code Values  Statistics Log

Definition

Mame : : | value

D FindSimilarCHMatchCode

Mame Find Similar CH Match Code

Last edited by 2024-02-28 14:39:29 by USERJ

Category \ Marketing Postcards (MarketingPostcards) E=

ll.‘.lr.leld by Mat-::h Code Dbjfe-::ts
D i | Name : | Edited by
FindSimilarCHMatchCode Find Similar CH Match Code 2024-02-28 14:40:58 by USERJ

More information on match codes is available in the Matching, Linking, and Merging documentation.

4. Used on Page: Displays publications that the selected object is used in. Additional information about working with
publications is available in the Publication Hierarchy section of the Publisher (Adobe InDesign Integration)
documentation.

Images & Documents

The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets that are
housed within that classification). Note that assets can be tied to classifications in two ways: as child products, or via
image and document references. Assets are typically referenced to classifications only when the classification contains
non-asset children for which the asset is relevant. In any case, assets referenced to classifications are not visible on the
Images & Documents tab. This is in contrast to how the same tab functions for products, where the tab displays all
assets referenced to the selected product. However, for the displayed assets (those that are child to the classification),
the functionality available for interacting with the assets is the same as what is available for referenced assets on a
product, which is described in the Images & Documents Tab topic.

Tables

The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information, refer to
the Tables topic.
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Status

The Status tab provides information about the status of the object, including revision history, translation status, and
approval status. Products and classifications share a common Status tab, which is described in the Status Tab topic.

State Log

The State Log tab displays the history of the selected object across all workflows. If the object has ever beenin a
workflow, a section is displayed per workflow and the history of transitions of the object within that workflow can be
viewed. Detailed information on the State Log tab is available in the State Log Tab topic in the Workflows
documentation.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges (only
tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the user is
able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More information on
the Tasks tab is available in the Moving Tasks through a Workflow in STEP Workbench topic in the Workflows
documentation.
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Collections

Collections provide a valuable tool for data maintenance tasks. A collection is a container for storing sets of objects from
Tree and System Setup, independently of their placement in the hierarchies. A collection can be created via a search or
an import, and all objects in a collection can be updated at the same time.

Collections and collection groups are found in the Collections hierarchy on the Tree tab. A 'collection group' can hold
multiple collections and other collection groups. Refer to Creating Collections or Creating Collection Groups topic for
more information.

Tree

P [ Primary Product Hierarchy
+ [ Collections
» £ alarms
» £ Backplate
» £ Copy Writing State
» £ Data Quality Collection
» £ Flashights
+ [ Tshirt Group
« B Men's Tshirts
» £ Size Large
» £ Size Medium
» £ Size Smal
» I Women's Tshirts
» B TShirtitems

Dimension dependencies and workspaces, among other settings, impact the results of a collection created from a
search. For more information, refer to the Collection Considerations topic.

For more on data maintenance of collections and collection groups, refer to the Maintaining Collections topic.

Temporary Collections

The 'Temporary Collections' node is system-generated to store read-only collections created by a process, such as bulk
update background processes, exports, profiles, and Web Ul basket. The right-click menu on this node does not allow
manual creation of new user collections nor deletion of existing temporary collections.

Note: The following functionality is managed by a configuration property that is not available in the Self-Service
Ul. Contact Stibo Systems Support for assistance.
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Temporary collections created by background processes (BGPs) are deleted automatically when the BGPs are deleted
viathe AutoDeleteBackgroundProcesses.AgeInHours. [processname]=[hours] configuration property. In
this setting, the [processname] designation is replaced with the name of the BGP and the [hours] designation is
how long to wait before deleting BGPs.

For example, running a bulk update BGP creates three temporary collections. Setting the
AutoDeleteBackgroundProcesses property with 'BulkUpdate' as [processname] allows the related bulk update
temporary collections to be deleted when the bulk update BGPs are deleted, based on the [hours] setting.

Manually deleting temporary collections is necessary when background processes have been manually deleted. Select
a temporary collection, on the Maintain menu, click 'Force Delete & Purge', and select one of the following options:

¢ 'Purge collection contents' - removes the contents of the collection but does not remove the root node.

¢ 'Purge collection node' - removes the contents of the collection and also deletes the collection root node.
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Collection Considerations

Collections created from a search include a URL that identifies the search criteria. However, unlike other URLs in
STEP, a collection URL does not include settings like workspace or context.

Toillustrate:

® The URL foran object in the primary product hierarchy includes Context1 and workspace Main:

step://product?editor=Producté&versionid=204372&contextid=Contextl&id=235113&workspac

eid=Main

The URL for a search on a list of three IDs (18212, 18213, and 18216) but not the context or workspace:
step://search?args0.0=searchString%$3d18212%0a18213%0a18216%2cuniqueKey%3dIDKey&searc
h0.0=IDListCriteria

The URL for a search on objects with a value of 'blue' for the COLOR attribute but not the context or workspace:
step://search?args0.0=IncludeDataContainers%$3dno%$2csearchString%3dCOLOR%c2%a0%28COLO
R%29+%253D+blue%2cRegExp%3dno%2cMatchCase%3dno%2cIncludeInheritedvValues$3dno%2cRecyc

1leBinOnly%$3dno&search0.0=ValueCriteria

Essentially, a collection created by a search operates as a saved search. The absence of the context and workspace
data in the 'Search URL' parameter allows the search to be rerun and a collection to be refreshed on a different context /
workspace. This also allows the results from a search collection to differ based on the current settings. Understanding
this flexibility can explain why results vary. Settings that can cause different search results include, but are not limited
to, workspace, context, dimension points, and privileges.

Important: The content of a collection created from a search displays the search results from the last time the
search was refreshed by using the Refresh option on the collection.

Workspaces and Collections Created from Search

Workspace is one setting that can cause the same collection created from a search to return different results. To
illustrate, consider a search that uses the 'Search from List' criterion with the IDs of three objects and that was run from
the Main workspace. None of the three objects are approved. The search is saved as a collection.
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. |Approved
Context English US Workspace
Advanced Search )4
Search from List ~ %
18212
18213
18216

Number of entries: 3

ID v

+ - Reset Search

Displaying 3 of 3 results  Show Details

Mame

18212 L B(18212)

18213 M O(18213)

18216 L O(18216)

0 tions on Entire Result

g O

On the Tree tab, the collection displays the three objects, shows a count of 3 in the 'Estimated Amount of Objects’
parameter, and the 'Search URL' includes the list of IDs from the search.
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Tree » || ThreeObjects X
M Collection  Data Profile  Log
B 1821218
& 18213 M0 o ription
B 18216L0
Name ¢ | value
;| ID 5777877
Name ThreeObjects
Estimated Amount of Objects 3
\ A\
Search URL step://search?args0.0=searchString%e3d18212%0a18213%0a18216%2cui
Last edited By 2024-07-26 12:46:11 by USER]
Purpose Ree
> Statistics

Changing the workspace to 'Approved' continues to display the same results since the collection has not yet been

refreshed.
Approved

Context English US Workspace 9
Tree 1| Three
¥ = [ThreeObjects Colecti
1821218 Collectic
18213 M0 —
B is216L0 v De

Right-click the collection and select 'Refresh’ to run the search with the current settings.

Approved View
Context English US Works 9 Mode VO
Tree “ || ThreeObjects
- g FEEGb]ECtS Cnllarting Data Pr
% Run Bulk Update
di Export Data Below ption
Repubiish...
e
[ g TireCol Refresh
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The refreshed search in the 'Approved Workspace' does not include any of the objects returned when originally
searched, which means the ThreeObjects collection in this workspace is empty.

Context Engish US el

Workspace
Tree Three
£ ThreeObjects Collecti
Collectic

D

To display the unapproved IDs again in the Main workspace, refresh the collection again with that workspace
selected.

Language-Dependent Search and Exports

Search results are dimension-dependent. A search in one context can display one set of objects while the same search
in another context can display a different set of objects.

Important: The recommended method that addresses dimension-dependency is to search on the attribute ID
with a wildcard (*) since it allows users to export results regardless of the context that the search was
performed in, or the context selected for export.

When searching and using collections with context-dependent data, consider the following:

* Because the name of a language-dependent attribute can be different based on context, name is not a reliable
criterion for repeatable searches. Searching based on an attribute name can return unexpected results depending
on the selected context. Instead, use the 'Search from List' criterion with the ID option to search on the object's ID,
since the ID is the same regardless of the selected context or value changes.

For example, consider an attribute with name of 'Description' in the English context and the name of
'Descripcion' in the Spanish context. In both contexts, the ID is the same. While in the Spanish context,
searching for attribute name of 'Description=100%*' returns zero results because the attribute name is
'Descripcion’ and no attribute name of 'Description’ exists in the Spanish context. To find the intended
information, use the 'Search from List: ID' option, as defined in the Search: Search from List topic.
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Important: Regardless of the context selected during search, the exported file includes data based on the
Context parameter on the Advanced step of the Export Manager. For details, refer to the Export Manager -
Advanced topic in the Data Exchange documentation.

* When exporting search results or exporting a collection made from search results, the context selected when
performing the search is used in the 'Displaying # of # results' list of objects found and the Export Manager
Advanced tab Context field determines which values are exported.

If a search or a collection from an Advanced Search is based on a language-dependent attribute's Name, the export
file is blank if the context selected in the Export Manager does not match the context selected during the search or

collection creation.

To export objects with their relevant language-dependent attribute values, regardless of the context in use during
search or collection creation, use the 'Search from List' criterion with the ID option from the dropdown (as defined in the
Search: Search from List topic). This ensures that the attribute values are identified by object IDs which are the same

for all contexts.

The example outlined below illustrates how creating a collection from search results can return different objects, based

on the dimension-dependent values in the context being searched.

This search is performed in the 'English US' context for the value 'Blue’ in the 'COLOR (COLOR)' attribute. The search

finds three objects with the value.

Mormal e

URL

Search Result Profiling

) | Approved View
Context English US Workspace Mode
Advanced Search
X

Search =
COLOR (COLOR) = Blue

Advanced

Reset

+ -

Displaying 3 of 3 results

Mame
|..|20808-013M (188285)

|..| 20808-016M (188415)

|..| 20808-017M (190450)

Show Details
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3 hit(s)
Click links to narrow down search

Results by Object Type
Product {3} -

exclude

|2 Sales tem (3) - exclude

Results by Position in Tree Hierarchy

Results per Parent

[Tl Sale Products (3} - sxclude

[C1Hats and Caps Sales ltem

5 (3) - exclude
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One of those objects has a translated value of 'Azul' for the language dimension point in the 'Spanish MX' context. The
other objects have no value for the attribute.

) .|| Approved View .
ontext Spanish MX Workspace Mode Mormal &«
Tree “ || Products
~ B Hats and Caps Products References Referenced By
» Il Cap Items
» Bl Hard Hat Ttems View: COLOR ,,|
w [0 Hats and Caps Sales
|-l 20808-013 ID : | (COLOR)
.. 20808-013M Name : | ID (COLOR)

|-l 20808-015M

|.. 20808-016M
| 20808-017M 20808-016M ! | 188415

20808-013M : | 188285 Azul

20808-017M : | 190450

Performing the same search again in the 'Spanish MX' context returns no records since the value of 'Blue' does not exist
for any of the records in the searched context.

Approved View

Context Spanish MX -~ Workspaoe Mode

Normal ~ & (% URL

Advanced Search ) 4 X

Search ~ »
COLOR (COLOR) = Blue

> Advanced Mo Search Result

+ - Reset

Displaying 0 of 0 results Show Details

Name
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Creating Collections

In the workbench, collections can be created in two ways:

1. Using the Advanced Search tab, perform a search, and create a collection of the results
2. Using an import file, create a collection of the contents

Regardless of how they are created, if a collection contains fewer than 10,000 objects, these can be inspected in
the Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat structure
regardless of any parent-child relations that may exist between the objects, and regardless of the parents and/or
children the objects have when viewed elsewhere in STEP.

Note: This topic and the Collections section do not address Web Ul functionality, however, to allow for the best
performance, the Web Ul Collection Content Screen has the same 10,000 object restriction.

In Web Ul, objects can be manually added to and removed from a collection. This functionality is not available in the
workbench.

Creating a Collection from Search

The most common way to create a collection is by creating a search. Refer to the Collection Considerations topic
for important information about how saved search results can changed based on the current settings.

To create a collection from search, follow the steps below.

1. Navigate to the Advanced Search tab, enter in the needed search criteria, and click Search to verify the results.
For more on how to search, refer to the Navigating and Searching topic in the Getting Started documentation.

2. Click the 'Save as Collection' button.
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Advanced Search X

Search Below ~
Flashlight Items (20859)

+ - Reset

Displaying 9 of 9 results Show Details

MName

B 103709 (103709)
B Army Green Flashlight (408124)

B Black Flashlight (212308)

Operations on Entire Result

| > o

3. Select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a collections
group folder), enter a collection name (the ID is autogenerated), and click OK.

Save as Collection in Background Process

Browse  Search

« [ Colections I
£ Addresses
£ alarms
£ Alltems
> Details

Collection ID 5744791
Collection Name  Flashlights

cance
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A background process runs, and the new collection is created and displays under the specified folder.

Tree

T WSEP
» B Publications
P [0 Primary Product Hierarchy
« [ Collections

» £ Addresses

£ alarms
£ Alltems
£ BGPs to delete
£ Copy Writing State

£ |[Flashlights
L.

L - - - -

4. As needed, right-click the collection and run a bulk update, or export the objects.

Note: The initial search criteria used to locate the included objects is stored on the collection, which allows
for later updates of the collection. To learn more about editing searches to update collections refer to the
Maintaining Collections topic.

Creating a Collection from File Import

Collections can be created from a text or CSV import file containing STEP IDs of products, assets, or classifications.
Objects in the import file must already exist as the import will not create or update objects, only place them in a
collection.

Important: If the import file includes only attribute values or unique keys of the products, assets, or
classifications to be added to the collection (and does not include the STEP ID), you must use the steps
defined in the Creating a Collection from Search section above.

To create a collection from a file:

1. Inthe Tree, right-click the Collections top node or a collection group to determine where the new collection will
be saved, and select 'Create Collection From File...".
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Tree e

» [T) Promotions
T WSEP
» Il Publications
P O] Primary Product Hierarchy
» B Collections
b [@ ecat & Create Colection Group...
IR | Create Collection From File...

collection.

Important: The file must not contain headers or any other data.

Create Collection From File

- |STIBOSYSTEMS

Lookin: 2 Documents v -
( ~ Custom Office Templates
% ~ GitHub

RecentIte... g3 CreateNewlLOV.xlsx

- £33 CSVLOVImportValues.csv
Desktop @38 CSVLOVImportvalueswith UNITS.csv

=

Documents
File name: CSVImport.csv
! Files of type: Al Files
Thic D™
ColectionID  |5764469
Collection Mame MNewProductks
File Contains Products

Classifications

Assets

b MASTER DATA MAMAGEMENT

In the 'Create Collection From File' dialog, locate the file that lists the IDs of the objects to be imported as a
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3. While the 'Collection ID' is autogenerated, for the 'Collection Name' parameter, add a Name for the new
collection.

4. Forthe 'File Contains' parameter, select if the import file contains IDs of products, classifications, or assets.

5. Click 'OK' to start a background process which will create the new collection.
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Creating Collection Groups

Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.

Creating a Collection Group

1. Depending on where you want the collection group to live, either right-click the top-level Collections node or an
existing collection group in Tree and select Create Collection Group....

Tree

» B Publications
P [T Primary Pri & | Create Collection Group...

» B Colections 5 Create Collection From Fik...
» (@] eCatalogs

» 3 Recyde Bir

2. Inthe 'Create Collection Group' dialog enter a Name (ID is autogenerated) for the new group.

Create Collection Group

ID 5767645

Name MNew_ Products

Cancel

3. Click OK.

Once created, collection groups can be selected to hold new collections, or more collection groups can be created
under them. For more on how to create collections, refer to Creating Collections in this documentation.
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Tree

¥ [ Primary Product Hierarchy
+ [ Collections
» £ alarms
» £ Backplate
» £ Copy Writing State |
» £ Data Quality Collection
» B |New_Products
v [ Tshirt Group
« 2 Men's Tshirts
» £ Size Large
» £ Size Medium
» £ Size Smal
» I Women's Tshirts
» B TShirtitems
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Maintaining Collections

Collections can be a valuable tool for data maintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects with data
anomalies could be grouped in a collection via search criteria. Once the data is corrected, the objects with updated
information no longer meet the search criteria. Thus updating the collection automatically removes any updated / fixed
objects from the collection. In this way, only the objects that still need to be fixed are displayed in the collection.

This topic addresses the various ways users can interact with and maintain collections.

* Delete Collections

Edit Search Criteria
Export Data Below
Refresh Data

* Run Bulk Update

* Republish

Search Below

Collections can also be maintained via the Web Ul. For more information, refer to the Collection Content Screen section
of the Web User Interfaces documentation.

Delete Collections

Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
They will still reside under their original nodes in Tree and System Setup. All collections and collection groups
below a collection group must be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placement in STEP as well. In this case, it would be best to just updated the collection through proper
maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and click Delete.
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Tree

~ [ Colections
» = Addresses

~ € alarms % Run Bulk Update

=6 di Export Data Below
=5 Alar
Repubiish...
=5 Alar rech
b = Allterr Refres

» = AlPPH Edit Search Criteria...

» £ Backp/| ¥ Delete
» = Basket

» = Batten

Search Below

Additionally collections and collection groups can also be deleted from the Maintain menu via the Delete option.

Fie Edit View MNavigate Format Maintain Window Help

Approved Insert >
D Context Engls...
Workspac
pa Link >
Tree Merge »
w [ Collections % Delete
» = Addresses
Force Delete & Purge
+ £ alarms
3 (160349)
= Alarm-001 Ctrl+)
= Alarm-002

For more on creating searches, refer to the Navigating and Searching documentation.

For more on how to use bulk updates, refer to the Bulk Updates documentation.

Edit Search Criteria

To edit a collection created from a search:

1. Right-click on the collection and click 'Edit Search Criteria'.
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Tree

~ [ Collections
» = Addresses

~ € darms %! Run Bulk Update

=6 di Export Data Below
3 Alar
Repubiish...
3 Alar croch
b = Allter Refres

» £ Al PPH Edit Search Criteria...
» £ Backp| ¥ Dpelete

2. Onthe Advanced Search tab, modify the original search criteria if necessary.
Advanced Search

Search from List ~ %

160349
411857
411860

Mumber of entries: 3

+ - Save Reset Search

Alternatively, if a collection was created using a search criteria, the 'Search URL' displays in the collection's Description
section for the Search URL parameter. Copy and paste the URL into the workbench URL parameter to display the
Advanced Search tab with the search criteria and make adjustments if needed.

Tree alarms
~ B Colections Collection  Data Profle  Log
» £ Addresses
fa -
- SENE Description
51 (160349)
= Alarm-001 Name : ¢ | Value
[ Alarm-002 D 5515707
»
& Altems Name alarms
» £ AIPPH
» & Backplate Estimated A... 3
» £ Baskets ISearch URL step://search?args0.0=searchString%3d160349%0a411857%0a411860%2cuniqueKey%3dIDKey&search0.0=IDListCriteria
»
€ BatteryBackupCock Last edited By 2024-01-04 08:39:48 by USER]
» £ BGPs to delete
Statistics
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For more information on searches, refer to the Navigating and Searching topic in the Getting Started
documentation.

Export Data Below

The Export Manager wizard allows a user to export data on demand and to create or modify an export configuration.

1. If a user wishes to export all objects in the selected collection based on the selected format and the mapped data,
they can right-click on the collection and select Export Data Below.

Tree X
+ [ Collections
» £ Addresses
~ € alarms %] Run Bulk Update
= Qs i Export Data Below
2 Alar
Repubilish...
2 Alar

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as needed.

Export Manager
1. Select Configuration Select Format
2. Select Objects Excel ™
4. Map Data Excel version Excel 2007
5. Advanced Export Empty Fields  no ~
6. Select Delivery Method

Back MNext Finish Cancel

For more information on exporting, refer to the Creating a Data Export topic in the Data Exchange documentation.
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Refresh Data

Only collections created from search results can be updated for the most up-to-date information and object groupings,
as objects in a collection that no longer meet the search criteria will be removed from the collection. Refer to the
Collection Considerations topic for important information about how saved search results can changed based on the

current settings.

* To start a refresh in the workbench, right-click on the collection and select 'Refresh'.

Tree

+ [ Collections
» £ Addresses

v € alarms %1 Run Bulk Update
ik

=as Export Data Below
3 Alar

Repubiish...
3 Alar

Refresh

» = Allter

Note: The 'Refresh'’ option is only available if the collection is created from a search.

* To start a refresh in Web Ul, go to the collection content screen, select the desired collection, and click the 'Refresh

collection' action.
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Collection Detail

Clear all EP Export % Refresh collection

Mame . Object Type . Path

Primary Product
Hierarchy/Produc
Root/Apparel
/Mpper Body
Wear/T-shirts,/T-
shirts ltems/Polo
T-shirt/18210 M
B_EN

18210 M B_EN ltem

Note: For more on how to setup a refresh in Web Ul, refer to the Scheduling a Collection Refresh in Web Ul

topic in the Bulk Updates documentation.

Run Bulk Update

This option allows the user to interact with the objects in the collection in a number of ways. To name a few, the objects
could be submitted into a workflow, assigned to a user group, or have an attribute updated.

1. Right-click the desired collection and select Run Bulk Updates.

Tree

~ [ Collections
» = Addresses

~ € darms %! Run Bulk Update

=6 di Export Data Below
1 Alar

Repubiish...
=1 Alar

2. Complete the steps in the Bulk Update wizard to make the same updates to all objects in the collection.
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Bulk Update

Configuration

2. Operations
3. Parameters () Use Existing Configuration

4. Preview © Create New Configuration
5. Advanced

Back Mext Finish Cancel

For more on how to use the bulk update wizard, and the various operations that can be applied to collections or a group
of collections, refer to the Bulk Updates documentation.

For information on how to schedule bulk updates for collections in Web Ul, refer to the Scheduling a Collection
Refresh in Web Ul topic in the Bulk Updates documentation.

Republish

The Republish action generates events on products, classifications, or assets in the collection. Common setup is to use
this option for on-demand creation of a republished event. For example, to generate events for all objects in a collection
that has never been published by an event queue.

For more information on events, refer to the Events topic in the System Setup documentation.

1. Torepublish an event, right-click on the desired collection and select 'Republish...".

Tree

+ [ Collections
» = Addresses

* = alarms %] Run Bulk Update

= Qs i Export Data Below
3 Alar
Repubiish...
3 Alar
» E Allter Refresh

Note: Users must have the privilege to maintain event queues in order to use this action.

© Stibo Systems - Public - 2025.3 - September 2025 237



- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

2. Clicking the action launches a wizard where users can choose the appropriate event queue from the dropdown
menu.
Republish collection
Republish to event queue: Webltems v
Process Description: Republish collection: alarms
Republish Cancel
3.

the 'Republish Node'.

w 5 Republish nodes

%4 Queued Processes

&5 Active Processes

w & Ended Processes
+- Republish collection: alarms

b &5 Revive Recursively
b &5 RuleSetExporter
b &5 RuleSetImporter

BG Processes X
‘.'..‘ .=.. Execution Overview

Search Below

Users can also enter in a Process Description to give a name to the background process, which can be monitored in

If a certain attribute on some of the items in the selected collection needed to be changed, a user could use this to

locate the items.

When a user right-clicks on a collection and clicks 'Search Below', it allows the user to search only the items in that

particular collection.
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Tree X
~ [ Collections
» = Addresses
~ € alarms % Run Bulk Update
=6 di Export Data Below
3 Alar
Repubiish...
3 Alar
» = Allterr

Refresh ‘

» = AlPPH Edit Search Criteria...

» € Backpl X Delete
» = Basket

b & Batter Search Below

Refer to the Navigating and Searching topic in the Getting Started documentation.
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Collection Properties and Statistics

Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can provide a
quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab

The Description and Statistics sections provide information about the selected collection. Below the sections are
described in more detail.

Tree Prod Attr BusRule

~ € Prod Attr BusRule Collection  Data Profle  Log
Il (119975)
I (119977) ription
I+l (5120906)
L (5120907) MName Value
I (5120908) D 5767722
Ll (5120909) Name Prod Attr BusRule
|l (5120910)
L (5120911) Estimated Amount ... 46
|| (5120912) Search URL step://search?exclude0.1=true&args0.0=topnodetypeda3dproduct...
5(5120913) Last edited By 2024-07-19 13:31:49 by USER]

w (5120914)
L (5120915) Statistics
| (5120916)
Il (5120917) Collection Content
I+l (5120918) 46 object(s)
\al (5120919) Motice: Objects in Collection may be hidden in Tree due to Context\Workspace visibility andlor privilege checks
W 11121211 Content by Object Type
li 20808-013 Product (44)
L2 20808-013M |i Sales llem (29)
|- 20808-014M = Sales Item Folder (1)
Level 3{1)

|.. 20808-015M Primary ltem (1)
L 20808-016M | Open Sales ltem (1)
| 20808-017M Attribute (1)
Ll A Special types (1)
|l Acid Green Top Hat (7% Business Action (1)

Description Section

This displays information about the collection:
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Prod Attr BusRule

Collection Data Profile  Log

Description
Name Value
ID 5767722
Name Prod Attr BusRule
Estimated Amount of Objects 46
Search URL step://search?exclude0. 1=true&args0.0=topnodetypea3dpi
Last edited By 2024-07-19 13:31:49 by USER]

ID: Shows the collection ID, which is auto generated.
Name: Shows the name of the collection.

Estimated Amount of Objects: Displays the total number of objects in the collection based on the latest 'Refresh’ of
the collection. The count is not filtered according to Context / Workspace visibility, privilege checks, or object types.

Search URL: Displays only on collections created from a search result. To review the search in the Advanced
Search tab, copy the 'Search URL' text and paste it into the URL field then press ENTER. Itis possible to edit the
search if needed. For more on searching refer to the Navigating and Searching topics in this documentation.

Last edited By: Displays the date, time, and user who last worked on the collection.

Statistics Section

The Statistics section gives an overview of which type of objects are included in the selected collection.
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Statistics

Collection Content

46 object(s)
Matice: Objects in Collection may be hidden in Tree due to Context®Workspace visibility and/or privilege checks

Content by Object Type
Product (44)

|- Sales ltem (28)

Il 'tem Folder (2)

[ Sales [tem Folder (1)
Level 3 (1)
Primary Item (1)

| Open Sales ltem (1)

Attribute (1)
Special types (1)
(2 Business Action (1)

In addition to breaking down the objects by type, it displays the exact number of objects in the entire collection based on
the latest 'Refresh' of the collection.

Note: While viewing the collection in Tree it may appear that there are fewer objects in the collection then what
is reported by the Estimated Amount of Objects field under the Description section or the total objects reported
under the Statistics section. This happens when objects are not approved for the current workspace and
therefore do not show or due to privileges.

Data Profile Tab

The Data Profile tab can display a dashboard to provide a graphical representation of the objects that are in the
collection. This can be modified based on the user's requirement.
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Data Profile X
Colection Data Profie Log
Generated: FriJul 19 2024 13:41 using Standard Profile Config Update Profie >
O Dashboard O Value Detais O Reference Details Default e
_TranslationStatus |
0-10% 36
10-20% B
4 4 W WvEster (5)
M Mot Translated (307 20-30% 0
0b] 0% O
4050% O
[ ApprovalStatys ]
- - 50-60% O
Attribute : | Completeness :
GO-T0% O
Color Add Values| 0%
W Complete fpproved ()
reason 0% W Partly Approved (13) T-60% 0
W Mot Approwved 27) BR-U0% [
Size 0%
GH00% O
Description Long| 0%

Most Complete Attributes Ohject Type Count
Attribute : | Completeness !

M Sales ke (33)

W ftern Folder 2)

[ Prirmary ke (1)

W Sales kern Folder (1)
W Lewel 3 (1)

[ Other object types (1)

Manufacturer N... 100%

Status 2 100%

International Di.... 100%

Path 100%

If a profile has never been created, a user can click on the Generate Profile link to create the collection's
Dashboard.

Colection Data Profie Log

zenerate Profile

Dashboard Value Detais Reference Details

If it has already been created, it is recommended to click the Update Profile link if it has not been updated
recently.
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Colection  Data Profie Log

Generated: FriJul 19 2024 13:41 using Standard Profile Config) Update Profile

O Dashboard O Value Details () Reference Details

For more information on how dashboards and data profiling work, refer to the Data Profiling documentation.

Log Tab

The Log displays details about the creation and modification of the collection, details about which user performed what

actions, and the number of objects in a collection when a collection is refreshed.

Prod Attr BusRule

Collection Data Profile Log

Showing page 1 of 1
2024-07-19 13:31:49 "USER]": Created

2024-07-19 13:31:49 'USER]": Name modified from "'null

2024-07-19 13:31:49 'USERD": Colection refreshed, number of objects: 46
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Entities

This topic covers information specific to the Entity super type that is important to know when working with entities. For
general object maintenance information (applicable to all object types rather than specific to entities), refer to the All
Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used to model customer-related data,
such as contacts, addresses, markets, or customers, though they can be used for any number of data modeling
scenarios, including modeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only use description attributes, the application of category-
specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type validity and all
entity instances of a particular object type will have the same attributes available for population. Additionally, entity
handling is limited for publishing (e.g., as part of print publishing solutions as defined in the Publisher (Adobe InDesign
Integration) documentation), and you cannot translate entities using a background process.

Entities may or may not be subject to approval, dependent upon the revisability settings (globally revisable entities are
the same in the Main and Approved workspaces, while workspace revisable entities adhere to standard approval
concepts). This provides a great deal of freedom in determining how entities are handled, specifically in terms of how
events are generated and processed. For more information, refer to the Revisability on Entity Object Type section of the
Getting Started documentation or the Events section of the System Setup documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination of a
hierarchical display (with source displayed as child to target, or vice versa). In effect, this makes classifications
unnecessary for use with entities as entities can be classified via entities. Additional information on this is available in
the Entity Reference Types section of the System Setup documentation.

However, entities do retain the standard data modeling capabilities and provide even more configurability. The
Revisability parameter allows you to define an entity object type that does not have to be approved and also determines
how events are processed.

Entity Hierarchy

Any number of entity hierarchies can be added to any system. For example, you may set up address hierarchies,
customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as part of the
implementation process and will likely differ on each system. The following is an example of an entity hierarchy.
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(= Entity Root
¥ &5 Customer Hierarchy

v & Customer A
4 Axel Kiers Veg 11
2E Jesper Jensen

v & Customer B
¥ 3200 Windy Hill Eoad SE
£%| Jane Smith

v & Customer C

For more information on hierarchy setup, refer to the Object Types and Structures section of the System Setup
documentation.

Entity Editor

Once the entity hierarchy is created and description attributes are applied to the entity object types, the next logical step
is to start entering values.

Every entity editor includes a References, Referenced By, Status, State Log, and Tasks tab. The labels on these tabs
remains constant, while the label of the first tab differs based on the object type. Each is defined below.

Note: Only description attributes can be applied to an entity object types and will appear in the entity editor.
Specification attributes are not allowed on entities.

Additional tabs may also be included based on other functionality or Component Models in use for the entity object,
such as Data Containers (as defined in the System Setup documentation), Matching, and Proof View.
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e Axel Kiers Veg 11
) ~ Address s Revision: 0.1
~ B3 Entity Root
~ &1 Customer Hierarchy Address Data Containers  References Referenced By Matching Proof View
~ & Customer A
4t Axel Kiers Veg 11 Description
25 Jesper Jensen Name VEIE

~ & Customer B

¥ 3200 Windy Hill Road SE D ADPD_5594305
&5 Jane Smith Name Axel Kiers Veg 11
v & Customer C Object Type Address
Rewvisian 0.1 Last edited by USERJ on Wed Feb 28 14:53:31 EST 2024
Path Entity hierarchy root/Entity Root/Customer Hierarchy/Customer AfAxel Kier...
City aec | Hojbjerg
Country Rec | Denmark
State ABC
Street REC | Axel Keirs Vej 11
v Zip Rec | DK-B270

For example, the image above shows an entity modeled as an address. The entity object has several description
attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute can be modified and
maintained. Since this entity object type has been modeled to be globally revisable, approval is not applicable.
Therefore, the Approval Status field is not shown.

References

You can view associated references of an entity object by selecting the References tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an entity object will list valid references. In this tab it is possible to maintain references
from the selected entity to other objects.

Refer to Reference Types topic in the System Setup documentation for more information.
An entity can reference a number of different objects. It is possible to create:

Entity-to-Entity references

* Entity-to-Product references

* Entity-to-Classification references

* Entity-to-Asset references
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In the example below, one entity-to-entity reference type is valid on the selected entity object. Clicking the plus
sign (+) button opens an editor for selecting objects to be referenced. Alternatively, you can type the name of an
object in the target field and press Enter.

Tree Customer A
~ 3 Entity Root CD_Customer » » Revision: 0.4
w ({8 Customer Hierarchy CD_Customer Data Containers References  Referenced

w & Customer A
4} Axel Kiers Veg 11 Ungrouped Entity References
&3 Jesper Jensen Reference Type v Target

» 2 Customer B S

2 Customer C Affiliate Of + | 1J | & Customer C X

* Targets can be unlinked by clicking the delete () button.

* Metadata attributes can be linked on the target reference in References tab.

Reference Type v Target Completeness Score

Affiiate Of + | 1| & Customer C

* The attributes that are linked on to the target reference are editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

For the meta attributes to be visible on target reference type, add the required description attributes under the Valid
Attributes section in System Setup under Reference Type.
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Affiliate Of

Reference Type  Valdity  Log

~ Description
Name : ¢ | Value
D AffilateOf
Name Affiiate OF
Last edited by 2015-11-05 15:18:34.0 by LA
Externally Maintained NO

Dimension Depend...

Allow multiple refere... Yes
Mandatory No
Parent/Child relation MNone
Inherit Privileges No
Inheritance None

> In Attribute Groups

~ Valid Attributes

ID { | Name

Completeness Score Completeness Score

Add Attribute

Referenced By

Selecting the Referenced By tab on an entity displays valid Reference Types. In this tab, you can maintain
references from other objects to the entity. Refer to Reference Types in the System Setup documentation for more
information.

An entity object can reference a number of different objects, including:
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¢ Product-to-Entity reference

Entity-to-Entity reference
¢ Asset-to-Entity reference
* Classification-to-Entity reference

In the example below, one entity-to-entity reference type is valid from an entity to the currently selected entity
object. Clicking the plus sign (+) button opens an editor to select objects that should reference the current entity
object. In the example, a reference from the 'Customer A' entity is made to the current entity object.

Customer C
CD_Customer = « Revision: 0.2

CD_Customer Data Containers References Referenced By

Referenced by Objects
Reference Type v Source

Affilate Of +| 13| & customer A X

* Metadata attributes can be linked on to the target reference in Referenced By tab.

Referenced by Objects
Reference Type ~ Source Completeness Score

Affiiiate Of +| 13 | & Customer A X

* The attributes that are linked on the target reference can be edited once the target reference is linked to the
entity reference type as shown in the above screenshot.

* To display the meta attributes on target reference type, add the required description attributes under Valid
Attributes section of System Setup under the Reference Type. Refer to the References section above for an
image.

Status

A record of all the changes that have been made to a currently selected entity will be displayed. This record will allow
you to examine the user that made the change and when the change was made.
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Customer A I
CD_Customer » 5% Complete » Revision: 0.4
CD_Customer Data Containers References Referenced By Matching Proof View Status .. >
~ Revisions
Revision : | Created . | Edited ¢ | Major ¢ | User : | Comment
0.4 Tue Nov 05 10:45... Tue Nov 05 11:3... USERJ Auto generated - elapsed time
0.3 Wed Feb 28 14:5... | Wed Feb 28 14:5... USER] Auto Generated
0.2 Wed Aug 28 15:3... Wed Aug 28 15:... USERB Auto Generated
0.1 Wed Jun 14 19:5... | Wed Jun 14 19:5... USER4

> Hidden values

> Diagnostics

You can purge past revisions or revert the old revisions. There is no Workspace, Translation, or Approval Status
sections since entities can be created as globally revisable, meaning they are the same in both the Main and

Approved workspaces.

However, Workspace, Translation, and Approval Status sections are displayed if an entity object type is created
as 'Workspace Revisable' as illustrated in the below images.
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Revisability on object type
Model

Entity user-type root

Object Type  References Log

“ Description
Name : : | Value
ID Model
Name Model
Last edited by 2024-11-05 11:58:39 by USER]

Mame Pattern

ID Pattern MOD_[id]

Enable Profiling NO

Default Profiing Configuration

InDesign Template Allowed Yes

Tcon a2

Dimension Dependencies

. | Revisability Workspace Revisable |

Reference Target Lock Policy Strict
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Status tab for a workspace revisable object

Jody Miller

Model = » Revision: 0.2

Model Data Containers References Referenced By ProofView Status Log Statelog Tasks

Revisions
Revision Created Edited Major User Comment
0.2 Fri Mar 10 15:3... | FriMar 10 15:4... USERJ] Auto Generated
0.1 Mon Oct 01 16:...| Mon Oct 01 16:... USER4
Workspaces
D Name Path
Approved Approved Approved 0.2
Main Main Main 0.2

Approval status in all contexts
Hidden values

Diagnostics

State Log

The State Log tab displays the history of the selected object across all workflows. If the object has ever been in a
workflow, a section is displayed per workflow and the history of transitions of the object within that workflow can be
viewed. Detailed information on the State Log tab is available in the State Log Tab topic in the Workflows
documentation.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges (only
tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the user is
able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More information on
the Tasks tab is available in the Moving Tasks through a Workflow in STEP Workbench topic in the Workflows
documentation.
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Products

This topic covers information specific to the 'product' super type that is important to know when working with products.
For general object maintenance information (applicable to all object types rather than specific to products), refer to the
Object Maintenance in the Tree Tab topic.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product number, etc.
In other words, any item that a company sells that can be ordered.

Product Hierarchy

The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy. The
product hierarchy consists solely of objects of the product super type. The product hierarchy is an organized hierarchy
where all products in the workbench are stored. This is also where products and product attributes are linked. Although
configurable, the product hierarchy is usually a multi-level hierarchy—each level controlled by its own unique object
type. Super users can control the naming convention(s) used to categorize the products at their different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually designed to
take advantage of this capability, with objects classified according to similar characteristics. More information on
inheritance is available in the Inheritance in the Product Hierarchy topic.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete objects are
represented by cubes.
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Tree

P [ Suppliers
» [C] Web Sites
» [T) Customer Root
» (T GDSN
» I Publications
* [0 Primary Product Hierarchy
w [ Products
[0 Apparel
b [0 Upper Body Wear
¥ [] Head Wear
* [0 Hats and Caps
~ [ Hats and Caps Items
Ll 20803
|l 20805
L. 109011
L 111989
L 123117
L 123118

All objects of the product super type must exist in the product hierarchy, and may exist only once (e.g., each object
can have only a single parent). The primary purpose of the product hierarchy is proper attribution of products. That
is, in the product hierarchy, products should be grouped according to their similar properties so that inheritance of
attributes, attribute values, and references can best be used. Based on this, it is evident that the Product Hierarchy
is not intended to be used for modeling website hierarchies or other taxonomies (e.g., merchandising hierarchy,
sales hierarchy, etc.) where an object can be represented multiple times. When a product needs to "live" in more
than one location, that can be accomplished using classification hierarchies. In this case, the product continues to
exist in the product hierarchy (and this is considered its true place of residence). It is then linked into one or more
classification hierarchies using references.

Product Editor

The Product Editor is displayed when an object of the product super type is selected in Tree.
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PROD
Tree 20808-013
Sales Item » » Revision: 0.44
» [ Publications
[ Primary Product Hierarchy —

5 Products -
» & Alarm Clocks Product Data Contaners Sub Products References Referenced By Images & Docu...
» 5 Alarms
~ B Apparel Description
¥ [0 Head Wear . -
5 Hats and Caps Name ] : | Value
» Wl Cap Items D 101567
» Wl Hard Hat Ttems Name 20808-013
* [0 Hats and Caps Sales Items
| 20808-013 Object Type Sales Item
|| 20808-013M Revision 0.44 Last edited by USER] on Wed Nov 06 08:13:42 EST 2024
L2 20808-015M Approved (! Last Approved on Fri May 12 15:02:51 EDT 2017
|- 20808-016M
Translation Mot Translated

|« 20808-017M
| Product A Path Primary Product Hierarchy/Products/Apparel/Head Wear/Hats and Caps/Hats an...
» 2 Audio Visual Equipment

Parent Jfx | Hats and Caps Sales Items
» 2 Automative
» 2 Buiding Products (i’ Category Specific Attributes
» 3 Electronics . .
» = Footwear Specifications
» 3 Furniture Sales Ttem Marketing Descriptions
» 2 Games N val
ame alue
» 2 Hardware
» 3 Miscellaneous Description, Table nec | 100% Cotton 6
» 3 Party Supplies Description, Web rec | 100% Bomuld
» [5 Safety
, 100% Murano Wool, Unstructured, Soft Crown, Low-Fitting, 6-panel cap, Seamed
2 School Supplies Description Long st | Front Panel without Buckram, 6 Rows Stitching on Visor, Matching Fabric
» 3 Wedding Undervisor, Matching Fabric Adjustable Hook and Loop Closure, One size fits most.
» B3 Discontinued Products Feature Bulet 1 mec | Unstructured, Soft Crown, Low-Fitting

If the object has a primary image referenced, a thumbnail version of it displays. The reference type to be used
for the thumbnail display is controlled in System Settings (on the Users & Groups node). Additional information
on this is available in the Primary Image Type topic in the System Setup documentation. Additional general
information on references is available in the Reference and Link Types topic, also in the System Setup
documentation.

The Product tab (known as the Product Editor) is the primary interface for working with product objects in the
workbench.

The Description section displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in the Tree Tab topic. Some information displayed is common for
all implementations, while other information is specific to the data model and configuration of each system.

Specification attributes are displayed in sections, with the section name matching the attribute group.
Sections can be expanded / collapsed. When attribute groups have sub-groups, configuration determines
whether the parent group or the child sub-group is displayed as the section name. This is set via the 'Product
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Editor, Group attributes by top group' parameter in System Settings (on the Users & Groups node). Additional
information on this is available in the Product Information Manager Default Settings topic in the System Setup
documentation. More general information on attributes is available in the Attributes topic, also in the System
Setup documentation.

5. Attribute values can be edited by clicking into any editable field. Additional information on the various editing
options is available in the Editing Objects in the Tree Tab topic. By default, attributes are displayed in
alphabetical order within each section. However, if an attribute display sequence has been configured, this
overrides the alphabetical sorting. More information on attribute display sequence is available in the Display
Sequence Attribute topic in the System Setup documentation.

Additional Editors

Refer to the additional topics listed below for information on the other editors available on products.

* Category Profile: Allows users to configure and view profiling data and dashboards for the objects under the

selected node. Refer to the Data Profiles topic in the Data Profiling documentation for more information.

Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists are often
used to store pricing information. Refer to the Commercial Data section of the Publisher (Adobe InDesign
Integration) documentation for more information.

Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from parental
objects). Refer to the Images & Documents Tab topic within this guide for more information.

Product Variants: Allows the user to generate and manage a family of products, which are basically the same, only
varying on the values of a small sub-set of their attributes. For example, clothing and shoes both offer good use
cases for product variants as these items may come in multiple sizes and colors, but are otherwise identical. The
product family holds all data for the item (e.g., a particular shoe), while the variants hold only the various
combinations of the color and size varieties (e.g., size 7 red, size 8 blue, etc.). The Product Variants tab is only
displayed if the system has been configured to support variants. For more information, refer to the Product Variants
topic in the System Setup documentation.

Proof View: Allows users to preview a close representation of how a product will look when mounted onto an
InDesign page based on a selected publication version and product template. For more information, refer to the
Print Proof View section of the Publisher (Adobe InDesign Integration) documentation.

Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit these
references. Refer to the Referenced By Tab topic.

References: Allows users to view all objects that the current object references, and add / remove / edit these
references. Refer to the References Tab topic.

State Log: Allows users to view the recent history of the object across all workflows in which it has been entered.
Refer to the State Log Tab topic in the Workflows documentation for more information.
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Status: Allows users to view basic information about the object, including revision history, translation status, and
approval status. Refer to the Status Tab topic for more information.

Sub Products: Allows users to view and edit all child objects of the selected object in a table format. Refer to the
Sub Products Tab topic for more information.

Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information, refer
to the Tables documentation.

Tasks: Displays all active tasks across all workflows for the selected object, subject to the user's privileges (only
tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the user is
able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More
information is available in the Moving Tasks through a Workflow in STEP Workbench topic in the Workflows
documentation.
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Inheritance in the Product Hierarchy

Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the child
products that exist under the parent product can inherit the value - meaning that the value is present on the child,
as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the value can be
locally edited on the child (e.g., a different value supplied so the child no longer inherits the value from the parent).
Note that value inheritance also applies to references, meaning that if a reference is populated on a parent, itis
also available on the child in the same way as an attribute value. However, references must be explicitly
configured for inheritance to be in place, while attribute values will automatically inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. This means that
attributes can be linked to specific nodes / categories so they only appear for those categories and their children. For
example, consider a company that manages data for both batteries and clothing. Size might be applicable to both
categories of objects since both batteries and apparel have sizes assigned. However, sleeve length and voltage are
characteristics applicable for clothing and batteries, respectively, and it could be confusing to have a 'Voltage' attribute
on a clothing item. To avoid this, the 'Voltage' attribute could be linked to the 'Batteries' category, while the 'Sleeve
Length' attribute could be linked to an 'Upper Body Apparel' category.

Inheritance perpetuates throughout the hierarchy, no matter how many levels are present (e.g., inherited attributes and

values appear on children, grandchildren, etc.). When attributes are considered applicable to all products, regardless of
category, they are called 'global attributes'. For example, attributes such as Price, Description, and Manufacturer Name.
Thus, these attributes are linked to the top level in the product hierarchy and are inherited down to all products beneath,
no matter how many levels there are.

Attribute inheritance only means that the attributes are available for all of the products beneath where they are linked.
The process of linking attributes to different levels does not have anything to do with the actual values that will go into
the attributes for any particular product. In the 'Voltage' example, when linking that attribute, you are only concerned
with making that attribute available to all the battery products—not with the actual voltage for any given product.
However, if many batteries under a parent shared the same value, the value could be populated on the parent to inherit
down to the children. Any children varying from the parent value could then be edited individually, while those having
the same value as the parent do not need to be updated further. Note that attribute inheritance within the product
hierarchy is only available with specification attributes, and is not available with description attributes. Further note that
this topic focuses on inheritance solely within the product hierarchy. However, it is important to be aware that attribute
inheritance can also be used within classification hierarchies that are used to organize product objects. Attributes can
be linked to a classification, making them available for all products linked into that classification (or a child
classification). More information on attribute inheritance with classifications is available in the Classifications topic, and
the Attribute Links topic in the System Setup documentation.
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Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a level
too high in the hierarchy. With such a setup, a single change could mean that thousands or millions of products
would have to be updated in downstream systems and many systems are not geared to handle massive feeds
like that.

When working with products and/or creating new products, users should be mindful of inheritance, considering
both the inheritance of the available attributes, as well as their specific values or references. It may be helpful to
consider the following:

* Isthe hierarchy granular enough to allow products within the category to be grouped so that all products only

have the relevant attributes, or are additional category levels required to obtain this granularity?
* Which attributes are required for the products in the category and/or subcategories?
If product variants are used, which attributes should be maintained at the family level and which ones should
be maintained at the variant level?

Note: Data can also inherit from dimensions (e.g., language or country). More information on this is available in
the Dimension Dependent Data section of the Contexts topic in System Setup documentation.

Linking Attributes to Products

To make attributes valid for products, they must be linked to the appropriate tree nodes in the product hierarchy. Some
attributes will be global attributes (applicable to all objects in the product hierarchy) and are linked to the “Product
Hierarchy” root node. These global attributes are then valid for all products. Other attributes apply only to specific
categories of objects, and are then linked directly to those categories, making them available for all objects within that
category (if also set as valid for those object types). Attributes should not be linked to individual leaf objects, as each
one would have to have the link individually applied. Instead, attributes should be linked to some parental folder in the
hierarchy above the objects needing to use the attribute.

Before proceeding, be aware of the following:

* Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes are made available for the children "under" the node at which they are linked
(being mindful that "under" means "actual children" in the product hierarchy, whereas it means "objects with a
reference to" when dealing with classifications).

* Linked attributes apply only to objects of the product super type. For example, linking attributes to a
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classification object that holds assets does not make those attributes available on the child assets.

¢ Only Specification attributes can be linked to products or classifications. Description attributes cannot be linked

attributes.

Linking Attributes

1. Select the product group or classification and click the References tab.

2. Expand the appropriate section and then click Link to Attribute.

* Linked Attributes from Product Hierarchy on product objects

Tree x

¥ [0] Electronics
 [0] Electronic Accessories
* [0 Power
» [T Batteries Leveld
[C] Batteries X
» B Batteries Items
MR Batteries Deco Items
w 7] Batteries SalesItems
|2l 20882-012 AA Battery
| 20881 AA Battery 2 Pk

*® Attributes on classification objects

Tree >

[ [lcons
&) (ADA_Icon)
%] CalGreen_Icon
&) CalGreen_Icon_Large
&) Icon Asset
'&| LeadFree_Icon

Co—

20881 AA Battery 2 Pk

Item = Revision: 0.8

Product Data Containers

Sub Products

References  Referenced By

Linked Attributes from Product Hierarchy

D MName : | AL
) AirTransportatbnRestrk:t‘nons Air Transportat‘non Restrictions
" | AnnualSalesForecastMaximum | Annual Sales Forecast, Maximum
"| value Value
| Link to Attribute |
Icons
Icons = Revision: 0.1
Classification  Sub Products  References  Referenced By
Attributes
D Name Attribute G
Link to Attribute

3. Inthe standard search / browse window that displays, locate the appropriate attribute(s) and click Select.
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Localizing an Attribute Link

Local attribute links can be created to override inherited attribute links.

1. Select any existing inherited attribute link and right-click on the row indicator.
2. Select the Create Local Link option.

Linked Attributes from Product Hierarchy

DisplaySequence : | ID : [ N
Hide s ¢
Show All Columns s | (1

B A

Link to Attribute Ctri+Plus | | o
Ctrl+Minus

. A

Create Local Link

PRAT I MSAFTIiCE &

This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the same way as inherited links, though removing a local link re-applies the inherited link.

Unlinking a Linked Attribute

Unlinking an attribute does not delete the attribute from STEP; it removes the link so the attribute is no longer
available for population on the selected node (and child nodes, if applicable). Note that attribute links must be
removed from the same node to which they were added. In other words, trying to remove an inherited attribute link
is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it must be
removed on the parental object that holds the link. However, care should be taken in doing this as it will remove
the link for all child groups, and will need to be re-linked at those lower child levels if it is still needed there.

1. On the References tab of the object, expand the appropriate section (Linked Attributes from Product
Hierarchy on product objects or Attributes on classification objects).

2. Right-click on the row indicator and select Remove Link to Attribute from the context menu (or use Ctrl + “-”).
Multiple attributes can be unlinked simultaneously by multi-selecting.
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Note: If an attribute has been linked locally, removing the link only removes the local link, and the inherited
link will again take effect.

Product Data Containers  Sub Products  References  Re

Linked Attributes from Product Hierarchy

DisplaySequence : | ID : | Name
Attrsize
Hide
Show All Columns AttrTShirtSize
Availability
Link to Attribute Ctrl+Plus Avaiabiiity En

Remove Link to Attribute Ctrl+Minus
Avaiability 56

Additional methods for maintaining attributes links

Attribute links can be added and removed in a number of ways, in addition to what has been described above. These

include:

* References tab of the attribute itself
* Maintain menu, then Link menu when a product or classification is selected

* Edit menu, then Link to Attribute / Remove Link to Attribute menu when a product or classification is selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values
There are many advantages to setting common values:

* When an update is needed, the value is only entered once in the product group instead of - potentially -
separately, across hundreds of products.

* When new products are added to the group, they automatically inherit the product group’s values.

* The translation of product group values only need to be performed once, as opposed to translating the same
value every time for individual products.
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As mentioned above, it is possible to set attribute values for an individual product, but consider a situation where all
products within a product group share common attribute values. For example, a set of hats that share a common
description and features.

There are two ways to approach this: 1) keep all common values with the individual product or 2) set the common value
at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the attribute value is inherited
down to all products beneath.

Tree 20808-013
TR e Sales Item » + Revision: 0.18
¥ [T] Apparel
~ 51 Upper Body Wear Product Data Containers  Sub Products References Referenced By Images & Documy
» [ T-shirts . -
Sales Item Marketing Descriptions
¥ [0 Head Wear
v [ Hats and Caps Name Value
» BB Hats and Caps Items 100% Cotton, Unstructured, Soft Crown, Low-Fitting, 6-pane
~ [ Hats and Caps Sales Items Description . Buckram, 6 Rows St'rtchirjg on Visor, Matching Fabric Undervis
s and Loop Closure, One size fits most.
| 20803-04 Description, Nickname | Rec
P LA Description, Short RABC
Ll 1112121 o
\i ThickPad X1 Carbide Do Teds e
lLal AC-XNPR746 Description, Web REC
t 812222 Feature Bullet 1 mac | Built-in sweatband wicks away sweat to keep you cool & dry
L (143931) Feature Bullet 2 mac | Stretch construction provides a comfortable fit

The image above shows three inherited values, which are designated by a green down arrow (™).

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products beneath will
inherit the same value.

Itis possible to override an inherited value by setting a different value at any subordinate level, e.g., the product level.
This is called a localized value. However, this requires that the attribute be valid for the child object type (as is the case
for the inherited values shown in the screenshot above). Attributes that display as inherited (indicated by the green
arrow) but not editable (e.g., value field is yellow rather than white) are not valid for the object, so they can only have a
common value with all sibling products, which is inherited from a parent higher in the hierarchy. Detailed information on
setting validity of attributes is available in the Validity on Specification Attributes topic in the System Setup
documentation.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental value.
Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object has the null
value).

For information on working with and/or setting up inherited reference values, refer to the Inheritance Example for a
Reference topic of the System Setup documentation.
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Images & Documents Tab

When working with products, the Images & Documents tab displays thumbnails of all assets that are referenced by the
selected product, or inherited from a parental object referencing the asset. When working with classifications, this tab
displays all assets that are child to the selected classification. The functionality for working with the displayed assets is
the same, regardless of whether a product or classification has been selected.

Tree Cotton T-shirts
¥ [0 Products Item Family » Revision: 0.25
v [T Apparel
¥ [T] Upper Body Wear , R .

¥ [0 T-shirts
~ Wl T-shirts Items
» Bl RoundNeck - T- |
» Bl Polo T-shirt
|« Supplier A - Teemr
» Wl T-Shirts Family

Referenced By Images & Documents  Commercial Ta...

<< Previous Fiter 1-20f2 Next ==

Il t-shirt r
Il T-=hirts =
H ER B
[l Coftton T-shirts
A Hanes Blue Hanes Family
|.. 4-PackMaroo
L 4-Pack Marox 191 x 332 px 194 x 305 px
674 KB 797 KB
| 4-Pack Maroc
Product Image » Primary Product Image

If more than 50 assets are present, the Next / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially useful
when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size, file
size, and reference type used to link the asset to the selected object.

Interacting with Assets

From the Images & Documents tab, several actions can be taken with the displayed assets.
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Edit asset

By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image to a disk
or local PC, and view the image on a larger scale.

Referenced By Images & Documents  Commel

<= Previous Fitter
% Edit Asset
External Viewer
= Save to disk
Image Viewer
Hanes Blue

10T v 22T

Edit reference type

The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdown will be disabled (grayed out) if there is only one valid reference between the object type and
asset type. If multiple valid reference types are available, selection of the reference type is enabled and can be edited
from this location. More information on references is available in the Reference and Link Types topic in the System
Setup documentation.

Filter the displayed assets

A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays assets that
have the entered value as part of the asset name, as shown below.

Note: The filter automatically applies wildcard functionality so explicit entry of wildcards (*) is not needed.
Entering an asterisk will cause the system to search for assets with an asterisk in their name.
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Product Variants

Sub Products  References  Referenced By Images & Documents %

<< Previous

Hanes Blue
191 x 332 px
674 KB

Product Image ~

Fiter || 1-40f4

[
Hanes Family HanesGrayT
194 x 305 px 147 % 164 px

797 KB 3KB

Next ==

HanesGreenT
300 x 300 px
6 KB

To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset

Referenced By

Cotton T-shirts

Item Famity « Revision: 0.25

Images & Documents  Commercial  Tables

<< Previous

Filter | family 1-10of1(4total)

Hanes Family
194 x 305 px
797 KB

Primary Product Image

Next ==

mage

- |STIBOSYSTEMS
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The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates directly to

the asset in the classification structure.
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Product Overrides

Product overrides are alternate versions of products and product families that may have differing values, references,
links, and structures. Attributes and values applied to the product family are inherited to the product override and can be
replaced with local values and references on the product override. Product overrides allow product objects to exist in
multiple locations in the product hierarchy and are the primary building blocks for many print product presentations. A
product override allows for the creation of 'pseudo’ product families that are flexible to ever-changing print
presentations. They can be thought of as a workaround for when an existing product family does not contain the exact
products needed for a publication layout and/or its accompanying STEP table(s).

A product override folder can include products from various "standard" (e.g., non-override) product families. Similarly, a
product override leaf object can live under a different product folder (override or standard) than the folder in which its
corresponding standard object resides.
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Tree “ || 104061-Override
] ) Standard Product-Override s Revision: 0.8
¥ [ Primary Product Hierarchy
» [3 Products Product SubProducts References Referenced By Images & Doc...
} 3 Discontinued Products o
ov [ Product Overrides ~ Description
b & (115606) — LED Pocket Flashiight Name Value
WA (115607) — Flashiights SalesItems D 104061
v [Clevel 1 y
Name 104061-Override
¥ [ Level2
b &l (104061-Override Object Type Standard Product-Override
b @ 115111-Override Revision 0.8 Last edited by USERY on Wed Jan 03 05:13:3
b @ 115605 — 2 inch heels o X .
Approv Never Been Approv
& 121537-duplcate 2 inch hee! PP PP
WA 121926 — 2-Pack Maroon T Translation Not Translated
@ 128818 — Level2 Path Primary Product Hierarchy/Product Overrides/Leve
W 128902 — 18214-012 e prog
Overridden Product
b & 128917 — T-shirts
o 128918 — 18214-012 Completeness Score | B3
& 128919 This product is overridden by 0 product overrid
GetOverriddenByPr...| Jx P DT TR
» & Flashiights Item Override — F ByPr...| f
b I Packaging Compare this with Overridden product
b B GDSN Products
¥ [ Translation Products e ' Attribute Group
> M PG-1301 Name Value
I ECLASS ADVANCED Product Root o
; ABC ium
» B Colections —

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from standard

products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and references

of a product / product family. This is useful in order to publish a limited version of a product family without modifying the

object itself.

Example
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E]|'_= Product Overrides
E|1'_= Level 1
EHLT) Level 2
= | [104061 — Ski Jacket Pro]
- g SKU 00001
L@ SKU 00002
G-l Packaging
=[] Regional Products
E|r_=| Apparel
=) Winter
E=I-I5) Winter Coats
=+ Ski Jacket Pro
- SKIU 00001
@ 5K 00002
g SKU 00003

In this example a product family Ski Jacket Pro has three products. A product override 104061 is created and based on
the product family Ski Jacket Pro. Attributes, values, and references are inherited from the product family Ski Jacket
Pro to the product override folder and can be replaced with local values and references on the product override.

Two products from the product family Ski Jacket Pro are linked into the product override folder (SKU 00001 and
SKU 00002). The product override only contains a subset of the products included in the original product family Ski
Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked into the
product override. These products will have their values inherited from their original structure instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow down arrow icon ( ggr ), if

an attribute or reference is inherited from an overridden product. Inherited values and references can be replaced with
local versions, assuming the relevant attribute and/or reference is valid on the relevant product override object type.

Creating a Product Override

1. In Tree, select an object for which an override should be created.
2. Right-Click and select New Product-Override
3. Inthe Create Product-Override dialog,

© Click an Object Type

® Keyin ID and Name

o Optional: Click the ellipsis button ) to select a product family to adapt values, references, and links from. The
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product-override will inherit all values, references, and links from the selected product family.

° Optional: Click 'Adopt Children' if the product-override should also include all products from the overridden

product family.

4. Click Create to create the product-override.

Linking Products into a Product Override

1. In Tree, select the product override

2. Right-click the product override and select Add Children to Override

3. Search or Browse for the products to be linked into the product override

Removing Products from the Product Override

* InTree, selectthe product override

* Expand the product override and select the product to be removed

* Right-click and select Remove Child from Override

Creating a Subordinate Product Override

1. In Tree, select the product override
2. Select a product linked into the product override

3. Right-click the product and click Convert to Product-Override

The product will be converted into a product override. Values, references, and links will get inherited from the

overridden product.
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Referenced By Tab

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that the

selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In addition, if the

object is used by product overrides, has a match code acting on it, or is used by any publication, that information can be

viewed on this tab. Finally, privileges assigned to the product can be added and edited from this location, and

subproducts that are present only in other contexts can be viewed (if the object is of a dimension-dependent object

type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data model.

Tree

5 Jeans
~ 3 Shoes
* 3 Pumps
» Wl Pumps Items
¥ [0 Pumps SalesItems
w [ Stuart Weitzmal
|l 20709
| 20738
| 20710
| 20711
» 5 Furniture
b 5 Games
b 5 Hardware
» 5 Kitchen
» 3 Lunchboxes
» 5 Miscellaneous
» 5 Musical Instruments
» [ Parker Jackets
» 3 Party Supplies
» 3 Safety
» 5 School Supplies
b 5 Wedding
» BB Discontinued Products
» = Product Overrides
» B8 Packaging
» I3 External Products
» Wl GDSN Products
» & Boards
& Fashion Board
B ECLASS ADVANCED Product Re
» I ACME Onboarding Training Root
[ ECLASS ADVANCED Products
» B Colections
» [& eCatalogs
» &% Rervcle Rin

20709
M Sales Item » * Revision: 0.7
[
Product Data Containers Sub Products References Referenced By Images & Documents
Object Data
Reference Attributes
o Sales Item References, Product
Reference Type v Source Thumbnail Equivalence Ra...
Accessory Optional + \‘=§*_ X
Accessory Required + \'=§*_ .
9 Referenced by Products, Classifications or Entities
Reference Type v Source
B Used By Product Overrides
D Name Path
o Linked into Product Overrides
D Name Path
B Used by Match Code Objects
D Name
B Used on Page
Publication Version Page Area Used Page Type
(@) Applied Privileges
Applie... Action... Attrib... Objec... Group Langu... Country
Add Priviege

P Visible Sub-Products in Other Contexts
No Visible Sub-Products in Other Contexts

1. Reference Sections: References can be placed in attribute groups for display purposes. All references for which the

selected object is a valid target that have been placed in attribute groups will display first on the screen, with the

section title being equal to the name of the attribute group. References can be added by clicking the (+) on the
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reference. This will open a dialog allowing the user to select a source for the reference, and a reference will be
created from the object selected in the dialog to the currently selected object that you are standing on (e.g., current
object = target, dialog selection = source). If any attributes are available on the reference and editable, they can be
edited within this interface. References can be removed by clicking the (X) on any existing reference. Additional
information on configuring and working with references is available in the Reference and Link Types topic in the
System Setup documentation.

2. Referenced by Products, Classifications or Entities: The functionality is identical to what is described for the
Reference Flippers section above. The only difference is that this area displays references that have not been
placed in attribute groups for display purposes.

3. Used By Product Overrides: Displays product override objects that are based on the selected object. More
information on product overrides is available in the Product Overrides topic.

4. Linked into Product Overrides: Displays product override objects that have the selected object as a child. More
information on product overrides is available in the Product Overrides topic.

5. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match code will
display. For example:

Find Similar
~ [ Match Codes and Matching Algorithms Match Code
-I FEusery Match Code  Match Code Values — Statistics  Log
-I- Find Similar Definition
-I- FindSimiarwEmbedded
i~ Name Value
L Fs D FindSimiar
I Individual MA Name Find Simiar
-I- Individual Matching ]
Last edited by 2017-12-05 04:56:49 by USERY
- wEmbed
‘1< TwoEmbed Category T-shirts and Sweatshirts (22586) I
» 5 Outbound Ini : /
» £ PDS Inbound | | 1 78€ T-shirts and Sweatshirts
+ [T Web Sites Web Level 3 » Revision: 0.8
~ 2] Acme Retail Web Site Classification  Sub Products  References Referenced By Images & Docy
~ [ Apparel Al
+ [ Mens Casual Website Display
P [T Caps
[ Mens Tops Ungrouped Referenced by Products, Classifications or Entities
» [ T-shirts and Sweatshirts
» (5 Women's Apparel Used by Match Code Objects
» [T Automotive D Name Edited by
» L1} Buiding and Electrical Products FndSimilar Find Similar 2017-12-05 04:56:49 by USERY
» [ Sales Promotions

More information on match codes is available in the Matching, Linking, and Merging documentation.
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6. Used on Page: Displays publications that the selected object is used in. Additional information about working with
publications is available in the Publisher (Adobe InDesign Integration) documentation.

7. Applied Privileges: Displays the privileges that have been applied to the selected node. Privileges can be added
using the Add Privilege link, and can be removed by clicking on the row indicator and selecting 'Remove Privilege'.
Existing privileges cannot be edited from this interface. Detailed information on creating and editing privileges is
available in the Privilege Rules topic of the System Setup documentation.

8. Visible Sub-Products in Other Contexts: Displays subproducts that are visible in another context, which is only
applicable if the object type is dimension-dependent. Note that it is not recommended to make product object types
dimension-dependent; instead, it should only be data on objects (e.g., attributes and references) that are dimension-
dependent. As a result, this section is rarely used.
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The References tab is where all references of which the selected object is the source can be viewed and edited

(assuming proper privileges are in place). In addition, if the object has associated index words, is used by any

publication, or has any linked attributes, that information can be viewed and edited on this tab.

The display of the References tab on a product will vary slightly from system to system, based on the data model.

Tree X Item 2
w [ Primary Product Hierarchy ftem » Revision: 0.20
w [ Products
~ [ Apparel Product Data Containers Sub Products References  Reference...
w [0] Upper Body Wear
~ [3 T-shirts » Display
~ W T-shirts Items o » Document References
~ Bl RoundNeck - T-s » Image and Document Maintenance
“ > Item References, Classification
b | Item 3 ~ Item References, Product
Ll Ttem 43 Reference Type v Target Qty
| Ttem 5b
\ Ttem 6 Supplier Replacement Item k] | Blue T-Shirt
L= Ttem 7 > Packaging Hierarchy References
» B Polo T-shirt e
> M8 T-Shirts Famiy e > Ungrouped Classification Links
-Shirts Fami
B Tshirts ~ Ungrouped Product References
» Bl Cotton T-shirts Reference Type v Target
> I Pltem1 Packaging Li... +
» I v-Neck - T-shirts
ProdToProd + W
» [T T-Shirts Sales Items
¥ 51 Head Wear > Ungrouped Entity References
¥ [ Electronics ~ Index Words
» [ Footwear
b (5 Safety Inherited From Index
b [3 Hardware Localy defined Index Words,
} [0 Displays Add Index Word
» [T Furniture
» [ Automotive o * Publications
» [0 Building Products D Name
» [ Food and Beverage
b [5 Kitchen 108373 Acme Wholesale Clothing
b [T Party Supplies Link to Publication or Section
» [0 Sample Products

» b PLM
» [ School Supplies
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Reference Sections: References can be placed in attribute groups for display purposes. All references for which the
selected object is a valid source that have been placed in attribute groups will display first on the screen, with the
section title being equal to the name of the attribute group. References can be added by clicking the (+) on the
reference. This will open a dialog allowing the user to select a target for the reference, and a reference will be
created from the currently selected object to the object selected in the dialog (e.g., current object = source, dialog
selection = target). If any attributes are available on the reference and editable, they can be edited within this
interface. References can be removed by clicking the (X) on any existing reference. Additional information on
configuring and working with references is available in the Reference and Link Types topic in the System Setup
documentation.

Ungrouped References: The functionality is identical to what is described for the Reference sections section above.
The only difference is that this area displays references that have not been placed in attribute groups for display
purposes. If all references that are valid for the selected object have been placed in attribute groups, the Ungrouped
Classification Links and Ungrouped Product References sections are not present.

Index Words: Allows users to view index words linked to the currently selected object, and to link index words using
the Add Index Words link. Index words are maintained in a dedicated hierarchy where it is possible to maintain the
word itself along with a sort word. More information is available in the Creating an Index Words Structure topic in the
Publisher (Adobe InDesign Integration) documentation.

Publications: Publications that the currently selected product is linked to are displayed, and new links can be
created using the Link to Publication or Section link. Additional information about working with publications is
available in the Publisher (Adobe InDesign Integration) documentation.

Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental node in the
hierarchy display under the Linked Attributes from Product Hierarchy section. The exact columns available will
depend on the data model and the attributes that have been made valid on product attribute links. Whether or not
the various attributes are editable will also depend on the setup of the data model. However, an ID and Name field
are always shown, with the attribute name being a hyperlink that can be used to navigate directly to the attribute. An
Attribute Groups column is also present, displaying the attribute group(s) that the attribute is in. A Mandatory column
is present and if checked, the object cannot be approved until a value has been provided for the attribute. Note that
mandatory settings on the attribute itself apply globally, while mandatory settings on the attribute link apply only to
objects that are child of the node at which the attribute is linked. More information on mandatory settings is available
in the Mandatory Attributes topic in the System Setup documentation. If the attribute link is inherited (indicated by a
green down arrow (") in the row indicator), the 'Inherited from' column will display the parental node where the
attribute has been linked, which is hyperlinked for easy navigation. More information on linked attributes is available
in the Inheritance in the Product Hierarchy topic within this guide and in the Attribute Links topic in the System Setup
documentation.

The Linked Attributes from Classification Hierarchy section is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is a member of
(e.g., has a reference to), rather than attributes that are linked to a parental product. The same considerations

© Stibo Systems - Public - 2025.3 - September 2025 276



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

apply in that the exact columns available will vary based on the data model, with ID, Name, Attribute Groups,
and Mandatory columns always being present and functioning in the same way as for product attribute links.
Note that objects shown in the 'Inherited from' column in this case are parental objects not of the selected
object itself, but instead of a classification that is parent to the classification that the selected object references.
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Status Tab

The Status Tab provides general information about objects, including revisions, translation status, and approval status.
For products and classifications, the Status tab displays the same information, regardless of the object type.
Publications, attributes, entities, and assets have slightly different information available, though much of it is common to
what is described below.

4-PackMaroonT-shirtsBR1

Item « Revision: 0.7

> Translation

> Approval status in all contexts

> Hidden values

6
?

Diagnostics

nces Referenced By Images & Documents Commercial Tables ProofView Status Log Statelog Ta..
_gllev'sinns
Revision Created Edited Major User Comment
0.7 Fri Jul 26 09:40:24 ...| Frilul 26 16:59:33 ... USERL Auto Generated
0.6 Thu Aug 31 16:15:...| Thu Aug 31 17:40:... USERB Auto generated - el...
0.5 FriOct 07 15:59:3... | FriOct 07 15:59:3... USERB Auto Generated
0.4 Mon May 16 14:14:... Mon May 16 14:38:... USERJ Auto generated - el...
0.1 Wed Jan 29 12:03:...| Wed Jan 29 12:03:... USERB
* Workspaces
ID Name Path
Approved Approved Approved 0.3
Main Main Main 0.7
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1. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a historical
snapshot of an object. The Revisions section provides a record of the revisions that have been made to the currently
selected object, including when changes to the object were made and who made them. Via right-click, users are
able to purge old revisions or revert to previous revisions. For more information on revisions, including how they are
generated and how they should be managed, refer to the Revisions topic in the System Setup documentation.

2. Workspaces:All the workspaces that the selected products are in will display, as well as the revision number that
exists in that workspace. Generally speaking, if the object has been edited since it was approved, the Main and
Approved workspaces will hold different revisions. However, it should be noted that not all changes to an object
generate a revision. More information on this is available in the Revisions topic in the System Setup documentation.
For more information on workspaces in general, refer to the Workspaces topic in the System Setup documentation.

3. Translation: Translation relations (sources and targets) and status (e.g., Up to date, Re-translation needed, etc.) of
the translations display. For more information, refer to the Translations documentation.

4. Approval status in all contexts: Displays the approval status of the object in each context on the system. More
information on approvals is available in the Approval of Objects topic. More information on contexts is available in
the Contexts topic in the System Setup documentation.

5. Hidden values: Displays hidden inherited values on the object. Hidden values are those that are inherited from
another dimension (e.g., language or country) rather than from a parental object. More information on this is
available in the 'Dimension Dependent Data' section of the Contexts topic in the System Setup documentation.

6. Diagnostics: Displays any issues with the object found by system diagnostics. If a problem has been found, the
information can be copied by clicking the file link.

Problems found. Press button to copy information to dipboard. Please supply this information to Stibo System.
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When the Sub Products tab is accessed on an object of the product super type, all direct children of the selected node
are displayed. If privileges allow, data can be edited on the displayed objects by clicking directly into any editable field.

Standard editing capabilities are available within this interface (as described in the Editing Objects in the Tree Tab

topic) including copy / paste functionality using Ctrl + C and Ctrl + V.

T-shirts

Sales Item Family * Revision: 0.1

Product Product Variants Sub Products References Referenced By Images & Documents  Commer...
Name 18217-0542 18214-012 18215-012
D D 127995 127992 127993
Name Name 15217-0542 158214-012 18215-012
Object Type Object Type Sales Item Sales Item Sales Item
Revision Revision 0.1 Last edited by ... | 0.2 Last edited by ... | 0.2 Last edited by ...
Path Path Primary Product Hi... | Primary Product Hi.. | Primary Product Hi...
Approved Approved X Never Been App...| X Never Been App...| X Never Been App...
Translation Transhation Not Translated Not Translated Not Translated
Classification 1 root | | Classification 1 root | | Classification 1 root |
Index Words | Index Words | Index Words |
Category Category Indexdoc | Epuda Indexdoc | arcimento| Indexdoc |
quam | 18217-0542 | | 18214-012 consequati |
18215-012
override text Alternate Supplier MultiSupplierltem,
Item, PrimaryDataSource,
GetRefTypelD GetRefTypelD Multisupplierltem, PrimarySupplierltem
PrimaryDataSource,
PrimarySupplierltem
Manufacturer Name Manufacturer Name | Manufacturer A
Parent Parent T-shirts T-shirts T-shirts
Apparel | Upper Body| Apparel | Upper Body| Apparel | Upper Body
Wear | T-shirts | Wear | T-shirts | Wear | T-shirts |
Path Path T_Shirte Salac Thame | | T_Chirte Calac Thanne | | T_Chirte ©alac Thamc |

Two views are available using the Rotate Table option. As shown above, the view can be organized to have attributes

on the vertical axis. As shown below, the table can also display products on the vertical axis.

Right-clicking on any field within the table exposes additional options, as shown below. These options can be especially

useful when editing multiple objects.
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Product Product Variants Sub Products Res

ID :
Name : |ID
18217-0542 . [ 17700C
&% Cut Ctrl+X
18214-012 Copy Ctrl+C
Paste Ctrl+V
18215-012 &= Paste Link Ctrl+L
Rotate Table
19317017
Hide Equal

Mark Different
Hide/Show Attributes
Fitter

Edit

Owverride

Recalculate

Right-clicking within the header field exposes different options than within the data fields, including an option to add a

product.
Product  Product Variants  Sub Products Product Product Variants Sub Products  References
1D D . |
N : D Hide —
ame : :
Name - | Show Al Columns |
18217-0542 127ag; _
Hide L 18217-0542 C 127995 sort b
18217-05< i ||
Show All Rows N 18214-012 © | 127992 Fiter
18207-01: Rotate Table 2] ' |
18214-012 Add Product Ctrl+Plus 3.
18715-013 Remove Row(s) Ctrl+Minus ;—
|
1
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Selecting Add Product opens a Create Product dialog allowing the user to input data to create a new object, which
will be added as a child to the currently selected node. The options available in the dialog are based on the data
model defined in System Setup. For example, the object type selection will vary based on the allowable object
types under the selected parent, and ID will only be available for population if the object type being created does
not have autogenerated IDs applied.

Create Product

Object Type

ID 229805

Mame

Create Cancel

Note: The same functionality is available using the Add Product link at the bottom of the Sub Products editor.
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Recycle Bin for the Tree Tab

Objects in the Tree tab Recycle Bin have been deleted from the Tree tab. For information on deleting objects from the

Tree, refer to the Deleting Objects in the Tree Tab topic.

For information on the System Setup Recycle Bin, refer to the Recycle Bin for System Setup topic in the System
Setup documentation.

Considerations

* Objects in the recycle bins are not included when searching from the Advanced Search tab, nor from Search.
Recycle bin objects can be searched using the Search in recycle bin option defined below.

® Attribute values of objects in the recycle bins cannot be edited. If editing is required, the object must be revived.

In the Web UlI, displaying an object that is in the Recycle Bin displays recycle bin images in the background, as shown
in the image below to indicate it is no longer in the primary product hierarchy. Viewing objects in the Recycle Bin is
allowed when the 'Show Recycle' parameter is checked in the Web Ul Tree Navigator component. For more
information, refer to the Tree Navigator Component for Global Navigation Panel topic in the Web User Interfaces

documentation.

To remove the recycle bin background, follow the Resolving Deleted Objects steps below to revive the object, or
permanently delete the object to remove it from displaying in Web UI.

* Deleted PDLs : 2000080964

Customer Details * Customer Specific data to PDL references

NCE » FOODS INC. > 200 removed for : 2000080964
B List stomer PDL
P Delate
g Mame - £
Master_2000080964
Number of items : 1
GTINs on Clavis PDL
_ustomer * CONVENIENCE * FOODS INC. * 2000080964

@ Select all
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Resolving Deleted Objects

Deleted objects in the Tree Recycle Bin can be managed as a group from the Recycle Bin node or individually.

The Tree Recycle Bin can include workspace revisable objects (those that allow approval) which are flagged with

'in Use' if they are in the Approved workspace and flagged with 'Not In Use' when they have not been approved.

For details, refer to the 'In Use and Not In Use Objects' section of the Approval of Objects topic.

Group actions

To address all objects in the Tree Recycle Bin, right-click the Recycle Bin node and choose one of the available options

described below:

Tree

+ 7% Recvcle Bin

E

%Fﬂl‘ﬁl_ﬁl_ﬁ

-

-
-
-

Search in recycle bin

Empty Recycle Bin

Empty Recycle Bin Before...
Force Empty Recycle Bin
Schedule Empty Recycle Bin

Approve Deletion Recursively

Search in recycle bin searches for deleted objects in this recycle bin. In Oracle-based systems, by default this

includes both ID and Name, while the default for Cassandra-based systems is by ID but allows searching

Name via an Advanced option.

The options in the Advanced section vary based on the type of database in use.
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Cassandra Database Options Oracle Database Options

Search in Recycle Bin

Search in Recycle Bin

Search

~ Advanced
[CJ Match Case on Names
[[J Include Names (can be time consuming)

[T Reguilar Expression

Search

~ Advanced

(] Match Case on Names and Values
() Include Inherited Values

() Exclude values

[_] Regular Expression

[J Include Data Containers

Match Case on Names- when checked,
capitalization provided in the search field for an object
must exactly match the name.

Include Names (can be time consuming)- when
checked, searches for matches on name and ID;
when not checked, only IDs are searched.

Regular Expression - when checked, search is
based on the RegEx provided.

Match Case on Names and Values - when checked,
capitalization provided in the search field for an object
must exactly match the name or value.

Include Inherited Values- when checked, inherited
values are also searched.

Exclude values - when checked, values are not
searched.

Regular Expression - when checked, search is based
on the RegEx provided.

Include Data Containers - when checked, values in
data containers are searched.

¢ Empty Recycle Bin attempts to permanently delete all objects flagged with 'Not in Use' in this recycle bin.
Workspace revisable objects are flagged as 'in Use' when Approve Deletion is required, or events / references
exist for the object. The 'in Use' setting prevents the object from being removed. Resolve the reported errors or
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consider the Force Empty Recycle Bin option for test systems, as defined below.

On the Confirm Purge dialog, the Skip Analysis button is enabled while counting the number of objects in the
recycle bin. Review the object counts and click Purge to delete them or click Cancel to close without changing the
recycle bin.

Confirm Purge

o Are you sure you want to permanentty delete these objects:
Assets: 186
Classifications: 5
Entities: 2
Products: 16
Skip Analysis Cancel

Empty Recycle Bin Before permanently deletes only contents deleted before the specified date and time. For
workspace revisable objects, approval of the deletion is required before removal is allowed.

On the Empty Recycle Bin Options dialog, click the ellipsis button ) to display the Date Picker and set the date

and time. Click OK to close each dialog and perform the purge.

[ Empty Recyce Bin Options X

"J Date Picker

Only purge objects deleted before: 2024-11-06 09:30:09 [3\

Year: Month: Day:

nov -~ 06 -~

Hours: Minutes: Seconds:
09 30 09

concel
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On the Confirm Purge dialog, the Skip Analysis button is enabled while counting the number of objects in the
recycle bin. Review the object counts and click Purge to delete them or click Cancel to close without changing
the recycle bin.

Confirm Purge

o Are you sure you want to permanenthy delete these objects deleted before Wed Nov 06 09:30:09 EST 2024:

Assets: 186
Classifications: 5
Entities: 2
Products: 16

Skip Analysis Cancel

* Force Empty Recycle Bin is not recommended for production data since it ignores deletion approvals, events,
and references and purges objects with an 'in Use' status. This option is intended to remove test data with
fewer steps required when ignoring dependencies is not an issue.

* Schedule Empty Recycle Bin allows scheduling recycle bin maintenance, as defined in the Schedule Empty
Recycle Bin topic.

¢ Approve Deletion Recursivelyattempts to remove the selected object and its children from the Approved
workspace, generates a DELETEAPPROVAL event for the objects, and attempts to run the Approve Deletion
action. This option is valid only for workspace revisable objects (those that allow approval) that are flagged as
'in Use.'

If the Approve Deletion Recursively BGP cannot be completed successfully (for example, due to existing
references), the Force Approve Deletion button is displayed in the Approve Deletion BGP execution report.
The Force Approve Deletion button deletes and approves deletion of objects identified in the execution report
with the 'Approve error report' text. ADELETEAPPROVAL event is generated for the deleted referenced

objects.

Important: The 'Force Approve Deletion' button can affect live objects in the Approved workspace since
references may be removed to allow the deletion and approval to succeed.

Individual object actions

To address one or more selected objects in the Tree Recycle Bin, right-click the object(s) and choose one of the options
described below. The options available vary based on the object selected.
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Note: If relevant, use group actions as defined in the previous section since they perform better than individual
object actions.

Tree

« {73 Recycle Bin
Audio Accessories
P [T Excel Custom Templates
I Suppliers
(T carmaker
B (199972
B (41188 X Purge
B (41188 Force Delete & Purge

B (53259 Approve Deletion

B (57375 Approve Deletion Recursivehy
B (Print_ Revive
Ll 18217+ Revive Recursively

¢ Purge permanently deletes the object if flagged with 'Not in Use' in this recycle bin, with no subsequent option
for revival. Workspace revisable objects are flagged as 'in Use' when Approve Deletion is required, or events /
references exist for the object. The 'in Use' setting prevents the object from being removed. This functionality is
managed by a configuration property that is not available in the Self-Service Ul. Contact Stibo Systems
Support for assistance. The number of warnings reported are limited to 100 of each type with a summary of
errors at the end of the background process, but that number can be changed via the
Purge.MaxNumberOfWarnings configuration property. To remove objects from the Recycle Bin on a
schedule, refer to the Schedule Empty Recycle Bin topic.

Force Delete & Purge removes an object regardless of deletion approvals, events, and references. Using this
option without first approving the deletion does NOT generate a DELETEAPPROVAL event. If deletion events
are required for downstream systems, first approve the deletion (defined below) and then purge the object
(defined above). For more information on events, refer to Events in the System Setup documentation. A similar
version of this option that excludes the recycle bin is available from the Maintain Menu, as defined in the
Maintain Menu topic.
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If the Recycle Bin and Object Purge BGP ends with errors, the Force Purge button is displayed in the Result
section on the BGP execution report. The Force Purge button deletes references to objects being deleted and
they are not restored if the object is revived.

Approve Deletion removes the selected object from the Approved workspace and generates a
DELETEAPPROVAL event for the object. For workspace revisable objects only (those that allow approval),
objects are flagged with 'In Use' if they are in the Approved workspace and 'Not In Use' when they have not
been approved. For more information, refer to the 'In Use and Not In Use Objects' section in the Approval of
Objects topic of the Getting Started documentation.

Approve Deletion Recursively attempts to remove the selected object and its children from the Approved
workspace, generates a DELETEAPPROVAL event for the objects, and attempts to run the Approve Deletion
action. This option is valid only for workspace revisable objects (those that allow approval) that are flagged as
'in Use.'

If the Approve Deletion Recursively BGP cannot be completed successfully (for example, due to existing
references), the Force Approve Deletion button is displayed in the Result section of the BGP execution report.
The Force Approve Deletion button deletes and approves deletion of objects identified in the execution report
with the 'Approve error report' text. A DELETEAPPROVAL event is generated for the deleted referenced
objects.

Important: The 'Force Approve Deletion' button can affect live objects in the Approved workspace since
references may be removed to allow the deletion and approval to succeed.

Revive restores the selected object, and based on dependencies, returns it to the location in the Tree from
which it was deleted. Objects are not always revived exactly as they were prior to deletion, for example, if an
object had references to other objects which have subsequently been deleted, those references are not
present upon revival.

When a reference for an approved object is deleted from the main workspace, the reference metadata is retained
(although not displayed). This enables the metadata to be revived when that reference is revived from the Tree
recycle bin or when the same reference type is recreated. For example, a reference is deleted from an approved
object but not purged from the recycle bin. Subsequently, a reference with the same source and target is created via
an import. Since this 'new' reference for the object matches the deleted one, it is actually revived from the recycle
bin. In this example, the previously deleted reference and its metadata attribute values are restored.

In rare cases where an object is revived but its previous parent has been purged, a temporary parent folder is
added to the Tree with the expectation that a user will change the parent folder to a more appropriate location
in the active hierarchy.
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* Revive Recursively restores the selected object, and based on dependencies, returns it and all child objects
to their previous location in the Tree tab. Objects are not always revived exactly as they were prior to deletion,
for example, if an object had references to other objects which have subsequently been deleted, those
references are not present upon revival.

When a reference for an approved object is deleted from the main workspace, the reference metadata is retained
(although not displayed). This enables the metadata to be revived when that reference is revived from the Tree
recycle bin or when the same reference type is recreated. For example, a reference is deleted from an approved
object but not purged from the recycle bin. Subsequently, a reference with the same source and target is created via
an import. Since this 'new' reference for the object matches the deleted one, it is actually revived from the recycle
bin. In this example, the previously deleted reference and its metadata attribute values are restored.
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Schedule Empty Recycle Bin

Objects within the Tree Recycle Bin can be automatically deleted and/or purged on a scheduled basis by using the
'Schedule Empty Recycle Bin' feature. Recycle Bin emptying scheduling is similar to scheduling other processes
in STEP (e.g., data imports, data exports, and bulk updates). The ability to schedule Recycle Bin emptying at
designated times (e.g., overnight) frees users from time-consuming, manual tasks to empty the Recycle Bin, and
allows the Recycle Bin to be regularly emptied with minimal or no user intervention.

The recommendation is to schedule emptying the recycle bin at least monthly and to include all contexts in use. The
'Data cleanup tools' healthcheck (defined in the Healthcheck Test Index topic of the Performance Analysis
documentation) identifies when no schedule exists for emptying the recycle bin, or if the schedule is not as
recommended.

Note: Scheduling is not available for the System Setup Recycle Bin since large numbers of objects are not
generally deleted routinely from System Setup. For more information on the System Setup Recycle Bin, refer to
the Recycle Bin for System Setup topic in System Setup documentation.

Configuration

To set a schedule for emptying the Tree Recycle Bin:

1. Right-click the Recycle Bin in Tree and select Schedule Empty Recycle Bin to display the Schedule Empty
Recycle Bin wizard.

Tree Search in recycle bin

» (T GDSN ¥% Empty Recyde Bin
» I Publication: (% Empty Recyde Bin Before...
» [ Primary Pr¢. 33 Force Empty Recyde Bin

» B Colections ' Schedule Empty Recydle Bin
b (@] eCatalogs

Approve Deletion Recursively
» 7 Recyde Bin

2. Onthe Delete Options step, set the following parameters:
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Schedule Empty Recycle Bin
Detete Options
2. Select Contexts Delete objects after | 75 days in the Recycle Bin
3. Scheduled Execution 0 Approve Deletion

4. Name Process Delete objects and their chidren from the Approved workspace.

[ Force Purge
Attempt to forcefully delete objects that cannot be deleted via
the standard Empty Recycle Bin operation.

Back MNext Finish Cancel

* Delete objects after __days in the Recycle Bin: Enter the number of days that an object must be in the
Recycle Bin before it is deleted. The default retention time value is 7. This means that process will only
remove objects from the Recycle Bin that have been approve deleted for at least 7 days or whatever you
have set the retention time to be.

Refer to the next bullet for additional Approve Deletion considerations.

Approve Deletion: Select this option to remove objects and their children from the Approved workspace,
which sends a DELETEAPPROVAL event.

Considerations

* The 'Approve Deletion' parameter is not affected by the value provided in the 'Delete objects after
days..." parameter. As a result, when the Schedule Empty Recycle Bin operation runs, if 'Approve
Deletion' is selected, all objects in the Recycle Bin are removed from the Approved workspace, even if
they have not been in the Recycle Bin for the specified number of days.

When an object is removed from the Approved workspace via 'Approve Deletion,’ a
DELETEAPPROVAL event is generated for that object. However, if the object is subsequently purged
from the Recycle Bin as part of the same Schedule Empty Recycle Bin operation, the event is also
deleted, since the object that the event is related to no longer exists in the system.
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Therefore, if an event-based OIEP is set up to be triggered on DELETEAPPROVAL events, it is
recommended to schedule this OIEP to start at more frequent intervals than the Schedule Empty Recycle Bin
process, since the DELETEAPPROVAL event may disappear before the OIEP is invoked. For example,
schedule the OIEP to start every minute and configure the Schedule Empty Recycle Bin process to run once

a week.

* Force Purge: Select this option to attempt to forcefully delete objects from the Recycle Bin that cannot be
deleted via the standard Empty Recycle Bin operation. For example, with this option, objects in the
Approved workspace can potentially be force purged from the Recycle Bin without having first been
removed from the Approved workspace through Approve Deletion.

Note: To use the Force Purge option, the user who configures the Schedule Empty Recycle Bin process
must have the 'Force Delete and Purge' setup action included in their user privileges. For more
information, refer to the Setup Actions and Error Descriptions topic in the System Setup documentation.

® Click the Next button.
3. On the Select Contexts step, move the contexts from which to delete objects to the Selected list. It is

recommended to include all contexts to ensure complete deletion of data. Click the Next button.

Note: In the rare instance that additional workspaces other than Main and Approved exist on your STEP
instance, this step is named 'Select Workspace and Context' and a list of additional workspaces is displayed
at the top of the wizard screen. Click the checkbox next to each workspace that you want to select.

© Stibo Systems - Public - 2025.3 - September 2025 293



- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

Schedule Empty Recycle Bin

1. Delete Options Select Contexts

2. Select Contexts Select the context(s) from which objects should be deleted.
3. Scheduled Execution Avaiable Selected

4. Name Process Danish (Denmark)

English (United States)
French (France)
German (Germany)

W

4 context(s) selected

Back Mext Finish Cancel

4. On the Scheduled Execution step, determine when and how often to empty the Recycle Bin. Click the Next
button.

Schedule Empty Recycle Bin

1. Delete Options Scheduled Execution
2. Select Contexts Start
O Now Start at (hh:mm): 13:27
4. Name Process ) Later Start on (yyyy-mm-dd): | 2025-01-15
O Weekiy End on (yyyy-mm-dd): |-
) Monthly Every: ®@Mon []sat
O Later and repeat (JTue [JSun
() wed
(J Thu
(] Fri

Start every Mon 13:27:00 EST, starting Wed Jan 15 2025

Back MNext Finish Cancel
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5. Onthe Name Process step, name the batch process for easy identification, and click the Finish button to
complete the setup.

Schedule Empty Recycle Bin

1. Delete Options Name Process
2. Select Contexts

3. Scheduled Execution

4, Name Process

Batch Process Name: \Weekly Scheduled Recyucle Bin Purge

Back Mext Finish Cancel

Scheduled Empty Recycle Bin processes are stored on the BG Processes tab (using the batch process name defined)
under the Scheduled Processes node within Queued Processes. They display a status of 'waiting' and can be edited by
clicking the 'Edit' button in the Status row.

BG Processes “ | Weekly Scheduled Recycle Bin Purge K
;"..-’. .:. Background Process

b &5 STEP Workflow Profiing
» {4 Scheduled Empty Recycle Bin

~ Properties
¥ 5 Scheduled Processes
- i Queued Processes Property Value
%+ Weekly Scheduled Recycle Bin Purge| Started by User J (USERD) &
T Active Processes d BGP_229806
&5 Ended Processes -
b # Seal Change-Package Description Weekly Scheduled Recycle Bin Purge
b &5 Smartsheet Export Schedule Every Mon 13:27:00 EST, starting Wed Jan 15 2025

» {5 Smartsheet Import
b i StateflowDeadline

» &5 Subscription import
» {& SuspendBGPs Created
» &5 Translation

Execution Server | doc-rel

Status waiting - 1 of 1 in SCHEDULE Edit

Wed Jan 15 13:33:33 EST 2025

» {4 Translation Import

» &5 UploadDTPDocument
¥ & Web UI Asset Pipeline Download

Started

Wed Jan 15 13:33:34 EST 2025

» &5 Unique Key Processes # of warnings 0
» &5 Unlink Object Type # of errors 0
P 5 Update actual page from plan
. pd pag P MNext Run Mon Jan 20 13:27:00 EST 2025

> Execution Report
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You have an object that has been sitting in the Recycle Bin for the default 7 days, but you have not approve deleted the

item and you run 'Schedule Empty Recycle Bin' now with retention time of 1 day. The object will first be approve

deleted, but it will not be removed from the Recycle Bin since it has only just now been approve deleted. If you then run

'Schedule Empty Recycle Bin' after, for example, 2 days, then that object will be removed from the Recycle Bin if it is

'Not in Use' and if last edit date is more than one day in the past. You can locate that information for an object as shown

below:

Classffication  Sub Products  Referencgs  Referenced By Images & ... >
~ Description \
Name Value
ID 179684
MName 179684 \
Object Type Suppliers Root \
Revision 0.1 Last edited by USER] on Thu Jan 07 15:38:23 EST 2021
Approved X Never Been Approved
Translation Mot Translated
Path Classification 1 root/Classifications/179684
Visibility USA
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Navigating and Searching

This section describes the many different ways you can access specific data in the workbench. STEP Workbench offers
rich functionality for finding both System Setup and Tree objects based on various criteria. Whether it be by standard
navigation, bookmarks, searches using basic, advanced, or drill-down functionality, STEP provides many ways to
locate the required data.

This section includes:

* Navigate hierarchies

* Find data quickly using the 'Search' function

Find data using 'Advanced Search' function
Perform drill-down searches using the 'Search Result Profiling' page
Use standard bookmarks and 'Search Bookmarks'
Note: Objects within the Recycle Bin are not searched and will not display in search results.

For information on search functionality in the Web Ul, refer to the Homepage Widgets topic and the Advanced
Search topic in the Web User Interfaces documentation.
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You can navigate the STEP tree structures in the same manner as you navigate Windows folder structures, following
basic desktop computer skills.

Expanding a Folder
Use one of the following methods to display the contents of a folder:

* Click the right arrow () to the left of a folder

* Double-click a folder

Collapsing a Folder

Use one of the following methods to hide the contents of a folder:

* Click the down arrow (w) to the left of a folder

* Double-click a folder

Collapse Tree

When any folders in the Tree hierarchy are expanded (item 1), all can be collapsed by using the 'Collapse Tree'
option from the 'View' menu (items 2 and 3). All expanded folder are collapsed (item 4).
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e\ﬂew Navigate Format Maint:

Tree o Mode Tree o

[J ACME Lookup Tables Context
« [ ACME Part Type Root Workspace
w [ Electrics for Cars and Motorl
[ starter Batteries

[J ACME Lookup Tables
» [0 ACME Part Type Root
» (O ACME Web Store
b [0 Article Groups
Filter
» [ ACME Web Store P [T] Assets

» 2 Article Groups » [T Bulk Update Configurations

S Select version
4 If » [T Classifications

P [T Bulk Update Configurations
P [T Classifications
* [] Configurations

Primary Hierarchy

» [ Configurations
[T DuplicateETIMG(2)
P [0 DuplicateUNSPSC(2)

» [0 Import Configurations X » b eClass 9.1
i Show Source Context
» [ Export Configurations » [T] ECLASS ADVANCED Classifications
P [ Asset Push Configurations » [T ETIM6 Article Groups
P [T Auto Classification Rule Sets Reload

» [ ETIM7 Article Groups
eColapse Tree » [ ETIMS Article Groups

Note: A folder with too many sub nodes displays an x (%) instead of an arrow and cannot be expanded in the
hierarchy. To view objects beneath such folders, use the Advanced Search Tab or Search functionality.

Collapse and Expand Items on the STEP Workflow Tab

When on the STEP Workflow tab, click the right arrow () to expand a section and displays the states for the
relevant process. Click the down arrow () to collapse a section.
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STEP Workflow X

Tasks  Profie

Asset Enrichment Workflow
&N o e a

Fitter by Collection [

Verify Digital Assets

Final Review

MNeed Info

Removed from Workflow

Review 10
Rejected 1

[ I R I

Business_Action

» Clerical Review Golden Record
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Search

The Search functionality allows the user to locate an object in STEP in a quick and efficient manner. In the Search field,
type the Name, ID, or Key of an object and press Enter or click the 'Go to next object' button (/{3’). A single object

matching the search displays.

ID/Name ~ |Search [

Additional functionality includes:

Use Citrl+G to go to the Search field.

* Use the ID/Name dropdown to select an existing Key and search for a value. Refer to the 'Keys in the Search

function dropdown' section below.

* When multiple results match the search, click 4> or Ctri+E to display the next result.

When you start typing in the Search field, suggested objects that match the text are displayed in a dropdown as shown
below.

ID/Name ~ 'shirt 3
|l Shirt_ Never approved (243017)

2] Shirts and blouses (5244163)

[ shirt (ETIM8_EC002088)

=1 Shirts and blouses (UNSPSC000.531
enced By  Images & DOE2 Shirts (208209)

£3 shirt Sizing NonTyped Attributes (Sh
£ shirt Sizing Attributes (Shirt_Sizing_~
E] shirts (Shirts)

All types of objects are searched including classifications, assets, attributes, user names, etc.
Consider the following while searching:

* Object IDs and Names are both searched.
¢ Object IDs are searched case-sensitive.
¢ Object Names are searched case-insensitive.

* Wild Cards are not allowed.
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For multiple results, a maximum of 20 items are displayed. ltems can be selected from the menu using either the mouse

or the up arrow and down arrow keys on the keyboard.
Search options are also available on the Navigate menu.

View Navigate Format Maintain Window
@ Advanced Search  Ctrl+F Vie

ntext .
Search Below
ree | p Search Ctrl+G
= ] ject Ctrl+E
M pri M Go To Next Object Ctrl+
v [O
L
L
- Bookmarks >

Find Similar Product
ies

Keys in the Search function dropdown

The ID/Name dropdown list displays all activated unique keys. Refer to the Creating and Deleting Keys topic in the

System Setup documentation.

ID/Name ~ | Search

Asset URL Key

GDSN Key

Supplier Part Number
TDR

Select an active key from this dropdown to identify and delete objects, parents, referenced objects, and assets.

The system displays the object that has the unique key value.

Setting the Primary Hierarchy for searches

A user can set the 'Primary Hierarchy' to be either a primary product hierarchy, classification folder, asset folder,
etc., through the View menu Primary Hierarchy option. Once the primary hierarchy is selected and an object is
searched, first priority is given to the folder that is selected and then the other folders are searched.
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View MNavigate Format Maintain Window Help

Mode
Context

Workspace

Filter
Primary Hierarchy

Select version

Show Source Context

Reload F5
Collapse Tree

>

>

>

b

URL

e

ACME Lookup Tables
ACME Part Type Root
ACME Web Store

Article Groups

Assets

Bulk Update Configurations
Classifications

Configurations

Other

[ ]
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For example, if the Primary Hierarchy is set to Assets, the product will first be searched under assets. Then

clicking on Search again, the user is shown in the actual hierarchy where the product was initially created.

Typically, by default, the object will be searched in the actual hierarchy where it was initially created.

Important: Objects within the Recycle Bin are not searched as part of the Search functionality.
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Bookmarks

Bookmarks are saved on the Bookmarks tab (E] ). Bookmarks are placeholders created by the user and provide a

shortcut for objects via standard navigation or search criteria.

Bookmarks

Search ltems
Cotton T-Shirts (18209)
Installation Manuals (InstallationManualRoot)

e @ o a

Refer to the Bookmarks Tab section for details and instructions for using bookmarks.
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Advanced Search

The Advanced Search tab, in combination with the Search Result Profiling page, offers extensive methods for locating
objects in STEP quickly and efficiently.

Generally, there are two approaches to performing searches:

1. If you know specific details about the object to find, use the Advanced Search tab. For example, all products
where the value for the attribute 'Weight' is less than '5 kg', the object is located below the product folder 'Office
Chairs' and is not of the object type 'ltem’.

2. If you do not know details, start with a broad search and then narrow it down using the Search Result Profiling.

Note: Objects in the Recycle Bin are not searched and will not display in search results.

Search Elements

The elements on the Advanced Search tab work together to create and refine a search for objects in STEP. The
numbered elements in the following image are described below.
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Advanced Search * || Search Result Profiling 1
Search: 225% X @
Search Result Profiling
Object Type = Asset ex
g hit(s)
Search v o % Click links to narrow down search
Results by Object Type
> Advanced Asset(9) - exclude
o 9 . Product Image (7) - exclude
Export Manager Confiquration (1) - exclude
+ ve Recet Search U2 Assets (1) - excluge
Displaying 9 of 9 results G ashow ~=-- | Results by Position in Tree Hierarchy
Name @‘Snrt Ascending -
Sort Descending
'm|Acme Tire Repair Kit1 (184614) Elude
Do not sort sxclude
W |BlueFlashlight (254337 exclude
j ght( ) Fitering enabled ater Im_aues (1) - exclude
i] Gray Cardigan_Flickr (264900) figurations (1) - =xclude
WM a Setup (Product I 336455) Copy table for Excel
ome Cinema Setup (Product Image
P age- Results by Value
'llumber SA(20823) ID matching "225*"
[2]MergeGRConfig (225255) D) - exclude
Values matching "225*"
\[# Tire Kit1 (Tire Kit1) (Values are displayed in lowercase)
220 (pixels) (B) - sxclude
ET"E Kit12 (Tre Kit12) 225 (dpi) (2) - exclude
) 2287777 TVTTTTT (mm) (1) - exclude
'&|white earbuds (104446) 225 30066666666665 (Mm) (1) - sxclude
225472 (1) - exclude

Operations on Entire Result Attributes with values matching "225*"
(displaying the 5 most commaon)
‘ E’ D [_[j H; assetpixel-height (4) - exclude
Ao nt mivol aeidts CAY 1
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1. Search criteria type selector - Click the text to display a list of available search criterion options. Refer to the
Advanced Search Functionality topic for more information.

2. Add criterion / operator button - Click the plus button (+) to add a new search criterion or hover the mouse

over and hold down the plus button (=) to display a sub menu and choose an OR operator or an Exclude

operator. Refer to the Advanced Search Functionality topic for more information.

3. Remove search criterion button - The X button (*) clears an individual criterion from the search. Click the

Search button to refresh the Results Area.
4. Reset button - Clears all results and search criteria from the Search panel and Search Result Profiling page.
5. Search button - Runs the defined search.

6. Search result counts - The number of items currently displayed and total number of items found by the search.
If the search finds objects not visible in the current context or objects that you are not privileged to view, a
message is displayed and the objects are not displayed in the search result.

7. Show Details / Hide Details toggle - Hyperlink shows or hides search result details. The details view displays
asset thumbnails. The asset thumbnail is displayed when the search is under a classification folder and there
are assets. Similarly, if the search is for the products and the product is linked to an asset, the thumbnail is
displayed. If no image is linked, 'No Primary Image' is displayed.

8. Results context menu () - Click to display options: sort ascending, sort ascending, do not sor, filtering

enabled, and copy table for Excel. All options are applied to the first 100 results displayed. When filtering is
enabled, options include all, empty values, non empty values, equals, begins with, ends with, contains, <, and
>. An additional dialog is displayed as needed to specify text for filtering and options such as 'match case’,
'alphabetic less than', or 'alphabetic greater than'. When copying the table for Excel, only data displayed in the
table is available for pasting in another document.

9. Search results list - When a search has been executed, the results are shown in a list below the search box.
Clicking one of the results will open the object editor for that particular object in the Search Results Profiling
pane, while continuing to display the search results list. It is also possible multi-selection from this list and a
maximum of 100 results are displayed. The complete result set can be viewed, exported, or updated using the
'Operations on Entire Result' options below.
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Note: This functionality is managed by a configuration property that is not available in the Self-Service Ul.
Contact Stibo Systems Support for assistance. The maximum results displayed can be adjusted via the
DrillDownSearch.Maxresults configuration property. However, it is not advisable to adjust the number
more than 100 as the system performance diminishes as the number increases.

Save as Collection button - Click to open the 'Save as Collection' dialog and save the entire result set as a
collection. Collections are available on the Tree. Refer to the Advanced Search Operations on Entire Result
topic for more information.

Export button - Click to open the Export Manager wizard and export the entire result set to a specified file type.
Refer to the Advanced Search Operations on Entire Result topic for more information.

Bulk Update button - Click to open the Bulk Update wizard and modify a variety of elements on each item for
the entire result set. Refer to the Advanced Search Operations on Entire Result topic for more information.

Search Result Profiling - Panel displays profiling information about the search including categories and
provides a convenient way to further refine the search. Refer to the Advanced Search Result Profiling topic for
more information.

Search Options

The Advanced Search tab dropdown includes a number of options. Each is described in greater detail in the topics that

follow.

Advanced Search

§

Advanced

* Advanced Search: Data Containers

* Advanced Search: Document Content

* Advanced Search: JavaScript Search

* Advanced Search: Missing Mandatory Values
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Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

Advanced Search:

: Object Type

Product Override Search
Referenced Assets

References and Referenced By
References and Referenced By
Revised Objects Changed Since
Sample Result

Search Below

Search from List

Search in Publication Hierarchy

STEP Workflow

[
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Searching for Translation Status
Advanced Search: Unapproved
Advanced Search: Unpushed or Failed Assets

For information on performing optimal searches, refer to the Scheduled Process Recommendations topic in the
System Setup documentation.

© Stibo Systems - Public - 2025.3 - September 2025 309



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Advanced Search Functionality

This section describes the different types of search criterion available in the STEP system as well as some basic search
functions.

Important: Calculated attribute values are generated on-the-fly. Searching for the value of a calculated
attribute is not allowed since generating all possible calculations would cause substantial performance issues.

Default Search Criterion
The default search criterion named 'Search' allows you to find objects based on name, ID, attributes and their values.

A text string entered in the search field will search for object names, IDs, or attribute values where the text occurs.

Advanced Search

Search =
T-shirt

Advanced

+ - Reset

If you enter a text string and click the Search button, search finds objects with an ID, and/or a name and/or an attribute
and/or their values matching the entered string. You can further refine standard searches as shown below.

Note: By default, searches are not case sensitive for name and attribute value searches, but searches are case
sensitive for ID searches. Make case sensitive name and attribute value searches using the Advanced option
'Match Case on Names and Values.' For more information on the Advanced options, refer to the Advanced
Search: Advanced Options topic.

Search Field Typeahead

Once you start typing in the default search criterion text field, the system suggests possible entries matching the typed
in text (case insensitive), and displays them on a dropdown menu as shown below.

© Stibo Systems - Public - 2025.3 - September 2025 310



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Advanced Search

Search =

hat

hatBulkUpData (274525)

[ Hatchets (5184488) |
[T Hatchets (UNSPSCD00.27111604)

|2 Hat Colection (259778)

|2 Hative de niort shallot purees (521253

In the typeahead menu, objects are displayed with their relevant icon, then name, and then ID in brackets. Attribute

values are shown as text.

Items can be selected from the menu using either the mouse or the keyboard 'arrow up' and 'arrow down' keys. A
maximum of 100 items will be displayed.

Note: Using configuration property entries, a system administrator can control the behavior of the typeahead.
E.g., after how many entered characters should suggestions be shown, etc. Search for the 'TypeAhead' section
on the Configuration tab. For more information, refer to the Configuration topic in the Administration Portal
documentation.

Limiting Results to Matches on IDs

You can limit standard searches to match on ID only by entering 'ID =" at the beginning of the text field as shown below.

Advanced Search

Search -

D =1

ID = 108286
ID = 108287
ID = 108348
|[A1D = 108349
ID = 108351
02 1D = 108357
ID = 108358
ID = 108370

L]

'id' and 'ld" will also work, as the spaces on each side of the equals sign are optional.
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Limiting Results to Matches on Name

You can limit standard searches to match only on name by entering ‘Name ="' at the beginning of the text field as shown
below.

Advanced Search

Search -

MName = drills

5 Name = Drills

[ Name = Drills high speed steel
[C Name = Drills high speed steel
|1 Name = DrilsInc

'name’ and 'NAME' also work since the spaces on each side of the equals sign are optional.

Attribute Value Searches

Using a standard search, you can limit the result to only match on values for specific Attributes.

Important: Calculated attribute values cannot be searched since they are generated only when viewed or
processed.

There are at least three ways to construct an attribute search query:

1. Start entering an attribute name or ID, then select the relevant attribute from the typeahead menu, to display
attribute name in the text field. Enter a search operator or enter a SPACE and select an operator from the
typeahead menu and enter the value to search for.

Advanced Search

Search =

Dirills

2 Drills (182521)

2] Drills high speed steel (5182249)

2 Drills high speed steel (UNSPSC000.23241606)
13
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2. Enter the attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator from
the typeahead menu, then enter the value to search for.

Advanced Search

Search ~ X

DrillsInc (DrillsInc)

DrillsInc (DrillsInc) !
DrillsInc (DrillsInc) !
DrillsInc (DrillsIng) =
DrilsInc (DrilsInc) <=
|DrillsIng (DrilsIng) =
—|DrrilsInc (DrilsInc) = ||
Corilsine (DrilsIng) »=

L]

3. Enter the attribute name (case insensitive), enter a search operator or enter a SPACE and select an operator
from the typeahead menu, then enter the value to search for.

Advanced Search

Search - x

Item=

Ttem=Accepted (ACC)
Item=~Forecasting (FOR)
Item=Regulatory Enrich (REG)
Item=Warehouse Data (WAR)

Note: As shown on the screenshot above, if you have the required privileges you will get typeahead
suggestions on existing values after having specified a search operator.

Attribute Value Search Operators

The following search operators that can be used when performing attribute value and reference metadata attribute
value searches.
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Operator Description

< Less than operator. Only works for number validated attributes (Validation Base Type = number,
integer or fraction)

<= Less than or equal to operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)

= Equal to operator.

> Greater than operator. Only works for number validated attributes (Validation Base Type = number,
integer or fraction)

>= Greater than or equal to operator. Only works for number validated attributes (Validation Base Type =

number, integer or fraction)

Operator used for finding objects where the specified attribute does not have values in current
context. The search does not check whether the attribute is valid for a given object. Also, if the
specified attribute has an inherited value (not a local value), then the object will be listed in the results
set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute values.

Operator used for finding objects where the specified attribute does not have local values in any
context. The search does not check whether the attribute is valid for a given object. Also, if the
specified attribute has an inherited value (not a local value), then the object will be listed in the results
set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute values.

Wildcards in Searches

The following two wildcards are available for performing searches on partial text strings:

®x (asterisk ), multi-character, represents any number of characters in a string

* 2 (question mark), single character, represents exactly one character

Wildcards can be used anywhere in the text string.
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Note: Searches starting with a wildcard should be avoided since they are significantly slower than other
searches.

Searches in 'Full Text Indexable' Attribute Values

Searches in values for attributes configured with the 'Full Text Indexable' parameter set to 'Yes' do not work in the same
manner as searches in other attribute values. Apart from common English words like 'in' and 'as,' each word is indexed
as a separate element. For more information about the words that are not indexed, search the Oracle website for the
'English Default Stoplist.'

For example, consider an attribute named 'Description’ that has the following value on a given product:

Black powder coated die-cast aluminum enclosure. Textured surface. Bulk version: Enclosures may possibly
have flaws in the finish such as scratches, dents, discoloration, etc.

® If the 'Full Text Indexable' parameter is set to 'Yes' for the attribute, a search for 'Description = aluminum'

returns the product.

“ If the 'Full Text Indexable' parameter is set to 'No' for the attribute, a search to find this product would require

a wildcard on both sides of the 'aluminum’ text like this: 'Description = *aluminum?®.

Note: Searches starting with a wildcard (as shown above) are significantly slower than other searches.

By default, if you have not specified an attribute, typeahead for Full Text Indexed attribute value entries is turned off. If
you have specified an attribute, you will first get typeahead suggestions after having entered three (3) characters of the
value entry. Refer to the Search Field Typeahead section above.

While changing this setting is allowed on an existing attribute, it does required special handling. For Oracle databases,
this action requires single-update mode (SUM), as defined in the Single-Update Mode topic. For Cassandra databases,
this action uses Lock-free Schema Change (LFSC) functionality, as defined in the Lock-free Schema Change topic.

Numeric Value Searches for Attributes with Units

Values for numeric searches with no units are assumed supplied in the default unit for the attribute. For example, if
kg is the default unit for the 'Weight' attribute, 'Weight = 1' will match '1 kg' and '1000 g'. If no default unit is
configured, the search 'Weight = 1' will only match the value '1' with no unit.

ISO Date Searches

If an attribute with the validation type of 'ISO Date,' where the date populated in the field is in the YYYY-MM-DD format,
a search on the populated attribute on objects can be performed using the following key words in the Advanced Search
tab: now, today, tomorrow, yesterday.
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While it does not matter if the 'ISO Date' is set to 'Strict Validation' or not, it does matter that the date is written in the
YYYY-MM-DD format. Any other format, including using slashes '/ ' instead of dashes '-' will not work since searches
work by matching only values conforming to the ISO standard (with dashes). For this reason, it is recommended that

'Strict Validation' be set to Yes, otherwise, the stored values are not guaranteed to be searchable.

In the example below, a user searched for an object that has a particular date. The user typed in the name of the date
attribute 'ISO Date', and then used an 'attribute value search operation’ followed by the literal date. (The keywords

'vesterday', 'today' and 'tomorrow' are also available.)

Advanced Search

Search -
ISODate (ISODate) = 2012-05-01

Advanced

+ - Reset

Search Result Profiling

Displaying 1 of 1 results Show Details

Mame

Il T-shirts Items (18203)

Using the 'Add Criteria' Operator

Search Result Profiling
1 hit(s)

Click links to narrow down search
Results by Object Type

Product (1} - e=clude

Bl ltem Folder (1) - exclude

Results by Position in Tree Hierarchy
Results per Parent

S I-shirts (1) - exclude

You can combine different search criteria to create advanced searches with the default '"AND' operator.

The search shown below:
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Advanced Search

Search: name = T-shirts X
Search Below = Apparel X
Object Type ~ X
Product ~

+ - Reset

Displaying 1 of 1 results Show Details
Name

[ T-shirts (18202)

generates the same results as the following search:

Advanced Search

Search Below = Apparel x
Object Type = Product x
Search ~ A

name = T-shirts

> Advanced

+ - Reset

Displaying 1 of 1 results Show Details
Name

IS T-shirts (18202)

Except for cases where one or more 'OR' operators are used, the sequence of the criteria does impact the results.

When no 'OR' or 'Exclude' operator is used, all criteria are added with the default '"AND' operator, meaning that all
criteria must be met to be included in the results.
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Click the add operator button (=), which applies the 'Add Criteria' operator, to construct a query that includes

more than one criterion.

As an example, the search shown below finds objects that have the value 'Red' for the 'Color' attribute AND that
are present below an 'Apparel’ hierarchy node. The order of criteria does not impact the results.

Advanced Search

Search: Color (Color) = Red (Red) x

Search Below -
Apparel (18200)

+ - Reset

Displaying 22 of 22 results Show Details

Mame

B 12-GGK79(182922) |

Using the 'Add OR' Operator

To add an 'OR' operator, click and hold the add operator button (<), then select 'Add OR' from the menu.

Add Criteria
Add OR

/ Add Exclude
+ Reset Search

-

When using 'OR' operators, search is divided into separate parts containing one or more criteria. Each part is executed
separately and the results are then compiled before presenting the final result.

Since itis not possible to work with parenthesis, when working with 'OR' operators it is often necessary to
configure the same criterion on each side of an 'OR' operator.

For example, the search shown below returns all objects where the ID starts with the text '1821' and the color is 'Aqua,’
plus all objects where the name starts with the text '1821' and the color is 'Aero Blue."'
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Advanced Search
Search: ID = 1821*% x

Search: Avaiable Colors (AvaiableColors) =Aqua X

[OR |
Search: ID = 1821*% X
Search - A

Available Colors (AvaiableColors)=Aero Blue

Advanced

+ - Reset

Using the 'Add Exclude' Operator

You can negate search criterion, by using the 'Exclude’ operator functionality.
To add an 'Exclude’ operator (also referred to as a 'NOT' operator), click and hold the add operator button (), then

select 'Add Exclude’ or click an 'exclude’ link in the generated 'Search Result Profiling' panel after displaying search

results.

'Exclude’ operators appear with red 'NOT' text on the left side of the criteria panel (shown below).
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Advanced Search Search Result Profiling
Search: ID = 1821% X

Search Result Profilin
Search: Avaiable Colors (AvaiableColors) =Aqua X g

3 hit(s)
NOT - — Click links to narrow down search
Search Below = Writing Tools x
OR Results by Object Type
Search: ID = 1821% 8 Product {3} - e=zclude

Search: Avaiable Colors (AvailableColors)=~Aero Bluex

NOT <4 Results by Position in Tree Hierarchy
Search Below = x Results per Parent
i Wl T-Shirts Family (31 - esxclude
Writing Tools (208645) Writing Tools (2] - sxclude e—
[ TimTown Three (1) - ssclude
[ Sleepwear (1) - exclude
+ - Reset Search
\ Add Criteria Results by Value
Add OR Values for Attribute "Available Colors”
Add Exclude Malues are displayed in lowercase)
agua (1) - exclude

Values for Attribute "Available Colors
(Walues are displayed in lowercase)

aero blue (2) - esxclude

Continuing with the example above, the search finds objects where all the 'positive' criterion are met, minus
objects where the objects are below the 'Writing Tools' node in the hierarchy.

When using an 'OR' operator, add the same 'NOT' to each section divided by an 'OR' operator.

When no 'OR' operators are used, the sequence of 'NOT' operators do not affect the results.

Note: A search that contains only 'Exclude’ operators without an 'Add Criteria' will not generate any results.
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Advanced Search Result Profiling

After performing a search, the 'Search Result Profiling' panel displays statistics about the search grouped under the

various headers.

Note: This functionality is managed by a configuration property that is not available in the Self-Service UI.
Contact Stibo Systems Support for assistance. Displaying profiling statistics is controlled by the
DrillDownSearch.GetStatistics configuration property. The property is set to 'true' by default, which
allows result profiling to display automatically. When the property is set to 'false’, the right-hand panel of the
Advanced Search tab is empty regardless of the search performed.

Apart from displaying information about the results of your search, you can use the panel to further refine your search.
For example, if you start by running a broad search, you can refine it by clicking the 'Exclude’ links in the profile - thereby
adding additional criteria to your search. For example:

Search Result Profiling
86 hit(s)
Click links to narrow down search

Results by Object Type

Product (38) - exclude

ltem Folder (12) - sxclude

Open lterm (107 - zxclude
[T15ales Item Family (9) - zxclud
[C15ales Item Folder (7} - exc

Asset (20} - exclude

7 Assets (5) - exclude

PHOTOHD (5} - sxcluds
"=t External Stored DAM Asset (3) - =ecluds
loge LOQ0 (2) - =xcluds
ﬁ\lnstallatinnru1anuall.’2‘.- - exclude

[ XML File (1) - sxcluds
¢ 11305 (1) - =xclucs
2 Product Video (1) - =xcluds

Classification (25] - exclude

[C1Suppliers Batches (5) - =xcluds
[ Suppliers Assets (5) - zxcluds
[Tl Suppliers Products (5 - =eciuds
[C1Suppliers Root (4) - =sxcluce
| MerchandisingClass (4) - =xclude
Media Asset Management (1) - sxcluds
[Cilcons (1) - sxcluds

Entity (3] - exclude
[T Account (3) - ssclude
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For all types of searches, the Search Result Profiling panel displays the results sorted by object type. The screenshot
above shows the Results by Object Type. The search result includes Products, Assets, Classifications and Entities.

If you click a link, an Object Type search criteria is added to the search. The search runs again, finding only objects with
the selected 'Object Type'.

If you click an exclude, an additional 'NOT" search criteria is added as shown below. All objects of the selected
Object Type are excluded from the search result.

Advanced Search

Search Below = Primary Product Hierarchy x

NOT
Object Type = External Item Enrichment Record X

NOT
Search - *

Excelence

Advanced

+ - Reset

Displaying 200 of 882 results Show Details

Name

| 120-Volt Tire Inflators (case of 4) (6813)
| 120-Volt Tire Inflators (pack of 2)(18619)

I 120-Volt Tire Inflators (pallet of 120) (6815)
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Advanced Search: Advanced Options

Additional Advanced Search options for narrowing results are available within the Advanced section.

Advanced Search

Search ~ »

Advanced
(] Match Case on Names and Values
[l Include Inherited Values
(] Exclude values
(] Regular Expression

[Tl Include Data Containers

+ - Reset Search

Each of the Advanced options is described below.

1. Match Case on Names and Values - When selected, Name and Attribute value searches are not case
sensitive. For example, this is a basic search with search criteria of 'Search = T-Shirt.'

Advanced Search

Search ~ %
T-Shirt

Advanced

+ - Reset Search

The search results are displayed with all the objects in STEP that match the search criteria, in this case 'T-shirt.'

STEP objects in the search result can include:
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© Classification / Asset / Product / Entity objects

© Special Types objects

© System Setup Tab objects

Advanced Search X

Search -
t-shirts

> Advanced

Reset

+v

Search Result Profiling X

Displaying 4 of 4 results Show Details

MName

[ T-shirts (18454)

= T-shirts (253689)

[3 T-shirts (18206)

[ T-shirts (18202)

Operations on Entire Result

e O

Search Result Profiling
4 hit(s)

Click links to narrow down search
Results by Object Type
Product {2} - exclude

[T SalesltemFamily (1) - sxclude
S Llevel 3 (1) - exclude

Classification {2} - exclude

Cdindex (1) - exclude
[ MerchandisingClass (1) - exclude

Results by Position in Tree Hierarchy
Results per Parent

Upper Body Wear (1) - sxclude
T({1) - exclude
= Battery Backup (1} - exclude
[C1Sportswear (1) - excluds

Results by Value

Name matching "t-shirts"

Mame (4) - exclude

Now, on the search, select the Advanced option 'Match Case on Names and Values.'

With this option selected, the search result will only include attribute values and all the object names in STEP that
match the search criteria in the correct case. Since the previous search results were all a different case, this search

will return no results.
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Advanced Search

Search -
t-shirts
~ Advanced

@ Match Case on Names and Values
[ Include Inherited Values

(] Exclude values

(] Regular Expression

[CJ Include Data Containers

+ - Reset
Displaying 0 of O results Show Details
Mame

Operations on Entire Result

e

Note: ID searches are always case sensitive.

2. Include Inherited Values -When selected, attribute value search results will show objects where the match
includes inherited values as well as objects where the match includes locally defined values.

Attribute values with hierarchical inheritance (values with green triangle) will only be included in the search result

when Include Inherited Values option is selected.

Exterior Color EE Alabaster

Dimension dependent Attributes - Specification or Description attribute values inheriting from other contexts (values
with a red triangle) will also be displayed in the search result even when the user does not select the option Include

Inherited values.
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Color IEEI White

3. Exclude Values - When selected, attribute values are not searched for the entered search term. If unchecked,
attribute values are searched for the entered term and objects with the search term populated as an attribute
value are included in the search results.

The Exclude Values in advanced search are useful for excluding objects which are having search content as a value
in it. For example, assume there are attributes which has value 'Red' in few objects and there are objects which has
Object Name/ID as 'Red.’

If a typical search is performed, the results for 'Red' are shown below.

Advanced Search * || Search Result Profiling X
Search ~ " | Results by Object Type
Red

Product (39) - e=clude

> Advanced Miem (310 - exclude

I Sales tem (4) - exclude
Bl ltem Folder (2) - excludes
=l Sales ltem Folder (1) - exclude

+ - Reset Bl tern Family (1) - exclude
Asset (20} - lud
Displaying 60 of 60 results Show Details . —
W] Product iImage (200 - sxclude
MName

Entity {1} - exclude
B Model (1) - excluds

T PUTEE LA LU DT

B red (242727)

'@ Red Rucksack (246932) Results by Position in Tree Hierarchy

Results per Parent

|| Silver Flashlight (20866) (displaying the 5 most common)
Cotton T-Shirts (23) - =xclude
[DTire Care SalesItems (SalesitemFolder_6853) Spnrtswear Clearance (10) - sxcluce
Writing Tools (10} - exclude
Bl T-Shirts Family (298905) [1DO(9) - exclode

| [C]Assets (3) - sxclude

B womens T POY w Class (179928)

Results by Value
Operations on Entire Result ,

Name matching "Red”
E} D T! Mame (1} - exclude
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If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and Names
matching the search are turned.

Advanced Search Search Result Profiling
Search v A _
Red Search Result Profiling
1 hit(s)
+ Advanced Click links to narrow down search
[_I Match Case on Names and Values Results by Object Type
[ Include Inherited Values Product (1) - exclude
@ Exclude values Bitem (1) - =cluce
(] Regular Expression Results by Position in Tree Hierarchy

Results per Parent

B Cotton T-Shirts (1) - ssclude

[CJ Include Data Containers

+ - Reset
Results by Value
Displaying 1 of 1 results Show Details Name matching "Red"
Name Mame (1) - excluds
B red (242727)

Operations on Entire Result

e & o

4. Regular Expression - When selected, attribute values are searched using the regular expression entered in
the Search text box. Although establishing an attribute with Validation Base Type of Regular Expression allows
more than 2000 characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only returns
results for matches within the first 2000 characters. For more information, refer to the Regular Expression topic
in the Resource Materials online help documentation.

5. Include Data Containers - Include any search terms contained inside data containers.
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Advanced Search Operations on Entire Result

These operations are found at the bottom of the Advanced Search tab.

Advanced Search

Search =
255900

Advanced

+ - Reset

Displaying 1 of 1 results Show Details

Mame

= Drafting (255900)

Operations on Entire Result

e & ™

Language-dependent searches and exports

When exporting search results or exporting a collection made from search results, the context selected when
performing the search is used in the 'Displaying # of # results’ list of objects found and the Export Manager Advanced
tab Context field determines which values are exported.

If a search or a collection from an Advanced Search is based on a language-dependent attribute's Name, the export file
is blank if the context selected in the Export Manager does not match the context selected during the search or

collection creation.

To export objects with their relevant language-dependent attribute values regardless of the context in use during search
or collection creation, use the 'Search from List' criterion using the ID option from the dropdown (as defined in the
Advanced Search: Search from List topic) and paste in a list of the object IDs to search on and export. Or, perform the
search only on the attribute ID along with a wildcard (*) for the attribute value.

Save as Collection

After conducting a search, you can save the search result as a collection.

Click the 'Save as Collection' button (E;) and specify the location, ID, and Name, of the new collection. For more

information on collections, refer to the Collections topic in the Getting Started documentation.
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Save as Collection in Background Process

Browse  Search

» [ Collections
» [@ eCatalogs

> Details

Collection ID 5744736
Collection Name

OK Cancel

Export

After conducting a search, you can export the search result by clicking the Export button (E—p) at the bottom of the
Advanced Search tab.

On the Select Objects step of the Export Manager, all the objects in the search result are considered. The objects
exported are determined by the selected export format and the other selections made in the Export Manger. For more
information on using the Export Manager, refer to the Export Manager topic in the Data Exchange documentation.

Export Manager

1. Select Configuration Select Objects

Product selection made by search URL.
3. Select Format
4, Map Data
5. Advanced

6. Select Delivery Method Only export selected objects @8

Only export leaf objects Export: Product w
Include object types «<All object types=
Back =~ Next  Finish
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Bulk Update

After running a search you can perform a Bulk Update on the entire search result.

Click the Bulk Update button ([ﬁg) to display the Bulk Update wizard. The search result is set as the dataset. For more

information on bulk updates, refer to the Bulk Updates topic in the Bulk Updates documentation.

Bulk Update

Confguration

2. Operations
3. Parameters

() Use Existing Configuration
4. Preview

5. Advanced

© Create New Configuratiors

Back Mext Finish Cancel

Note: To bulk update only some of the objects in the result, select or multi select in the search result and then

click the 'Run Bulk Update' option on the File menu.
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Advanced Search: Data Containers

The Data Containers search criterion allows users to limit search results to only objects for which data containers exist
for the specific data container types, or those objects for which specific attributes are linked via data containers.

Searching for objects with information in data containers is available using the standard search criterion and also using
the specific Data Containers criterion. Each method is defined below.

For more information on data containers and the terminology used in this topic, refer to the Data Containers topic of the
System Setup documentation.

Standard Search Including Data Containers

This option searches data containers and other identified objects for the defined values. For more information, refer to
the Examples section below.

1. Click the Advanced Search tab, and select Search from the dropdown.

Advanced Search

Search -

Advanced

+ - Reset Search

2. Open the Advanced section and check the 'Include Data Containers' option.
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Advanced Search

Search -

Advanced
(] Match Case on Names and Values
(] Include Inherited Values
(] Exclude values

(] Regular Expression

B include Data Containers

3. If needed, click the plus button (- ) to add additional search criteria.
4. Click on Search to run the search and view results.

Data Containers Only Search

This method requires that the searched data exist in a data container. Matching data outside of data containers is not
displayed. For more information, refer to the Examples section below.

1. Click the Search tab, and click the Search dropdown.

Advanced Search

Search -

Advanced

+ - Reset Search

2. Inthe Search Criteria Type Selector, select the 'Data Containers' search criterion.
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Advanced Search

Search

Search

Object Type
Search Below
Referenced Assets
Background Process Search
Revised Objects Changed Since
Data Containers

Search from List

Tavascrind search

3. Supply the Data Container Type parameter and the additional text input parameter as needed:
® Continue to the next step without populating either parameter to return all objects for which any data
container of any data container type that has been added.

® Click the selector button () for the Data Container Type parameter to limit the search results to only

those objects for the selected data container type. Click Select and then click Search. The search returns a
list of objects for which the data container type has been added, even when no attribute values exist in the
data container. For more information, refer to the Examples section below.

© Stibo Systems - Public - 2025.3 - September 2025 333



Advanced Search

Data Containers ~ i
Data Container Type [E]N
> Advanced
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Data Container Type

Browse  Search

+ [ Data Containers for Entities
El Address
El Contacts
El Emai |
[E] shipping Address

» £ Data Containers for Products

Details

Select Cancel

If necessary, narrow the search using additional search terms in the text input parameter. Type the selected
‘Data Container’ attribute to display typeahead suggestions. Once selected, the available operators =, <, >,

<=,>=,1 Il are displayed. If the selected attribute has a value in the ‘Data Container’ tab, the values display

as a dropdown. However, the search result will be displayed only for the attribute value which is present for

the attribute in the Data Container tab. For more information, refer to the Examples section below.

Advanced Search

Data Containers ~

Data Container Type shipping Address (ShippingAddress)
Country Code (CountryCode) =

Country Code (CountryCode) =ANGUILLA (128360)

Country Code (CountryCode) =ANTIGUA AND BARBUDA (12 |
Country Code (CountryCode) =ARGENTINA (128399)
Country Code (CountryCode) =ARUBA (128374)

Country Code (CountryCode) =AUSTRALIA (128343)
—Country Code (CountryCode) =AUSTRIA (128368)

Country Code (CountryCode) =BAHAMAS (128336) |
lCountry Code (CountryCode) =BARBADOS (128403)

ils

Advanced Search

Data Containers x

Data Container Type shipping Address (ShippingAddress)
Country Code (CountryCode) = BAHAMAS (128336)

> Advanced

+ - Reset

Displaying 2 of 2 results Show Details

Name
& Customer A(CUS_101545)

& Customer B(CUS_107835)

* If necessary, open the Advanced section and set the following parameters:
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Advanced Search

Data Containers ~
Data Container Type shipping Address (ShippingAddress)
Country Code (CountryCode) = BAHAMAS (128336)

Advanced
Instance count = -~

[ Match Case on Values

[] Regular Expression

+ - Reset

* Instance count - specify a number of data container instances an object must have.
® Match Case on Values - makes the search case sensitive.

¢ Regular Expression - search data containers using a regular expression. For more information, refer to the
Regular Expression topic in the Resource Materials online help documentation.

5. If needed, click the plus button (- ) to add additional search criteria.
6. Click on Search to run the search and view results.

Examples

The following examples show a variety of searches for values in data containers.
Standard Search for Product Data Container Value

The dataset includes an object with a Flat Crush Test value of '10 kN'. This value is in a product data container.
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Tree

» O Footwear

» 51 Furniture

» [0 Games

~ 3 Hardware
» 3 Doors and Doorknobs
b = Hardware Kits
w [0 Packaging Supplies

Blcomugeted o

b [0 Tools

» 51 Kitchen

» 3 Lunchboxes

Corrugated Box

Item e 6% Complete » Revision: 0.1

Product DataContainers Sub Products References Referenced By

Images §

~ Industry Standard B

D Attribute Name Value
Edge Crush 12a | 43-47
Flat Crush 12a | 10 kN
IndustryStandardB_271889
Pin Adhesion 123 [ 11.05
Scuff and Abrasion | 12a | 70N

Searching for the value '10 kN' with the standard Search criterion returns 0 results.

Advanced Search

Search =
10 kN

~ Advanced

+ - Reszet

X

M

(=]
LA
m

Displaying 0 of 0 results

Show Details

Mame

arch Result
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Checking the Advanced option to 'Include Data Containers', and searching again, displays the object as a result.
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Advanced Search Search Result Profiling
Search ~ X _
10 kN Search Result Profiling

2 hit(s)
Advanced Click links to narrow down search

[ Match Case on Names and Values Results by Object Type

[ Include Inherited Values Product (2) - exclude

() Exclude values Blem @) - sxciuce

(] Regular Expression Results by Position in Tree Hierarchy

@ Include Data Containers Results per Parent

5 Packaging Supplies (1) - sxclude
= Hardware Kits (1) - sxclude

+ - Reset

Displaying 2 of 2 results Show Details

MName
¥ Corrugated Box (271881)

B Thermal Valve (245934)

Standard Search for Entity Data Container Value

In this example, a user searches for all instances of the value 'BAHAMAS' in STEP. Select the standard 'Search' from
the dropdown, add 'BAHAMAS' into the text input parameter, open the Advanced section and check the 'Include Data
Containers' option, and click Search. The results includes Customer A and Customer B entity objects where
'BAHAMAS' occurs inside a data container, and also includes the 'BAHAMAS' values that appear outside of data

containers.
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Search =
BAHAMAS

Advanced
(] Match Case on Names and Values
() Include Inherited Values
[ Exclude values
("l Regular Expression

B Include Data Containers

+ - Reset

Displaying 6 of 6 results

Mame

\.. 18210 M B_EN(18210)

£ Axel Kiers Vej 11 (ADD_101571)
& Customer A(CUS_101545)

& Customer B(CUS_107835)

Ll EVN-12(8108)

| InDesign modified (123216)

Show Details

Data Container search for Entity Data Container Type

[ ]

STIBOSYSTEMS

MASTER DATA MAMNAGEMENT

In the example below, a user searches for a data container type called 'Shipping Address' without refining the search
any further. If the user selects 'Shipping Address' as the Data Container Type and clicks Search, a list of entities for
which a data container has been added to an entity under the data container type 'Shipping Address' will display.
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Advanced Search X

Data Containers ~ X
Data Container Type shipping Address (ShippingAddress) F=

> Advanced

+ - Reset

Displaying 3 of 3 results Show Details

Mame

2 Customer A(CUS_101545)

2 Customer B(CUS_107835)

2 Customer C(CUS_107836)

The entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of 'ARGENTINA' in the Customer
tab, but with the value of ' BAHAMAS' on the Data Containers tab.

Customer B 1| Customer B
Customer « Revision: 0.6 Customer  Revision: 0.6
Data Containers  References  Referenced By .. > Customer References  Referenced By .1{
~ Description ~ Shipping Address
Name : ¢ | value i D ¢ | Attribute Name : ¢ | value
¢ | ID CUS_107835 ICountr\,-r Code =m | BAHAMAS I
| Name Customer B Country ISO =
¢ | Object Type Customer
¢ | Revision 0.6 Last edited by USERJ on Thu Jul 28 11:21:...
¢ | Path Entity hierarchy root/Entity Root/Customer Hie...
¢ | country Code =0 | ARGENTINA |

When a search is performed on the ‘Shipping Address' data container and the attribute 'Country Code' is selected, all of
the values are displayed. The search result will display the entity ‘Customer B’ only if the value is ‘BAHAMAS.’ The
search result will return ‘0’ if the value selected is ‘ARGENTINA’
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Advanced Search Advanced Search

Data Containers ~ X Data Containers « ~

Data Container TYPe  shipping Address (ShippingAddress)

Country Code (CountryCode) =

Country Code (CountryCode) =ANGUILLA (128360)
Country Code (CountryCode) =ANTIGUA AND BARBUDA (12 I Advanced
Country Code (CountryCode) =ARGENTINA (128399)

Data Container TYPE shipping Address (ShippingAddress)

Country Code (CountryCode) = BAHAMAS (128336)

Country Code (CountryCode) =ARUBA (128374) P—
Country Code (CountryCode) =AUSTRALIA (128343) + -

—{Country Code (CountryCode) =AUSTRIA (128368) — . - —
Country Code (CountryCode) =BAHAMAS (128336) | Is | Displaying 2 of 2 resufts Show Details
Country Code (CountryCode) =BARBADOS (128403) Mame

& Customer A(CUS_101545)

2 Customer B(CUS_107835)

Data Container search for Entity Data Container Type and Value

To continue the previous example, if the user refines the search for entities with a 'Country Code' data container type to
only include those data containers containing the value 'BAHAMAS', the user would enter ' BAHAMAS' in the input field.
In this example, results returned from the search show two of the original four entities. This means that a 'Shipping

Address' data container has been added to these two entities, and an attribute within those data containers also
contains the value 'BAHAMAS'.
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Advanced Search X

Data Containers ~ x

Data Container Type shipping Address (ShippingAddress) F=
BAHAMAS

> Advanced

+ - Reset Search

Displaying 2 of 2 results Show Details

Name

2 Customer A(CUS_101545)

2 Customer B(CUS_107835)

Operations on Entire Result

e & o
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Advanced Search: Document Content

With the Document Content search criteria you can search for a specified word / text string in text documents stored as
Assets in STEP.

Important: The option is only available for a system that meets these prerequisites:

* Full text indexable functionality is enabled

* Not running In-Memory

To use this search:

1. Click the Search tab and in the Search dropdown select Document Content.

Advanced Search Advanced Search
Search ~ X Search X
Search
Advanoad Object Type
Search Below
+ - Reset Search Referenced Assefs

Background Process Search
Revised Objects Changed Since

Data Containers

Cocurment Content

2. Enter the word / text string into the Find field.
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Advanced Search X
Document Content -~ A
Find
+ - Reset Search
Displaying 0 of 0 results Show Details
Name

3. Optionally, click the plus sign (=) to add additional search criteria.

4. Click on'Search' to run the search and view results.
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Advanced Search: JavaScript Search

The JavaScript search criteria searches through all JavaScript in STEP. It can match items in Business Rules, Match
Algorithms, Decision Tables, or any other structure programmed with JavaScript.

Follow the steps below to set up a JavaScript search:

1. Click the Advanced Search tab and click the Search dropdown.

Advanced Search

Search ~ x

» Advanced

+ - Reset Search

2. Select JavaScript search, add text to find in the Find field and click the Search button.

Advanced Search Search Result Profiling
Javascript search ~ X
Search Result Profiling
Find a
137 hit(s)
(] Match case Click links to narrow down search
O :
_J Match whole word only Results by Object Type

Special types (124)

+ - Reset Business Action (109) - exclude
Business Condition (15) - sxclude

Displaying 137 of 137 results Show Details

Name
& (acn-07e2afeb-f313-473c-84ef-ccf284- |
#¥ (acn-102dfec1-d94e-487e-8cc6-a55dal

& (acn-264295a6-ded44-49bf-bf88-642d8

JavaScript Checkbox Options
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These checkbox options are available with JavaScript search criteria:

* Match Case: If you select this, the search will only return results that match the upper or lower case letters that are

in the search criteria.

Advanced Search

Javascript search ~
Find | a

@ Match case

(L] Match whole word only

+ - 1 Reset

Displaying 68 of 68 results Show Details

Name
& (acn-07e2afeb-f313-473c-84ef-ccf284z |

#¥ (acn-102dfec1-d94e-487e-8cc6-as5dal

S farnoE02RA1 7 BRI AL TOR1RFAEEA"

* Match whole word only: will return only results that are the exact criteria that were put in that standalone. An
example would be if the letter 'a' were typed into a search, and only results that had 'a' in it that standalone

somewhere in the JavaScript were returned.
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Advanced Search p 4
Javascript search ~ X
Find a

() Match case

@ Match whole word only

+ - / Reset

Displaying 8 of 8 results Show Details

Mame

() BsSSPackagingLibrary (final) (BSSSPack |

i Bulk Notffication (BulkNotification)
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Advanced Search: Missing Mandatory Values

The Missing Mandatory Values search criteria is used for finding product objects that have valid mandatory
specification attributes without values.

To set a criteria as a Missing Mandatory Values search:

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ x

Advanced

+ - Reset Search

2. Select Missing Mandatory Values from the dropdown and click the Search button.

Advanced Search

Missing Mandatory Values|~ X
Missing Mandatory Values

+ - Reset
Displaying 0 of O results Show Details
MName
Use Cases

1. Product object which has specification and description attribute as mandatory with empty values.

The 'Manufacturer's Part Number' attribute is set as mandatory for Item object types. For product object
126418, the attribute value is left empty. In the Advanced Search tab, Missing Mandatory Values search
criteria is used with Search Below ‘ProductsRoot’ search criteria. 126418 is included in the search results.
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Advanced Search X 121212
Ttem = Revision: 0.1
Missing Mandatory Values X *
Product Data Containers  Sub Products  References Re
Search Below ~ X

Products (ProductsRoot) E=

~ Supplier Modify

+ - Reset Search Name ; f | Value
Displaying 200 of 372 results ~ Show Details ¢ | Long Ttem Description RBC

Name : ¢ | Manufacturer's Part Number | gsc

|x 114859 (114859) Sell Pack Qty m

e 121212(126418) Product Name asc

W 121933(121933) e e —

2. Description attribute is mandatory and is left blank on entity object.

In this example, the 'City' description attribute is set to mandatory. On the address entity ADD_114888, the
'City" attribute is empty. A search is performed that has a 'Missing Mandatory Values' search criteria with
Object Type ‘Entity’ search criteria. The ADD_114888 object is returned as a result.

Advanced Search * || 750 South Hampton Dr
Missing Mandatory Values " Address « Revision: 0.2
Address Data Containers References Referenced By f
Object Type ~ X
Entity ~
Hty ~ Description
+ - Reset Search Name : i | Value
D ADD_114888
Displaying 31 of 31 results show Details
Name Name 750 South Hampton Dr
Object Type Address
£ 56 West James Dr(121607)
Revision 0.2 Last edited by USER on W
£ 78 South Hampton Rd (121608)
Path Entity hierarchy root/Entity R
4+ 750 South Hampton Dr(ADD_114888)
Gty gac
4 3550 George Busbee Pkwy (ADD_107837)

The search criteria requires no data input or selections to be made. However, it is encouraged to use in conjunction
with another search criteria (by clicking the + sign) to help further refine the search.
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Note: As the Missing Mandatory Values search criteria only works on Product objects, using it in combination
with other search criteria will limit the search result to such objects.

The Missing Mandatory Values search criteria can also be set to exclude Product objects with missing Mandatory
values. This functionality is described in the Using the Exclude Search Criteria section of the Advanced Search
Functionality topic.
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Advanced Search: Object Type

With the Object Type search criteria you can limit your search result to items of a specific Object Type. These objects
are maintained in the workbench System Setup > Object Types & Structures folder.

1. Click on the Advanced Search tab and click the Search dropdown.

Advanced Search

Search ~ x

Advanced

+ - Reset Search

2. Select Object Type from the dropdown.

Advanced Search

IDI:r]'ect Type ~ e
Product ~

+ - Reset Search

3. Inthe dropdown that displays 'Product' by default, select an object type. Refer to the System Setup Object Types

section below for more information.

Hover on an object type to display a sub menu when available.

“ When an Other... option is available, click it to display a selection dialog. Use the Browse or Search tab to select

the object type. Click Select to confirm.
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Advanced Search

Object Type ~
Product
Product > Product
Asset_ | ’ DItem
Classification ? External Ttem Eni
Attribute Buy Side
List of Values Level 1
Unit _ Level 2
Pubﬁcat_lon Group > Level 3
Pubﬁcat-lon _ ? Eltem
Publication Section > PG_1301
Entity i’ Ttem Family
Special types ? Sales Ttem

Other...

”

Browse

Please Choose Object Type

Search

* [ Primary Product Classification
¢ [T Discontinued Products

» (& eClass Advanced Product Root
» & External Products

» Bl GDSN Products

P BB Packaging Hierarchy

P [0 Primary Product Classification
& Product Folder

F O Product Overrides

b [0 Products

> Details

Select

Cancel

Advanced Search

Object Type = Product

Search =
ACME i

> Advanced

Reset
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Note: Without the additional search criterion shown above, the results will be a list of all objects of the

specified type.

5. Click Search to run the search and view results.

Advanced Search * || Search Result Profiling
Object Type = Product x
y Search Result Profiling
SIE T 33 hit(s)
ACME Click links to narrow down search
7 Advanced Results by Object Type

Product (33} - e=xclude

+ - Reset Ll ltem (21) - excluce
tltem Folder (B} - exclude
; ; o Meta w Sales tem (8) - sxclude
Displaying 33 of 33 results Show Details [SiLevel 2 (1) - sxcluce
MName
Results by Position in Tree Hierarchy
|.:1 20803 (20803)
Results per Parent
|L21933 (2 1g33) (displaying the 5 most common)
[T DeskLlamp ltems (16) - =xclude
i1 27244 (27244) Bl Beds Items (5) - =eclude
[ClIn-Ear(3) - exclude
|- ABC-123(110014) O Over-Ear (3) - exclude

Bl Befrigeration ltems (2} - exclude

Bl Acme In-Ear Headphones - Black (Print_

MR Acme In-Ear Headphones - Blue (Print_| Results by Value

) Values matching "ACME"
MR Acme In-Ear Headphﬂnes - Green (Prlnt Malues are displayed in lowercase)
Ml Acme Over-Ear Headphones - Black (Pri acme (34) - exclude

Attributes with values matching "ACME"
H% Manufacturer Mame (13} - exclude

Brand Mame (¥} - exclude
Print Brand (6] - exclude

Operations on Entire Result

System Setup Object Types

Some object type selections require further information, as indicated by the additional context menu.
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Advanced Search

Object Type ~
Product
Product >
Asset H
Classification >
Attribute
List of Values
Unit

=1

Publication Group >
Publication »
Publication Section >
Entity »
Special types >

Attributes, Lists of Values, and Units

The Attribute, List of Values, and Unit object type categories do not include sub selections. All of the selected
object types available will be searched for each of these categories.

Special Types

Special Types includes Table Type, Business Rule, Business Library, Business Condition, Business Action, and
Business Function object types.
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Advanced Search: Product Override Search

With the Product Override search criteria you can locate and identify any product overrides present in your system. You

can search for all overrides in STEP or you can narrow your search to overrides of a specific product. If more concise
results are required, you can specify sub-products.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ X

Advanced

+ - Reset Search

2. Select Product Override Search from the dropdown.

Advanced Search

Product Override Search - ~
rOverridden Product
() Find Al

© Find by Overridden Product
Overridden Product

-Sub Products
() Exact Match on Chid Products

Sub Product

Add Child Product

3. Inthe Overridden Product group, select a radio button :
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“ Find All - Searches for all product overrides.

® Find by Overridden Product - Searches for the specified product, as shown in this image. In the text box, either

type the product's name, or click the selector button ) to browse or search for a product.

Advanced Search Overridden Product
Product Override Search - Browse Search
rOverridden Product
) Find Al w [T Electronics
© Find by Overridden Product v P B Audio Accessories
» [ Computer Products
Overridden Product  gatteries (20878) il P
* [0 Electronic Accessories
-Sub Products w [ Power
("] Exact Match on Child Products b [5 Batteries
Sub Product Il Type S Contactors and Starters
mns St rrF
Add Child Product & Stereo power ampifier
P [ Game Software
» = Mobile Phones
+ - Reset Search P 2 Small Appliances
Details
Select Cancel

4. Inthe Sub Products group, set the following options as needed:

“ Exact Match on Child Products - When checked, search results must have every sub-product specified.

© Add Child Product - Click the link to select sub products that will narrow the search further by requiring search
results to have exactly the specified sub-products linked to them.

Click the edit button (i) on one or a group of rows to display the following menu and perform the action:
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-Sub Products
(] Exact Match on Child Products
Sub Product
|:| Add Chid Product
] Hide
+ - Sl et Search
Displa Add Chid Product  Ctrl+Plus Show Details

‘ MNam Ctrl+Minus

® Hide - Hides an added child product from list.

© Show All Rows - Show all hidden child products.

© Add Child Product - Does the same operation as the ‘Add Child Product' link as stated above.
© Remove sub product - Removes the selected child product.
5. If needed, click the plus button (- ) to add additional search criteria.

6. Click on Search to run the search and view results.

This image shows products with the specified child product, but others child products could exist as well.
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Product Override Search =

rOverridden Product
() Find Al

O Find by Overridden Product
Overridden Product patteries (20878)
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* || Search Result Profiling

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type

Product (1] - exclude

-Sub Products
(] Exact Match on Child Products

Wl Standard Product-Override (1) - seclude

Sub Product

Results by Position in Tree Hierarchy

Results per Parent

Batteries Rechargeable ItemFolder

ELlevel 2 (1) - sxclude

Batteries Items

Add Child Product

+ -

Reset

Displaying 1 of 1 results

Show Details

Mame

|1 Batteries Override 2 — Batteries(179577)

This image shows there are no overridden products with only this exact sub product.
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Product Override Search -

rOverridden Product
() Find Al

O Find by Overridden Product
Overridden Product  gatteries (20878)

-Sub Products
(] Exact Match on Child Products

Sub Product

Batteries Accumulators

Add Child Product

+ - Reset

Displaying 0 of 0 results

Show Details

Name

M

=]

Search Result

This image shows overrides regardless of sub products.
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Product Override Search ~

rOverridden Product
) Find Al

© Find by Overridden Product
Overridden Product atteries (20878)

Search Result Profiling

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Product (3] - exclude

rsub Products
(] Exact Match on Chid Products

Sub Product

Add Child Product

+ - Reset

Displaying 3 of 3 results

Show Details

Mame

|2 Batteries Override 1 — Batteries(124085)

2 Batteries Override 2 — Batteries (179577)

12 Batteries Override 3 — Batteries (179584)

\ Standard Product-Override (3) - seclude

Results by Position in Tree Hierarchy

Results per Parent
S Level 2 (3) - exclude
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Advanced Search: Referenced Assets

The Referenced Assets search criteria is used for finding product objects which has referenced assets to the
specified product.

By default, all local referenced assets for the specified product are displayed.
To set up Referenced Assets search criteria:

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search - ~

Advanced

+ - Reset Search

2. Select Referenced Assets from the dropdown.

Advanced Search

Search »

Search

Object Type
Search Below
Referenced Assets Search

i Background Process Search
_ _ _ show Details
Revised Objects Changed Since

3. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By running a
basic search, it will return results of all referenced assets of the product specified.
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Advanced Search Search Result Profiling
Referenced Assets ~ X
Search Result Profilin
Product Name dress shoes i) g
(1153
Include Inherited Assets [ Click links to narrow down search

Match Case on Names [
Results by Object Type

+ - Reset Asset (3] - exclude
| Product Image (3) - sxclude
Displaying 3 of 3 results Show Details
Name Results by Position in Tree Hierarchy

Results per Parent

|| 20695 back (20700
J ( ] C120(3) - exclude

W 20695 main (20701)

W 20695 side (20702)

Note: If the product ID and name are the same, or if the product name has numbers as part of its name, the
search result will still display all the local referenced assets of the product specified.

Checkboxes for Referenced Assets Search

When performing a search, there are two search checkbox options that can be selected.

* Include Inherited Assets - This option is used when the inherited referenced assets on the specified product are to

be included in the search result.

Tree 235915-2
~ Bl T-shirts Items Ttem = Revision: 0.35
» Wl Cotton T-Shirts Product Data Containers  Sub Products References  Refel
~ [l 235914-1
B 235915-2 Buyer, View
» Bl Women's T-Shirts Reference Type v i | Target
» Wl T-Shirts Fami -
_ v Accessory Optional + % | | Black Crew Neck *
P [T T-Shirts Sales Items
' i i + | @
» B3 Audio Visual Equipment Accessory Required /
b 3 Automotive Brand Logo + }j - ACme

k= Duildima Dradii—te
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® Match Case on Names - This ensures that the specified product name is searched matching the case (case

sensitive) and all local referenced assets are displayed in the search result.
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Advanced Search: References and Referenced By

The References and Referenced By criteria work similarly.

To navigate to either of these searches:

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ X

* Advanced

+ - Reset Search

2. Select Referenced By or References from the dropdown.
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Advanced Search

Search X

Search
Object Type
Search Below
Referenced Assets
=2arch
Background Process Search
2 Revised Objects Changed Since ————
w Details
Data Containers
Search from List
Javascript search
Missing Mandatory Values
Unapproved
Product Override Search

Search in Publication Hierarchy

Referenced By

References
STEP Waorkflow

Both options require a reference type selection to begin. Reference types are setup in STEP Workbench System Setup
tab in the Reference Types folder, and the Web Ul Advanced Search allows you to pick from image and document
reference types, classification reference types, and product reference types.

Once a reference type is entered, no additional options need to be filled in to start a search. Use the information at a
high level or fill in the other values to drill down further (e.g., multi-supplier item references). Select a reference source
under Referenced By and a target under the References. Plus enter specific attributes and values to search reference
metadata.

References

For References, there are three boxes that can be checked: Include Inherited References, Include Data Container
References, and Finding Missing References.

Include Inherited References: When this is selected, it will show items that have the particular search criteria passed
down to them from a parent folder or level.

© Stibo Systems - Public - 2025.3 - September 2025 364



- |STIBOSYSTEMS

b MASTER DATA MAMAGEMENT

Advanced Search “ || Search Result Profiling

References ~
Search Result Profiling

Reference T .
YPE Owners Manual (OwnersManual) o+ 42 hit(s)

. Click links to narrow down search
@ Include Inherited References

[_] Include DataContainer References Results by Object Type
Product (42} - exclude
Ll ltem (42) - exclude

("] Find Missing References

Reference Target

Search ~ X Results by Position in Tree Hierarchy

Results per Parent
(displaying the 5 most commaon)

> Advanced Il Cotton T-shirts (33) - =sxclude
F'mdun:t Classification (12) - exclude

L[] T-Shirts (3] - =sclude

Bl Roundieck - T-shirts (3) - =xclude

r_=|F'FUdLIE'tS ['3} - exclude

Reference Metadata

+ - Reset

Displaying 42 of 42 results Show Details

MName

el Item 3(124627)

.. Ttem 4a(124631)

Include Data Container References: When this is selected, references that appear on data containers may appear in

the search results.
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Advanced Search p 4

References -
Reference Type cystomer To Location (CustomerToLocation) T =

[ Include Inherited References

B Include DataContainer References

(] Find Missing References

Reference Target
|

+ - Reset

Displaying 1 of 1 results Show Details

Mame

(D Acme (Acme)

Finding Missing References: When the reference type is selected, and this box is checked, the populated results will

show all items that have that particular missing reference.
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References ~
Reference Type \video (Video)

[] Include Inherited References

[ Include DataContainer References

@ Find Missing References

Reference Target

Reference Metadata

+1r

Reset

Displaying 126 of 126 results

Mame
[51(122866)

|..(122868)

Reference Target

Show Details

[ ]

STIBOSYSTEMS
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The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button. This

will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’ search

field.

In this example, the ‘Reference Type’ field is empty. Hence the result is regardless of the reference type.
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Advanced Search

References -

Reference Type

[] Include Inherited References
[ Include DataContainer References

() Find Missing References

Reference Target

Search =
image/jpeg

* Advanced

Reference Metadata

Reset

+v

Displaying 34 of 34 results

Mame

18225 (8225) |

] P L R I R Tt Y

The search result will differ when the ‘Reference Type’ is specified.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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Advanced Search

References -

Reference Type product Image (Productimage)

[] Include Inherited References

[ Include DataContainer References

[l Find Missing References

Reference Target

Search =
image/jpeg

* Advanced

Reference Metadata

Reset

+v

Displaying 10 of 10 results

Show Details

Mame

| 18217-0542(127995) |

] e K M Y il B TRy S ol W ] w1

If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and select

the appropriate option. For more details on the advanced options, refer to the Advanced Search: Advanced

Options topic.
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Reference Target

Search - *
image/jpeg

Advanced
(L] Match Case on Names and Values
[ Include Inherited Values
[ Exclude values
(] Regular Expression

() Include Data Containers

Referenced By
Reference Source

The user must type the ID / Name of the source to search. It will list the items which have been used as a source.
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Advanced Search X
Referenced By ~ 4
Reference Type [

[] Include DataContainer References

Reference Source

Search Below ~ X
Primary Product Hierarchy (Product hierarchy root) ©:

Reference Metadata

+ ~ Reset

Displaying 200 of 342 results Show Details

Mame

|l (115603) |

Click the selector button () to browse for a reference type for search either type in the reference type ID / Name

for more restricted search.
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Advanced Search
Referenced By ~
Reference Type product Image (Productimage)
(] Include DataContainer References
Reference Source

Search Below ~
Primary Product Hierarchy (Product hierarchy root)

Reference Metadata

Reset

+ -
Displaying 22 of 22 results

sShow Details

Mame
72207 (155618)

m!01N22EMa1NR2EY

If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open the
Advanced flipper and select the appropriate. For more details on the advanced options, refer to the Advanced

Search: Advanced Options topic.
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Referenced By ~
Reference Type product Image (Productimage)
([ Include DataContainer References
Reference Source

Search =

Advanced
(] Match Case on Names and Values
[ Include Inherited Values
(] Exclude values
(] Regular Expression

[ Include Data Containers

References and Referenced By Metadata Attribute Value Searches

Values for metadata attributes may be searched by using the References or Referenced By search options. Users may
indicate any value to search all metadata attributes for a matching value. Although the following pictures demonstrate
with References, the same is true for Referenced By.
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Advanced Search X

References -

Reference Type gj| of Materials (BillOfMaterials) =
[] Include Inherited References
[ Include DataContainer References

() Find Missing References
Reference Target

Search ~ »

* Advanced

Reference Metadata
Qty (Qty) =1

+ ~ Reset

Displaying 2 of 2 results Show Details

Name

L.l 123855 0(123855)

i 123858 0(124458)

Alternatively, users may enter an attribute /D or name, operator, and value for a more restricted search.
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Advanced Search X
References - x
Reference Type L-

[] Include Inherited References
[ Include DataContainer References

() Find Missing References
Reference Target

Search =

* Advanced

Reference Metadata
Qty (Qty) =1

+ ~ Reset

Displaying 4 of 4 resuits | Show Details

Name

L.l 123855 0(123855) |

| 123857 G(123857)

Note: Itis not possible to perform searches on missing metadata values.
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Advanced Search: Revised Objects Changed Since

With the Revised Objects Changed Since search criteria you can find recently edited objects in the workbench. To
narrow your search, enter an exact date / time to determine how old the changes can be, or you use intervals of days,
hours, or minutes. Revised Objects Changed Since criteria can be combined with any other search criteria.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ X

Advanced

+ - Reset Search

2. Select Revised Objects Changed Since from the dropdown.

Advanced Search

Revised Objects Changed Since ~ X

Date b

2025-01-15 14:00:39

+ - Reset

3. Make a selection from the dropdown:
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Advanced Search

Revised Objects Changed Since ~ X
Date

Interval in days
Interval in hours
Interval in minutes

+ - Reset Search

Note: Only number values are accepted as input for the options Interval in days, Interval in hours, Interval

in minutes. When Days/day, hour/Hours/H, or minutes/Min/M is suffixed along with number, the number
value is considered.

In this example, 'Date' is used for the 'Revised Objects Changed Since' search field. The Date option will
provide a data picker, allowing for the selection of the data and time.

Ml 5J Date Pick
Advanced Search : E2 Date Picker
Revised Objects Changed Since ~ » Year: Month: Day:
Date w 2025 ~ jan ~ 15 ~
H
2025-01-27 14:06:16 g Hours: Minutes: Seconds:
- 14 00 39|
+ - Reset Search
Cancel

4. Click the ellipsis button ) and determine the date / time of the oldest objects to search. Click OK.

5. If necessary, click the plus button (=) to define additional search criteria.

6. Click on Search to run the search and view results.
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Advanced Search X
Revised Objects Changed Since ~ X
Date o

2025-01-15 14:00:39

+ - Reset
Displaying 10 of 10 results Show Details
Name

Il 235914-1(235914)

B235915-2(235915)

I mpMont F1E7e18)

Interval in days - Specify the number value in the field.

b MASTER DATA MAMAGEMENT

The search result is displayed as shown below with objects which are revised since last 3 days.

Advanced Search X
Revised Objects Changed Since ~ e
Interval in days w

3
+ - Reset
Displaying 5 of 5 results Show Details
Name :

Il 235914-1(235914)

B235915-2(235915)

L. ALRM-01(157618)

BE Packaging (PackagingRoot)

= Products (ProductsRoot)
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* Interval in hours -Specify the number value in the field.

The search result is displayed as shown below with objects which are revised since last 60 hours.

Advanced Search X

Revised Objects Changed Since ~ X

Interval in hours v

24

+ ~ Reset

Displaying 3 of 3 results Show Details

Mame

Il 235914-1(235914)

¥ 235915-2 (235915)

.. ALRM-01(157618)

* Interval in minutes - Specify the number value in the field.

The search result is displayed as shown below with objects which are revised since last 30 minutes.

Advanced Search X

Revised Objects Changed Since ~ X

Interval in minutes w

160

+ ~ Reset

Displaying 2 of 2 results Show Details

Mame

Il 235914-1(235914)

¥ 235915-2 (235915)
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Advanced Search: Sample Result

The Sample Result Search Criterion allows users to refine the search results to only those specified numbers. When
the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a user enters a
random number and clicks on the Search button, the search result will be zero. Hence, this option should always be
appended to an existing search. Add a numeric value for 'Sample Results Size' to further refine the search result based
on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has 125
products. To do so, on the Advanced Search tab add a Search Below criterion and select the appropriate node to
search below. For more on how to search below, refer to the Advanced Search: Search Below topic.

Advanced Search Search Result Profiling
Search Below ~ X _
Food and Beverage (8303) Search Result Profiling
125 hit(s)
Click links to narrow down search
+ - Reset Results by Object Type
Product {(125) - exclude
Displaying 125 of 125 results Show Details llﬂ Oenn‘fl"msflles ”_e\':v(_gf} - =xclude
I ltem Folder (4) - sxclude
hame Lue Sales Item (3) - xclude
ELE"I’EI 3(3) - exclude
L. 7132-06 (8093) | [ Level 2 (2) - exclude
[T Sales ltem Folder (1) - exclude
|1 7133-12(8081) [ SalesltemFamily (1) - sxclude
o Llevel 1 (1) - exclude
li?134_24(8094j iltem Family (1) - exclude
|_13240069 (3240069) Results by Position in Tree Hierarchy
|_324DCI?CI (32400?03 Results below child nodes of Food and Beverage
= Beverage (111} - exclude
|_324Dl?3(324[]1?3] 5 Eood (13} - exclude
|—3240195 (3240195) Results per Parent
(displaying the 5 most commaon)
|_3240196|[324[1196]
|61 713424 (96) - exclude
Bl Kellogg's (6) - exclude
Operations on Entire Result Il Evian Water Famllv f4:- - exclude
[l Products (3) - exclude
E} D T! [T\ Eiltered Water Famlll.r f3} - exclude

Now, to append the results with the ‘Sample Result’ search criterion, click the 'Add Criteria' button (+) and select

'Sample Results' from the dropdown and enter a sample size and click the Search button. In this example ‘10’ is the
Sample Results Size.
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Advanced Search » || Search Result Profiling X
Search Below = Food and Beverage x
» Search Result Profiling
Sample Result ~ 13 hitgs)
Sample Result Size 1 Click links to narrow down search
Results by Object Type
+ - Reset Search Product (13} - exzclude
| Open Sales ltem (11} - sxclude
ELE":‘El 31 - exclude
Displaying 13 of 13 results Show Details EEmi{l) - exchue
Name : Results by Position in Tree Hierarchy
| 3240195 (3240195) Results below child nodes of Food and Beverage
Beverage (12} - exclude
| 13370540(3370540) gma (1) - -';xclhc-; -
|_13370587(3370587) Results per Parent
|_3381301(3381301:| I 7134-24 (11) - exclude
‘KE”UGG'S I,"H - exclude
| 3381303 (3381303) ] Products (1) - exclude
51 Beverage (1) - exclude
|L13381378(3381378)
|_13381393(3381393)
Operations on Entire Result
e & o

A set of random results display and around the specified sample results size number. Click the Search button
multiple times to change the sample search results.
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Advanced Search: Search Below

The Search Below Search Criteria allows you to limit your search result to objects below a specified node in the
System Setup or Tree tab hierarchy.

Note: The search below option can be applied to the following object types only: attribute, classification,
collection, entity, product, and publication.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search - X

Advanced

+ - Reset Search

2. Select Search Below from the dropdown.
Advanced Search

Search Below ~ X
Primary Product Hierarchy (Product hierarchy root)

+ - Reset Search
Search Result Show Details
MName

3. Click the selector button ) to display the Search Below... dialog. By default the Primary Product Hierarchy is

selected as search criteria.
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Advanced Search p 4

Search Below ~ X
Primary Product Hierarchy (Product hierarchy root) E

Search Below...

4 oh

+
Eag Browse  Search Details
MNai

P [T Classification 1 root

» [TJ Entity hierarchy root

¥ I Primary Product Hierarchy
¥ £ Attribute Groups

> Details

Select Cancel

4. Select a node in the hierarchy and click the Select button.
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Advanced Search p 4

Search Below ~ X
Primary Product Hierarchy (Product hierarchy root)

Search Below...

ch

Saqf Browse  Search Details

Mai

P [T Classification 1 root I
» [TJ Entity hierarchy root
* I Primary Product Hierarchy
[0 Products
[0 Alarm Clocks
3 Alarm-001

=i Almems AND

> Details

Cancel

5. Click the Search button

Advanced Search X
Search Below ~ X
Alarm Clocks (160298)

;- Rese
Search Result Show Details
MName

The Results displayed includes only items at or below the selected node. Additionally, the selected node for
the search below criteria will also be included in the search results.
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Advanced Search

Search Below -
Alarm Clocks (160298)

+ -

Reset

Displaying 4 of 4 results

Show Details

Mame

5 Alarm-001 (411857)

[ Alarm-002 (411860)

5 Alarm-003 (160349)

S Alarm Clocks (160298)

© Stibo Systems - Public - 2025.3 - September 2025

b MASTER DATA MAMAGEMENT

385



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Advanced Search: Search from List

With the Search from List search criteria you can search using a list of data. This data can be manually entered into the
user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet. Users may specify whether
the entered data should be used to search for object IDs, names, key values, attributes values (with specification of the
particular attribute), or other criteria. This makes Search from List an efficient and easy way to find large numbers of
objects in STEP and, in combination with other available search option, suitable for highly complex and extensive

searches.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search -

Advanced

+ - Reset Search

2. Select Search from List from the dropdown to display a text field and dropdown with a options based on your

system.
Advanced Search

Search from List ~

Mumber of entries: 0

ID w

MName

Asset URL Key
—HGDSN Key -
Key 11

[Supplier Part Number
TDR

Attribute...
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In this example, we choose Search from List: ID, which allows specifying the data list in the text field and
searching by 'ID' (selected from the dropdown).

3. Use one of the following methods to enter the data list to search in the text box:
Advanced Search

Search from List ~

17739
23345
12325

Mumber of entries: 3

ID V

+ - Reset

° Manually use the Enter key to create a line break between each value.

@ Copy data from Excel or any other application where line breaks or tabs are included to separate the values. Each
value must be listed on a line or be separated by a tab delimiter, without any characters (including bullet indicators
and spaces) around it. Refer to the Using a Data List from an External Application section below.

4. If needed, click the plus button (- ) to add additional search criteria.

5. Click on Search to run the search and view results.
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Advanced Search Search Result Profiling
Search from List ~ ”

Search Result Profiling
17739 .

2 hit(s)
23345 Click links to narrow down search

12323

Results by Object Type
Product (1) - exclude

ID - | Sales tem (1) - exclude
Classification (1] - exclude

Mumber of entries: 3

+ - = [CJAssetlevel 2 (1) - exclude

Dispiaying 2 of 2 results show Detals || pasylts by Position in Tree Hierarchy
hame Results per Parent

[C155(17739) [T Hats and Caps Sales ltems (1) - exclude

L 1112121-1(17739)

Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID

Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example above.
Search from List: Name

Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.

Enter the values to search into the text field. Click Search to run the search and view results.

The search results display with the name of the objects specified in the data list.
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Advanced Search Search Result Profiling
Search from List ~ X
Search Result Profiling
Cotton T-Shirts .
-Shirts Family 2 nit(s)
T-5ni Click links to narrow down search
Results by Object Type
Number of entries: 2
Product (2] - exclude
Name > Bl ltem Family (2) - exclude
+ ~ Reset Results by Position in Tree Hierarchy
: : : Results per Parent
Displaying 2 of 2 results Show Details B T-shirts tems (2) - exclude
Name [C1Pencils (1) - sxclude
r_=|F'EFIS (1} - exclude
[T Sale Products (1) - excludes

Bl Cotton T-Shirts(18209)

Il T-Shirts Famity (298905)

Search from List: Key
Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the data

list.
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Search from List =

ox5-21211
160350
651352

Number of entries: 3

Supplier Part Number

Reset

+v
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Search Result Profiling

Search Result Profiling
3 hit(s)
Click links to narrow down search

Results by Object Type
Product {3} -

exclude

Displaying 3 of 3 results

Mame
|.. 18215-012(18215)

8233440 (233440)

Considerations

Show Details

B8 Nuts and Bolts Kit (231117)

Pitem (2) - =xciude
5 Sales tem (1) - sxclude

Results by Position in Tree Hierarchy

Results per Parent

5 Hardware Kits (1) - =xclude
[ Battery Backup (1} - exclude
[ Hats and Caps (1) - =sxclude

Only active keys are available as an option in the dropdown list.

Active keys that have values in products can be searched.

*® Searching for active keys with empty values in a data list field will NOT return search results.

For more on keys and how to activate them, refer to the Unique Keys topic in the System Setup documentation.

Search from List; Attributes

Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute’ from the

dropdown.
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Advanced Search

Search from List =

Number of entries: 0

|Attribute...

Please Select Attnbute

Browse  Search

Search Re

A OAES a mae m

Nan v (£ Attribute Groups
b £ (BMECat_Attributes)
» £3 00 | Reference Metadata
» £3 02 | Product Attributes

> Details

Select

-

Cancel

b MASTER DATA MAMAGEMENT

Note: Description attributes are displayed under the product hierarchy node in the folders for which they are

valid.
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Please Select Attribute

Browse  Search

* [ Display
w [ Ttem Maintenance
~ [ Ttem Brand Information I
1% Brand Owner
1% Brand Name
13 Qualifier 1
13 Qualifier 2

> Details

Select Cancel

The search results display with the attributes specified.
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Advanced Search Search Result Profiling

Search from List -
Search Result Profiling

ACME 5 hit(s)
Click links to narrow down search

Results by Object Type

Number of entries: 1
Product (5} - exclude

Brand Name v Vi ltem (5) - exciude

+ - Reset Results by Position in Tree Hierarchy
_ _ : Results per Parent

Displaying 5 of 5 results Show Details g8 Beds ltems (5) - sxcivge
MName

|« Comfy Bed (22155)

|l Comfy Bed (128527)

|l Comfy Footboard (22168)
|« Comfy Headboard (22167)

|« Comfy Side Rail(22165)

Considerations
¢ Only one attribute can be selected from the Attribute Group browse / search window to be used as search criteria.

* Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes the object
that contains the searched value as a local value. While this object may not match an object type restriction, it points

to the origination of the searched text.
® Attribute values inheriting from other contexts can be specified in the data list.

*® Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be displayed
with any search result. (This restriction is not limited to the Search from List functionality.)

Using a Data List from an External Application

Copied data can come from Excel or any other application as long as line breaks or tabs are included to separate
the values. To copy data in, each value must be listed on its own line or separated by a tab delimiter, (tab key from
keyboard) without any characters (including bullet indicators and spaces) around it.
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In the example below, IDs have been copied over from an external file. Data can be horizontal or vertical as long as the
appropriate line breaks or tabs are in between the values.

Advanced Search X Advanced Search X
Search from List ~ x Search from List = »
[5x5-21211 [5%5-21211 160350 651352
160350
651352
Number of entries: 3 Number of entries: 3
Supplier Part Number - Supplier Part Number v
+ - Reset + ~ Reset
Displaying 3 of 3 results Show Details Displaying 3 of 3 results Show Detais
Mame Name .

\. 18215-012 (18215) L 18215-012 (18215)

233440 (233440) ¥ 233440(233440)

B nuts and Bolts Kit (231117) ¥ Nuts and Bolts Kit (231117)

© Stibo Systems - Public - 2025.3 - September 2025 394



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Advanced Search: Search in Publication Hierarchy

Objects below a specific publication hierarchy can be searched, and the status or a specific result can be
determined, by using the ‘Search in Publication Hierarchy.’

Keep in mind that this search is not used to search for different templates (such as products, publications, or page
templates) or to search number of objects / links placed in product template. It is only used to search the objects
below a specific publication hierarchy.

Note: To use 'Search in Publication Hierarchy' in the Advanced Search tab, it is recommended to have prior
knowledge of Print Publisher and the publication hierarchy. For more information, refer to the Publication
Hierarchy topic of the Publisher (Adobe InDesign Integration) documentation.

To search in a publication hierarchy:

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ x

Advanced

+ - Reset Search

2. Select Search in Publication Hierarchy from the dropdown.

© Stibo Systems - Public - 2025.3 - September 2025 395



[ ISTIBOSYSTEMS

MASTER DATA MAMNAGEMENT

Advanced Search

Search in Publication Hierarchy ~ A
Search below: Publications
Search for: Objects linked to Publication / Section >
+ - Reset Search
Show Details
Name

Note: The search criteria requires no data input. However, it is helpful to further refine the search by
pressing the plus sign button (=), and entering in information to limit the search results.

3. Supply information for the following 'Search for' parameters:

* Search below: Used for choosing a node. Select either the publication group or publication. The search
result will display all matched product objects which are under the selected publication group or publication.

* Search for: Specifies what object is being searched.

Advanced Search

Search in Publication Hierarchy ~
Search below: Publications

Search for: |l Objects linked to Publication / Section ~

+ - Objects in Assortment Lists

Objects in Baskets
Objects on actual pages .
Objects on planned pages
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@ Objects linked to Publication / Section: When this option is selected, products and assets linked to a

publication will be displayed in the result.

Advanced Search

Search in Publication Hierarchy ~

Search Result Profiling

Search Result Profiling

T hit(s)
Click links to narrow down search

Results by Object Type
Product (7} -

exclude

Search below: Electronics Sale Poster

Search for: Objects linked to Publication / Section ~ ~
+ ~ Reset
Displaying 7 of 7 results Show Details
Mame

I521933(21933)

|1 22200(22200)

|l Acme Automatic Drip Coffee Maker (22196)

|l Comfy Bed (22155)

| Comfy Footboard (22168)

Wl L uigi Bormiol Chardonnay Glass - 1(8063)

|« Luigi Bormioli Chardonnay Glasses - 4 (8059)

© Objects in Assortment Lists: This is a legacy component.

w fem (B) - exclude
Openltem (1) - exclude

Results by Position in Tree Hierarchy

Results per Parent
(displaying the 5 most commaon)

[ Products (3) - sxclude

B Beds tems (2) - exclude

Bl lrons tems (1) - exclude
Drinking tems (1) - exclude
104061-Override (1) - excluds

© Objects in Baskets: The products saved in a Basket will be displayed in the results.
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Tree # || Spring Party Catalog X
~ I Pubiications Publication Plan Version Pages Publcation Planner  Plan Notes i >
» B Templates
» B standard Publications Basket maintained locally Show flatplanner
» [l Autopage Publications
~ [ Flatplanner Publications Column View: ' Default e w
4 ﬁlSpring Party Calﬂog| D ¢ | Name ¢ | Primary Image : | On Pages
» [P spring Wedding Catalog
w [ Primary Product Hierarchy s 121183 I..| Pink & Blue Giraffe Party Hat 3,6
~ [0 Products 121218 I Pink & Blue Owl Party Hat 3.7
P [0 Apparel . A
Advanced Search Search Result Profiling

Search in Publication Hierarchy ~
Search Result Profiling

Search below: Spring Party Catalog
27 hit(s)
Search for: Objects in Baskets v Click links to narrow down search
+ ~ Reset Results by Object Type
Product sz} - exclude
Displaying 27 of 27 results IShow Details Vi tem (27) - sxciuce
Name :
Vv Results by Position in Tree Hierarchy

|« Pink & Blue Giraffe Party Hat (121183)
Results per Parent

= Pink & Blue Owi Party Hat(121218) (displaying the 5 most common)

[l Products (7) - exclude

|1+ 22200(22200) BB PaperHats (5) - sxclude

Bl Evian Water Family (3) - esclude

|..] Acme Automatic Drip Coffee Maker (22196) 3% r|:|d;xc2IL |
- exclude

| b st Phmimbn o | lme 4734 4 004% 1

Object on actual pages: the product and asset are used on actual pages (DTP documents) and will
display the results field.
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Tree

- [ Publications
» I8 Templates
| ~ Im Flatplanner Publications |
- [ Acme Party Supplies
» B Commerdial Data
b = Paper Hats
* 3 Party Hats
N
(55 4 - Galley Page
» & DTP Documents
b = Party Favors

Al Crvina WWinddina Catalan

Party Hats
Planned Page
Plan Planned Page Plan Notes  References Status  State Lo
Flatplanner
E B@ EE |Er|& i Wi H: |\-'iew Preview w
Galley Page
4

| [Pink & Green Party Hat}

Bog P et Assorirhe
TR, RS
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Advanced Search

Search in Publication Hierarchy ~

Search below: Flatplanner Publications
Searchfor:  Objects on actual pages
+ - Reset

Displaying 73 of 73 results

Show Details

Name

- OO T T LE LET

B Pink & Green Party Hat(121171)

|| pinl & Green Bam-Dam Hat 1211921

° Object on planned pages: The products and assets used on planned pages will be displayed in the

result.
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Tree || Acme Party Supplies
~ [ Publications - . . -
Publication  Miestone Dates Plan  Version Pages Publication Planner  Plan Notes
» [l Templates —
~ [ Flatplanner Publications
~ (3 Acme Party Suppies Flatplanner
» B8 Commercial Data a
B BN EE ‘H|x: Y: W H: View Plan
b 2 Paper Hats
~ [ Party Hats [ ] [ ] 1
(5F 2 - Party Hats Advanced Search X
ﬁ 4 - Galey Page
= ey Pag Search in Publication Hierarchy - X
» [E DTP Documents  belon
Searc : Flatplanner Publications
» O Party Favors _ _ [Crizmas Pary Az Bloz & vz
» [ Spring Wedding Catalog | S€archfor:  objects on planned pages
= [ Christmas Catalog
» B8 Commercial Data + -

Displaying 43 of 43 results

Name
- 1y 7 /

NB\ Christmas Party Hat (121184)

B A rfatt Malear (100Q50

4. Click the Search button to view the results.
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Advanced Search: STEP Workflow

With the STEP Workflow search criteria you can search for and monitor STEP workflows. Selecting a specific workflow

from the dropdown list will show all items associated with the workflow. You can also specify the workflow state to
narrow your search.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ X

Advanced

+ - Reset Search

2. Select STEP Workflow from the dropdown to display two additional dropdowns with options based on availability in
your system.

Advanced Search

STEP Workflow ~ ~
STEP Workflow Item Creation e
State w
+ - Reset Search
Search Result Show Details
MName

3. Forthe State dropdown, specify the state to search within.

© Select a state defined in the workflow to search only items currently in the state.

“ Select [any State] to search the entire workflow.

© Select [not in STEP workflow] to search objects which are not present in the selected workflow.
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Advanced Search

STEP Workflow =
STEP Workflow Item Creation

State
+ - [not in STEP Workflow]
Final Item Review
Supplier Enrichment
Search Result Buyer Review
Name Forecasting
Reqgulatory Enrich

4. If needed, click the plus button (<) to add additional search criteria.

5. Click Search to run the search and view results.

Advanced Search X
STEP Workflow ~ X
STEP Workflow Item Creation v
State [any State] v

+ - Reset
Displaying 94 of 94 results Show Details
Name
B (6005339) |
B (5005340)
| - s nnzaan
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Advanced Search: Unapproved

This criteria is used to identify objects that are not currently approved. These include classifications, products, images
and documents, and entities setup to be Workspace revisable.

1. Click on the Search tab and click the Search dropdown.

Advanced Search

Search ~ x

Advanced

+ - Reset Search

2. Select Unapproved from the dropdown.
Advanced Search

Unapproved ~ e
© Never Approved or Modified in Main

O Never Approved

O Modified in Main

B status in Current Context

+ - Reset | Search |

3. Select the appropriate radio button and set the checkbox:

© Never Approved or Modified in Main: All objects that have 'Never been approved' and have been 'Modified in

main'.
° Never Approved: Objects (products, classifications, assets & documents, or entities) that are workspace

revisable and that have never been approved.
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(4525820)
Sales Item « 2% Complete » Revision: 0.1
Product Data Containers Sub Products References Referenced By Images & Documern
* Description
Name : : | Value
D 4525820
Name
Object Type Sales Item
Revision 0.1 Last edited by USERL on Tue Aug 31 09:31:42 EDT 2021
Approved X Never Been Approved
Translation Not Translated
Path Primary Product Hierarchy/Products/Alarms/Alarm Clocks/Digital/B

ALRM-03

Sales Ttem e 6% Complete » Revision: 0.14

Product Data Containers Sub Products References Referenced By Images & Documsg

*~ Description
Name : ¢ | Value
ID 157620
Mame ALEM-03
Object Type Sales Item
Revision 0.14 Last edited by USER] on Fri Mar 31 14:56:59 EDT 2023
Approved (% Last Approved on Thu Nov 05 09:21:18 EST 2020 |
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Modified in Maintenance: Objects that are modified after the approval or added to in the maintenance workspace.
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* Status in Current Context: When this box is checked, only the current context is searched. If unchecked, all objects
in all contexts are searched.

Approved Vi
Workspace M

Context English Us -~

Advanced Search

Unapproved -
() Never Approved or Modified in Main
© Never Approved
() Modified in Main

@ status in Current Context

+ - Reset Search

4. If needed, click the plus button (<) to add additional search criteria.

5. Click Search to run the search and view results.
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Advanced Search: Unpushed or Failed Assets

The Unpushed for Failed Assets search criteria allow you to identify assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Download
Error.'

Acme Logo-100

Logo « Revision: 3.1

Images & Documents  References Referenced By Status Log Statelog Tasks

> Translation

~ Asset Push Status

Configura... : | Asset Push Status : | Relative Path i | Wor... : | Visibiity
Asset Push 2A Never been handled Main

raw-main v Downloaded i raw-main/32/25/103225.jpg Main

LowRes v Uptodate ai| LowRes/32/25/103225.jpg Main

Asset Push 4 A| 7 #873 (Never been handled) Approved
raw-approved Download error Approved

1. Click on the Search tab and click the Search dropdown.

Advanced Search 4
|Search - x
» Advanced
+ - Reset Search

2. Select Unpushed or Failed Assets from the dropdown and click the selector button ) to display the Select

Asset Push Configuration dialog. Select a configuration and click the Select button.
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‘9 raw-approved
& raw-main
¥ Event Queue A

> Details

Advanced Search X
Unpushed or Failed Assets ~ e
Configuration: , .

Select Asset Push Configuration
+ -
Browse  Search
Name b &) Asset Push 2
# Downstream Data
~ @ DTP Queue

Cancel

3. Click the Search button to display the Search Results List and Profiling information.
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Advanced Search X

Unpushed or Failed Assets ~ X
Configuration:  rzw-approved (raw-approved)

+ - Reset

Search Result Profiling

Displaying 200 of 618 results Show Details

MName

— ST A CoT O Do T

[#]CSVExport(182447)

[#]CSV w ZIP assets (198628)

'm|Cup (28062)

‘& Cup2 (28063)

‘& Cup3(Cup3)
D&BCustimp (24534)

[#1 Matarnntainere (7170451

Search Result Profiling
618 hit(s)

Click links to narrow down search
Motice: Profile is not filtered according to context visibility / privilege check

Results by Object Type
Asset (618 - exclude

@] Export Manager Configuration (244) - sxcluge
W) Product Image (185} - exclude

@] Import Manager Configuration (501 - sxcluds
@] Transformation Lookup Table (27) - excludes

2% Image Conversion Configuration (14) - exclude

GOSM Receiver X530 (7) - sxclude
GOSH Receiver CIN Sample (7)) - exclude
Installation Manual (6) - exclude
@] XML File (5) - exclude

| | BMECat Template (5) - exclude
loga |00 (5} - exclude

| Watermark (5) - exclude

i7l Owners Manual (4) - exclude

| lcon () - exclude

. GOSM XS0 (2) - =xcluds

2 Unknown / Undefined (1) - sxclude

“2 Translatinn Canfinuratinn (4% - =l

Note: Click an item in the list to view it, or click a profiling link to update the search results list.
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STEP Workbench Keyboard Shortcuts

Within STEP Workbench there are many shortcut key combinations that allow users to quickly navigate and make

- |STIBOSYSTEMS
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changes through the system. The following tables list and describe the options available for Shortcut Key options.

Basic Shortcuts

Shortcut Description Shortcut
Key

Copy Creates a duplicate of the information selected that can be pasted somewhere else. Ctri+C

Cut Takes away information that can be pasted into a different location if desired. Ctrl + X

Duplicate This duplicates the item selected, with the option to duplicate references as well. Ctrl +J

Go To Next | Finds the next item that matches what the user is looking for based on a search. The Ctrl+E

Object results may differ depending on what tab the user is working with, or the selected active
area.

Help When the workbench is open, displays a new window with the STEP Online Help F1
documentation.

Next Shifts the focus to the next cell. Tab

Paste When information that was either cut or copied from before is placed into an alternate Ctrl+V
area.

Previous Shifts the focus to the previous cell. Shift + Tab

Redo Goes to the changed sate, if the change was reversed. Ctrl + Shift

+Z

Reload Reloads the workbench and updates to any changes made. F5

Search This brings the user to the Search field in the upper right corner of the workbench Crl+G
screen to look up items.

Select All When the desired area is clicked in or is already the active area, pressing this key Ctrl+ A
combination will choose everything in this particular area.

Undo Goes back to the original state before the change was made. Ctrl+Z
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Navigate to Main Side Bar Tabs in STEP Workbench

Shortcut Description Shortcut

Key

Advanced Leaves the user looking at what they were on in the main frame, but brings up the Ctrl+F
Search Tab Advanced Search Tab along the left hand side.

Background Unless a product is being viewed, this will bring the user to the Background Alt+P
Process Tab Processes tab. If a user is on a product, this key combination will not transpire.

Bookmarks Brings the user to the Bookmarks side tab. Alt+M
System Setup | Brings the user to the System Setup tab. Alt+Y
Tab

Tree Tab This will bring a user to the Tree Tab only if not viewing an item in Tree in the main Alt+T

screen, or having an item still show up in the main screen even though navigation
has been away from it.

Workflow Tab | Navigates to the STEP Workflows tab. Alt+W

Navigate to Horizontal Tabs within Sidebar Tabs
To navigate to the horizontal tabs within the main tabs in the workbench, press Alt + (the letter underlined on the tab).

For example, if a workflow is selected within System Setup, pressing Alt + Sdisplays the Status tab for the workflow
being viewed because 'S’ is the underlined letter for the Status tab.

System Setup * || Clerical Review Golden Record I
v £ Workflows STEP Workflow Type « Revision: 0.12

i (acn-67aaf43b-259a-440b3-b73a-| STEP Workflow Editor  Validity | Status | Log
& (New Collection) —

» B Business_Action v Revisions
) Clerical Review Golden Record - . .| ]

Revision : | Created : | Edited : | Major

B Clerical Review Workflow Individuz

b (] Clerical Workflow 2 f 1012 Wed Aug 31 09:03...| Wed Aug 31 09:03...

¥ (Bl Collection 011 Thu Mar 03 15:03:... | Thu Mar 03 15:03:...
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Options for shortcut keys to horizontal tabs vary depending on what item is selected and the tab that a user is on (Tree,

Advanced Search, BG Processes, System Setup, Bookmarks, and STEP Workflow). Not all tabs have underlined

letters for shortcut key options.

General Shortcuts in STEP Workbench

Shortcut Description Shortcut
Key
Add Bookmark When on an object and this is pressed, it will add the item to the bookmark Ctri+D
list on the Bookmark tab.
Add Element When adding various elements, pressing this key combination will often (not | Ctrl + Plus
in all cases), bring up a dialog allowing the user to add to the desired list.
Approve Obiject When in Main, approves an object that was previously unapproved. Ctrl + Shift
+J
Mark Different (On In Tree, when viewing multiple products at once, or when viewing the Shift + F12
multi-product display) horizontal Sub Products tab for an item, selecting this key combination will
mark all areas that are different green.
New Window With STEP Workbench open, this will open an additional STEP Workbench | Ctrl+ N
window.
Remove Element When deleting various elements from lists or rows, pressing this key Ctrl +
combination will often remove the desired connection or item. Minus
Rotate Table (On Multi- | In Tree, when viewing multiple products at once, or when viewing the F11
Product display) horizontal Sub Products tab for an item, this rotates the table view if the
table is the active area.
Toggle attribute values | When on a field that is editable, selecting F2 allows the user to write in the F2

selection between
blinking cursor and
blue filter

field. When pressed again, the entire field turns blue, rendering it entered
and non-editable, unless F2 is pressed again or the field is clicked into
again.
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Insert Options

Shortcut Description Shortcut
Key
Insert Action Set In System Setup, when in the Action Sets, pressing this key Ctrl + Shift
combination will create a child Action in an Action set. +S
Insert Asset The Create Asset dialog appears when in Tree. Ctrl + Shift
+A
Insert Attribute Displays the Create Attribute dialog in System Setup. Ctrl + Shift
+T
Insert Attribute Group In System Setup, this creates a new Attribute Group if sitting on | Ctrl + Shift
the proper level. + 1
Insert Background Process | This allows a user to set up a background process to monitor Ctrl + Shift
to Monitor Deadlines / STEP | states with exceeded deadlines in the desired time frame. +D
Workflow Deadline
Monitoring
Insert Character Tag When typing in a field and this is selected, a dialog appears Ctrl+R
allowing the user to select from character tags.
Insert Classification In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+C
Insert Classification Root In Tree, a new Classification Root or top node yellow folder is Ctrl + Shift
created. +R
Insert Dimension In System Setup, when sitting on the top node for contexts, Ctrl + Shift
clicking these keys will bring up the dialog to create a new +D
dimension.
Insert Dimension Point In System Setup, when on a dimension, selecting this will Ctrl + Shift
create the dimension point. +M
Insert Group In System Setup, when on the node that houses Users and Ctrl + Shift
Groups, selecting this key combination will create a new group. | +G
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Shortcut Description Shortcut
Key
Insert List of Values In System Setup, when sitting on the top node for List of Ctrl + Shift
Values, pressing this will bring up the dialog to create a new +L

List of Values.

Insert non-breaking space Enters a non-breaking space when editing attribute values. Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute, which Ctrl + Shift
will appear in italics. +0

Insert Product When in Tree, this will create a new object under the one Ctrl + Shift
selected. +P

Insert Special Character When in a field that allows typing, selecting this brings up alist | Ctrl + Shift
of characters that can be selected and inserted into the field. +E

Insert STEP Workflow In System Setup, when on the top node for workflows, or when | Ctrl + Shift

inside the node for workflows, selecting this will bringupanew | +R
STEP Workflow Designer window to create a new workflow.

Insert Workspace In System Setup, when on a workspace, selecting this key Ctrl + Shift
combination will create a different workspace. +W

Linking Options

Shortcut Description Shortcut

Key

Link Asset When on References or References By tab, this allows asset links or references to | Ctrl + Shift
be selected and put into the appropriate folders. Note that the Reference Type can +F
be changed from the drop-down menu in the dialog that appears.

Link Attribute to | To link an Attribute to an item, select the item that needs the attribute and select this | Ctrl + Shift
Classification key combination. Linked attributes will appear in the References tab under the +Y
'Attributes' section.
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Shortcut Description Shortcut
Key

Link Attribute to | When on a product, selecting this key combination links an attribute to a product. Ctrl + Shift

Product +K

Link This links a classification to a product. It can be found under the Reference tab Ctrl + Shift

Classification to | under the 'Linked Attributes to Classifications Hierarchy' section. +H

a Product

Paste Link Creates a new reference (pointer or link) to an existing / copied object. An example | Ctrl +L

would be if the user copied a SKU from a blue folder and pasted it into the yellow
folders. Note that object types need to be compatible.

Link Product/ When on References or References By tab, this allows product links or references Ctrl + Shift
Create Link to be selected and put into the appropriate folders. +Q

Style Options

Shortcut Description Shortcut
Key

Bold When typing in a filed, this activates bold text. Ctrl+B

Character Tag | Opens the Insert Character Tag dialog for adding character tags to Ctrl+R

attribute values.

Italic When typing in a field, this activates italic text. Ctrl + 1
Non-breaking Enters a non-breaking space when editing attribute values. Ctrl +
Space Enter
Special Opens a dialog showing the most recently used special characters, as Ctrl + Shift
Character well as an option to select to view all special characters. Allows user to +E

select a special character to insert when editing attribute values.

Style This key combination can be pressed to bring up the Style box, where Ctri+Y
there are a number of styles to choose from.
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Shortcut Description Shortcut
Key

Rich Text Opens the Rich Text Editor in STEP Workbench when editing an attribute | Alt+ F2

Editor value.

Paste and When in a field, if 'text A" is copied from one area and is going to be Ctrl + Shift

Match Style pasted into 'text B' that is a different style, pressing this key combination +V

will make it so the copied 'text A" will past into 'text B' with the style of 'text
B'.

Flatplanner Shortcuts

Shortcut

Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctrl+ Alt+S

Zoom In (In Flatplanner) This zooms in on what is being worked on. | Ctrl + Plus

Zoom Out (In Flatplanner) | This zooms out of what is being worked on. | Ctrl + Minus
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